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General Information

Safety Information

Before using these products, read the
operating instructions for safe usage
& contained in the Product Safety and RF
Exposure booklet 6864117B25.
The MTHB80O0 is restricted to occupational use only to satisfy
ICNIRP RF energy exposure requirements. Before using the
products, read the RF energy awareness information and
operating instructions in the Product Safety and RF Exposure
booklet (Motorola Publication part number Safety Leaflet
6864117B25) to ensure compliance with RF energy exposure
limits.
Keep this User Guide and the Product Safety and RF
Exposure booklet in a safe place and make it available to
other operators in case the accessories are passed on to
other people.

Disposal Information

The European Union Waste of Electrical and
Electronic Equipment directive requires that
mmm products sold into EU countries must have the
crossed out trashbin label on the product (or the package in
some cases). As defined by the WEEE directive, this cross-
out trashbin label means that customers and end-users in EU
countries should not dispose of electronic and electrical
equipment or accessories in household waste.
Customers or end-users in EU countries should contact their
local equipment supplier representative or service centre for
information about the waste collection system in their
country.
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Copyright Information

The Motorola products described in this manual may include
copyrighted Motorola computer programs stored in
semiconductor memories or other mediums. Laws in the
United States and other countries preserve for Motorola
certain exclusive rights for copyrighted computer programs,
but not limited to, including the exclusive right to copy or
reproduce in any form the copyrighted computer program.
Accordingly, any copyrighted Motorola computer programs
contained in the Motorola products described in this manual
may not be copied, reproduced, modified, reverse-
engineered, or distributed in any manner without the express
written permission of Motorola. Furthermore, the purchase of
Motorola products shall not be deemed to grant either directly
or by implication, estoppel, or otherwise, any licence under
the copyrights, patents, or patent applications of Motorola,
except for the normal non-exclusive licence to use that arises
by operation of the law in the sale of a product.

Product Specific Information

Max. Voltage 42V

Max. Current 05A

Max. RF Power 1 Watt

Max. Speaker Load 0.5 Watts at 8 Ohms
Antenna Impedance 50 Ohms

Operation Temperature Range -30 °C to +60 °C

Operating Time Continuous / Intermittent

In general, the terminal transmit and receive time (operating
cycle time) is determined by the communication system. On
overload, respectively on extensive use beyond the systems
specifications at high ambient temperatures, the terminal is
protected by its thermal control, which cuts down the RF output
power, thus reducing the terminal coverage range.



Ilcon Conventions

The document set is designed to give the reader more visual
cues. The following graphic icons are used throughout the
documentation set. These icons and their associated
meanings are described below.

The signal word Warning with the associated
safety icon implies information that,

A if disregarded, could result in death or serious

injury, or serious product damage.

The signal word Caution with the associated
safety icon implies information that, if

& CAUTION disregarded, may result in minor or moderate
injury, or serious product damage.

The signal word Caution may be used without the
CAUTION safety icon to state potential damage or injury that is

not related to the product.

Notes contain information more important than the surrounding

text, such as exceptions or preconditions. They also refer the
reader elsewhere for additional information, remind the reader
how to complete an action (when it's not part of the current
procedure, for instance), or tell the reader where something is
located on the screen. There is no warning level associated with
a Note.
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Getting Started

Congratulations on your purchase of the Motorola MTH800.
Enhanced TETRA features and state-of-the-art technology
help to keep you in constant touch with all of your work and
personal contacts.

You can operate your MTH800 in English, German, French,
Spanish, Dutch, Swedish, Russian, or in a language defined
by your Service Provider. The default setting from factory is
English. For more information, please see “Setting the
Display’s Working Language” on page 124.

How to Use this Guide

This guide describes the MTH800 features as setup and pre-
programmed at the factory.

Your Service Provider or your organisation may have
customised your MTH800 to optimise its use for your
individual needs. Check with your Service Provider or
organisation to find out the differences from this guide.

Throughout the text in this publication, you will notice the
following special notations used to highlight certain
information or items:

payiels Buipen

Example Description
@ or Select Key presses are shown as a key symbol

or in bold print for soft key functions.

More...> Networks > TXI | Indicates navigation in menu items.
Mode > Activate

Contacts Highlighted text indicates the selection.

¥ On Indicates the active setting.

Status Delivered Information appearing on the MTH800
display is shown in special print.

<User Defined> Indicates a prompt or message
configured by your Service Provider.




Installing the Battery

1. Remove the battery from its protective clear plastic case.
. If necessary, remove the battery cover as shown below.
. Insert the battery top into the compartment as illustrated.

. Carefully press the battery silver bottom downward until it
clicks into place.

5. Replace battery cover.

HWDN

Replacing the Battery
1. To remove the battery cover, push down the cover button.
Slide the cover away.
2. Push retaining clip up and then lift the top of the battery out.
3. Replace the battery.
C




Charging the Battery

Motorola approved chargers provide optimum performance.
Other chargers may not fully charge your Motorola Lithium-
lon battery or may reduce the life of the battery.

The MTH800 can be either On or Off during charging.

1. Insert the connector on the charger into the socket at the
base of the MTH800. Select the required plug adapter (UK
or European type) and connect to the charger. Then plug
the charger into a suitable mains socket.

2. The MTH800 displays the Charger Connected message
only if the MTH800 is On when connecting the charger. If
the MTH800 is Off, the display shows an icon of the battery
in charging. Remove the MTH800 from the charger only
when the display goes off.

The Battery icon shows the charging status (see below).

e s (.

A

Empty Full Empty Full
Battery Capacity Battery Charge Progress
Battery Capacity Information
Information Description
Green icon Full (50% - 100% capacity)
Yellow icon Middle (20% - 50% capacity)
Red icon Low (10% - 20% capacity)
Empty icon Very low (5% - 10% capacity)
Low Battery message Less than 5% capacity
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Battery Maintenance

The performance of the rechargeable battery delivered with
your terminal depends on the way the battery is treated.

Therefore, to comply with the Motorola warranty for batteries
and to assure high performance and a long life cycle of your
Motorola rechargeable battery, please read and follow the
maintenance rules stated below.

Storage

Do not store your battery where the temperatures will exceed
+65 °C or fall below -20 °C.

New Lithium-lon batteries (i.e.batteries that have never been
charged before) may be stored for up to 2 years (with up to
50% of maximum charge) in well ventilated, cool and dry
areas with some capacity loss in life cycle.

Batteries, which have already been charged and then stored
for more than 2 months should be recharged overnight (14-
16 hours) before use.

Extending Battery Life

A battery is an expendable part and may need replacing
during the life of the terminal. To ensure maximum service life
of your handset, always replace the battery with a genuine
Motorola replacement.

In order to ensure maximum life from your battery, do not
place the handset and/or battery in the charger, unless you
really want to charge the battery.

Battery Charging Temperature

Your charger will only charge your battery when it is at
temperature range of 1 °C to 37 °C.

This is due to the fact that the internal battery cell can be
charged in the temperature range of 0 °C to 45 °C.

As the temperature gets colder (close to 0 °C) less capacity
is stored in the battery.



If, during charging, the temperature is out of range, the
battery might not be fully charged since the charging is
temporarily stopped until the temperature becomes suitable.
The range of battery operation is from 0 °C to +45 °C in
charger mode and from -10 °C to +60 °C in discharge
(application) mode.

First Time Battery Charging

Always charge your new battery/(whichever type) overnight
(14 - 16 hours) before using it. This is referred to as Initialising
and will ensure maximum battery start capacity.

Battery Charging Rules

Generally, to reduce the number of charge cycles as much as
you can wait for Low Battery message to charge as this will
ensure maximum battery life.

Do not use your charger as a terminal stand or leave your
terminal and fully charged battery connected to the charger
whilst not charging. Continuous charging will shorten the
battery life.

Attaching the Antenna
NOTE Turn the MTHB800 Off before installing or removing the antenna.

Insert the bottom of the antenna into the screw-in base on the
top of the MTH800. Turn clockwise until snug. Do not force.

N

Turn clockwise to attach
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Controls and Indicators

21. Emergency Key
(on top of the MTHS800)

20. Rotary Knob
(on top of the MTH800)

— 1. Antenna

19. Earpiece

18. PTT Button
(at the side of the MTH800)
17a. Programmable

Side Key
(at the side of the MTH800)

16.Soft Keys (2)
15. Send Key

14. Four-Way
Navigation Key

13. Speaker
(under keypad)

12. Speaker Contre
Key

2.LED
3. Top Microphone

4. External
Antenna Connector
(back of the MTH800)

5. Alphanumeric
Display

6. Menu Key

7. On-Off/End/Home
key

4 ¢ 8. Audio Accessory

Connector

(at the side of the
MTH800)

(™~ 9. Alphanumeric
Keypad

10. Bottom
Microphone

11. Accessory Connector
(at the base of the MTH800)

Item

Description

Antenna

LED (Indicator)

Top Microphone
Activated during Simplex, high-audio calls such as Group
Calls.

10




Item

Description

External Antenna Connector

Used with the digital car kit to connect the RF signal to the
external antenna.

(At the back of the MTH800)

Color Display

Provides alphanumeric text and images within 65,536
colours and 130 x 130 pixels with backlighting and
scalable fonts.

Menu Key
Used to enter the main menu and the context sensitive
menu.

On-Off/End//Home Key

Press and hold to turn the MTH800 On/Off.
Press to end calls.

Press to return to the Home display (idle screen).

Audio Accessory Connector
(At the side of the MTH800)

Alphanumeric Keypad
Use the keypad to enter alphanumeric characters for
dialing, contact entries and text messages.

10

Bottom Microphone
Activated during Simplex and Duplex, low-audio calls such
as Phone Calls.

1

Accessory Connector
Provides connection for accessories.
(At the base of the MTH800)

12

Speaker Control Key
Selects earpiece (low audio) or speaker (high audio)

13

Speaker (under keypad)

14

Four Way Navigation Key

Press up, down, left or right for list scrolling, while moving
around the menu hierarchy, or for alphanumeric text
editing.

11
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Item Description

15 | Send Key
Used to initiate or answer Duplex calls (such as Phone
Calls), or send status and text messages.

16 | Soft Key(s)
Press to select the option that appears in the display
directly above the left or right soft key.

17 | Programmable Side Keys 1 and 2

Default programming: upper Side key activates/
deactivates Backlight; lower Side key activates Screen
Saver.

(See also No. 20)

18 | Push-To-Talk Button (PTT)

Press and hold this side button to talk in Simplex calls,
release it to listen.

Press to send status and text messages.

19 | Earpiece

20 | Programmable Rotary Knob

Default programming: “Dual” - Press the knob to toggle
between “volume” and “list”. Side keys (No. 17) operate as
programmed.

21 | Programmable Emergency Button (on top of the
MTH800)

Press and hold to enter Emergency mode, and send
Emergency Alarms (as programmed). Press and hold to
start an Emergency Private Call (Simplex or Duplex).
When the MTHB800 is Off, press and hold to power on in
Emergency Operation or in standard mode (as
programmed).

Before using your MTHB80O for the first time, remove the plastic
NOTE lens protector from the display, and charge battery ovemight to
ensure battery is initialised to it's full capacity.

Take care to clean the boftom connector frequently and
NOTE particularly prior to the programming procedure e.g. with a soft
brush (do not use fluids).

It is recommended to tumn off the terminal before connecting any of
\(O21F the accessories.

12



Powering On/Off (On-Off/End/Home Key)
To power On, press and hold . Your MTHB800 performs a
self-check and registration routine. After successful
registration, the MTHB800 is in service.
To power Off, press and hold @ You will hear a beep and
the Powering Off message is displayed.

The terminal powers On and Off without visible and audible
NOTE notification if Covert Mode is activated. (Refer to “Covert Mode”
on page 36.)

Powering On (Emergency Button)
Press and hold the Emergency button to power On.

The MTH800 will power On in Emergency Operation or in
standard mode (as programmed).

Powering On with Transmit Inhibit (TXI) Active
Transmit Inhibit is a feature allowing you to switch off
transmission before entering a Radio-Frequency (RF)
sensitive area. To activate this feature, press /*w\ and select
More... > Networks > TXI Mode > Activate.

Pressing the Emergency button, even if
A _ Transmit Inhibit is activated, causes the
MTHB800 to transmit immediately. The
MTHB800 must NOT be within the RF sensitive
area when entering Emergency Operation.

The TXI Mode remains active at power On. You will be asked
whether to leave the TXI Mode On or not.

A Ensure you have left the RF sensitive area
before deactivating Transmit Inhibit.
Press the Yes key to deactivate the TXI Mode. If the MTH800
was previously used in Trunked Mode, it will register to the

network. If the MTH800 was previously used in Direct Mode,
it will remain in Direct Mode.

13
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Press No in Trunked Mode and the MTH800 powers down;
press No in DMO and you remain in DMO with TXI selected.

Unlocking the MTH800
Your MTH800 may be locked at power up.
To unlock the MTHB800 after powering on, enter the code at
the prompt. The MTH800 enters the default Home display.
The unlock code is originally set to 0000. Your Service
Provider may change this number before you receive your
terminal.

Locking/Unlocking the Keys/Buttons
Press /»=w\ and &=). For detailed information, see “Locking/
Unlocking the Keypad” on page 118.

NOTE Your Service Provider can lock the keypad with and without the

PTT, and @ during incoming call, but the Rotary knob and

are always available.

The Emergency button is not locked. Pressing the Emergency
NOTE
button unlocks all keys.

Selecting Your Network
Before you start operating your MTH800, you can select the
network you want your MTH800 to be registered to. For
detailed information, see “Networks” on page 152.

RUA/RUI

Radio User Assignment (RUA) & Radio User Identity (RUI) is
providing logon authentication service. It gives flexibility to
the user to have the same possibilities with any radio as with
a personal issued radio. To use full access to the system user
needs to provide the login with the PIN number.

14



To login go to Menu > More... > RUI > Log on
You will see the screen as illustrated, where T,

you can type your User ID (up to 16
alphanumeric characters) and User PIN AT

(up to 6 numeric characters). Press Select to || User PIN:
login. You should see the display with Log On

Accept.

NOTE All the time the display indicates if the user is logged on (blue
color of the icon) or logged off (grey color of the icon).

Select | [Back

How to Hold Your MTH800
The terminal has two microphones: a top microphone for
Simplex dispatcher calls and a bottom microphone for Duplex
telephone-like calls.
A call can be placed in high or low audio. To activate low or
high audio, see “High/Low Audio toggle” on page 16.
In high audio the user transmits via the top microphone and
listens via the internal speaker.
In low audio the user speaks into the bottom microphone and
listens via the earpiece.
Group, Phone and Private Calls are Simplex calls and can be
placed in high or low audio.
Phone, PABX, and Duplex Private Calls are placed in low
audio. The speakerphone feature allows to hold Phone,
PABX, and Duplex Private Calls via the MTH800 internal
speaker.

Use in Low Audio (Phone, PABX, and Duplex Private
Calls)

When placing or receiving a call and while speaking, hold
your MTH800 as you would a telephone. Speak into the
bottom microphone. Listen via the earpiece.

Keep antenna at least 2.5 centimetres from your head and
body.

15
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Use in High Audio (Group, Phone and Private Calls)

Hold MTHB800 in a vertical position with its top microphone
5 to 10 centimetres away from your mouth. Speak into the
top microphone. Listen via the terminal's internal speaker.

Keep antenna at least 2.5 centimetres from your head and
body.
High/Low Audio toggle

The user is able to switch from the external earpiece to the
main speaker using one button and is not required to
disconnect the external earpiece or PHF.

The states of the routed audio are:

* HIGH indicates that audio is routed to the
main speaker.

Speaker HIGH

+ LOW indicates that audio is routed to the Eat F =
earpiece or PHF earpiece, and not to the (]
main speaker.

Speaker LOW

During the call, label of the soft key indicates the next
possible change. Accessory default setup:

16

Soft key label ngh”'o‘.” audio
setting

Spkr Main speaker

(HIGH Audio icon)
Erpce Earpiece

(LOW audio icon)
PHF Personal Hands Free

(LOW audio icon)




Getting started

* PHF connected - audio mode PHF Microphone/PHF
Earpiece

* PHF earpiece only connected — audio mode Top
Microphone/PHF Earpiece

* No accessory attached - Top Microphone/Internal Speaker

Accessory to radio by soft key:

* Audio toggle between PHF and main speaker — audio
mode PHF Microphone/PHF Earpiece to Top Microphone/
Internal Speaker and vice versa

* Audio toggle between PHF earpiece only and main
speaker — audio mode Top Microphone/PHF Earpiece to
Top Microphone/Internal Speaker and vice versa

Lapel/Shoulder Use

For Group and Private Calls turn your head towards your
shoulder/lapel, and speak directly into the top microphone.
Listen via the terminal's internal speaker.

Speakerphone Use
Place the MTH800 30 to 60 centimetres away from you. In a
noisy environment, you may want to move the MTH800
closer to you for better transmission.

Looking After Your MTH800

Never leave your MTH800 or battery in extreme
temperatures (over 60 °C) - for example, behind windscreen
in very hot, direct sunlight. Do not immerse your MTH800 in
water.

To clean your MTH800, use a moistened or antistatic cloth.
DO NOT use a dry or electrostatically charged cloth.

17
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The Display
Home (ldle) Display

A powered-on, idle terminal shows the following typical
Home display:

Trunked Mode Home Display

Direct Mode Home Display

Tal [ J&————— statusicon area ————— L,
etk text display area
o —
e P DMO Folder 1
Tallg;r(lalup ! Talkgroup 1
e Hello
&—— softkeyarea ——P
Optns [EEl]  Contcs| Optns |EEI[ Contes

f menu/context sensitive icon

Status Icons

18

Status icons appear when your phone is engaged in certain
activities or when you have activated certain features.

Status Icon

Description

Trunked Mode Operation

E.’inl

Signal Strength (TMO)
Allows you to check signal strength. More bars
indicate a stronger signal.

X

No Service

S

Scan
Indicates scanning is activated in the MTH800.

H

Data Connected

Displayed when the MTH800 is successfully
connected to an external device and ready for data
transfer.

k=
-4

Data Transmit/Receive

Displayed when the MTHB80O0 is transferring data to/
receiving data from the external device (laptop or
desktop PC).

No number — standby data session.

Number 1, 2, 3, or 4 —indicates active data session
with 25%, 50%, 75%, or 100% bandwidth.




Status Icon

Description

Direct Mode

Operation

Signal Strength (DMO)
Indicates an incoming Direct Mode Group Call.

1=+

Direct Mode
Displayed when the MTH800 is in Direct Mode.

¢

DMO Gateway

Indicates that gateway is selected. The icon has
three states:

Solid — while the MTHB800 is synchronised with the
gateway.

Flashing — while the MTH800 is not synchronised
or during attachment.

No icon — during a terminal to terminal and
repeater call.

Il

DMO Repeater

Displayed when the repeater option in DMO is
selected. This icon has three states:

Solid — while the terminal has detected the
repeater (i.e., when the terminal receives a
presence signal).

Blinking — while the terminal has not detected the
repeater or during attachment.

No icon — during a terminal to terminal and
gateway call.

General Icons

INY

All Tones Off / Duplex & Simplex Ring Muted
Indicates that all alert tones are off in the MTH800
or both Simplex Ring volume is set to 0 and Duplex
Ring volume is set to 0.

Simplex Ring Muted
Indicates that Simplex Ring volume is set to 0 and
Duplex Ring volume is set to more then 0.

Duplex Ring Muted
Indicates that Duplex Ring volume is set to 0 and
Simplex Ring volume is set to more then 0.
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Status Icon

Description

El'ﬂ
(L,

Vibrate On

Indicates that the MTH800 will vibrate to alert you of
an incoming call.

-]
|.t
v

Vibrate and Ring

Indicates that the MTHB800 will vibrate and ring to
alert you of an incoming call.

i

Speaker Off (Low Audio)

Indicates that the audio will sound through the
earpiece. (See detailed explanation of Speaker
Control Key.)

t Low Audio
Indicates that the audio mode is changed to low.
Eﬂ High Audio

Indicates that the audio mode is changed to high.

Earpiece Connected
Indicates that the earpiece is connected.

RUI Pseudo Log On
Indicates that the user is pseudo logged on.

Battery Strength

Shows the charge in your battery. Full icon is full
charge.

Emergency

Appears while the MTH800 is in Emergency
Operation.

® | 0k >

List Scrolling
Displayed to indicate that the Rotary knob use is list
scrolling, as long as this use is selected.

b=

New Message Has Arrived
Indicates a new message just arrived.

[

New Message(s) in Inbox

Indicates that you have unread messages in your
Inbox.




Status Icon Description

o Unread (New) WAP Message

when the priority is high).

= Indicates that that you have not entered WAP Box
since last WAP Message was received (Blinks

'53‘ Unread (New) WAP Message

Indicates that new page was loaded to the browser.

The LED Status Indicator

The LED indicator shows the in-service states of your

MTHB800. Please refer to the table below.

Indicator Status

Solid GREEN In use

Flashing GREEN In service

Solid RED Out of service

Flashing RED Connecting to a network /
Entering DMO

Solid ORANGE Transmit Inhibit (TXI) in service /
Channel busy in DMO

Flashing ORANGE Incoming call

No indication Switched off

Key, Knob, and Button Overview

Soft Keys

Press @ or \*\ to select the option that
appears in the screen directly above the left
or right soft key. In this example, Contcs is
displayed above the key. Pressing enters
the contact list. In the user guide, this action
is described as “press Contcs”.

Ll =

Network 1
Folder 1
Talkgroup 1
Hello

Optns _[I=[ Contes

O,
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Menu Key

Press /wew) to enter:

* The menu (when there is no on-going activity).
The MTH800 menus allow you to control your MTH800
settings. Menus are organised in a hierarchy. See “List of
Menu Items” on page 109. The menu options provide
access to a further list of options called a sub-menu.

* The context sensitive menu (when [T iconis on) to view
a list of items for the current menu.

Examples of Menu and Sub-menus:
The example below shows how to setup the Vibrate function
in the terminal.

1st Sub-menu 3rd Sub-menu

2nd Sub-menu

Z.’i.ll (2 Z.’i.ll [CH Z.’i.ll [CH Z.’i.ll [CH
Network 1 @, Messages Vibrate Vibe & Ring
Folder 1 N i Contacts N Ring Style \ Vibe Only
Talkgroup 1 EC/ & Security EC/ Set Volume EF/  Ring Only
Hello €5 Setup J Language Details. ..
& More... Data Setup
Optns_[EEI[ Contcs| Select | [ Back Select | [ BacK Select | [ BacK
®» @ G] ]
Example of Context Sensitive Menu:
This example shows the 7, TR =
screen when edltlng a name Contacts (__Contacts Menu )
li . . [New Contact] Edit
isted in the contact list. From David || Deete number
i Ann £ Delete contact
'(:?e I—tlomesdlsﬁltay’tr?ress Ray GE’ New Contact
ontics. Scroll 1o the name 2255 Capacity
. . Vi [E] Back Select Back
you wish to edit. Press /uen) 'eW = B== =
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The context sensitive menu
opens up, allowing you to
choose among the entries.




Rotary Knob

Press and hold the Rotary knob to lock it, press and hold it
again to unlock. Powering Off also unlocks a locked Rotary

knob.

For detailed information on how to setup Rotary Knob, see

“Rotary Knob” on page 140.

Emergency Button

Press and hold this button to enter Emergency Operation.

When the MTH800 is powered down, press and hold this
button to power On in Emergency Operation (if configured by

your Service Provider).

See “Emergency Operation” on page 73.

Function Keys

The required time you need to press the Side or assigned keys

to activate an one-touch function is set as default to 0,1 (side
buttons) or 1 (assigned keys) second. This time may be set,
however, by your Service Provider.

For information on the function assigned to each Side or
NOTE ; ; X
assigned key, please refer to your Service Provider.

Side Keys

The Rotary knob and Side key programming are paired:

Rotary Knob Programming

Side Key Programming

Dual Control Programmed to a one-touch
function
: Volume U
List Control o P

{J: Volume Down

Volume Control

Programmed to a one-touch
function

23
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When the Rotary knob is set to Volume Control or Dual
Control, the Side keys support the one-touch feature that
allows you to select or activate commonly used features by
pressing and holding a single key. By default, the upper side
key is set to “Backlight On/Off” and the lower side key is set
to “Screen Saver On”. Please check with your Service
Provider, which feature is assigned to which Side key. For
detailed information on how to setup Rotary Knob, see
“Rotary Knob” on page 140.

Programmable Keys (0-9, * and #)

The MTH800 supports the one-touch feature that allows you
to select/activate commonly used features by pressing and
holding an assigned key. Your Service Provider should
program the keys with the relevant features.

The following table lists the programmable features and their
availability in specific MTH800 states/modes. For detailed
information on the features, see the relevant section in the
user guide.

Feature

Description

Talkgroup Switch

Switches to a specific talkgroup

Previous Talkgroup
Switch

Switches to the previous talkgroup
(even if the operation mode was
different)

Talkgroup Scan

Toggles on/off the Talkgroup Scan
function (TMO only)

DMO/TMO

Toggles between DMO and TMO

Status Message

Sends a dedicated status message to a
dedicated address

Text Message
Template

Sends a predefined/user defined
template to a dedicated address

Call Dial (Private,
Phone, PABX)

Initiates a call to a predefined entry in
the contact list

Vertical Flip Display

Toggles on/off vertical flip




Feature

Description

Transmit Inhibit (TXI)

Toggles between activated and
deactivated TXI Mode.

Screen Saver

Activates screen saver.

Backlight Adjustment

Toggles on/off backlight

Covert Mode

Toggles on/off covert mode

Time & Date

Shows time and date.

Initiate Fallback Alert

Sends Fallback Alert

RUI Log On/Off

Logs on/off the u

Hi/Lo Audio

Activates low/high audio

If programmable one-touch keys are enabled, one-touch dial is
NOTE g
disabled (see page 71).
To use the one-touch feature:

1. Press and hold the required key for a few seconds.
2. Your MTHB800 will act according to the programmed

feature.

One-touch Private Call is set by the Service Provider.

1. If it is set to Simplex, then outgoing Private Call is Simplex

too.

2. Ifit is set to Duplex, then outgoing Private Call can be

duplex in TMO, Simplex in DMO with the last Group Call

Originator number.
3. If it is set to Duplex, then outgoing Private Call can be

duplex in TMO and cannot be initiated in DMO when the
phone book index is required.
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Speaker Control Key

Press to activate the earpiece (low audio) or speaker
(high audio), depending on the menu settings.

Type of Call Menu Setting Key Use

Menu > Setup Speaker On/Off for Group
Simplex call > Audio and Private Calls
(Group*/Private) > Audio Toggle

> Spkr Cntrl

Menu > Setup Speaker On/Off for Private

> Audio Call

> Audio Toggle

> Always Loud
Duplexcall | - Controls speaker/earpiece
(Private/Phone/PABX) of the on-going call

*In an Emergency Group Call, the voice sounds from the speaker
regardless of the speaker setting.

Aliases (Names)

Aliases are optional names that you can assign to stored
phone and private numbers (or IDs). To edit an alias, see

page 115.

Aliases can be up to 12 characters in length and may consist
of letters, numbers, and spaces.

Aliases are displayed during contact list scrolling or during an
incoming call. Aliases are also used in alphanumeric search
to retrieve numbers from your memory list.

The following screens show examples of how the caller’s

private number can be displayed.

Private ID
without alias Prvt In Use

or

26

Private ID

Prvt In Use with alias
Simon




Screen Saver

If your Service Provider configured this feature, the screen
saver will automatically cover the MTHB800 display after the
MTHB800 stays idle for a pre-programmed period of time. If
you press a key or a call arrives, the screen saver is

deactivated and the MTH800 resumes standard operation.

You can also activate this feature manually, by pressing the
relevant pre-programmed button (either a side button or
numeric key). For example, if manually activated during a
group call, the screen saver allows to hide the caller’s identity
for confidentiality. The screen saver consists of a logo and an
alphanumeric text. Check in the menu options whether the
Service Provider has given you the capability of entering your
own screen saver text (see page 133).

Home Display Text Message T =

Your MTHB800 is provided with a feature that
allows your Service Provider to send special

text messages to your MTH800 display. <Home display
The message is displayed when your Gptns_[F=I]_Contes
MTHBS8OO is idle.

The message will stay on your MTH800 display until a new
message is received.

If configured by your Service Provider, your MTH800 will
display an internal Home display until another message is
received.

Time & Date

If your Service Provider configured this feature, the MTH800
shows current time and date on home display.

You can also check time and date, wherever in menu, by
pressing relevant one-touch button.

Check in the menu options whether the Service Provider has
given you the capability of customising time and date settings
(see page 129).
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Terminal Disable/Enable

Your MTHB800 is provided with a feature that allows your
Service Provider to disable it temporarily in case it is stolen.
When your MTH800 is disabled, no calls can be initiated or
received.

While your MTHB800 is disabled, it will look and act like it is
turned Off.

If you try to turn your MTH800 On, when it is disabled, it will
operate as described above.

If your MTHB800 is found, your Service Provider can re-enable
it. After your MTHB80O is re-enabled, you may resume normal
operation.

Terminal Permanent Disable

Your MTHB800 is provided with a feature that allows your
Service Provider to disable it permanently in case it is stolen
or lost. When your MTHB800 is disabled permanently, it
becomes inoperable.

After a Permanent Disable the MTH800 can not be re-
enabled by your Service Provider over the air.

NOTE Only your Service Provider can disable your MTH800
permanently.
Selecting TMO or DMO Operation

General

In Trunked Mode Operation (TMO) the MTHB800 is used with
the infrastructure services within system coverage.
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In Direct Mode Operation (DMO) the MTH800 is used without
infrastructure services required.

While operating in DMO the propagation travels directly from the
transmitting terminal antenna to the receiving terminal antenna,
with no assistance from any base station or tower. Therefore,
the range is critically dependent on the position of the user and
the antenna. To achieve best results, hold the terminal in the
hand as high as comfortably possible, and be sure not to
obstruct the antenna in any way. Be sure that the antenna is
clear from the body, cables, or other obstructions. As there is no
tower-mounted base station to assist, and the two users are
usually standing at ground level, the range is usually shorter
than that can be achieved fowards a tower or hilltop. Any
obstructions (hills, buildings, etc.) between the users will further
decrease the range. Conversely, raising the terminal higher or
moving to a higher location may improve the range.

A MTHB800 in DMO can communicate with the trunked
system (and vice-versa) through a gateway device. To use
that feature, please enable the gateway option in your
MTHB800 (see “Gateway/Repeater Selection” on page 53).

In DMO it is only possible to place Group Calls, Emergency
Group Calls and Private Simplex Calls.

Entering TMO or DMO
Enter TMO or DMO in one of the following ways:

From the Home display press Optns and select Direct
Mode if the MTH800 is in TMO.

From the Home display press Optns and select Trunked
Mode if the MTH800 is in DMO.

Press /s and select More... > Networks > Trunked
Mode if the MTH800 is in DMO.

Press /ww\ and select More...> Networks > Direct Mode
if the MTH800 is in TMO.

Press the TMO/DMO one-touch button (if programmed by
your Service Provider).

Your terminal can alert you of an incoming call. Select the alert
settings in the Vibrate menu and Tones menu items.
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TMO Calls

You can make and receive the following types of calls when
the MTH800 operates in Trunked Mode:

» Group Calls

* Private Calls

* Phone Calls

* PABX Calls - local (office) extension calls
+ Emergency Calls

DMO Calls

You can make and receive Group Calls when the MTH800
operates in Direct Mode (DMO). This includes Emergency
Group and Private Calls.

The MTH800 returns to the Home display when there is no
activity for a few seconds.

PTT Double Push

This feature, if enabled by your Service Provider, allows you
to send the tone when the radio is in idle or Group Call mode
by pressing PTT twice.

After D-PTT tone is sent keeping PTT pressed will result in
permission to talk. D-PTT tone is not audible on sending
radio.

Individual Call
Talk Group Dialing by Index
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You can press Talk Group speed number then &= to join the
Talk Group. Press Attach to confirm.



Non-Emergency calls:
* Pressing PTT
Your terminal can alert you of an incoming call. Select the
alert settings in the Vibrate menu and Tones menu items. If
the call type is “Group” or Private”, then pressing PTT
initiates Group or Private Simplex Call accordingly.
Otherwise special indication is given to the user.
* Pressing Send key
If the call type is “PABX” or “Phone” or “Private”, then
pressing Send shall initiate PABX or Phone or duplex private
call accordingly. Otherwise special indication shall be given
to the user.

Incoming Calls During Dialing
The MTH800 remains affiliated to the last Talk Group and
receives all the group calls. An incoming call is indicated to
the user and the dialling process is interrupted. Non-
emergency call does not suspend dialling but the user is able
to hear the tone of incoming call. When the radio receives a
private or a phone call, radio indicates and gives to the user
the option to reject or accept it. If the user accepts the call,
dialling process ends. When the user rejects it the goes back
to the dialling process.

Entering Emergency Mode During Dialing
Dialing process stops when, meanwhile, the user tries to go
to emergency mode.

Incoming Long Text Message message during dialing
The Long Text Message is indicated on the display and it
interrupts the dialing process.

Changing Call Type

By dialing from the idle screen the user is given the possibility
to change the Type of the Call.
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Modifying the Type of Call

The infrastructure can modify the type of call you started.
For example, you might start a Simplex Private Call, and the
infrastructure could modify the call to a Group Call.

The terminal will alert you of the modification and will display
the following messages, depending on the type of call:

+ Call Modified (to Duplex)

+ Call Modified Use PTT (modified to Simplex)

Continue the modified call depending on the type of call.

» Simplex Private Call modified from direct setup to hook setup:
NOTE

a ringing tone will alert of the change.
» Simplex Private Call modified from hook setup to direct setup:
there will be no indication of the change.

Receiving Calls

Your MTH800 automatically receives the incoming call.
Additionally, if Inactivity Revert Mode is enabled, the MTH800
returns automatically to the Home display, after that call
ends.

NOTE Inactivity Revert Mode will occur if configured by your Service

Provider.

Your MTHB800 alerts you of an incoming call depending on
the setting you selected in the Vibrate menu option (see
page 122) and the Tones menu option (see page 127).

During message or contact editing, scrolling through the
menu and changing any configuration you will be alerted of
an incoming Group/Emergency/Broadcast Group Call if
configured by your Service Provider.

Pre-emptive Calling
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Pre-emptive calling is particularly useful when you need to
speak urgently with a user whose terminal is busy in a non-
emergency voice call.

A pre-emptive priority call (PPC) is either an Emergency
Group Call or a Private PPC (Simplex or Duplex call).



This feature allows to disconnect the on-going lower priority
call and to connect to the incoming higher priority call.

To place a PPC, see the Emergency Operation and Private
Call sections in the user guide.

Your MTHB800 receives the call via speaker or earpiece,
according to the setting used when the PPC is received.
NOTE For call alert, see settings in the Vibrate menu option (page 122)

and the Tones menu option (page 127).
Receiving a PPC is explained in the following paragraphs.

In the screens, <Any> in Use refers to any of the non-
emergency voice calls: Group, Private, Phone, or PABX.

Receiving an Emergency Group Call during a Call

The MTHB800 receives the Emergency Group Call, drops the
on-going non-emergency voice call, and connects to the
Emergency Group Call.

A
) iE

<Any>in Use Emgcy In Use

ID:David
Talkgroup 1

Optns

Receiving a Private PPC during a Call

If configured by your Service Provider, the MTH800 receives
the PPC, drops the on-going, non-emergency, lower priority
voice call, and connects to the higher priority Private Call.

A PPC with lower or equal priority, will be dropped without
any indication to the called user and will enter the missed call
list.
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A PPC Call with Emergency Call priority will be displayed on
the screen as “Emergency” (instead of “Priority”).

Simplex Private PPC Received

=]
Call
Preempted
<Any> in Use |::> %iority PrE;>s Priority
Private Call PTT Prvt In Use
David David
2234 2234

Duplex Private PPC Received

Mzl
Call
Preempted

<animation> :> <animation>

<Any> in Use |::> Priority David Press Priority
2234 any key Prvt In Use
David
Mute [ T Spkr! Mute | | Spkr

Broadcast Call

The Broadcast Group Call (also called Site
Wide Call) is a high-priority group call from the
console operator (or dispatcher) to all users

located at one or more sites. The terminals David
are configured to monitor a Broadcast Call, Optns
but the users cannot talk back.

The call can be received as normal

Group In Use

Broadcast Call or Emergency Broadcast Call. A
The Broadcast Call pre-empts an on-going dEﬂm i Use
Group Call that has the same (or lower) call David
priority. Op?r:‘;aTCaSt

For selecting a talkgroup during a broadcast
call, see “Selecting a Group” on page 40. For changing folder
during a broadcast call, see “Selecting a Folder” on page 43.
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Ambience Listening (AL)

This feature, if enabled by your Service Provider, allows a
console operator (or dispatcher) to establish a special call
with a specific terminal to monitor voice activity in the local
vicinity. The call is setup without any indication to the affected
terminal, and any lower priority ongoing voice call or packet
data transfer may be pre-empted.

After accepting the call, the terminal transmits in a Simplex
Private Call without any action from or indication to the user.
The Ambience Listening call is automatically ended when the
user initiates any voice call and uses the terminal normally.

Cancelling a Call
Choose one of the following, as relevant:
e Press @ If you wish to make a new call, start it at once.

* Wait to answer the call. After a time-out set by your
Service Provider, the call number will be forwarded to the
missed call list.

* Press Reject soft key (displayed in an incoming Duplex
call). The call number will be forwarded to the missed call
list.

Using In-call Features

Handsfree Speakerphone

The speakerphone feature allows you to hold
impromptu meetings in Phone, PABX, and Prons T Use

Duplex Private Calls. David
06754321

1. To activate speakerphone, press Spkr. Mute | | Spkr
The display shows Speaker HIGH.

2. Place the MTH800 30 to 60 cm away from you. In a noisy
environment, you may want to move the MTHB800 closer to
you for better transmission.

3. To de-activate speakerphone, press Erpce. The display
shows Speaker LOW.

<animation>
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Muting/Unmuting the Bottom Microphone

During a Phone, PABX, or Duplex Private Call, use the mute
feature to:

* hold conversation without being heard by the caller

* silence possible background noise in your area

1. Press Mute. The display shows Mute is On. The
microphone is muted. You can hear the incoming audio, but
the caller cannot hear any speech coming from your
MTH800.

2. To speak, press Unmute. The display shows Mute is Off.
The microphone is on.

Covert Mode

36

If configured by your Service Provider the Covert Mode gives
to you the ability to completely shut down all visible and
audible MTP850 alerts and notifications. This feature makes
the MTP850 effectively unnoticeable even in a silent and
dark environment.

To Enter the Covert Mode:

* Press the Cover Mode one-touch button (if programmed
by your Service Provider).

+ Select Covert Mode in the Security menu (refer to “Covert
Mode” on page 121).

High/low Audio in Covert Mode

* If none of the accessories are connected to the radio then
high/low audio toggle is not enabled.

» External earpiece/PHF connected - by pressing high/low
toggle button the audio mode switches from the Internal
Microphone/Internal Earpiece to PHF Microphone/PHF
Earpiece

* PHF earpiece only connected - by pressing high/low
toggle button the audio mode switches from the Internal
Microphone/lnternal Earpiece to Top Microphone/PHF
Earpiece.



Local Area Service

This mode, also called Fallback Mode, allows more than one
terminal from the same site to communicate when the link
between the site and network central controller fails. Entering
and exiting Local Area Service (that is, returning to System
Wide Services) is done automatically.

This mode can be disabled by your Service Provider.
NOTE vy

Entering Local Area Service

When the MTH800 receives a Local Area Service indication

from the system, the following occurs:

* The MTH800 sounds a tone.

* The display shows the “Local Area Service” message.

+ Display icons and soft keys turn green.

* Any call in progress is dropped upon entering Local Area
Service mode.

If configured by your Service Provider, this message/alert is
periodically repeated to remind you that the MTH800 is still
operating in Local Area Service mode.

The following features are available while the MTH800 is in
Local Area Service:

* Registration

+ Attachment

» Group Call

+ Emergency Call

+ Emergency Alarm

Exiting Local Area Service

When the link with the central network controller is re-
established, the MTH800 exits Local Area Service and the
following occurs:

» the MTHB800 sounds a tone

+ any call in progress during Local Area Service is dropped.
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Packet Data

The Packet Data (PD) Service allows you to transfer data in a
TETRA system using the Internet Protocol (IP). Check with
your Service Provider for the availability of this feature.
For transferring data from a standard computer over the air
connect the computer via the Active Data Cable FKN4897 with
your MTHB800. Your Service Provider has to setup additional
applications on your computer.
If set up by your Service Provider it is possible to accelerate
the transmission by using the Multi-Slot Packet Data (MSPD)
Service (refer to “Packet Data” on page 155).
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TMO Group Call

General

A Group Call is an instant communication between you and
others in a talkgroup that you select. Participants may join
(late entry) and leave an on-going Group Call. A talkgroup is
a pre-defined set of subscribers enabled to participate in and/
or invoke a Group Call, that is set up by your Service
Provider.

Talkgroups appear on your display as names or numbers (for
example: Sales, Service, Electricians, Talkgrp10).

Talkgroups can be divided into many folders. Each folder
may contain several talkgroups.

For ease of use, your MTH800 also provides the ability to:

» Perform an alphabetical search of the talkgroup aliases.
Scroll through the entire talkgroup list.

» Organise your groups into three folders (default name for
the first favorite folder is called My Groups which is set up
by your Service Provider).

Your talkgroups may be organized into scan lists (set up by
your Service Provider, or by yourself through the Menu).

When you activate one of these scan lists, your MTH800 will
continuously monitor the activities of the selected talkgroups.

By assigning priorities to the talkgroups defined in the scan

list, you will be capable of accepting calls that have higher

priority than the on-going call.
You go to talkgroup, folder, or scanning selection when the
terminal is idle.

Pressing PTT during talkgroup selection switches to a new

group and starts a call.

Each talkgroup may have one associated Announcement

Talkgroup (ATG) that it monitors (if set up by your Service

Provider).
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An ATG is a special group which is linked to a number of
talkgroups and has the highest priority level, thus enabling
broadcast of the call to all these talkgroups.

When an ATG is selected, the scanning icon is not displayed.
The MTHB800 monitors the ATG scan list instead of the
selected scan list. The ATG scan list contains all the
talkgroups associated with a selected ATG. Your Service
Provider should advise what talkgroups are associated with
which Announcement Talkgroup.

Your MTH800 will always monitor the Group Calls in the ATG
scan list. To place an Announcement Call, you must first
select the specified Announcement Talkgroup as advised by
your Service Provider, otherwise you will only be able to
participate when an Announcement Talkgroup is received.

Activation and deactivation of talkgroup scanning has no
effect on the ATG scan list.

Dual Microphone Feature
See “How to Hold Your MTH800” on page 15.

Selecting a Group
You can select a talkgroup in one of the following ways, by
using the:
* rotary knob
* navigation key
« alphabetical search
+ folder search
* numeric keypad entry — Speed Dialing (if configured by
your Service Provider)
For group scrolling configuration, see page 44.

When you navigate in the favorite folders and select a DMO
\OX0S group, your terminal will switch between TMO and DMO (and
vice-versa).
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Using the Rotary Knob
(If configured by your Service Provider)

From the Home display, press shortly on the Rotary knob and
rotate until the requested group appears.

Group selection occurs:

* After a time-out
» By pressing Select (if configured by your Service Provider)

* By pressing PTT

Using the Navigation Key

From the Home display, scroll left or right until the requested
group appears. Then press Select to confirm selection.
Pressing the PTT will also choose the group automatically
and start transmission.

Using Alphabetic Search

From the Home display, press Optns. Select a group by abc
search (“TG by abc”). You can type up to 12 characters that
are shown at the bottom of the screen while you are typing. It
will highlight the closest talkgroup name. Press Select to
enter the group.

Using Folder Search

From the Home display, press Optns. Select a group by
folder search (“TG by Folder”). Select the folder name and

select the group.

For alphabetic and folder search there are no duplication names
\(OX13 Jisted. If the user selects the group that is located in more then
one folder, the radio chooses the one that is prioirtized by:
1. current folder
2. parent folder to the current folder
3. default talkgroup folder which is defined by the Service

Provider.
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Using the Numeric Keypad - Speed Dialing

From the Home display, you can dial a group by entering its
speed number via the keypad. This feature is called
Talkgroup Speed Dialing. The speed number is pre-
configured in the terminal. You can view a speed number

attributed to a group, if it exists.

Viewing the speed number
1. From the Home display, press Optns.
2. Select:

* TG by Folder then select the folder and
highlight an appropriate talkgroup

* TG by abc and then highlight an
appropriate folder name

3. Press [uen)

4. Select View to view the talkgroup speed
number.

In this example “82” is the speed number.
Press Back to return to the attached group
screen.

Dialing a speed number
1. Enter a number (for example: “82”).

2. Press Go.
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TalkGroup1
TalkGroup2
TalkGroup3
TalkGroup4

Select [[F]  Back

2.’.1] (=
TG List Menu

View

Select “j[ Back

Ll s
TalkGroup 2
706002
Folder 3

SpeedNum 82*

Select | [ Back

ﬁ Private #:

Ctype [FE1[ Delete




3. Press Attach to attach the new group, or 2 =
press PTT to attach and to call.
706002

Folder3

Attach | [ Back

Selecting a Group using

Navigation Keys/Alphabetic Search/Folder Search
You can select a group folder without an interruption on
receiving and during a call.

Selecting a group on receiving a call
If you select a group and a call is incoming, MTH800 display
remains unchanged while you hear the call.
During the selection you cannot see calling party information.
Press Cancel when using Navigation Keys and Back when
using Alphabetic/Folder Search, and then calling party
information display appears, if you are still in the call.

When an Emergency Call is received, then selecting is aborted
(8213 and Emgcy In Use display appears.

Selecting a group during a call
If you start selecting a group during a call, Group In Use or
Emgcy In Use display disappears.
During the selection you cannot see calling party information.
Press Cancel when using Navigation Keys and Back when
using Alphabetic/Folder Search, and then calling party
information display appears again, if you are still in the call.

Selecting a Folder

From the Home display, press Optns. Select Folder, and
select the desired folder. The display shows the last selected
group in that folder, after selection of the group folder.

“My Groups” Folders
You can organise your favorite groups into three folders.
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Selecting My Groups

From the Home display, press @ to quickly access the
folder.

Adding/Deleting Groups

For more information, see “My Groups (TMO/DMOQO)” on
page 142.

Group Scrolling Configuration
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Your Service Provider can configure scrolling via rotary knob
or navigation key as follows:

+ Scroll to next folder — when the folder end is reached
during group scrolling, further scrolling switches to the
group list in the next folder.

Forexample: Folder 1 has Group11 and Group12. Folder 2
has Group21 and Group22. Group11, Group12, Group21,
Group22 will appear during scrolling.

OR

+ Stay in folder — when the folder end is reached during
group scrolling, further scrolling restarts the folder group
list. To move to the next Folder, you should select it.

For example: Folder 1 has Group11 and Group12. Folder 2
has Group21 and Group22. Select Folder 1: Group11,
Group12, Group11,Group12 will appear during scrolling.
Change to Folder 2: Group 21, Group 22, Group 21, and
Group 22 will appear during scrolling.

In addition, your Service Provider might configure the rotary
knob as follows:

* End-Stop Rotary Knob Scrolling — the rotary knob will
stop when it reaches the last group in the folder, and a
tone will alert you that you have reached the last group in
the folder. Use the navigation key to continue scrolling
through the list.



Activating/Deactivating Scanning
See “Setting Group Scanning” on page 138.

Making a Group Call

1. Select required talkgroup and from the
Home display press and hold the PTT.

2. Wait for the talk permit tone (if configured)
and then speak into the microphone.
Release the PTT button to listen.

When you start a call, all members of the

selected group who have their units turned

on, will receive the Group Call.

Ll ]

Network 1
Folder 1
Police
Hello

Optns [F[ Contcs

E
2E]
Group In Use
Folder 1
TG4

Optns | [ Folder

The “No Group” message is displayed when you are out of the
W21 normal coverage area of your selected group. You must then
select a new group that is valid for your working location.

If you are in an on-going Group Call and wish to make a new
NOTE call, press @ to ignore the current call. Start the new call.

Talk Group Dialing by Index — this feature is used as a speed
NOTE 1Y groups. It works by pressing the Index of TG and the * at

the end.

Receiving a Group Call
General

Unless it is engaged in a call, your MTH800 will receive the

Group Call.To talk back, press and hold PTT.

Your MTH800 shows the Group name and the caller’s private
number or name if previously stored in your contact list.
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The following screens show examples of how the caller’s
private number (ID 124) is displayed.

CE .

Group In Use

E

Group In Use

ID:124 OR ContactName
TG4 TG4
Optns [ l Folder Optns l I Folder
Private ID Private ID
without alias with alias

For incoming call alert, see settings in the Vibrate menu option
(page 122) and the Tones menu option (page 127).

Any incoming Group call is always received through the main
speaker. If configured by your Service Provider, the Audio menu
item allows to setup the audio of the incoming Group Call.

If the setup is Speaker Control, you can direct the audio of an
active group to the earpiece (low audio) or the main speaker
(high audio). In low audio speak into the bottom microphone and
listen via the earpiece. In high audio speak into the top
microphone and listen via the speaker.

At the end of a call which has been directed to the earpiece, an
audio hang timer is activated, if it is enabled by your Service
Provider. Within the preprogrammed hang time, any incoming
call is still received through the earpiece. When the timer
expires, a low pitch tone is emitted alerting you that the next
incoming Group call will be received through the speaker. Upon
hearing this alert, you are advised to hold the terminal at a
comfortable distance away from the speaker.

When receiving a Group call, you will hear a “New Group Call”
tone (if configured by your Service Provider).

Receiving a Group Call in Idle Screen with Scan Off

You can receive a group call from the selected
talkgroup or from the associated ATG only.

Your MTHB800 will receive the Group Call.
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o
B
Group In Use
TG4
ID: David

Optns | [ Folder,




Receiving a Group Call in Idle Screen with Scan On
With Scan On, you can receive a group call

from the scan list you set up, in addition to i
receiving a group call from the selected djemupwse
talkgroup or from the associated ATG. o4
Receiving the scan call functions as receiving [Optns ] [ End

an associated ATG or selected call in scan off
is possible, except for the following:
* The terminal sounds a tone as explained in the note below.
» When receiving a High Priority Group Call, you will hear a
NOTE “High Priority Group Call” tone (if configured by your Service
Provider).
» When receiving a Group Call from your scan list, which is not
from a high priority group, you will hear a “New Group Call”
tone (if configured by your Service Provider).

+ To block reception of a Group Call, select Optns then
Block. Powering off/on the terminal unblocks the reception
of this Group Call.

Receiving a Group Call during an On-going Group Call
Depending on how the Service Provider has configured
incoming calls, the incoming call will either be:

» Forced upon you and will interrupt the on-going call (if the
incoming call has higher priority than the on-going call).
OR

» Presented to you (if it has higher priority
than the on-going call). _

* To accept the call, press Join. L roup In Use

TG4

* To cancel the call, press End. ID: David
Join | [ End

Receiving an Emergency Group Call
For detailed information, see page 33.

Receiving a Broadcast Call
For detailed information, see page 34.
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Transmit Inhibit

You can activate the Transmit Inhibit (TXI) Mode before
entering RF sensitive areas, e.g. in hospitals or in potentially
explosive areas, where safety can be jeopardized due to
MTHB800 transmission radiation.

NOTE Radiation of the MTH800 is only suppressed if the TXI Mode is
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activated or the MTHB800 is separated from power supply.

In TXI Mode the MTH800 will not transmit under any
circumstances, except for the Emergency Call, which can be
initiated even if the MTH800 is in TXI Mode.

All MTH800 functions and keys which cause transmission,
e.g. registration to the network, change of talkgroup or folder,
sending messages, pressing PTT, etc. are disabled. In this
case the display shows “Not Allowed In TXI Mode” and the
MTHB800 sounds the “Transmit Inhibit” tone.

When no danger to safety exists anymore (for instance if you
leave the RF sensitive area), the TXI Mode can be
deactivated and the MTH800 returns to standard operation.
Setting the TXI Mode is described in “Setting Transmit Inhibit
(TXI) Mode” on page 154.

Activated Transmit Inhibit is indicated by the solid orange
LED and flashing between the two displays:

Ll [;: Ll [;:
Folder 1 v TXI Mode
Police Folder 1
Hello C) [ TXIMode ) Police

Activated Hello
Optns [E] Contcs [E] Contcs




Dynamic Group Number Assignment (DGNA)

DGNA provides the ability for a network operator or
authorised user to dynamically allocate new, or update
existing talkgroups to selected terminals over the air
interface. Using supplementary services messages (SS-
DGNA), the network operator can command your terminal to
add talkgroups or to update the existing talkgroups, or to
delete talkgroups from the list. This operation is performed by
transmitting the data into your MTH800.

Your Service Provider can gather some Talkgroups under one

N2 Super-group and transmit it to your MTH800 as a DGNA. In such
a case, you will be able to participate in calls to/from all the
groups in the Super-group.

DGNA Reception with Notification Message

When a DGNA message is received and
DGNA notification was configured by your Talkgroup
Service Provider, you will get a tone updating
indication and notification message

(“Talkgroup list updating”), and then a

display of the new assignments.

You can use the View, Attach, Back soft
keys, /¥=4\, Rotary knob, ¢, and Emergency
button. Talkgroups:
10 Added
Pressing one of them exits the DGNA display. 6 Removed
View | [ Back
1. To view the added/deleted talkgroups T |
details press View. You may scroll through
the list. \);TG2
TG3
2. To return to the previous display press VA
Back. Attach [FE)]  Back

3. To select the DGNA group, press Attach.
Or scroll to another group and press Attach.

» Group attachment is not allowed in TX| Mode.
NOTE | Once you exit the DGNA notification screen, select one of the
newly added groups as explained on see page 40.
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DGNA Reception without Notification
Message Back

If the DGNA message is received to delete
all Talkgroups, your MTH800 will display the

followi ng: All Talkgroups:
Deleted

If DGNA notification was not configured by

your Service Provider, you will get a tone indication and
notification message only and only if a selected group was
changed by the DGNA.

DGNA Auto Select Group

If DGNA Auto Select was configured by your Service
Provider, whenever a DGNA message is received by your
terminal, the talkgroup will automatically be made the
selected group by your terminal.

Button/Footswitch
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This feature provides to the user ability to send preset status
message by pressing the button/footswitch. In TMO mode,
the ability to send an Alarm and initiate a TMO Group/Private
call is unavailable.

Message addressing and sending:

+ the address can be predefined by the Service Provider, if
not it is sent to currently selected group

* if no group is selected the message is sent to the reserved
address

* message is sent even if the user is involved in any active
call.

The indication depends on the setting from the Service
Provider. Visible/audible indications can be disabled for the
status message.

When the radio is PIN locked the user can still press the
Button/Footswitch to send the message.

If the radio is out of service the user will only see indication
that the operation failed.



DMO Group Call

General

In DMO, the MTH800 can be used without your Service
Provider’s infrastructure.

Direct Mode allows communication with other terminals also
operating in Direct Mode, which are on the same frequency

and talkgroup as your MTH800.

NOTE In DMO it is only possible to place Group Calls, Emergency
Group Calls and Private Simplex Calls.

You can receive a call:

* From the selected talkgroup

» From other users within talkback range (if configured by
your Service Provider). This is called an InterMNI (Mobile
Network identity) call.

* From an open group. (An open group is a super-group to
which all DMO groups belong.)

When you start a call, the members of the selected talkgroup

who have their units turned on, and are within the group

subscriber identity (as configured by the Service Provider),

will receive the transmission.

In DMO the MTH800 can communicate with the trunking
system (and vice-versa) if the Gateway option is enabled in
the MTH800.

To enhance the terminal's DMO coverage area the DMO
group can link to a repeater if the Repeater option is enabled
in the terminal. Additionally the GW + Rep (gateway and
repeater) communication mode can be used.

If Transmit Inhibit is activated while the terminal is set to
DMO, the PTT is disabled. You can only listen. For detailed
information on Transmit Inhibit, see page 48. DMO Talkgroup
selection is allowed when Transmit Inhibit is activated.
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Dual Microphone Feature
See “How to Hold Your MTH800” on page 15.

Favorite Folders
You can organise your favorite groups into three folders.

Selecting the My Groups Folder
From the Home display, press @ to quickly access the
folder.
NOTE Default name for the first favorite folder is “My Groups”.

Adding/Deleting Groups from Favorite Folders
For more information, see “My Groups (TMO/DMQO)” on
page 142.

Adding/Deleting/Renaming Favorite Folders

For more information, see “My Groups (TMO/DMOQ)” on
page 142.

Selecting a Group
See “Selecting a Group” on page 40.

Selecting a Group using Navigation Keys/
Alphabetic Search / Folder Search

See “Selecting a Group using Navigation Keys/
Alphabetic Search/Folder Search” on page 43.

Selecting a Folder
See “Selecting a Folder” on page 43.

Group Scrolling Configuration
See “Group Scrolling Configuration” on page 44.
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Gateway/Repeater Selection
Use the DMO Config sub-menu for setting

. 1-+1 [
the Gateway and Repeater optpns. | DMO Folder 1
1. Press Optns to enter the options menu in Police
DMO Hello
Optns [ [ Contcs
DMO Options sub-menu
Folder
TG by Folder
TG by abc
Trunked Mode .
Confi 1MS -MS 1 Automatic
] m
2 Gateway — 2 Specific
3 Repeater 1 Aut )
4 GW + Re utomatic
P t 2 Specific
2. Scroll to Config, and press Select.
Folder
TG by Folder
TG by abc
Sl Trunked Mode
. Config
Selecting DMO Group Call MS to MS Select | [ Back
To change from gateway or repeater mode to
MS - MS mode (DMO terminal to terminal call):
1. Press Optns, scroll to Config and press
Select.
VMS-MS
2. Scroll to MS - MS and press Select. The Gatoway
. . epeater
following message to be displayed for a few Y Rep
seconds: MS - MS Will Be Used.
Select | [ Back
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Selecting DMO Group Call via Gateway

While in DMO, proceed as follows to choose a gateway to set
up a call via Gateway for the selected talkgroup:

1. Press Optns, scroll to Config and press Select.
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2. Scroll to Gateway and press Select.

3. The display shows the last gateway selection method. Use
the navigation key to scroll to your selection and press Ok:

Automatic — the MTHB800 will use the first
available gateway for that talkgroup. The
Gateway icon will flash upon selecting that
option.

Specific — the MTH800 will use only the
gateway with the specified Gateway
address for that talkgroup.

I=+] [mm;:
GW Options:

WV Automatic
Specific

Select | [ Back

Upon selecting “Specific”, you will see one of the following

displays:

* The selected gateway address (e.g.:
1022), pre-programmed by your Service
Provider or previously entered by yourself
via the keypad. Press Edit and then Ok to
use the current address, or enter a new
address via the keypad, and press Ok.
The Gateway icon will flash upon selecting
the gateway.

* “None’, indicating that no gateway was
selected for that talkgroup. Press Edit and
enter an address via the keypad, Press
Ok. The Gateway icon will flash upon
selecting the gateway.

When the MTHB800 detects the suitable
gateway, the Gateway icon will turn solid.

1=+ (I

Selected
Gateway:
1022

Edt | [ Back

1=+ [

Selected
Gateway:
None

Edit | [ Back

T - [

DMO Folder 1
Police
Hello

Optns  [FEI[ Contcs




Selecting DMO Group Call via Repeater

While in DMO, proceed as follows to choose the Repeater

option to set up a call via Repeater for the selected talkgroup:

1. Press Optns, use the navigation keys to scroll to Config
and press Select.

2. Scroll to Repeater and press Select.

3. The MTHB800 will use the first available S
repeater for that talkgroup. The repeater DMO Folder 1
icon will flash upon selecting that option. Police

Hello

Optns [EE] Contcs

When the MTH800 detects the proper Pl

repeater presence signal, the Repeater DMO Folder 1

icon will turn solid. Police
Hello

Optns [Eﬂ Contcs

Selecting DMO Group Call via Gateway and

Repeater
While in DMO, proceed as follows to choose the Gateway
and Repeater option to set up a call via Gateway or Repeater
(Gateway preferred) for the selected talkgroup.

1. Press Optns, scroll to Config and press Select.
2. Scroll to GW + Rep and press Select.

3. The display shows the last “GW + Rep.” BT
type selection. Use the navigation key to

. Aut ti
scroll to your selection and press Select: \/S:ec:;:;]ii ¢

Automatic — the MTH800 will use the first
available gateway for that talkgroup. The
Gateway icon and the Repeater icon will
flash upon selecting that option.

Specific — the MTH800 will use only the Gateway with the
specified Gateway address for that talkgroup.

Select | [ Back
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Upon selecting “Specific”, you will see one of the following

displays:

* The selected gateway address (e.g.:
1022), pre-programmed by your Service
Provider or previously entered by
yourself via the keypad. Press Edit and
then Ok to use the current address, or
press Edit and enter a new address via
the keypad, and press OKk.

& UK

M
Selected

Gateway:
1022

The Gateway and Repeater icons will flash upon

selecting the gateway.

* “None”, indicating that no gateway was selected for that
talkgroup. Enter an address via the keypad, and press
Ok. The Gateway and Repeater icons will flash upon

selecting the gateway.
When the MTHB800 detects the appropriate
gateway and/or the Repeater, the Gateway
and/or Repeater icons will turn solid,
respectively.

Making a DMO Group Call (MS to MS)

1. Enter Direct Mode by pressing Optns and
selecting Direct Mode.

2. Make sure that you have selected the
required group. Press and hold the PTT
button.

3. Wait for the talk permit tone and then speak

T R |

DMO Folder 1
Police
Hello

(Optns [[E]] Contcs

1=+l [mm;:

V' MS - MS
Gateway
Repeater
GW + Rep

Select| [Back

into the microphone. Release the PTT button to listen.

Making a DMO Group Call via Gateway

1. While in DMO, choose a gateway as described in
“Selecting DMO Group Call via Gateway” on page 54.
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2. Place the call for the selected talkgroup:

* If you press PTT while the gateway is not available, you
will start a DMO call without gateway. The Gateway icon
will disappear.

* If you press PTT while the selected
gateway is available, but the call is MS - MS
rejected by the gateway, your MTH800 Call
will sound a tone and display the
following screen, informing you that the
call will be setup without gateway. The Gateway icon
will disappear.

« If you press PTT while the gateway is available, you will
start a DMO call with gateway. The Gateway icon will be
solid.

Making a DMO Group Call via Repeater

1. While in DMO, choose the Repeater option as described in
“Selecting DMO Group Call via Repeater” on page 55.

2. Place the call for the selected talkgroup:

* If you press PTT while the repeater is not available, you
will start a DMO call without repeater. The Repeater
icon will disappear.

* If you press PTT while the selected
repeater is available, but the call is MS - MS
rejected by the repeater your MTH800 Call
will sound a tone and display the
following screen, informing you that the
call will be setup without repeater. The Repeater icon
will disappear.

« If you press PTT while the repeater is available, you will
start a DMO call with repeater. The Repeater icon will
be solid.
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Making a DMO Group Call via Gateway and Repeater

1. While in DMO, choose the Gateway and Repeater option
as described in “Selecting DMO Group Call via Gateway
and Repeater” on page 55.

2. Place the call for the selected talkgroup:

* If you press PTT while both gateway and repeater are
not available, you will start a DMO call without gateway
and repeater. The Gateway and Repeater icons will
disappear.
« If you press PTT while both gateway and repeater are
available, but the call is rejected by the gateway, a
repeater call will be attempted.
> Ifitis successful your MTH800 will display the
message Repeater Call and a call via repeater will
proceed. The Gateway icon will disappear.

> If itis not successful your MTH800 will display the
message MS-MS Call and a terminal to terminal call
will proceed. The Gateway and Repeater icons will
disappear.
« If you press PTT while both gateway and repeater are
available, a gateway call will be attempted.
> Ifitis successful your MTH800 will start a DMO call
with gateway. The Gateway icon will be solid. The
Repeater icon will disappear.

> If synchronising with a gateway is not successful a
repeater call will be attempted.

> Ifitis successful your MTH800 will display the
message Repeater Call and a repeater call will
proceed. The Gateway icon will disappear and the
Repeater icons will be solid.

> Ifitis not successful your MTH800 will display the
message MS-MS Call and a terminal to terminal call
will proceed. The Gateway and Repeater icons will
disappear.
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If Gateway and Repeater mode is selected, and if one of the
devices is not available, the call setup is proceeding as if this

device was not selected.

Example: In case of the Gateway is available and the Repeater

is not available, after an unsuccessful Gateway call attempt the

call falls back to MS - MS mode immediately with the MS-MS

Call message.

Receiving a DMO Group Call
You can receive a DMO Group Call only when your MTH800
is in DMO.

Your MTHB800 will display the caller’s private number or alias,
and the talkgroup name.

The following screens show examples of how the caller’s
identity can be displayed.

NOTE For call alert, see settings in the Vibrate menu option (page 122)
and the Tones menu option (page 127).

Receiving a DMO Group Call (MS - MS)

all 1=+ [E: all I=+1 B all |=+1 [
E E] E
BE 3 EE
Group In Use Group In Use Group In Use
DMO Folder 1 OR ID:124 OR ID: David
DMO TG4 DMO TG4 DMO TG4
ptns [ Forder | Optns [ Folder | Optns
Without alias and Private ID Private ID
Private ID without alias with alias
il 1=+ [mm; all I=+] [

=l
3

Group In Use Group In Use

1D: David OR ID:...1234

Open Group TG4
Opins Opins Network
Open Group Call InterMNI Call
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When an InterMNI call is received, you can press Network to
see the Network alias and/or number.

Receiving a Group Call (via Gateway / Repeater)

Fall I+1 [ £l 1+ all [

o
3

Group In Use Group In Use

Group In Use

ok OR Tor OR
Optns Folder UBW] T)ptT] older
Without alias and Private ID Private ID
Private ID without alias with alias
(e.g. via gateway) (e.g. via gateway) (e.g. via repeater)

The display shows the ID of the TMO caller.

The Gateway plus DMO or the Repeater icons are displayed
accordingly to the ongoing call type (Gateway or Repeater).
* IfMS to MS mode is selected, and the terminal receives a call
NOTE via repeater, the Repeater icon will be shown (if the repeater
mode is enabled by the Service Provider, otherwise the call
will not be accepted).
« If Gateway mode is selected but a gateway is not available,
The Gateway icon will be solid in case of an incoming
gateway call.

DMO Private Call

If configured by your Service Provider it is possible to make
and receive a Private Call in DMO.

However the Gateway and/or Repeater options are activated
they are not used for a DMO Private Call. The DMO Private
Call will be a direct communication between two TETRA
terminals (MS - MS).

For detailed information, see “Private Call in DMO” on
page 65.

Emergency Group Call
For detailed information, see “Emergency in DMO” on
page 82.
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Exiting DMO
To exit DMO, press Optns and select Trunked Mode. For
other ways, see “Selecting TMO or DMO Operation” on
page 28.
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Private Call

General

A Private Call, also called Point-to-Point or individual call, is a
call between two individuals. No other terminal can hear the
conversation.

This call can be a
* Duplex call (if the system allows) in TMO, or
+ a Simplex call in TMO or DMO.

In a Duplex call, both participants can speak at the same
time, while in a Simplex call, only one person can speak at a
time.

If your Service Provider has restricted access to the Contacts
NOTE list, it might not be possible to create a new contact, edit existing
contacts or dial up a number which is not in the Contacts list.

For operating the MTH800 in RF sensitive areas, see
“Transmit Inhibit” on page 48.

NOTE While Transmit Inhibit is activated, an incoming Private Call is
indicated, but it is not possible to answer the call.

Dual Microphone Feature
See “How to Hold Your MTH800” on page 15.

Making a Private Call in TMO

If you are in an on-going Group Call and wish to make a new
NOTE . .
call, press to ignore the current call. Dial the number.

1. From the Home display dial a number.

2. If Private is not the first type of call

presented, press Ctype to select the g Prae® |
Private Call type.

2234

CType [[EI] Delete
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3. For a Simplex call, press and release the PTT button. You
will hear a ringing tone. Wait for the called person to answer
your call. (This is also called a hook setup.) OR,

Press and hold PTT. Wait for the talk permit tone (if

configured) before talking, and release the PTT when
listening. (This is also called a direct setup.)

The user can make the MS-ISDN Simplex call by pressing the
NOTE PTT, when this feature is enabled by the Service Provider.

For a Duplex call, press and release @ You will hear a
ringing tone. Wait for the called person to answer your call.

4. To end the call, press .
If the called person or the infrastructure end the call, the Call
Ended message is displayed.

While Transmit Inhibit is activated, an incoming Private Call is
NOTE Big
indicated, but you cannot answer the call.

Other Ways of Dialing
Dialing via Contact List

You can also use the contact list to select a number you
previously stored. Press Contcs and search the stored

number by scrolling (@ or @) or by entering up to 12
letters.

If no name is stored under a letter, the MTP850 automatically
NOTE searches forward, alphabetically, until the next name is found. If

more than one name in the list begins with the same letter, you
can scroll to view other names or type up to 12 letters.

If the contact has more than one number stored, pickers
surround the contact icon. Use @ /@ to select the number.

Short Number Dial

If set up by your Service Provider, Short Dial allows you to
dial part of the full number of the person you wish to call.

63

I1eD ajeAld



Your MTH800 will automatically complete the number and
send it over the air based on your own MTH800's identity. For
example:

1. Dial 456 (instead of 4282456, the full number).
2. To place the call, press the PTT or @ .

3. To hang up, press or @

Dialing Scheme
Private ID is a number with up to 16 digits.

16-14 13-9 8-1
MCC MNC ISSI

Two options are given to the user:

+ Fixed - user may provide up to 16 digits which include the
MCC, MNC and ISSI numbers or if less than 16 digits are
entered, it will be filled with the digits that are set by the
service provider.

* Automatic - you need to provide up to 8 digits (if more it will
switch to fixed mode). If you will provide less then 8 digits,
terminal fills the number with its own ISSI. The rest of the
16 digit number is automatically given by the terminal.

If you select more then 16 digits the display will give you a
warning about incorrect input.

Recent Calls List

Select the number from the recent call list. See “Recent
Calls” on page 144.

One-touch Dial
See “Programmable Keys (0-9, * and #)” on page 24.

Calling a Number in a Message
See “Calling a Number in a Message” on page 166.
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Receiving a Private Call in TMO

1. The MTH800 switches to the incoming Private Call. The
display shows the caller’s identity.

2. To answer an incoming Simplex call, press PTT. To answer
an incoming Duplex call (indicated by Spkr/Erpce soft

keys), press ().

3. To end the call, press .
Your terminal can alert you of an incoming call. Select the alert
NOTE o ; :
settings in the Vibrate menu and Tones menu items

Private Call in DMO

If configured by your Service Provider it is possible to make
and receive a Private Call in DMO. You can make or receive

a DMO Private Call only when your MTH800 is in DMO.

Private Calls via DMO Repeater and/or DMO Gateway are not
NOTE
supported.

The calling and called party needs to be on the same
talkgroup.

Making a Private Call in DMO
1. From the Home display enter a number.

1=+1 [
Dialing via
Private #:
» Contact List or j@
* Recent Calls Lists 2234
works like described in “Other Ways of CType [ [ Defefe

Dialing” on page 63.
2. Press and hold PTT. Wait for the talk permit tone (if

configured) before talking, and release the PTT when
listening.

3. The call ends after a pre-programmed time, or if you

press 2.
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There is no presence check for Private Calls in DMO. This
NOTE means you don’t know whether the called party is available
when you start the call.

Receiving a DMO Private Call

all 1-+1 [
When a DMO Private Call is received, the
call is started immediately without need to d
. Prvt In Use
accept it by the called party. David
1. Press PTT to talk back and start talking. 1234

2. The call ends after a pre-programmed time,
or if you press &Y.

(\[eyg= Ifthe called party presses the DMO private call is
suspended for a specified time and in case the calling party is
still transmitting the call is joined again.

Dialing On Receiving a Call

Dialing process is not changed for the Group Call. Otherwise
display is changed accordingly to the incoming call type and
after the call display returns to where the dialing process was
left.

When an Emergency Call is received, then dialing is aborted
NOTE .
and Emgcy In Use display appears.
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Making a Private PPC (Pre-emptive Priority Call)
NOTE This feature is only available if set up by your Service Provider.

1. Enter the private number and press PTT

or @. -
2. Ifthe display shows the called user is busy, gisviyd
press Yes to interrupt the on-going call. Interrupt?
3. You will hear a ringing tone. Wait for the Yes No

called person to answer your call.

4. Continue the call as in a regular Simplex or Duplex Private
Call.

Call Queuing

When there are no available infrastructure resources for a
call while in a setup phase, or while in an active call during
cell re-selection, the call will be queued. The MTHB800 will
remain in queue for a pre-programmed period of time. If the
resources become available, the call will proceed. If there are

no resources after a certain period of time, the MTH800 will
end the call.
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Phone and PABX Calls

General

The Phone Call allows you to call a landline telephone
number or a cellular mobile phone number. The Private
Automatic Branch Exchange (PABX) Call allows you to
call local (office) extension numbers. This type of call needs
to be activated by your Service Provider.

In this publication we use “phone number” when referring to
these numbers.

Both calls have the same dialing features.
For operating the MTH800 in RF sensitive areas, see
“Transmit Inhibit” on page 48.

While Transmit Inhibit is activated, an incoming Phone or PABX
NOTE Call is indicated, but it is not possible to answer the call.

If your Service Provider has restricted access to the Contacts
NOTE list, it might not be possible to create a new contact, edit existing
contacts or dial up a number which is not in the Contacts list.

Dual Microphone Feature
See “How to Hold Your MTH800” on page 15.

Making a Phone or PABX Call

NOTE If you are in an on-going Group Call wish to make a new call,
press @ to ignore the current call. Dial the number.

1. From the Home display dial a number.
2. If Phone or PABX are not the first type of

call presented, press CType repeatedly to | (B =% |
select the Phone or PABX Call type.

03671234
CType [ [E] [ Delete
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3. Press and release @ You will hear a ringing tone. Wait for
the called person to answer your call.

4. To end the call, press @

Other Ways of Dialing

Dialing via the Contact List

You can also use the contact list to select a number you
previously stored. Press Contcs and search the stored

number by scrolling (@ or @) or by entering up to 12
characters of the contact name. If the contact has more than

one number, use €3 /€%y to select the number.

If no name is stored under a letter, the MTH800 searches

forward, alphabetically, until the next name is found. If more than
one name in the list begins with the same letter, press up to 12
letters.

If the contact has more than one number stored, pickers
surround the contact icon. Use @ /@ to select the number.

Speed Dial

Speed dial allows you to dial a shortened nhumber of up to
three digits instead of the full number. The speed dial number
is the location of an entry in the contact list.

1. Enter the pre-programmed speed dial number (for
example: 5) and press # ).

2. To place the call, press @

3. To hang up, press @

This feature is available only in TMO.
NOTE
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Talk Group Dialling by Index
Talk Group dialling by index allows you to dial the index of the
TG and * instead of going through the menu and picking the
correct group.

One-touch Dial

One-touch dialing allows you to place a call by pressing and
holding one of the keys (1-9).

1. Press and hold the required key for a few seconds. Your
MTHB800 will display the number and dial it.

2. To hang up, press .

If programmable one-touch keys are enabled, one-touch dial is
NOTE disabled (see page 24).

DTMF Overdial

If set up by your Service Provider, DTMF
allows you to communicate with an

automated answering device (for example, <animation>
the voice mail or answering machine) during Phone In Use

. . 12345"#67890
an on-going private, phone or PABX call.

While in an on-going private, phone or PABX
call, press the DTMF keys (0-9, *, #). When pressed, the
DTMF key will sound a tone and the entered digit will be
displayed on the screen.

MS-ISDN

This feature adds to the radio ISDN number. Users can
choose between MS-ISDN and ISSI to address the call,
send the message or pre-defined templates. It works for both
simplex and duplex calls, based on the assigned ISDN
number.

Recent Calls List

Select the number from the recent call list. See “Recent
Calls” on page 144.
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Calling a Number in a Message
See “Calling a Number in a Message” on page 166.

Dialing on receiving a call
See “Dialing On Receiving a Call” on page 66.

Answering a Phone or PABX Call
1. The MTHB800 switches to the incoming Phone/PABX Call.

2. To answer the incoming call, press @ or any other key if
programmed (except Home/End/On-Off key).

3. To end the call, press .
If the called person or the infrastructure end the call, the Call
Ended message is displayed.

NOTE For call alert, see settings in the Vibrate menu option
(page 122) and the Tones menu option (page 127).
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Emergency Operation

General

Emergency Operation is available in TMO and in DMO, if the
MTHB800 is in service.

Emergency Mode indication (alert tones) can be disabled by
your Service Provider.

Dual Microphone Feature
See “How to Hold Your MTH800” on page 15.

Entering TMO or DMO
See “Selecting TMO or DMO Operation” on page 28.

Important Information

» The required time you need to press the Emergency button is

set by default to 0.5 seconds. The time can be configured by
your Service Provider (Shorter press then configured will not
activate the emergency mode).

Pressing the Emergency button can be used to activate one
or more services:

- Emergency Mode

- Sending Emergency Alarm

Starting Hot Mic operation

- Starting emergency individual call

- Powering up the terminal

- Sending the GPS location infromation, if this option is
enabled by your Service Provider

Pressing the Emergency button even if Transmit Inhibit is
activated causes immediately the MTH800 to transmit. When
entering Emergency Operation the MTH800 should not be
within the RF sensitive area any longer!

The MTHB8O0O interrupts the AL call when you press the
Emergency button.

For call alert, see settings in the Vibrate menu option

(page 122) and the Tones menu option (page 127).
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An Emergency Group Call is configured as non-tactical or
tactical:

* A non-tactical call initiates on a talkgroup designated by
your Service Provider. The group might be different than
the one displayed on the terminal screen when starting the
call. After exiting from non-tactical emergency mode the
terminal will be attached to the group that was selected
before initiating the non-tactical call. When in non-tactical
emergency mode, you will not be able to switch
talkgroups.

DGNA messages have no impact during non-tactical
emergency mode but only after exiting the non-tactical
emergency mode.

+ A tactical call initiates on the currently selected talkgroup.

Emergency Call

You are able to make an Emergency Call either by PTT or
emergency button/footswitch (when in Emergency Mode), if it
is enabled. Terminal provides the information about the
current active Emergency Call. If the Emergency Calls are
disabled you are going to see PTT Denied on the screen.

Emergency Power Up during PIN Lock

Terminal enters Emergency Mode without PIN Lock
prompted no matter if in service or not. When you exit the
Emergency mode, the terminal will go back to the PIN Lock
entry screen.

Alarm Addressing

Address type is Private, message is sent to predefined
individual address.

Address type is Group:
+ Tactical — message send to attached talkgroup

* Non-Tactical — message send to predefined group defined
in GSSV/ISSI
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If both types are not selected, alarm will be send to the
address given by Service Provider.

Emergency in TMO
Overview

Please check with your Service Provider for the configuration
of your terminal.

Your terminal may be configured with one of the following:

Emergency Group Call

The terminal will enter Emergency Mode when you press
and hold the Emergency button.

The Emergency Mode allows you to use the PTT to transmit
with Emergency priority (by either initiating an Emergency
Group Call or requesting emergency transmit priority).

After entering Emergency Mode, you may send an
Emergency Alarm (if configured) and then start the
Emergency Group Call and activate Hot Microphone (if
configured).

The Emergency Alarm is a special Status message sent to
the infrastructure before the Emergency Group Call starts.
The terminal may wait for infrastructure acknowledge for this
Alarm and attempt retries. Each time you press the
Emergency button, the terminal will send an Emergency
Alarm.

Hot Mic (Hot Microphone) allows you to talk without pressing
the PTT. Pressing PTT during Hot Mic ends Hot Mic
transmission. Pressing the End soft key ends Hot Mic
activity. If Hot Mic is disabled, then use PTT to talk.

Emergency Private Call (Simplex or Duplex)

The terminal will start an Emergency Private Call to a pre-
defined ID when you press and hold the Emergency button.
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If an Emergency Private Call gets modified to an Emergency
Group Call, the terminal will enter Emergency Mode and will
leave the Emergency Mode when the call ends.

Emergency Private Call and Emergency Alarm

If the address type is set to Private and Emergency Alarm is
enabled, press the Emergency button to send the emergency
alarm to the address configured by the Service Provider.
When those requirements are satisfied the Emergency Call is
initialized.

Changing Folder or Group

See Group Call section on page 39.

Entering or Exiting Emergency Mode

76

Upon entry into Emergency Mode any existing call or service
other than packet data service will be aborted or cleared
down.

In Emergency Mode, the terminal will automatically reject
Phone, PABX and Private Calls, and will not monitor the
groups in the user selected scan list. If an ATG is the
selected group, however, the terminal will monitor the sub-
groups associated with the ATG. The terminal will remain in
Emergency Mode until you exit it.

Press and hold the Emergency button to T A =
enter Emergency Mode. Emergency
When the MTH800 is Off, press this button to T;,fédrifj;1
power the MTH800 On in Emergency Mode Hello

(if configured). Opins | [ Ext

The terminal exits Emergency Mode and
switches to the Home display:

* If you press and hold the Exit soft key during an
Emergency Group Call.

« If the infrastructure ends the Emergency Group Call.



Sending an Emergency Alarm
Your MTH800 will send an Emergency Alarm to the
dispatcher (if configured by your Service Provider):
« Automatically, upon entering Emergency Mode.
« If you press the Emergency button while the MTH800 is in

Emergency Mode.

+ If you change group while in Emergency Mode.

The screen will show one of the following delivery reports:

e Alarm Sent

* Alarm Failed

In both cases, the screen returns within a few seconds to the
main screen of the Emergency Mode.

Due to no delivery confirmation in DMO, Alarm Sent
information confirms only sending the alarm.

Or - if configured by your Service Provider - your MTH800 will
send an Emergency Alarm:

« If you press the Emergency button without entering

Emergency Mode before.

- Other Emergency services such as starting TMO
Emergency Mode or initiating Emergency Private Call
will be unavailable.

- No visible and audio indication on sending Emergency
Alarm will be done.

Some systems do not support the Emergency Alarm feature
NOTE o .
when the useris in a “Local Area Service” area (see page 37).

High/low Audio is not making any difference to the operation in
NOTE
Emergency Mode.

Making an Emergency Group Call

While in an Emergency Group Call, you can still perform group
NOTE operations (such as changing group/folder, searching for a
group, or entering the My Groups folder).
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To initiate or answer a call while in Emergency Mode:

* Press and hold PTT.

+ Wait for the talk permit tone (if configured) and talk.

* Release PTT to listen.

For the delivery reports, see “Sending an Emergency Alarm”
above.

You can also participate in an Emergency Group Call
(initiated by others) in Emergency Mode or in a standard
Group Call.

Hot Microphone Feature in TMO

If the Hot Microphone feature was programmed into your
MTHB800 by your Service Provider, you can make an
Emergency Group Call without the need to press and hold
the PTT.

The following will happen upon entering Emergency Mode:

1. The MTHB800 will automatically send an Emergency Alarm
to the dispatcher (if configured by your Service Provider).

2. A Talk permit tone will be heard.

3. The following typical display will appear:

The microphone will stay open for a time J &

period determined and programmed by =E] _

your Service Provider. EMmgcy Mic On
After the Hot Microphone time period expires, Op{j's“g?’“p[“ —

or if you press PTT during the Hot
Microphone period, or if you press End soft key: the Emgcy
Mic Ended message will be displayed.The talk session ends.
To resume, press the Emergency button again. Your radio
can also resume the Hot Mic session automaticly when the
Alternating Hot Mic feature is enabled. Talk permit time is
granted without any user interaction. The same screen
indication is displayed as for regular Hot Mic.

Talk time and resume Hot Mic time is specified by your Service
NOTE ;
Provider.
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If talk permit is granted to another member of

the group, an “Emergency call received” tone &
will be heard. If configured by your Service E
Provider, your MTH800 will automatically e
attempt to get talk permit again and the Wait Optns""?“ F‘l’r "’”°Exit

For Mic message will be displayed.

During this pending time the MTH800 microphone is not active
NOTE ; ; oo )
until the Emgcy Mic On message is displayed again.

NOTE Hot Microphone feature is available in DMO and TMO modes.

Receiving an Emergency Group Call

A terminal in TMO receives an Emergency Group Call to the
selected group, associated ATG (Announcement Talkgroup),
or scanned group. If the ATG is the currently selected group,
the terminal will receive the Emergency Group Call to the
group associated with this ATG. (For information on the ATG,
see page 39.)

When the MTHB800 receives the call, the display will show
Emgcy In Use and the caller’s identity.

If upon entering Emergency Mode, your MTH800 receives an
Emergency call, and Hot Microphone was enabled by your
Service Provider, the Wait For Mic message will be
displayed. Your MTH800 will attempt to get a talk permit.
The caller’s voice will always sound via the speaker (unless
an external earpiece is connected to the terminal).

If configured by your Service Provider, the screen
background will be red.

Making an Emergency Private Call
1. Press and hold the Emergency button.

2. The terminal will start the call as a Simplex or Duplex call
(as programmed). The Emergency ID is pre-defined and is
not displayed.

3. Continue the call as you would do in a Simplex or Duplex
call.
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Receiving an Emergency Private Call
1. The talker’s identity is displayed when the terminal receives
the Simplex call.

2. When the terminal receives the call, the display will show
Emergency Prvt In Use and the caller’s identity.

If configured by your Service Provider, the screen
background will be red.

3. Continue the call as you would do in a Simplex or Duplex
call.
Modifying the Type of Call
The infrastructure can modify on-going calls as follows:

+ Emergency Group Call to Emergency Private Call, and
vice versa.

* Anyone of the above to a Phone Call.

If Hot Mic is interrupted when the modification occurs, the
display will show the Emgcy Mic Ended message.

Continue the modified call depending on the type of call.

Silent Emergency Mode

Silent Emergency mode is a type of emergency services that
provides no audible indications and no keypad tones at the
entrance. Silent Emergency alarm is sent to the group or a
user defined by the Service Provider. All the screen
indications are kept as it is for the normal mode but the
terminal cannot use any of the services except:

* receiving Ambience Listening.

+ sending Silent Emergency alarms.

» sending GPS signal based on SDS application.
Entering the Silent Emergency Mode

To enter Silent Emergency mode the user needs to press the

Emergency button.

NOTE This feature needs to be enabled by your Service Provider.
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Exiting the Silent Emergency Mode
To exit the Silent Emergency mode:
* user initiates it by pressing Menu and then # key within 3
seconds.

+ the Silent Emergency alarm is not successful or it is
rejected

Count of the efforts and duration that your terminal waits for the

NOTE reply of the alarm are set by the Service Provider. This can be
only interuppted when the user exits the Silent Emergency
mode.

« ambience listening terminates.

Silent Emergency Mode interactions

User presses the Emergency button while in Silent
Emergency

« terminal sends silent emergency alarm.
« terminal provides no audible/visible indication.

In Silent Emergency Mode when the battery is removed the
NOTE . . o
terminal will turn on again in the normal mode.

Silent Emergency and TMO/DMO Mode
As the Silent Emergency is only available in TMO, terminal
will change the mode from DMO to TMO. When the user is in
a private or group call, Silent Emergency waits until any of
the calls is ended to change the mode and enter the Silent
Emergency Mode.
If the Silent Emergency mode enters after the call the only
change on the display is the Private/Group notice which
disappears.
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Power off in Silent Emergency mode

If user initiates the power off while in Silent Emergency mode
the terminal goes to pseudo power off state. In this state
audio and visible indications are turned off but the terminal is

still on in the Silent Emergency mode as before.

NOTE If the terminal exits the Silent Emergency mode after powering

off in it, the terminal shuts down without any indication.

Power on in pseudo power off

User presses the Emergencey button, the terminal indicates
power on but it is still in Silent Emergency mode.

Silent Emergency mode and PIN protect

The terminal enters the Silent Emergency mode while in the
PIN protected state, it asks the user for the unlocking code.
When the terminal exits the Silent Emergency mode, it is still
in the PIN protected state.

Emergency in DMO
Overview

82

You can initiate an Emergency Group Call to a group.

You can receive an Emergency Group Call:

* From the selected talkgroup

* From other users within talkback range (if configured by
your Service Provider). This is called an InterMNI call.

* From an open group. (An open group is a super-group to
which all DMO groups belong.)

Emergency calls can be placed via gateway and repeater.

For gateway and repeater settings, see “Gateway/Repeater

Selection” on page 53.



Hot Microphone Feature in DMO

This functionality is allowing the user, that is in emergency
situation, to be heard without pressing the PTT. It needs to be
enabled by your Service Provider for DMO mode. For the
detailed functionality please see “Hot Microphone Feature in
TMO” on page 78.

NOTE When the terminal is in emergency mode and it switches from
TMO to DMO (and vice versa), the Hot Mic feature is still active.

Changing Folder or Group

Proceed as explained in the Group Call section, “TMO Group
Call” on page 39.

Making an Emergency Group Call
To initiate or answer a call:
1. Enter Emergency Mode by pressing the Emergency
button.
2. Press and hold PTT.
3. Wait for the talk permit tone (if configured) and talk.
4. Release PTT to listen.

Your MTH800 enters TMO by pressing the Emergency button

(if configured by your Service Provider). The terminal attaches
to the predefined talkgroup and starts the Emergency Group
Call. If the predefined talkgroup is invalid the terminal attaches
to the last selected talkgroup.
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Receiving an Emergency Group Call

84

1. The display shows Emgcy In Use and the caller’s identity
as a private number or an alias.

2. The caller’s voice will always sound via the speaker (unless
an external earpiece is connected to the terminal).

If configured by your Service Provider, the screen
background will be red.

« If the incoming call is an InterMNI call in Emergency
Mode, you can view network information by pressing
Optns and selecting Network.

+ If the incoming call is an InterMNI call not in Emergency

Mode, you can view network information by pressing
Network.



Using the Browser

The WAP (Wireless Application Protocol) browser provides
services (such as database access) to the terminal. Check
with your Service Provider for the availability of this feature.

Icons
Icon Description
& Browsing via Wireless Transport Security
(WTLS) to https://... site

In non-secure browser session, the Packet Data icons are

NOTE displayed. (See “Status Icons” on page 18.)

Entering/Exiting the Browser
Enabling Browser Entry

If the Service Provider configured the
browser feature in your terminal, the Browser
option will be listed third in the main menu.

Ll

2. Messages
4 Contacts
> Browser
5 Setup

& More...

3

Select | |

Back

If not, the Security option will be listed third.

Entering/Exiting the Browser

1. Set Packet Data to Voice & Data or Data Only (see
“Setting Up the Data Function” on page 125).

2. From the main menu, press /*\ and select Browser.

3. The display shows one of the following:
+ Clear screen (first-time activation after power up), then

your home page.

+ The last page you navigated to if you re-activate or

resume the browser.

Information on the last page is recovered from the cache if the page
NOTE R e expire and if the browser has enough memory to restore

it from the cache at that time.
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* browser menu, if Packet Data is not available. See
“Disabled Packet Data Service” on page 88.

4. Start browsing using the keypad, four-way navigation key,
and soft keys.

5. To de-activate the browser, press @ or power off the
terminal.

Entering the Browser Menu Panes

The browser menu contains panes with items required for
operating the browser.

1. After entering the browser as explained on page 85, press

Menu or /vens\.

2. Usually, it will bring up the Navigate pane, or the last
browser menu pane you were in.
The Options pane will pop up if the web page you navigated
to has two or more soft keys/options.
From here you may scroll to other panes with the left or
right navigation keys.

Or you may select Browser Menu and then scroll to the
required pane.

Tips for Browsing
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Create and use the following for easy browsing.

Creating a Bookmark via Navigate Pane > Mark Page
Mark a web page for quick download.

1. Enter the browser and browse to the required page.

2. Press Menu to enter the browser menu.

3. Select Mark Page.

4. The screen displays the title and URL of the marked page.
5. Press Save (or Select) to save the page in Bookmarks.



Or select Menu and select an option:

« Save - confirms the bookmark creation.

« Edit - allows to edit the title, folder choice, and URL of
the created bookmark.

» Cancel - cancels the operation.

Creating a Bookmark via Bookmarks Pane
> New Bookmark

1.
2,
3.

Enter the browser.
Scroll to Bookmarks pane.

Select Organise (if there are no saved bookmarks), or
More...

4. Select Menu.

5. Scroll to New Bookmark.
6.

7. Press Save.

Enter the bookmark title and URL, and select its location.

Using a Bookmark

1.
2,
3.

Enter the browser.
Scroll to Bookmarks pane.

Scroll to the required bookmark and select Go. The
bookmark downloads the selected page from the web.

Creating a Hotkey

Assign a bookmark to a hotkey (keys (0:£)-@) to quickly
download a web page.

1.
. Scroll to Bookmarks pane.

. Scroll to the required bookmark.

. Press Menu. Select Hotkeys.

. Select an unassigned key.

. Click Assign. The display shows the bookmark and its

OO0 hAh WOWN

Enter the browser.

assigned hotkey.

87

Jasmoug ayj Buisn



Using a Hotkey
1. Enter the browser.

2. Press and hold a hotkey to download the corresponding
bookmark from the web.

Saving a Page

Save a page (snapshot) for off-line browsing.

1. Enter the browser and browse to the required page.
2. Press Menu.

3. Scroll to Tools pane.

4. Select Save Page. Edit the proposed page title if required.
Scroll down and select Save. The page will be saved in the
Bookmarks Saved Pages folder.

Selecting a Saved Page

1. Enter the browser.

2. Scroll to Bookmarks pane.

3. Select Organise (if there are no saved bookmarks) or
More...

4. Select Go to enter the Saved Pages folder.

5. Select a saved page and press OK. The display shows the
saved page. Depending on the saved page, you may
browse the web from here.

Disabled Packet Data Service

88

If there is no Packet Data Service, the terminal displays
Error: Network Not Available when entering the browser for
the first time. Select left soft key to retry entering, or right soft
key to enter the browser menu.

When re-entering the browser, the terminal displays the last

browsed page if Packet Data was previously available, or the
last page to which you navigated off-line.



Disabled Browser Entry
Browser entry is disabled:
+ during any type of voice call, except ambience listening
call
* in DMO mode
* during Emergency mode
* during PIN lock
« if the Service Provider has not configured this feature
* when the terminal is disabled.

» Browser entry is enabled during Ambience Listening (AL). If
you navigate to previously stored pages, the AL state
remains.
* When you need to activate Packet Data for the first time, AL
is disconnected, and you have the same “look and feel” as if
you were not in AL before.
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Browser Menu Pane Contents

1 Home

2 Open Page

3 Search

4 Mark Page

5 Forward

6 Reload
Advanced... |

— Navigate

— 1 Settings... ——

2 Security... ——

3 Clear...

— 4 Restart Browser

5 About...

<Up to 9 entries>

— Bookmarks —|

— History —'_

— Tools

<Saved Pages Folder>

<Up to 9 entries>

1 Show URL
2 Save Page
3 Find Text

4 Copy Text

90

1 Downloads

2 Scroll Mode

3 Key Press Timer

4 Set Proxy
1 WAP Proxy 1
2 WAP Proxy 2

— 3 WAP Proxy 3
5 Circuit Prompt
6 Resend Data

1 Secure Prompt
2 Current Certificate
3 CA Certificates
4 Send Referrer
5 Authentication



Keys Usage

When the browser is active, the usage described below
occurs inside or outside the editor.

Key Press

Action

Press:

-

* In the editor: enters a digit and/or character
depending on the text entry mode selected.

+ Outside the editor: in a numbered list, selects the
required item list.

Press and hold:

-

* In the editor: standard use

+ Outside the editor: hotkey for navigating to the
numbered bookmark. (For this use, first assign the
relevant bookmark to the specific hotkey as
explained on “Creating a Hotkey” on page 87.)

Press, or press and

hold =)

In the editor, inserts a space.

Press, or press and

hold:

Brings up the Text Input pane, while in editor.
Otherwise, sounds a wrong key press.

Left and right soft
keys

Selects the option that appears in the display
directly above the left and right soft key (part of the

page).

&

While in list of options, moves up one line.

Press and hold @

Moves up on page.

&

While in list of options, moves down one line.

Press and hold @

Moves down on page.

&

Moves to the previous pane.
In the editor: moves left

Press and hold @

Functions as Backward

%)

Moves to the next pane.
In the editor: moves cursor to the right and inserts
space if at the end of the word.

Press and hold @

Functions as Forward.
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Key Press

Action

Press and hold at

the centre of @

Auto-repeat

=

Brings up the browser menu.

(;m

Press to de-activate the browser.

N

Disabled in browser active state.

Rotary button

Used for volume adjustment only.

Emergency

De-activates the browser. The terminal enters
Emergency mode.

Browser Menu Panes Overview
The browser menu includes the following panes:
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Menu Pane Description
Navigate Provides access to the home page and commonly
used items.
Bookmarks Provides access, editing, and storage options to

stored bookmarks and saved pages.
Provides access to recently visited pages and

History shows the position of the currently loaded page in
the history stack.

Tools Provides access to applications and utilities.

The following panes are displayed according to the context:

Options

Displayed only when there are additional options for
the pane or page.

Image

Displayed only when an image is selected.
Provides access to image details, storage, and
display use.

Input Text

Displayed only in text entry mode. Provides access
to text entry mode (e.g.: symbol)




Navigate Pane
Select one of the items below:

Home - for loading the home page.

Open Page - for entering the URL to be loaded.

Search - item disabled.

Mark Page - for creating (saving) a bookmark for the
current document. A title and URL for the bookmark are
displayed, and the root folder is chosen for the location.
Forward - for navigating to the document located one step
forward in the navigation history. If there is no forward
history, this item is disabled.

Reload - for reloading the current document.

Advanced... See following section.

Advanced...

1.
2,

From the Navigate pane, select Advanced...

The screen displays a list of items for accessing advanced
browser features and settings. Select the required item.

Settings...

1.

From the Navigate pane select Advanced... > Settings...
Select the required item.

* Downloads - for setting download preferences. You
may de-activate the downloading of images and
objects. The browser will display a special icon instead
of the images and objects.

+ Scroll Mode - for setting the scrolling mode and speed.

* Key Press Timeout - for setting key press timeout.
This timeout is used for text entry.

+ Set Proxy — Select the WAP Proxy (1, 2, 3). The
browser connects to the web via the selected proxy or
gateway. The network provider installs and configures
the proxy. To establish a secure session, select a
secure proxy.
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Please ask your Service Provider which proxy is
configured for a secure session.

Though you can choose your home page, the Service
Provider may decide to force its own home page on
your terminal.

Circuit Prompt - for turning ON/OFF the circuit prompt.

Resend Data Prompt — for turning ON/OFF the data
resend prompt.

Security...

1. From the Navigate pane select Advanced... > Security...
Select the required item.

Secure Prompt - for enabling/disabling the browser to
inform you that it replaced a non-secure connection with
a secure connection, and vice-versa.

Current Certificate — for viewing the digital certificate
identifying the server that delivers the current
document. A Certificate Authority (CA) digitally signs
and thus authenticates this certificate. Up to 10
additional custom WTLS certificates can be added to
the default list of certificates installed. Please ask your
Service Provider if you wish to have these custom
WTLS certificates added.

CA Certificates — for viewing the digital certificates
installed in the browser and digitally signed by
Certificate Authorities (CA).

Send Referrer — for turning ON/OFF sending of the
HTTP Referrer header as part of HTTP requests. The
Referrer header provides the URL of the link source to
the server.

Authentication - for turning ON/OFF the caching of
HTTP Authentication credentials. HTTP Authentication
protects access to content on the server. If you try to
access a protected content, you will be asked for your
credentials (user name or password).



Clear...

1. From the Navigate pane select Advanced... > Clear...

2. Select clearing of browser data: history, cache, cookies, or
auto-fill.

Restart Browser

1. From the Navigate pane select Advanced... > Restart
Browser.

2. The browser restarts, clearing the history.

About ...
1. From the Navigate pane select Advanced... > About...

2. The display shows information about the current version of
Openwave Mobile Browser.

Bookmarks Pane
If there are bookmarks in the root folder, select More... to
access the Options pane.

If the root folder is empty, select Organise... then press
Menu to access the Options pane.

The Options pane allows you to manage bookmarks.
The Saved Pages folder contains snapshots of saved pages.

Working with the Options Pane for a Selected Bookmark
1. From the Bookmarks pane select More...
2. Scroll to a bookmark.
3. Select Menu to open the Options pane for that bookmark.
4. Select an option:

« Back - for displaying the page associated with the
bookmark (page is downloaded if not available in
cache).

* Details - for modifying the bookmark title and URL.

* Delete - for deleting the bookmark.

* New Bookmark - for creating a new bookmark.

* New Folder - for creating a new folder.
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* Move - for moving this bookmark to a new folder (or in
Bookmarks).

* Delete All - for deleting all bookmarks.

« Hotkeys - for assigning hotkeys ((0})-@™) to

available bookmarks.

Working with the Saved Pages Folder

1. From the Bookmarks pane select Saved Pages folder.

2. The browser displays the page (snapshot) saved using
Save Page in Tools pane.

3. Scroll to a saved page.
4. Select Menu to open the Options pane for the saved page.
5. Select an option:

« Back - for displaying this page saved on its cache.

* Details — for modifying the page title and URL of the
saved page.

+ Update Page - for replacing the saved version with the
current version (to be downloaded from server).

* Delete - for deleting this page from its cache.
* Delete All - for deleting all the saved pages from its

cache.
+ Cancel - for exiting this pane and returning to the last
page displayed.
History Pane
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This pane displays the list of recently-visited pages (up to
nine history entries can be listed). Each history entry shows
its title, if present. (Otherwise, “No Title” is displayed.)

To navigate to a recently visited URL:

1. Select the URL.

2. Press the OK softkey.

To access the history:

1. Select More..., then select Menu to display the Options
pane.



2. Select an option:

* Show URL - for showing the URL of the selected
history entry.

+ Delete - for deleting the selected history entry.

* Delete All - for deleting the list of history entries.

+ Exit - for exiting the Options pane.

* Next History and Prev History - for accessing the next
and previous entries page, respectively.

Tools Pane
1. From the Tools pane select More...
2. Scroll to a document.
3. Select Menu to open the Options pane for that document.
4. Select an option:
* Show URL - for displaying the current document’s URL.
+ Save Page - for creating a snapshot for the current
document.
* Find Text - for finding a text string in the current
document.
« Copy Text — for copying text from the current document
to the terminal’s clipboard.

Options Pane
This pane is specific to the page or pane being displayed.

Image Pane
This pane appears in the browser menu if you enabled the
download of images via Navigate pane > Advanced...
> Settings...
The following items are available:
+ Save - for saving the image in the terminal.
* [Send] - for sending the image to the destination of your
choice.
* Reload - for reloading the image.
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 Details — for displaying the image details.

» Show Image - for showing the image on its own page.

Text Input Pane

This pane is visible when the browser menu is opened and
text entry field is active. The browser has several text entry
modes, depending on the type of input required.

For example, to enter a URL extension when typing a URL:

1. Type the URL.
2. Press the abc soft key. The Text Input pane opens up.
3. Scroll to www.
4. Press the www soft key.
5. Scroll the required extension (for example: .com).
6. Press the .com soft key. The screen displays the URL with
the selected extension.
Mode Soft Key Action
Alphabetic characters - abc Enter text in lowercase
lower case
Alphabetic characters - ABC Enter text in uppercase
upper case
Symbols Sym Enter symbols
Numeric 123 Enter numbers.
http mode www Enter

WAP Box
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This feature needs to be enabled by your Service Provider and it

NOTE is unavailable in DMO.

MTHB80O0 is able to receive the notifications
sent from your Service Provider. It contains
the URL to the service, which can be loaded
immediately or stored as a message in WAP
Box. Then it can be accessed by entering
main Menu > Messages > WAP Box.

Ll

=

B
52
B3

) Low Priority
) Urgent
) Normal

Read

[E]  Back




All the WAP Push messages are passed to the Browser.

More about “Using the Browser” on page 85.

The following icons indicate the status of messages in the

WAP Box:
WAP Box o
Description
Icon
& WAP Message Icon
(En Displayed next to the priority in the message
list view.
E WAP Message Title Icon
Displayed next to the title along with the text.
WAP Message - Created
@ Displayed next to the create date.
WAP Message - Expired
'%ﬁ' Displayed next to the expiry date.

Message View
Shows the title, URL, delivery time and when
the message expires.

Press Go to to open the link in the browser.

Submenu of the WAP Box includes:

+ Select Open Link and press Select to
open it in the browser.

» Select Delete and press Yes to delete the
WAP message. When the display shows
“Deleted: Message n”, the current
message is deleted from the WAP Box.

Ll L}
( E@Messaée 2 )
Title:
You have 4 new
messages

URL:
U http://iwww.motoro

Goto [EI[  Back

L Cd
Wap Box Menu

ﬂ Open Link
Delete
Delete All
Refresh

Select [ [ Back

+ Select Delete All and press Yes to delete all the
messages. When the display shows “Deleted: All
Messages’, all the messages are deleted from the WAP

Box.

messages (if any).

Select Refresh to re-order the WAP Box list and see new
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New WAP Message Received
Types of the WAP Messages and their priorities:
NOTE Service Provider sets the priority of the message.

* Push Message - &,

> High - animation and the icon (blinking) are displayed
with the New WAP Message tone

> Medium - animation and the icon are displayed with
the New WAP Message tone

> Low - icon is displayed with the New WAP Message
tone

> Delete - available only if the user is in WAP Box, the
text Message Deleted Remotely is displayed,
otherwise there is no indication.

Animation is not displayed if the user is in a call, or in

Emergency mode, or in Call Out, or in message editor, or PIN
lock state, or switching to DMO.

* Load Push Message -
> High - Browser opens to the user with the New WAP
Message tone
> Low - the icon is displayed with the New WAP
Message tone
Browser does not open if the user is in a call, or in Emergency

mode, or in Call Out, or in message editor, or PIN lock state, or
switching to DMO.

To check the tone related to WAP Box, please go to “New
WAP Message” on page 189.
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GPS Location Service

Your terminal’s GPS Location feature uses information from
Global Positioning System (GPS) satellites orbiting the Earth
to determine the approximate geographical location of your
terminal. The availability and accuracy of this location
information (and the amount of time that it takes to calculate
it) will vary depending on the environment in which you are
using the terminal.

For example, GPS location fixes are often difficult to obtain
indoors, in covered locations, between high buildings, orin
other situations where you have not established a clear
broad view of the sky.

SEE: IMPORTANT - Things to Keep in Mind.

The GPS location Service can assist your Dispatcher or
Colleagues in many ways such as more efficient deployment
of resources or locating your terminal if you trigger your
emergency service.

The terminal can be configured to display location
information on the terminal’s display or to send it over the air
to your dispatcher where it can be displayed in control center
(Please check with your Service Provider on the
configuration of your terminal).

It is possible to send the location information in TMO via
Packet Data, if the user activate this feature.

IMPORTANT - Things to Keep in Mind

Where adequate signals from multiple satellites are not
available (usually because your terminal cannot establish a
view of a wide area of open sky), the GPS feature of your
terminal WILL NOT WORK. Such situations include but are
not limited to:

* In underground locations

+ Inside of buildings, trains, or other covered vehicles
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* Under any other metal or concrete roof or structure

* Near a powerful radio or television tower

* When your GPS antenna is covered (for example, by your
hand or other object) or facing the ground

+ In temperature extremes outside the operating limits of
your terminal

Even where location information can be calculated in such

situations, it may take longer to do so. Therefore, in any

emergency situation, always report your location to your

dispatcher.

Furthermore, please note that even where adequate signals
from multiple satellites are available, your GPS feature will
only provide an approximate location, often within 20 - 100
meters from your actual location.

Enhancing GPS Performance
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Sometimes the GPS feature of your terminal may be unable
to complete a location calculation successfully. You will then
see a message indicating that your terminal cannot see
enough visible satellites.

To maximize the ability of your terminal to determine a
location fix please note the following guidelines:

« Stay in the open. The GPS feature works best where there
is nothing between your terminal and a large amount of
open sky. If possible, go outside, away from tall buildings
and foliage. While performance in a building is improved
by moving closer to windows, glass with certain sun
shielding films may block satellite signals.

* Position your terminal to enhance reception. Signals from
GPS satellites are transmitted to your GPS antenna, which
is in your terminal antenna. Hold your terminal away from
your body, giving the antenna clear access to satellite
signals. Do not cover the antenna area with your fingers or
anything else.



+ Stand still. If possible, stand still until your terminal is
finished determining your location. Moving your terminal at
a walking pace while your terminal is calculating your
approximate location may substantially decrease GPS

performance.

* In a car. When using the GPS feature in a car, position
your terminal so that the GPS antenna has good access to
GPS signals. Typically, the GPS antenna has best access
to GPS signals in a car when placed near a window.

GPS Icon

When your terminal is receiving valid GPS location data, a

GPS icon will be shown in the display:

'-E%

Please note, that during Emergency mode, your terminal will
not display the GPS icon even when receiving GPS location
data. If valid GPS location data is available when you leave

emergency mode the GPS icon will be displayed again.

GPS Enable/Disable
1. From the main menu, select More...
> Location > Interface.

The current selection (On/Off) is
highlighted.

2, Select the new choice. The display shows:
* Location Service On
* Location Service Off

Ll & [

VoOn
Off

Select

Back
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Entering GPS Location Service

To enter the GPS sub-menu, press /v T
and select More... > Location:
Position
» Position provides the actual position Interface
. . Accuracy
information.
* Interface allows you to enable/disable the  [seect | [Bawk

GPS location service.

+ Setting Accuracy allows you to select high location
accuracy or the energy optimised mode for GPS location
service if the MTHB800 is not connected to a charging
device (Digital Car Kit or charger etc.).

Scroll to your selection and press Select to access the next

display.

This estimate of accuracy of the calculated location is only a

very rough estimate and may vary substantially from the

actual accuracy of the approximate location information
reported.

This feature works in DMO and TMO modes when it is set by the
NOTE . )
Service Provider.

The variation will vary in accordance to the GPS Configuration
set by your Service Provider.

The availability of the GPS Location menus is dependent on

your terminal configuration, please contact your Service

Provider for further details.

Viewing Your Position YR
i
1. From the main menu, select More.... —
> Location > Position. <Latitude>
i X <Longitude>
2. Scroll to view the entire screen. <Tracked satellites>
This displays the following information about [Rfsh | [ Back
the last time your location was calculated
(if available):

* The time the location was last calculated
* The latitude expressed in degrees, minutes, and seconds
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» The longitude expressed in degrees, minutes, and
seconds

* The number of satellites used to calculate the location. In
general, more satellites make for better accuracy. The
maximum is twelve satellites.

To calculate your location again, press Refresh.

For the users from United Kingdom and Fa S
Ireland there are two letters (for UK) or 1
letter (for IRL) displayed. This feature needs  ||Sm< qiions
to be enabled by the Service Provider. Pyt |
It may take your terminal several minutes to g™ T 5]

complete the process of determining your

location. During this time, a message usually appears on
your terminal’s display stating:

* Insufficient Visible Satellites, or

+ Insufficient Visible Data

For tips on getting the best location calculation, see
“Enhancing GPS Performance” on page 102.

The Position screen displays the updated information.
To cancel a location calculation before it is completed:
Press Back to return to the previous screen.

Each time approximate location of your terminal is
calculated, the latest location information is stored in your
terminal and remains there even when your terminal is

powered off. You will see this information the next time you
view the Position screen.

If you received a terminal call or alert while attempting to
determine your location, the Position screen will disappear,
but your terminal will continue attempting to determine its
location. If it is successful, the new location information will
be displayed the next time you view the Position screen.
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GPS Accuracy T R
1. From the main menu, select More...
> Location > Accuracy. High
2. Select the new choice:
* Medium (default) - Power consumption [Select | [ Back
optimisation is combined with less
position accuracy.
* High - Better position accuracy is combined with less

power consumption optimisation.

The MTH800 works automatically in the high accuracy mode

if connected to a charging device (Digital Car Kit or ch
etc.).

arger

NOTE This feature is only available if set up by your Service Provider.
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The Menu

To Enter the Menu ltems

You can enter the menu items during a call. If you are viewing
a menu when a new call starts, the terminal will exit the

menu.

1. Press /v,

2. Scroll to the required item, press Select or @ to select.
Or use shortcuts to access frequently-used menu items. (See
“Shortcuts” on page 147.)

If the menu item contains a further set of menu items as in
the example below, repeat step 2.

Navigating Menu Items

1st Sub-menu 2nd Sub-menu 3rd Sub-menu
Ll (2 Ll (3 Ll (3 Ll [CH
( Main Menu ) ( Setup ) ( Vibrate )
Network 1 &, Messages Vibrate Vibe & Ring
Folder 1 |:'L\> & Contacts I:Lr\ Ring Style I:L“\ Vibe Only
Talkgroup 1 /|| & Security / Set Volume /  Ring Only
Hello £} Setup Language Details...
&3 More... Data Setup
Optns [EE] Contcs Select | [ BacK Select | [ Back Select | [ Back
O} (oJ (oJ (oJ

When scrolling up/down menu items, try also right/left
scrolling. (This will select the item or return to previous level.)

In a list press and hold &3 for automatic scrolling.

To Return to the Previous Level

Press Back or @

To Exit the Menu Items

Press .

Your MTH800 may exit if no key presses are detected for a time-

NOTE out period.
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Menu Icons
The following icons make it easy to identify the menu items at

first glance.
Menu Icon Description
E' Main Menu Items/Context Sensitive Menu

Appears above /*\ if the main menu items/
context sensitive menu are active.

% Messages
» Send status messages,
» Send text messages (free text or according to user
defined or predefined templates),
» Received messages in Inbox.

Contacts
Add, search, edit, or erase entries in the contact
list.

Security
Lets you turn On/Off and verify security features,
and change passwords.

Setup
Allows you to customize your MTH800.

More...
Contains more customisable menu items.

Scroll Bar

Indicates navigation among items that occupy
more than one screen. If all items appear in one
screen, the scroll bar is empty.

—_— | B = @
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List of Menu Items

—— Messages

—— Contacts

——Security

—— Setup

See next page

New Message
Inbox

Outbox

CO Box
Templates
Predefined
Send Status

<New Contact>

<Name 1>
<Name 2>

PIN Protect
T
Off

Change Code

Keylock
Lock Keypad
Auto. Lock
Delay
Start Locked
Air Encrypt
K Validity

TMSCK Validity
DMSCK Validity

DMO SCK
Covert Mode
On/Off
Vibrate
On
Off
Remote Ctrl
On
off
Vibrate
Vibe then Ring
Vibe Only
Ring Only
Details ...
| I—

— Duplex Calls

N

— Simplex Calls

X

— Group Call

|

“— Vibrate Messages

N

Vibe then Ring
Vibe Only
Ring Only

Vibe then Ring
Vibe Only
Ring Only

Vibe On
Vibe Off

Vibe & Ring
Vibe Only
Ring Only
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—— Setup

See next page
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Ring Style
Duplex
<9 styles>
Simplex
<10 styles>
Set Volume
Language
English

<User Defined>

Al

Book On
Book on Accept
Book on Reject
Data Setup
Voice Only
Data Only
Voice & Data
Audio
‘—|: Audio Toggle
Volume Adj. Mode
Tones

— Keypad Tone

— All Tones

4

— Talk Permit

N

— Clearto Send

|

— Periodic Alert

— D-PTT

—

Always Loud
Spkr Cntrl

Individual
Common

On
Off

On
Off

No Tone
Short Tone
Normal Tone

Tone On
Tone Off

Alert
Period

D-PTT
On
Off
Tone Style
Single
Double
Triple



Setup

—— More.

See next page

i

Display

Time & Date

Energy Economy

Rotary Knob
[

%4 Group Setup
2

Flip Display

Text Size

4 d

Screen Saver

Backlight

Wallpaper

Contrast

Display

Format

Ad oA d

System Update

|

EE Status
EE Selection

a

Rotary Mode

|

Rotary Lock

a

In Keypad Lock

]

Wrap Around

1

Scroll Range

1

Confirm TG Sel.

i

Function Keys

Scan

ol

On
off

Zoom
Standard

Activate
Text

Auto
Disabled
SemiAuto

on
Off

Time & Date
Time Only
Date Only
off

Format Time
Format Date

Set Time
Time Offset
Set Date

off
Time Only
Time & Offset

On
Off

Dual
Volume
Scroll

Locked
Unlocked
Disable

Lock None
Lock Volume
Lock Scroll
Lock Both

On
Off

Stay In Range
Scroll To Next

On
Off

Auto

Volume Adjust.

OTB Feature

Scanning
on/off

Select List
Active List
Scan Lists
<40 lists>
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—— More...

@ l——_J Group Setup
5 My Groups
[New Folder]
<FolderName>
L <FolderName>
My Info
My Private Num
My Phone Num
Service Page
— Recent Calls
Dialed
Received
Missed
— Shortcuts
lg |—|: [New Entry]
<shortcut name>
— RUI
A I—E Log On
Log Off
— Networks
@ L———  Networks Sel
l—‘: Home Only
Select Net
— Trunked Mode
— Direct Mode
— TXI Mode
I_E Activate
Deactivate
— Location
& — Position
<Time>
N:<Latitude>
E:<Longitude>
Sats Used:<Tracked satellites>
— Interface
T
Off
— Accuracy
l—‘: Medium
High
—_ Packet Data
Sent Data
Received Data
Bandwidth
Encryption
- This is the standard menu layout. Your Service Provider may
NOTE enable/disable some menu items or change their names.
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Messages
Refer to “Messages” on page 159 for details.

Contacts

General
Contacts stores Private, Phone, and PABX numbers. Each

Contacts entry can store several numbers. A Contacts entry

contains:

* A Name - A name is required if you are storing more than
one number to the entry; otherwise, it is optional. Typically,
this is the name of the person whose contact information is
stored in the entry.

* A Contacts type — Each number stored must be assigned
a Contacts type.

* A Number - Each Contacts entry must contain a number.
This may be any type of phone number and Private ID.

* A Speed Dial number — When you store a phone number,
it is assigned a Speed Dial number. You can accept the
default Speed Dial number or change it.

- If set up by your Service Provider. It is not possible to create or

NOTE edit Contacts or dial a number which is not in the Contacts list.
The menu items for creating, editing, and deleting Contacts are
not available.

Speed Dial Number is not assigned to a Private type contact.
NOTE P g yp

Contact Icons

In the contact list display, the following icons may appear
next to the contact numbers to indicate the type of stored

number.
Contact Icon Description
é Private ID Number
'Ii:ﬁi Mobile Phone Number
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Contact Icon Description

Home Phone Number

Work Phone Number

PABX Number

Other Phone Number

B |6 |0 |Ch

{:] E’ Pickers
Indicate more than one number is stored
with the contact.

Creating a Contact
1.

114

(g s |
From the Home display, press Contcs.

[New Contact]

Select [New Contact]. David ¢
Or - from the main menu select Contacts. Ray g
Select [New Contact]. Sezlesz @[ Back

Or - while editing the list from the Contacts
Menu, select [New Contact].

. Enter name. (For details on text editor use, see “Writing

Text” on page 174). Press Ok to confirm.

. Scroll left or right and select the type of stored number

(such as Private).

. Enter number (#). Press Ok.
. Scroll up and down the entries. Continue to enter other

types and numbers, as you may keep several nhumbers
(Private, Mobile, Home, Work, PABX, Other) for the same
person under the same contact name. To correct an entry,
press Change.

. When finished, press Done. Press Back to return to Home

display.




Editing a Contact
1. From the contact list, scroll to the entry you want to edit.
2. Press /»=w\ to enter Contacts. Select Edit. The entry details
screen displays.
3. Follow the instructions in “Creating a Contact” on page 114
to edit the various fields.
Deleting a Number

1. From the contact list, scroll to the entry that contains the
number you want to delete.

2. Scroll left or right to display the contact type for the number
you want to delete.

3. Press /»=w\ or select View and then /s
4. Select Delete Number.
5. Press Yes to confirm.
If an entry contains only one number, deleting the number
NOTE
deletes the entry.

Deleting a Contact
1. From the contact list, scroll to the entry you want to delete.

2. Press /»=w\ or select View and then /s
3. To delete the entire entry, select Delete Contact.
4. Press Yes to confirm.

Checking Capacity
To see how many numbers are stored in Contacts:
1. From the contact list, press /w=w).

2. Select Capacity.
3. Select Contact to check. Select Back to exit.
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Security

From the main menu, select Security Tl =
i
or > More... > Security (see the note on BIN Protact
page 112)_ Change Code
Keylock
Air Encrypt
PIN Protect K'(/aﬁgirt{/p
Select| [Back
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Network access protection is configured by

your Service Provider:

» No access to network operation — you can only send or
receive Emergency Calls and adjust the volume level. Unit
lock takes effect at the next power on.

To protect access to network operation:

1. From the main menu, select Security > PIN Protect. On is
highlighted.

2. Press Select.

3. At the Code? prompt enter the 4-digit code (factory setting
0 0 0 0). To avoid disclosure of the code, asterisks are
displayed instead of the code digits. The display will show
the following message:

Unit Locked — you entered the correct code. The display

returns to the Security sub-menu and shows the active

setting: On.

To unlock the MTH800 before powering off:

1. From the main menu, select Security > PIN Protect. Off is
highlighted.

2. Press Select.

3. At the Code? prompt enter the 4-digit code. The display will
show the following message:

Unit Unlocked - You entered the correct code. The display

returns to the Security sub-menu and shows the active

setting: Off.

To unlock the MTHB800 after powering on, enter the code at

the prompt. The MTH800 enters the Home display.



If you fail to enter the correct code, the following message will
be displayed:

Incorrect Code Entered - You are prompted to try again.
After failing, your MTH800 will be blocked. Please check with
your Service Provider how many failed attempts are allowed.
How to unblock the MTH800

The display shows Unit Blocked. You can only send an
Emergency Call.

To unblock the MTHB800, enter the PUK (Personal
Unblocking Key). The PUK is an eight-digit master code to be
obtained from your Service Provider.

After entering the PUK successfully, you will be prompted to
replace the forgotten code.

At the New Code? prompt enter the new 4-digit code, and
repeat the code to confirm. If the code does not match, you
will be prompted to enter it again until the new code message
is accepted.

Change Code
From the main menu, select Security > Change Code.
NOTE The default PIN code is 0000.

At the Old Code prompt, enter the 4-digit code. If the old
code does not match the entered code at verification, the
display prompts you to re-enter the old code.

If the entered code matches the old code, the display
prompts you to enter a new 4-digit code and to repeat it for
confirmation. If the confirmation code does not match the
new code, the display prompts you to re-enter the new code.
When the new code is accepted, the display returns to the
Security sub-menu.

NOTE If the PIN protection feature is enabled, changing the PIN code
cause all the messages from the Inbox/Outbox to be deleted.
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Locking/Unlocking the Keypad

To prevent accidental key/button presses: (g |
Press [\ 2 to lock/unlock the keypad. s
Delay: 5 min
Service Provider can choose the notification Start Locked O
for the Keypad lock and if to lock the PTT.
Select| [Back

NOTE The Emergency button is not locked. Entering Emergency

Operation, unlocks all keys.

Keypad Lock Notification

When the keypad is locked one of the following instructions is
displayed:

» None - no notification is display.

* Notification Only - Keys Locked is displayed.

* Notification and Instruction - Keys Locked, Press Menu
and * to unlock is displayed.

Automatic Keylock

This feature locks the keypad automatically after not using it
for predefined minutes. To turn it on/off highlight Auto. Lock
and press Change then choose the On/Off. To change the
delay of the key lock highlight Delay and press Change.

Adjust the time by pressing £ or € and press Done.

Keypad Lock on Startup

User can set the Keylock at the start up of the terminal. To
turn it on / off highlight Start Locked and press Change.
Choose On/Off and press Select.

Air Encryption On/Off
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From the main menu, select Security > AirEncrypt.
This sub-menu allows you to view air encryption On/Off state.

Call encryption provides service confidentiality between you
and the system.



If encryption is on and you receive a clear call (unencrypted),
the MTH800 will display a Call & Data Not Encrypted
message.

You cannot manually disable Air Encryption (if fitted) from the
NOTE menu. This sub-menu only indicates if Air Encryption is enabled

at that moment.

The Air Encryption feature is only enabled depending on your
NOTE . ;
Service Provider.

Air Encryption Key Deletion
Please check with your Service Provider whether the
terminal is provided with air interface encryption keys.
You can delete the air interface encryption keys from the
terminal by entering the following sequence from the keypad:

**00##
It takes a minute for this feature to delete all the enryption keys
NOTE from the radio. During this time please do not remove the
battery.

Using this feature will disable the terminal,

A CAUTION and your Service Provider will need to re-

enable the terminal.

Deletion is performed in idle TMO/DMO or Emergency
NOTE :
Operation.

K Validity
From the main menu, select Security > K Validity.
K (Key) is a secret key the infrastructure uses to authenticate

the MTHB800 in the system. It is part of the authentication that
provides service confidentiality between your MTH800 and

the system.
To verify K validity, press Select. The display will show one
of the following messages:
» Kis Valid - the infrastructure can authenticate your
MTH800.
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« Kis Invalid - the infrastructure is unable to authenticate
your MTHB800. Please call your Service Provider to restore
K to your MTH800.

TMSCK Validity

From the main menu, select Security > TMSCK Validity.

SCK (Static Cipher Key) is a secret key the infrastructure

uses to encrypt call and data in the system. Air interface

encryption provides service confidentiality between your

MTHB800 and the system. Your MTHB800 is provided with a

set of SCKs.

To verify SCK validity for TMO, press Select. The display will

show one of the following messages:

* TMSCK is Valid — your MTH800 can work encrypted in
TMO.

* TMSCK is Invalid — your MTH800 cannot work encrypted
in TMO. Please call your Service Provider to restore SCKs
to your MTHB800.

DMSCK Validity
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From the main menu, select Security > DMSCK Validity.

SCK (Static Cipher Key) is a secret key the infrastructure

uses to encrypt call and data in the system.

Air interface encryption provides service confidentiality

between your MTH800 and the system. Your MTH800 is

provided with a set of SCKs.

To verify SCK validity for DMO, press Select. The display will

show one of the following messages:

* DMSCK is Valid — your MTH800 can work encrypted in
DMO.

* DMSCK is Invalid — your MTH800 cannot work encrypted
in DMO. Please call your Service Provider to restore SCKs
to your MTHB800.



DMO SCK
From the main menu, select Security > DMO SCK.
Key version is displayed when you select the option.

Air Interface encryption provides service confidentiality
between your MTH800 operating in Direct Mode and another
terminal or a group of terminals operating in Direct Mode.
You can change the current key, if the key change operation
is allowed by your Service Provider.

To change the key, if not in a call, select Next. The display
will show the following message: Change to version...

+ Select Yes to change the key. Key version changed

display will appear.
+ Select No to leave the key. Key version display will

appear.
Covert Mode

From the main menu, select Security F

> Covert Mode.

On
Vibrate

Set Covert Mode to On

Select On. All tones are set to off, and the
backlight and the LED are disabled Sefect | | Back
immediately. The group audio is routed to the

earpiece.

Set Covert Mode to Off

Select Off. All settings for tones, backlight and audio are
restored. The LED is enabled and the message Covert
Mode Off is shown.

Set Vibrate
From the Security sub-menu select Covert Mode > Vibrate.

» Select Off to disable all vibrations.
» Select On to restore all vibrations.
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Setup
From the main menu, select Setup.

This sub-menu allows you to change your
MTHB800 configuration: vibrate, ring style, set
volume, language, data setup, audio, tones,
display and time & date.

Setting the Vibrate Feature

This sub-menu allows you to determine if
your MTHB800 vibrates, or rings, or both
vibrates and rings when receiving a call.

To change the Vibrate setting:

1. From the main menu, select Setup
> Vibrate.

2. Scroll through the settings.

T

B (]
s )
Vibrate
Ring Style
Set Volume
Language
Data Setup
Select | [ Back

Vibe & Ring

Vibe Only
+ Ring Only

Details...

Select l [ Back

3. Select required setting, and press Back to exit.

The Vibrate settings mentioned above apply for all calls. Your
MTHB800 can associate different Vibrate settings for different

calls.

To make specific Vibrate settings for different calls:
1. From the main menu, select Setup > Vibrate > Details.
2. Choose which type of call that you want to modify its

Vibrate settings, and press Select.

* Duplex Calls — Phone calls, PABX and Duplex Private calls
NOTE [Jeni P

» Simplex Calls — Simplex Private Calls
» Group Call

* Vibrate Messages (Vibrate Msgs) - Status Messages and

Text Messages

3. Select the required setting, and press Select. Press Back

to exit.
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Ll 3
Duplex Calls

Vibe & Ring
Vibe Only

v Ring Only

|:rL ) Selected

Ll m;

Group Call

 Vibe On

Select | [ Back Vibe Only/On

Vibe Off

Select | [ Back

If you choose Duplex Calls, Simplex Calls or Vibrate Msgs,
NOTE the settings available are Vibe then Ring (for messages it is

Vibe & Ring), Vibe Only or Ring Only.

If you chose Group Call, the settings available are Vibe On or

Vibe Off only.

Setting the Ring Style
This sub-menu allows you to set the incoming
call ring style. Your MTHB800 features nine for
Duplex and ten for Simplex selectable ring
styles.

From the main menu, select Setup > Ring
Style > Duplex or Simplex.

Lol L3

 British
Style 2
Style 3
French
German

Select| [Back

Upon entry into this sub-menu, the display shows the current

ring style used.

Scroll to the desired style and press Select. You will hear the
new ring style immediately for a few seconds. If necessary,

adjust the volume level.
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Setting the Volume

This sub-menu allows you to adjust the
Simplex, Duplex, Earpiece, Speaker, and
Keypad tone volume.
To set the volume:
1. From the main menu, select Setup

> Set Volume.
2. Scroll through the list.

) [

Ll

Duplex Vol: 0_
Simplex Vol: 1_
Earpiece Vol: 1_
Speaker Vol: 0_
Keypad Vol: 0_

Change[ [ Done

3. Choose the required item, and press Change.

4. Adjust the level with the left arrow to decrease and the right
to increase the volume. A feedback tone is heard, and a

volume level bar is displayed.
5. Press Back to exit.

If the display shows only one option Volume, user can adjust all
of the above settings at once. User has the option to change the
settings individually when the Volume Adj. Mode is set fo
Individual. More information please go to “Setting Volume

Adjustment Mode” on page 126.

- The volumes for the Call-Out messages are not adjustable.

NOTE

Setting the Display’s Working Language
From the main menu, select Setup
> Language.
The display shows the current language
used. You can customize your MTH800 to
operate in English, German, French,
Spanish, Dutch, or in a language defined by

ol 3]
English
Deutsch
Francais
Espariol
Nederlands
Select [ [ Back

your Service Provider. The default setting from factory is

English.

Scroll to the desired language and press Select. The display
shows the selected language for a few seconds.
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Setting Up the Data Function

You can connect the MTHB800 to an external device (such as
a laptop or desktop PC). The MTH800 will then be capable of
transmitting and receiving data from the external device. To
connect the MTH800 accessory connector to the external
device, use cable FKN4897. The external device must run an
application complying with the TETRA standards.

From the main menu, select Setup > Data Tal |
Setup.
. . . Voice Only

The display shows the current setting: Data Only
1. Voice Only — The MTH800 receives and
transmits voice calls only. Select | [ Back

2. Data Only — The MTHB800 acts as a
modem. The MTH800 rejects incoming and outgoing voice
calls (except for Emergency Calls), status and text
messages.

3. Voice & Data — The MTH800 acts as a modem but voice
calls have priority over data calls and will interrupt them.
Scroll to the desired setting and press Select.
In Data Only and in Voice & Data, the Data Connected icon is
displayed after you have connected the MTH800 to the
external device and the MTHB800 is ready for data transfer.
The Data Transmit/Receive icon is displayed to indicate data
is being transferred to/received from the external device.

The MTH800 ends the Ambience Listening (AL) call and the
microphone is closed when the MTH800 is in one of the
following states:

+ Entering the out-of-service area

» QOutgoing packet data call setup

To exit data, return to Data Setup and select Voice Only.
The MTH800 returns automatically to Voice communication.

Data services are available only in TMO. Data Services are
MM piocked in TXI Mode.

125

nua\ 8yl



126

When set to Voice Only, the built in data modem is disabled to

NOTE conserve battery power.
Setting Audio

From the main menu, select Setup > Audio.

This sub-menu allows you to adjust
the MTH800 audio settings.

Setting Audio Toggle
You can control audio routing (speaker/

Ll [
Audio
Audio Toggle

Volume Adj. Mode

Select [ [ Back

earpiece) for any Private or Group Call via the dedicated

Speaker Control key (see page 26).

You can also define via the menu to have all Group calls in

high audio or controlled by the Speaker Control key.

1. From the main menu, select Setup > Audio Toggle.

2. The display shows the current audio setting. When set to
Always Loud, the audio sound comes from the speaker
(high audio). When set to Speaker Control, the audio sound
comes from the earpiece or the speaker, per Speaker

Control key use.
3. Select the required setting.

Setting Volume Adjustment Mode

You can set the volume to Individual or to
Common. When it is set to Individual, the
audio for Duplex, Simplex, Earpiece,
Speaker and Keypad can be set per user
preferences. When set to Common, the
audio have one setting for all items.

Ll ‘:]’JJ
Il Volume I

Duplex Vol: 11
Simplex Vol: 11
Earpiece Vol: 11
Speaker Vol: 11
Keypad Vol: 11

Change[E][ Done

1. From the main menu, select Setup > Audio > Volume Adj.

Mode.

2. Choose required setting, and press Select, or press Back

to exit.



Setting Tones

From the main menu, select Setup > Tones. 7y & |
: ;
This sub-menu allows you to activate/ ———
deactivate the MTH800 tones. All Tones
Talk Permit
i 1 “ ” Clear to send
For a detailed list of tones, see “Tones” on Groar fo sond
page 187. Select | [ Back
Setting Keypad Tone

To activate/deactivate keypad tone at every key press:

1. From the main menu, select Setup > Tones > Keypad
Tone.

2. Scroll through the settings (On/Off).

3. Choose required setting, and press Select, or press Back
to exit.

Setting All Tones

To activate/deactivate all tones (keypad tone and other
activity tones used in your MTH800):

1. From the main menu, select Setup > Tones > All Tones.

2. Scroll through the settings (On/Off).

3. Choose required setting, and press Select, or press Back
to exit.

NOTE When all tones are disabled, your MTH800 switches into covert

mode, and all audio is routed to the earpiece, instead of the
speaker for low audio operation. Remember to disable this
feature, when your covert operation is complete, to return your
MTHS800 to high audio operation.

Setting Talk Permit Tone

There are 3 tone settings: N
* No Tone (no tone heard upon pressing
the PTT) ﬁgfrrr:aTIO?oie
+ Short Tone (a short tone heard upon
preSSing the PTT) Select | [ Back
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* Normal Tone (the factory-default tone heard upon
pressing the PTT).

To change your Talk Permit Tone settings:
1. From the main menu, select Setup > Tones > Talk Permit.
2. Scroll through the settings.

3. Choose required setting, and press Select. Press Back to
exit.

Setting Clear to Send

The Clear to Send tone indicates to the transmitting terminal
that the receiving terminal is ready to accept the
transmission.

To activate/deactivate the Clear to Send tone:

1. From the main menu, select Setup > Tones > Clear to
send.

2. Choose required setting, and press Select. Press Back to
exit.

Setting Periodic Alert

Periodic alert indicates the missed calls, the unread
messages and low battery. For each indication the unread
message tone is played with the amber LED color.

To activate/deactivate the Periodic Tone:

1. From the main menu, select Setup > Tones > Periodic
Alert > Alert.

2. Choose required setting, and press Select. Press Back to
exit.

To set the period between tone indications.

1. From the main menu, select Setup > Tones > Periodic
Alert > Period.

2. Choose required setting, and press Select. Press Back to
exit.



Setting D-PTT Tones

To activate/deactivate the D-PTT Tone:

1. From the main menu, select Setup > Tones > D-PTT
Tones > D-PTT Mode.

2. Choose required setting, and press Select. Press Back to
exit.

To choose the tone:

1. From the main menu, select Setup > Tones > D-PTT
Tones > Tone Style.

2. Choose the tone between three options: Single, Double or
Triple. Please go to “Double PTT - Single Tone” on
page 189 to view the specification of the tones.

NOTE All the setting are kept after powering off the radio.

Time & Date Features
The Time & Date menu controls the displayed time and date.
From the main menu, select Setup > Time & Date.

Time & Date Display Settings

From the main menu, select Setup > Time & Date

> Display.

The display shows the current setting:

1. Time & Date — The MTH800 displays time and date.

2. Time Only — The MTH800 displays time only. Format Date
sub-menu is disabled.

3. Date Only — The MTHB800 displays date only. Format Time
sub-menu is disabled.

4. Off - The MTH800 does not display time nor date. Format
menu is disabled.

Scroll to the desired setting and press Select. Press Back to

exit.
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Setting Time Format
To change displayed time format between 24-hour scale and
12-hour scale:
1. From the main menu, select Setup > Time & Date
> Format > Format Time.
2. Scroll through the settings.

3. Choose required setting, and press Select. Press Back to
exit.

Setting Date Format

To change displayed date format between DD/MM/YY, MM/

DD/YY, DD-MON-YY and YY/MM/DD:

1. From the main menu, select Setup > Time & Date
> Format > Format Date.

2. Scroll through the settings.

3. Choose required setting, and press Select. Press Back to
exit.

Time and date are synchronized by the infrastructure. When not
NOTE within the infrastructure signal range you can set the values

130

manually.

Setting Time
To set time:

1. From the main menu, select Setup > Time & Date > Set
> Set Time.

2. Enter time using navigation key and/or numeric keypad,
and press Done. Press Cancel to exit.

Setting Date

To set date:

1. From the main menu, select Setup > Time & Date > Set
> Set Date.

2. Enter time using navigation key and/or numeric keypad,
and press Done. Press Cancel to exit.



Setting Offset

To set local time offset:

1. From the main menu, select Setup > Time & Date > Set
> Time Offset.

2. Enter time offset using navigation key, and press Done.
Press Cancel to exit.

You can adjust the offset value, with 15 minute steps, up to 14
NOTE hours ahead or behind.

System Update

You can pick how you would like to update the time and the

date displayed on the radio:

1. To turn off the automatic update from the infrastructure
Setup > Time & Date > System Update > Off. All the
broadcasted informations are ignored. The terminal uses
internal time and offset.

2. To turn on the automatic update only for time Setup
> Time & Date > System Update > Time Only. The time
displayed is calculated from the offset programmed by your
Service Provider added or subtracted from the network
time.

3. To turn on the automatic update Setup > Time & Date
> System Update > Time & Offset. Time and offset are
updated after receiving broadcasted information.

Display Features
The display menu controls how the display

appears.
. Flip Display: Off
From the main menu, select Setup Text Size: Stand..
- . Screen Saver
> Display: Backlight: Auto
. . . . . Wall 2 O
+ Flip Display - flips the display upside Grange | | Do
down.

+ Text Size - sets size of text on the display.
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+ Screen Saver — covers the MTH800 display after the
MTHB800 stays idle for a pre-programmed period of time (if
configured by your Service Provider).

« Backlight — A backlight lights the display and keypad when
you make or receive a call, or press keys or buttons.
Backlight can be set to Automatic, Semi Auto or Disabled.

* Wallpaper — changes the wallpaper that appears on the
idle screen.

+ Contrast - sets the contrast of the display.

Setting the Display’s Vertical Flip

When this feature is activated, the content of the display is
flipped upside down.The feature is particularly useful for a
user who has to wear the MTH800 on shoulder, belt, or lapel
and at the same time wishes to read the display upside
down.

To activate/deactivate:

From the main menu, select Setup > Display > Flip Display
> On. Or press and hold the pre-programmed one-touch
button (if configured by your Service Provider).

Please note the position of the soft keys in the vertical
display.

(Lo s | auoq abuey)

UQ :Jaded|gpm
Flip Display: Off omy Jybiyoeg W
Text Size: Stand.. N Janeg usaIdg
Screen Saver |:C/> PUEIS :9ZIS X8
Backlight: Auto JO :Aeidsig dij4
Vilgaper; On

Change ] [ Done = 7

G [\ ) & [\ )

For Rotary knob use in the flipped display, see page 23.
See below for navigation key use in the flipped display.



Scrolling down and up using the navigation key

suog | [@bueyd suog | [ ebueyo
TO :Joded|epy TO :Joded|lepy
oy JyBipoeg oy ubipeg

Janeg usaIog
"PUBIS ‘9218 X3

JaABS UsBIS
TPUBFS 828 IXaL

=

up Jaded|iepy
oy Jubioeg
JaneS U98.0g
"PUEIS :82ZIG X8|

10 Keidsig dil4 3O Aedsig dil4 JO Aejdsig dil4
Reidsiq Keidsig Reidsig
[ L] (A [[53
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Scrolling left and right using the navigation key
[EI] edio ajerea  |EI] 8df0 [EI] adlo

‘# eleA!Jd@ |:> # e;e/\ud@ |:>

sjvleg s1elea

# SleAld

P
G L2\ E LoD R
& % &

To exit display flip:
From the main menu, select Setup > Display > Flip Display
> Off.

Setting the Text Size
1. From the main menu, select Setup > Display > Text Size.

2. Press Change. Select Standard or Zoom to see the text
on the display in two sizes.

Setting the Screen Saver

1. From the main menu, select Setup
> Display > Screen Saver.

2. Press Change. Press Change again and
select the screen saver setting: Auto or
Disabled.

3. Scroll to Text. Press Change. Type/edit
the screen saver text using the keypad. (For details on text
editor use, see “Writing Text” on page 174).

Abc 14 | Screen
5|saver:

Hello

Delete

ok &
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4. Press Select to exit.

NOTE The menu options will display the Screen Saver if your Service

Provider pre-programmed this feature.

Setting the Backlight

Your MTHB800 has 3 backlight settings:

Auto:

In this mode the backlight is triggered by turning on the radio,
by pressing any key on device or on the accessory that is
connected to it. Also charging or getting signal from the
services like: Call-Out message, RUA request, DGNA and
TX timeout during priority call are going to turn the backlight
on.

Semi Auto:

By selecting this option backlight is turning on when user is
switching on the radio, pressing assigned button to the
backlight feature or charging.

NOTE The backlight remains on until the pre-programmed timer runs
ou
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Disabled:

The backlight feature is disabled.

To change your backlight settings:

1. From the main menu, select Setup > Display > Backlight.
2. Press Change.

3. Select required setting.

4. Press Done to exit.

Setting the Wallpaper

1. From the main menu, select Setup > Display > Wallpaper.
2. Press Change.

3. Select required setting (On/Off).

4. Press Done to exit.



Setting the Contrast
1. From the main menu, select Setup > Display > Contrast.
2. Press Change.

3. Use the left and right navigation keys to change the
contrast. Press Ok.

4. Press Done to exit.

Energy Economy PN
Energy Economy (EE) is a mode of
operation where in order to save battery life EE Selection
the MTH800 does not monitor all downlink
time slots of the Main Control Channel. Ifthe 5o e

terminal is in the charger, Energy Economy
mode is not needed.

From the main menu, select Setup > Energy Economy
(if setup by your Service Provider).

Energy Economy Status
1. From the Energy Economy sub-menu select EE Status.
2. The EE status is displayed:
* Energy Economy Is Currently Supported By System.
OR

* Energy Economy Is Currently Not Supported By
System.

Energy Economy Selection

1. From the Energy Economy sub-menu select EE Selection.
2. Select required setting (On/Off).

3. Press Back to exit.
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Rotary Knob

Here you can set all the related PR
functionalities of the rotary knob. From the Rotary Knob
. lvRotary Mode
main menu, select Setup > Rotary Knob. Rotary Lock
In Keypad Lock
Wrap Around
ROtary MOde Scroll Range
Your options are: Select] [Back

* Dual - both modes are available. Turn the
Rotary Knob to adjust the volume or press and then turn to
switch to different talkgroup

* Volume - the knob is used only as a volume control; turn
clockwise to increase the audio volume level

 Scroll - turn the Rotary Knob to change the talkgroup, or
when in the menu the knob is used to scroll lists or menu
items.

NOTE If you choose Scroll and the display shows:
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» Scroll Selected - you need to go to the main menu, select
Setup > Set Volume to adjust the volume level.

* Function Keys are set to Adjust Volume - you can use your
programmable side buttons to adjust volume.

Rotary Lock

Your options are:

* Locked - locks Rotary Knob, you can unlock it by selecting
Unlocked or by pressing and holding Rotary Knob.

* Unlocked - unlocks Rotary Knob, you can lock it by
selecting Locked or by pressing and holding Rotary Knob.

+ Disabled - locking function is unavailable. Your Rotary
Knob is unlocked all the time.

In Keypad Lock
You can set behavior of the rotary knob when the keypad is
locked. Your options are:
* Lock None - scrolling and volume setting functionalities
are available
* Lock Volume - rotary knob can be only used for scrolling.



* Lock Scroll —rotary knob can be only used for setting the
volume.

* Lock Both - scrolling and volume setting functionalities
are unavailable.

Wrap Around

If it is set to Off, scrolling through the talkgroup list stops after
reaching first or last talkgroup in the current selected folder.
Otherwise, after reaching last or first talkgroup in the current
folder scrolling is looped or is moved to the next folder.

Only when Wrap Around is set to On and the Scroll Range is
el setto Scroll To Next, you are able to scroll through all the

talkgroups and folders.

Scroll Range

If you set it to Stay In Range, scrolling through the talkgroups
in the current folder only. If you prefer to scroll between all the
available talkgroups and folders, choose Scroll To Next.

Confirm TG Sel.

If it is set to On, you need to confirm the talkgroup selection
by pressing Select or pressing PTT to immediately start a
call on a new talkgroup. Otherwise the radio attaches to the
selected talkgroup without any additional prompt.

Function Keys
Your options are:
+ Auto - the function keys are set according to Rotary mode
setting. If it is set to:
> Dual or Volume - display shows Auto Selected
(OTB), volume can be set only via Rotary Knob.
> Scroll - display shows Auto Selected (Volume),
volume can be set only via function keys.
* Volume Adjust. — function keys can be used to adjust the
volume.
+ OTB Feature - functionalities of the function keys are
assigned by your Service Provider.
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Entering More...

3’:|I| [CH
. .
From the main menu, select More... . This %
sub-menu Contains more customisable E gontaits
. ecurity
menu items. € Setup
More...

Select

Entering Group Setup

From the main menu, select More... . T =]

> Group Setup. This sub-menu allows you

to set the Scan and My Groups features. My Groups
Select | [ Back

Entering Scan

From the main menu, select More... T T
> Group Setup > Scan.
. . Scanning
This sub-menu allows you to activate/ Aciive List
. . . . can Lists
deactivate scanning, view the active scan
list, and edit the scan lists.
Select [ [ Back

It is not possible to enable or disable group scanning in TXI|
NOTE Mode

Setting Group Scanning

This sub-menu allows you to activate/deactivate the
scanning of a list of pre-defined groups programmed in the
MTHB800. The MTH800 will join any group call as long as this
group is defined in the scan list and scan is turned on.

From the main menu, select More... > Group Setup > Scan
> Scanning.

After completing the settings, the display returns to the Scan
sub-menu.
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Set Scanning to On

Scanning is Off. Select On. A message may
indicate that all scan lists are empty. Select
Scan Lists to fill the scan list(s).

The display shows the following state:

Then, the display shows (for example) the
Scanning Scan List 1 message. The
terminal will then try to attach to this list.

Set Scanning to Off

Scanning is on. Select Off. The display
shows the following state:

Then, the display shows the Scanning is
Off message.

Selecting a List with Scanning On

1. Select Select List.

2. To select a list other than the highlighted
one, scroll and press Select. The display
shows (for example) the Scanning Scan
List 1 message. The terminal will then try
to attach to this list.

Selecting a List with Scanning Off
1. Select Select List.

Ll 1]

Ll s
On
Select List

Select l [ Back

Off
Select List

Select [ [ Back

Ll 1)
Network List
Scan List 1
Scan List 2
Scan List 3

Select | | Back

2. To select a list other than the highlighted one, scroll and
press Select. The display shows (for example) the Scan

List 1 Selected message.

The Network List

Your terminal can scan (and attach) to a list belonging to
another infrastructure than the Dimetra infrastructure:

* Upon pressing Select, if the Network List is selected, only

this list will attach. If a user list is selected, then both the
Network List and the user list will be attached.
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* In some cases part of the groups in the scan list could be
invalid for specific sites. In this case, when the terminal
tries attachment to the list, the infrastructure might partially
reject attachments. The terminal’s display shows: “List

partially attached”.

* When the Network List is empty, it will be displayed as No
List. Selecting No List will display the message No

Selected Scan List.

Viewing the Active Scan List

This sub-menu allows you to view the active scan list (Scan

List 1 in this example).

1. From the main menu, select More... > Group Setup

> Scan > Active List. Press View.

The display will show one of the following states:
» There is a selected, inactive scan list (Scan List 1 is Not

Active). Scanning is off.

+ Scanning is off and the Network List is selected (Network

List Not Active).

* There is a selected, active scan list. Scanning is on.

Then, the display will show the Scan Lists

sub-menu.

2. Scroll to the required list and press View to
see the groups that belong to the list.

3. Scroll to the required group and press
View to view the group status (attached or

Ll

-

Scan List 1
Network List

View

EI[ Back

not attached) and priority (if pre-programmed).
4. Press Back to return to the previous display. Then, if

required, press /w=w\. You can select to delete the group

from the scan list or change its priority.

NOTE If the Network List is empty, it will not be displayed.
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Editing Scan Lists

Ll 1]

Ll 1]

i
1. From the main menu, o s List Optns
can List 1 Rename
select More... Scan List2 Capacity
Network List Clear List
> Group Setup Add Group
. Edit
> Scan > Scan Lists. View  [E[ Back Select | [ Back

2. Scroll to the required
scan list. Press View to see the groups used in the scan list.
Press Back to return to the previous display.

3. To edit/view the contents of a scan list, press /wew)\.

4. In the Scan Menu, scroll to the required option and press
Select.

NOTE The options below cannot be used for the Network List.
If the Network List is empty, it will not be displayed.

* Rename the active scan list. (For details on text editor
use, see “Writing Text” on page 174). Enter a new name
(alias) and press Ok. The display shows the new
setting.
* Check the capacity of the active scan list (number of
groups stored in the list).
* To Clear all groups from the selected scan list, press
Yes. You will be prompted to remove all groups from the
selected scan list.
« Add a group to the selected scan list. Every added
group (including a favourite group) comes with its folder,
its name or number, and its priority (if pre-programmed).
> To select a folder, scroll through the folder list. The list
does not show folders whose groups are fully used in
the selected scan list. Press Ok to select a folder.

> To select a group, scroll through the group list within
the selected folder. The list shows groups that are not
in the selected scan list. Press Ok.

> To set a priority to a group, scroll through the priority
list: high, medium, or low.
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A call from a high priority group will interrupt an on-
going call with a medium and low priority.

A call from a medium priority group will interrupt an
on-going call with a low priority.
A call from a low priority group will not interrupt any
on-going call.

+ Edit the scan list groups.

> Scroll to the group you wish to remove from the

selected scan list, press /*w\ and Delete. You will be
prompted to remove the selected group. After a few
seconds, the display shows the updated scan list.

> To change the group priority, press Priority. Scroll to
the selected priority and press Select.

My Groups (TMO/DMO) T
This sub-menu allows you to select/edit your
favorite group list. My Groups

Adding a Group

1. From the main menu, select More...
> Group Setup > My Groups > <FolderName>
> [New Group].

2. Select a group by folder search (“TMO/DMO by Folder”).
Select the folder and select the group. The group is added
to the “My Groups” folder. OR, select a group by alphabetic
search (“TMO/DMO by abc”). You can enter up to 12 letters
of the group’s name.

Select | [ Back

Deleting a Group
1. From the main menu, select More... > Group Setup
> My Groups > <FolderName>.

2. Highlight talkgroup name that you want to delete and select
Delete.

3. Select Yes to confirm.
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Deleting All Groups

1. From the main menu, select More... > Group Setup
> My Groups > <FolderName>.

2. Press [w=w)\. Select Delete All.
3. Select Yes to confirm.
NOTE This option is available only if the Service Provider enables it.

Adding Favorite Folder

1. Press /*w\ and select More... > Group Setup
> My Groups.
2. Select [New Folder].

3. After entering the name of the folder press Ok to confirm.

Renaming Favorite Folder
1. Press /*\ and select More... > Group Setup
> My Groups.
2. Highlight a group folder name and press /v,

3. Select Rename Folder.
4. After editing the name of the folder press Ok to confirm.

Deleting Favorite Folder

1. Press /s and select More... > Group Setup
> My Groups.
2. Highlight a group folder name and press /=)

3. Select Delete Folder.
4. Press Yes to confirm.

NOTE You cannot delete the last favorite folder.
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Viewing/Modifying Personal Information

Use this feature to view your own private or T
. all
phone number at any time.
. My Private N
1. From the main menu, select More... My Phone Num
> My Info Radio Info

2. Select My Private Number, My Phone soea | [ ek
Number or Radio Info.

The displayed private number cannot be modified.
To modify the displayed phone number, press Edit.

Edit the number and select Ok to confirm.The new phone
number does not modify the MTH800 number in the system.

Radio Info stores information about: =

« Manufacturer
Motorola

* Product Type MTH80D

« |SSI 8582:

* TEI Back | [ More

+ Serial Number
* OPTA (information available only if the BSI feature is
anabled).

NOTE This feature is available only if the Service Provider enables it.

Recent Calls

You can view the history of all calls: T
+ Dialed Calls
» Received Calls - calls you answered pecelvod
* Missed Calls - calls received but not

answered, or rejected by the MTH800. Select | [ Back

Each list of calls may contain up to 50
numbers, the more recent call being at the top of the list.

If the number of a recent call is stored in the contact list, the
name associated with the number appears in the recent calls
list.
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An icon appears beside the name or number, indicating the
contact type of the number used in the call. See “Contacts”
on page 113.

Old calls remain in your recent calls list until you delete them
or until they reach the end of the list.

A number dialed more than once, will appear only once in the
list.

Upon receiving a missed call notification, the
MTHB800 will display the missed calls
prompt.

When a call is received during an active call,
the number is written to the missed calls list.
This missed calls prompt will be invoked
automatically at the end of the call. Press Ok
to display the missed calls list.
If your Service Provider has restricted access to the Contacts
list, it might not be possible to dial up a number which is not in
the Contacts list.

1 missed call

Delete

Viewing Recent Calls
1. From the main menu, select More... > Recent Calls.
2. Scroll to the desired list (dialed, received, or missed) and
press Select.
To get more information on a recent call:
From the recent calls list, select the call you want information
on. Press View or if the number is not in your contact list
press /v\ and select View. This displays information such
as the name associated with the call, the number of the call,
call time and the call duration.
Call time information are only available if the time and date is

set in the radio. Call duration is not available in the missed calls
list.
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Storing Recent Calls to Contacts

1. From the recent calls list, scroll to the number you want to
store.

2. Press Store.

If Store is not assigned to the left soft key, the number is
NOTE )
already stored in Contacts.

3. To store the number as a new entry, select [New Contact].
Or, to store the number to an existing entry, select the entry
by selecting View then Edit.

4. With the contact type field highlighted, scroll left or right to
display the contact type you want to assign the number. For
information on contact types, see page 113.

5. If you wish to add more information to the entry, see
page 114.

6. Press Done.
Deleting Recent Calls

1. From the recent calls list, scroll to the call you want to
delete.

2. Press /v=w\. Enter Dialed Calls. Select Delete. Press Yes to
confirm.

To delete all calls:

1. From the recent calls list, press /s,
2. Select Delete All. Press Yes to confirm.
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Calling from Recent Calls
1. You can make a Phone, PABX, or Private Call from the
entry, depending on the entry you are selecting in the list.

A call that was missed or received without a calling number, will
NOTE be stored in the list as “unknown”. You cannot start a call to

such a number.

2. After completing the call, the MTH800 will exit the received/
missed/dialed list.

NOTE From the Home display press ® to access the list of the last

dialled calls.
Shortcuts
Use shortcuts to access frequently-used menu items.
Help on Creating a Menu Shortcut I
1. From the main menu, select More...
> Shortcuts. 3 g;ruep
2. Select [New Entry] and read the first page 3 Details .
. . ) Group Call
of instructions. Press More to read the Select || Back

second page.
3. Press Done to exit help.

Creating Menu Shortcut
For example, let's create a shortcut to the All Tones options.
1. From the main menu, select Menu > Setup > Tones, then
highlight All Tones.
2. Press and hold /*w\ until a confirmation screen appears.

Press Yes to confirm.

3. The first free position is assigned as a shortcut key. A
confirmation screen appears. Press Done to confirm.
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Viewing the Menu Shortcut List
1. Press /v,

2. Select More... > Shortcuts. The display shows the shortcut
list.

If the Service Provider configures the shortcuts, [New Entry] will
NOTE :
not be displayed.

Editing Shortcuts T =]
:
1. From the main menu, select More... [New Entry]
> Shortcuts. J) Edit
. . 2) Delege
2. Scroll to the shortcut you wish to edit. 3) Details..
4) Group Call

GoTo &[]  Back

To modify a menu setting or create a new shortcut from this
NOTE step, highlight the menu option and select GoTo. Otherwise, go
to Step 3.

3. Press /*=w\ and select Edit.

4. Type a number (1-20) that you want to assign to this
shortcut. Press Ok to confirm. You can delete typed
number and press Cancel to quit editing.

If the number is already assigned as a shortcut for another
option, you will be asked to replace the current shortcut
number with a newly created one.

Deleting Shortcuts
1. From the main menu, select More... > Shortcuts.
2. Scroll to the shortcut you wish to delete.
3. Press /»=w\ and select Delete. Press Yes to delete a
shortcut. Press No to cancel.
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Deleting All Shortcuts
1. From the main menu, select More... > Shortcuts.
1. Scroll to the shortcuts.

2. Press /»=w\ and select Delete All. Press Yes to delete
shortcuts. Press No to cancel.

Shortcut Display Messages
The display might show one the following messages for a few
seconds:
* Shortcuts Full: the shortcut list is full.
Press Yes to confirm that you wish to assign a shortcut to
the option. Enter a new key number. If the number is
already assigned as a shortcut for another option, you will
be asked to replace the current shortcut number with a
newly created one.
« Shortcut not Allowed for this Item
+ Invalid Shortcut Position: enter a new number from the
number entry screen.

Menu Shortcut Use

From the Home display, press /+=\ and the numeric key(s)
assigned to the shortcut.

RUI

It gives more flexibility to the users to pick any radio and log
on with it and have a full access to the service. All the
services are forwarded to the radio that you are logged on to.

If the Service Provide disables this feature, full service is
NO ; -
granted without logging.
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« If you have logged on to another terminal, the Store &
Forward message report may not be valid for this terminal.
Sending explicit message confirming reception is
recommended.
 This is recommended to delete the messages from the
Outbox before you log off.

Radio States

* Full Service — User Log On/Book On Was Successful.
Radio has full functionality.

» Limited Service — User Not Logged On. Specified by the
service provider.

* Pseudo Log On

Radio has full functionality available (depending on

the service provider) except some services like g

forwarding calls. The little icon (as displayed)

indicates when the radio is in pseudo-log-on mode.

Log On
From the idle screen you need to press /uen\
> More... > RUI > Log On.
ser iD:
User PIN:

Select [ [Back

1. Selecting User ID.
« to edit User ID go down to second line

. User ID:
and press Edit. -
User PIN:

Edit Back

Ll

7
User ID List
« to enter New User ID press Select New User'm]
Jan

Type your User ID and press OK Peter
Mark

Select| [Back
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* to choose your User ID from the list o

R
highlight the correct one and press

Select Egﬁw User ID]

Peter
Mark

Select| [Back

NOTE You can press v\ anytime to view the detailed list (useful for
the long User ID’s that are not fully displayed). Press  [ven\
again to go back to the previous list.

2. Type your User PIN 5

Ll [
When the User PIN is highlighted press
Select and type your User PIN on the next -

screen then press OK. User PIN:

Select| [ Back

3. Logging s
From this point the request to logon is sent. ]
You can stop the logging process by pressing Logging ..
Cancel. When the logging process ends the R
display is changed to idle screen. I

Color blue of the display is when the user is in full service mode.
NOTE .
In other case the grey scale screen are displayed.

User ID List
The user can check who was using this radio before, by
going to Menu > More > RUI > Log on > User ID. The
chronological list is displayed under the [New User ID].

Log Off
You can change the state that you are logged on by pressing
[s=n\ > More... > RUI > Log Off from the idle screen. The
radio prompts to accept log off state or to deny it (if you
selected it by mistake).
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Book On

Any radio (if the Book On is enabled by the
Service Provider) can be assigned by the
service provider to one person. You are going
to see only screen with your login and the full
service is granted from this point.

Book On Setup
Menu > Setup > Book on Setup
You have two options:

» Book on Accept - radio is going to accept
all the book on requests.

* Book on Reject -- radio is going to reject all
the requests from the Service Provider and
user is not going to see any notification.

user is not able to change Book on setup.

Force Off

The Service Provider can log off the user.
Radio informs the user about the result and
the reason of Force Off state.

Networks
Entering the Networks Sub-menu
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From the main menu, select More...

> Networks.

This sub-menu allows you to select the
network your MTH800 registers to, and what
mode it operates on.

Lall 1]

Ll =

Book on as
<Jan>
Granted Assigment

period 6 hours

Ll 3
Book on Accept
Book on Reject

Select[FE] Back

When the Book on feature is disabled by the Service Provider

Ll [

Force Off
Time out

Ok ]

Networks Sel
Trunked Mode
Direct Mode
TXI Mode

Back

Select | |




Selecting Your Network

This sub-menu allows you to select the T
network your MTHB800 will be registered to.
+/ Home Only
Select Net
Select | [ Back

Selecting Home Only Network

Registration
From the main menu, select More... > Networks > Networks
Sel > Home Only.
Selecting this sub-menu causes your MTH800 to recognise
the first network on the allowed network list only and to
register to it.

Using the Select Net Registration

If configured by your Service Provider, this sub-menu allows
you to select manually the network from the allowed network
list you want your MTHB800 to be registered to.
1. From the main menu, select More... > Networks

> Networks Sel > Select Net.

2. The list of the allowed networks is displayed. Scroll to the
desired network.

A network may have an alias. Press /%) to view the
network ID. Then press Select.

3. Return to the Home display. The display shows the network
ID or alias.

It is up to your Service Provider to ensure your own MTH800
NOTE identity is allowed to register on other networks in your list.
Some groups may not be available on other networks.
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Selecting Trunked Mode

This sub-menu allows you to select the
mode your MTH800 will be operating on.

To set up your operating mode:

1. From the main menu, select More...
> Network > Trunked Mode.

2. The MTH800 switches to Trunked Mode.

Ll L3
Networks Sel
Trunked Mode
Direct Mode
TXI Mode

Select [ l Back

NOTE It is not possible to switch from Direct Mode to Trunked Mode,

if the MTHB800 is in Transmit Inhibit Mode.

Selecting Direct Mode

This sub-menu allows you to select the
mode your MTH800 will be operating on.

To set up your operating mode:

1. From the main menu, select More...
> Networks > Direct Mode.

2. The MTH800 switches to Direct Mode.

Ll 3
Networks Sel
Trunked Mode
Direct Mode
TXI Mode

H

Select [ [ Back

NOTE It is not possible to switch from Direct Mode fo Trunked Mode,

if the MTHB80O0 is in Transmit Inhibit Mode.

Setting Transmit Inhibit (TXI) Mode

This mode should always be set before
entering areas where transmission is

prohibited, e.g. in hospitals or in potentially

explosive areas.
To activate the TXI Mode:

1. From the main menu, select More...
> Networks > TXI Mode.

2. Select Activate.
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The MTH800 will sound the “Transmit Inhibit” tone. The
display shows TXI Mode in the first row, and the solid amber
LED indicates the TXI Mode.

NOTE All menu items which cause transmitting are blocked in TXI
Mode. It is not possible to change the group.

To deactivate the TXI Mode, e.g. after you have left the area
where transmission is prohibited:

1. From the main menu, select More... > Networks > TXI
Mode.

2. Select Deactivate.

The MTH800 sounds the “Transmit Inhibit” tone and
exits TXI.

Location
Refer to “GPS Location Service” on page 101 for details.

Packet Data
This menu item allows to display statistical Ta E |
values related to a packet data connection. If
Multi Slot Packet Data Service is enabled by Recelved Data
your Service Provider the screens present Encryption
information about sosa ] [Bak

« Amount of sent data,

« Amount of received data,

+ Bandwidth of the data session
+ Data encryption status.

Data services are only available in TMO. The data option must
WIS pe set to Voice&Data or Data Only. (Refer to “Setting Up the
Data Function” on page 125).
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Viewing Sent Data Statistics
1. Select Sent Data in the Packet Data sub-menu.

The number of KBytes sent since current
packet data activation is displayed.
Additionally the throughput is shown:

9 kbps (e.g.) — active packet data session.
N.A. — standby packet data session.

Viewing Received Data Statistics
1. Select Received Data in the Packet Data sub-menu.

2. The number of KBytes received since
current packet data activation is displayed.

Additionally the throughput is shown:
9 kbps (e.g.) — active packet data session.
N.A. — standby packet data session.

Viewing Bandwidth Status

The bandwidth percentage represents the number of
allocated time slots (“channels”) during the data session.

1. Select Bandwidth in the Packet Data sub-menu.
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2. The bandwidth percentage is shown
75% (e.g.) — active packet data session,
N.A. — standby packet data session.

Ll & (o

Sent Data

Sent: 100KB

Throughput:
9kbps

Back

Ll & [

Received Data

Received: 100KB

Throughput:
9kbps

Back

Bandwidth
75%

Back

Your Service Provider has set the maximal number of time slots
to allocate to 1, 2, 3, or 4. The bandwidth percentage refers to

the possible number of slots (1, 2, 3, or 4) as 100%.

Example:

50% is displayed, if 2 of 4 possible slots are allocated.
100% is displayed, if 4 of 4 possible slots are allocated.
100% is displayed, if 1 of 1 possible slot is allocated.



Viewing Encryption Status
1. In the Packet Data sub-menu select
Encryption.
2. The encryption state of the ongoing packet
data session is displayed:
* Encrypted
* Not Encrypted (clear)

Packet Data

Encrypted
Back|
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Messages

General
The messaging feature lets you:
+ Send text messages (free text or according to user defined
or predefined templates).
+ Send status messages.
* Receive messages.

A status is a number corresponding to a pre-programmed
message in a list your group recognises. A text message is a
text containing up to 1000 characters. There are two places
where you can find text messages:

* Inbox - stores all incoming messages.
» Qutbox — stores all outgoing messages.

NOTE If configured by your Service Provider it is only possible to send
a message to a private number that is stored in the Contacts list.

Sending a Text Message
* Itis not possible to send a status or text message in TX|

NOTE Mode.

* |tis not possible to send a status or text message during a
call in DMO

You can send new messages, send messages based on user
defined templates or send messages based on predefined
templates.

The predefined templates are programmed into your
MTHB800 by your Service Provider. The user defined
templates can be Inbox messages or new Outbox messages
that you choose to store in your MTH800 memory. User
defined messages may also be programmed into your
MTHB800.
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You are allowed to edit your messages before sending them.
You can send a message when the terminal is idle or during a
Group/Emergency/Broadcast Call (if configured).

If configured, a message will alert you of an incoming Group/
Emergency/Broadcast call, of your joining it, or of its end.

In DMO text messages are sent on the frequency of the

current talkgroup. Make sure you select the desired talkgroup
before sending a message. For selecting group details see
“Selecting a Group” on page 40.

Sending a text message during a Group Call (if configured)

Press @ One of the following might occur:

* The call started before message editing began. The
terminal will leave the call and send the message. If the
call is still active, the terminal will re-join it.

* The call started after message editing began. The terminal
will leave the call and send the message. The terminal will
return to the edit screen.

* The call started before or after message editing began.

The terminal will send the message while staying in the
call.

Sending a text message during Emergency/Broadcast Call (if
configured)

Press @ One of the following might occur:

+ The call started before message editing began. The
terminal will leave the call and send the message. The
terminal will return to the edit screen.

* The call started after message editing began. The terminal
will send the message while staying in the call.

Displaying Long Text Messages

In the message view screen, press More to read the next
page, and Back to return to the previous page.
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Entering the Messages Sub-menu
From the main menu, select Messages.

The sub-menu allows you read text
messages, send text messages, and send
status messages.

Scroll to your selection and press Select to
access the next display.

L =

(__ Messages )
New Message
Inbox
Outbox
CO Box
Templates

Select [[E][  Back

NOTE Your MTH800 can receive calls while in the Messages sub-

menu.

New Message

Creating a Message
1. From the main menu, select Messages
> New Message. An empty screen will
open.
2. Type/edit your message using the keypad.
(For details on text editor use, see “Writing
Text” on page 174).

Press /ww\. Select Store to add your

message to the template list (name of the
template can be defined by the user).

Sending the Message
1. Press Send.

* If set up by your Service Provider you
have the option to send the message to
a private, phone number or a talkgroup.

+ Otherwise select the mail recipient of
your choice from the contact list or enter
the address directly.

Abl ¢ Edit
0 |Message:

Send [E[ Cancel

Ll [
Store
Entry Mode
Entry Setup
Message Setup

Select [EI]  Back

&y =
Target selection

Private
Phone
Group

Select [ EIJ Back

2. Press Send or PTT or @ to send the message.
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The display will show one of the following delivery reports:

* Message Delivered - to indicate that the message was
successfully sent and received.

* Message Failed — the message was not received.

MS-ISDN feature enables the user to send the message to the
NOTE
phone as well.

Sending Store & Forward Message

After typing the message press . Select T =

Message Setup and select one of the (_ Message Setup )
options. First is to send the text message to On/Ofine sere”

the online user.

Second option is to send the Store & Forward (g5 11
message. More about “Store & Forward” on

page 172.

After sending the message, your MTHB800 will return to the
templates list or to the message editor screen.

NOTE It is recommended to wait for the message acknowledge before
sending a new message.

Using the Inbox

The inbox list contains new or old incoming text messages
and can contain 100 messages.

Inbox Icons
The following icons indicate the status of messages in the
Inbox.
Inbox Icon Description
E Unread (New) Message
Indicates that you have not read the message yet.
E—\ Read (Old) Message
E Indicates that you have read the message.
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Inbox Icon Description

AT Sender Information in Message View

= Indicates sender information (name or number).

l:ﬁ Time and Date Stamp in Message View
Indicates the time and date of message arrival.

= Delivery Status Received
Indicates delivery status for Store & Forward
messages.

Inbox sub-menu indicates how many messages are in. If the
NOTE indication is for example 2/4, it means that 2 unread and 4 read

messages are in the Inbox.

Entering the Inbox

T 1

i
From the main menu, select Messages —
> Inbox. 2) f@ Peter
3) §@ 2255

The status of the list is displayed for a few

seconds:

Read [FE]  Back

* No New or Old Messages - the screen
returns to the previous display within a few seconds.

* Inbox info Inbox Full. Press Ok to confirm.

Reading a Message in the Inbox

1. Scroll to the message.
2. Press Read.
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New Message Received
If you press Back, you dismiss the message.

<animation>
You can access the message later from the TNew Message
inbox.
1. Select Read to read the entire message. Read | | Back

Reading a new text message changes its
state from New to Old. The read message is kept in the
Inbox.

2. The display shows the incoming message number, sender,
and up to 4 lines of the text message.

You will hear the “New Mail Received” alert tone when a new
NOTE message is received while your MTHB800 is engaged in a call (if
configured by your Service Provider).

» For message alert, see settings in the Vibrate menu option
(page 122) and the Tones menu option (page 127).

« If your service provider has enabled the PTT Callback
feature, then pressing PTT will initiate a call to the message
originator. Otherwise, PTT will be directed to the currently
selected talkgroup.

Displaying Long Text Messages

In the message view screen, press More to read the next
page, and Back to return to the Inbox. You can view your
message line by line using @ and @ keys.

Handling Messages

When in the inbox or after reading the -
Lol (;:
message, press /=w\ and select one of the

Store
: H . Delete
following options: Delete Al

+ Select Store and press Select to store the || Fersa

message as a template in the template list. [Select [E[  Back
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Select Delete and press Yes to delete the message. When
the display shows “Deleted: Message n”, the current
message is deleted from the Inbox.Select Delete All and
press Yes to delete all the messages. When the display
shows “Deleted: All Messages”, all the messages are
deleted from the Inbox. The display shows the Messages
sub-menu.

Select Reply. This invokes the edit screen. The old
message body serves as the default message and the
message originator is the destination. When you are done
with editing/adding text press Send, PTT or @ to send
the message.

Select Forward. This invokes the edit screen. The old
message body serves as the default message. Enter the
recipient’s number and press Send, PTT or @ to send.
Select Refresh to re-order the inbox list and see new
messages (if any).

Press Back to return to the previous display.

NOTE Radio notifies you when the message is too long.

Immediate Message Tl & %
New Message:

When the new Immediate Message is From:
received, radio plays the New Mail Received
tone and displays the content overlaping your
previous screen. All Immediate Messages [Back |

<Text>

Time Stamp

are stored in the Inbox.

If the radio is in PIN Lock state, Immediate Message is
displayed after correct PIN is entered.
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Calling a Number in a Message

You can return a voice call to the sender of a
message or to any number that is embedded
in the message text. Your Service Provider
could configure this feature.

1. In the inbox list, highlight a message.
OR
read a message containing number(s).

2. Press PTT or @

&
all

) (3

Call me at 15.00
num 6743 or 6677

U

Reply [E]  Back

3. The display lists the numbers (including the sender’s

number).

4. To call, scroll to your selection and press PTT or @
To store, scroll to your selection and select Store and
choose existing contact or create a new one (for details on
how to create a contact, see “Creating a Contact” on

page 115).

5. Press CType to select the type of call (Private, Phone, or

PABX). Then press PTT or Q).

If necessary, save the entries in the contact list.

Outbox
All sent messages are stored in Outbox. To go to Outbox
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press [ww\ > Messages > Outbox.

Submenu of the Outbox includes:

» Select Store and press Select to store the
message as a template in the template list.

If configured by your Service Provider it is not possible to call
back to a number that is not in the Contacts List.

Ll [0

Outbox Menu

Store
Delete
Delete All
Resend

U Forward

Select [FEI[  Back




+ Select Delete and press Yes to delete the message. When
the display shows “Deleted: Message n”, the current
message is deleted from the Inbox.Select Delete All and
press Yes to delete all the messages. When the display
shows “Deleted: All Messages”, all the messages are
deleted from the Outbox. The display shows the the
Messages sub-menu.

» Select Resend to edit the message and send it to the
same participants.

+ Select Forward. This invokes the edit screen. The old
message body serves as the default message. Enter the
recipient’s number and press Send, PTT or @ to send.

+ Select Refresh to re-order the outbox list and see new
messages (if any).

* Delivery Status (as displayed) o =

Shows the date and the time of the message

Msg Sent

when it was Sent, Delivered, Read, Expired 4AMay-18 10:17
was not delivered, Expired was not read, e 01
Failed unknown. Every time the status is Msg read

Select [EEI[  Back

changing you are going to receive new
message regarding it.

All the messages are described by three icons:

Outbox Icon Description

Delivery in Progress

i

Delivery Accomplished

Delivery Failed

X

Delivery report is saved in Inbox and in the associated
message in Outbox. However it is deleted from Inbox after
viewing it.
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User Defined Templates

The user defined mail templates are
received, new, sent or programmed
messages that are stored in the templates list
and may be used for sending messages.

1. From the main menu, select Messages
> Templates. The first template in the
template list is displayed.

Ll

; =

1) Template 1
2) Template 2
3) Template 3

Select [[E[  Back

NOTE It is possible that the templates have user defined titles.

2. In the templates list, scroll to the template you want to use.

Press /w=\ and select one of the following options:

* View to view the message in the template

« Edit Text to edit the message in the template for your
needs. (For details on text editor use, see “Writing Text” on
page 174). Press /ww\ to enter the Editor Menu. Select
Store to save the edited template as a new one. Default
name is given (Template 1, Template 2, ...). Select Save

Changes to save edited template.

+ Edit Name to edit the name of the template that is stored.
After editing, select Ok to save the name. Delete and
press Yes to delete the template. When the display shows
“‘Deleted: Template n”, the current template is deleted from
the Inbox. The display shows the templates list.

3. Send the template. See “Sending the Message” on

page 161.

Predefined Templates
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Predefined mail templates are templates that
are programmed into your MTH800 by your
Service Provider. You are allowed to perform
limited edit operations of the predefined
template and to send it, but you will not be

Ll

[
Predefined

1) My IP address...
2) Meeting at...
3) Register ABC 27

Select [[E[  Back

able to store the edited template or erase it from the

predefined template list.



Editing a Predefined Template Send | [ Delete

1. From the main menu, select Messages > Predefined. The
first template in the predefined template list is displayed (if
no predefined template exist, the message
No Predefined will be displayed).

2. Scroll through the list and select the required template. You
can also search the template by the name. Use the keypad
to enter up to 12 characters.

Press [« to enter the Predefined Menu and select one of
the following options:
* View to view the message in the template

« Edit (In the example, a registration
message is displayed)

Reqister
ABC 27 |

Check with your Service Provider for the

types of predefined templates in your terminal.

There are three types of predefined templates:

« Alphanumeric - enter characters and digits

* Numeric — enter digits

* Mixed - enter digits, *, and #

Select Edit from the Predefined Menu. The cursor is located
on the last character. To move the cursor backward, press
@. You can only enter as many characters as it was
originally in the template.

After editing a template, you can send it.
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Sending a Predefined Template

A predefined message address is also defined by your Service
NOTE . ) .
Provider during programming and cannot be changed.

1. Press Send, PTT or @ or the relevant one-touch numeric
key to send the message.

2. The display will show one of the following delivery reports:

* Message Delivered - to indicate that the message was
successfully sent and received.

* Message Failed — the message was not received.
3. After sending the message, your MTH800 will return to the
predefined template list or to the message editor screen.

NOTE It is recommended to wait for the message acknowledge before
sending a new message.

Sending a Status Message to a Group

1. Switch to the desired talkgroup, to which you want to send
a status message.

2. From the main menu, select Messages > Send Status.

3. In this example, Lunch is the last sent —_—
status. If you wish to send a different status,
scroll to your selection in the list of pre- ﬂ;; bunch
programmed statuses, or enter 5 digit 3) Mesting
status number and skip the next step.

Select [E]  Back

4. Press /w=w\ and select View to view the
status message. Press Back to return to the status list.

5. Press Select, PTT or @ and select Group as a target of
your status message.

6. Highlight required talkgroup and press Select, PTT or @
to send the status message.

NOTE If you want to send a different status message, you can enter 5 digit
status number and press SendTo. After that follow the step number
5.
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Targeted Status

If your Service Provider has enabled the Targeted Status
feature, the status sending display will show you the option of
To enter the private number, either key in the recipients
number or press abc to search the contact list. For a group,
select the group within the folder. Then send the status
message by pressing Select, PTT or @
The display will show one of the following delivery reports:
+ Status Sent - the screen exits the status screen.
+ Sts Failed - the screen returns within a few seconds to the
previous display.
Wait for the delivery report before sending a new status.
If you enter the status menu from a busy talkgroup, audio is

momentarily suspended to allow transmission of your status
message.

If an Emergency call is received, the MTH800 immediately joins
NOTE
the Emergency call.

If set up by your Service Provider it is not possible to send a
NOTE status message to a private number that is not in the Contacts
List.

Long Text Messages
TETRA infrastructure is supporting messages up to 1000
characters long. You can see the number of characters left.
Received long text messages are editable and you can
forward and reply them. Inbox and Outbox is sharing the
memory. By receiving long text messages your storage area
can be filled very quickly so remember to delete old
messages.

NOTE Long Text Messages can be disabled by the Service Provider.
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Store & Forward

This feature enables the host and mobile stations to

communicate with each other without having to be available
at the same time. The message is stored until the recipient is
affiliated to the system or the expiration time was exceeded.

Call-Out

This feature allows the user to receive CallOut alerts. When
the Call-Out messages have been received by the radio, it
interrupts current services and attends to the call-out alert
without any further delay. After call-out alert has been
cleared, the radio exits Call-Out mode and reverts back to
normal mode. The user is able to receive only Emergency
Calls during Call-Out mode. There are four types of the Call-
Out alert:

* Normal call-out
» Storm plan - it is sent to a group several

time to raise reliability. User can only
accept the Call-Out by pressing any button Test Group

and is moved to information phase (soft Car accident
keys are not labelled). -

» Fallback Mode - it includes only voice
communication. It can be cleared manually

NOTE Fallback is only possible when Radio is in Local Site Trunking.

+ Test Call-Out - dispatcher has the ability to test this
feature. Radio is generating the tone with “Call-Out Test”
on the display. Only one softkey is enabled “Test OK” to
confirm and to clear the test.

Interactions when the user is in other mode:

* TXI Mode - users can read the message but they can not
respond to it. They have an option to leave the TXI Mode
by pressing soft key or reject the Call-Out message.

* DMO Mode - Call-Out is not supported.

+ Emergency Mode - all the Call-out alerts are ignored.
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Call-Out service phases

+ Alerting phase — user receives a Call-Out message. The
alarm tone indicates that the message text is displayed.
Under it there are three options for the user to pick:
Accept, Reject or /w=w\ . If the user accepts the alert no
other service from this point can interrupt. Menu key gives
more choices (display on the right).

Ll Q) = T ) = |
Cal-Out
Severity-1 /'S\fac:(ﬁy
Test Group Reject
Car accident Messages

Exit
Accept [EEI[ Reject Accept | | Reject

The user can stop the alert tone by pressing PTT or any of the soft
NOTE keys

* Information phase - the user is still in the call-out mode
and can receive more detail information about the incident
that occurred via subsequent text or the voice message.
The user can query for more information using voice group
call or Call-Out text function which enables to send a text
message to the Service Provider. User can always
respond and send back the text or the voice message
using voice group call.

Call-Out Box
CO Box gives the user the option to view and store the Call-

Out messages for future reference. To view them press

> Messages > CO Box. When the radio is in Call-Out Mode,
you can only read the ongoing Call-Out messages.

WAP Box
Please go to “WAP Box” on page 98 to find more information.
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Writing Text

Selecting the Text Entry Mode

Text entry modes make it easy for you to enter names,
numbers, and messages.

In the text entry screen, select /w=w\ >Entry Mode, and then

select one of the following modes:

* Primary - for entering alphanumeric characters

* Numeric - for entering numbers only

* Symbol - for entering symbols only

* Secondary - for entering alphanumeric characters. (This
mode is optional and you have to add it to the list.)

In the text entry screen, you can also press repeatedly
to change to Primary, Numeric, Symbol, or Secondary (if you
have set it up).

Adding Secondary to the List of Text Entry Modes

Secondary is convenient when you use one language, and
sometimes wish to switch to another one.

This mode appears in the list only if you set it up first via

[x=w\ > Entry Setup.

None is the default programming from factory and indicates
no secondary entry mode is selected.

Selecting the Text Entry Method and Language
There are two text entry methods:

* TAP - Enter letters, numbers and symbols by pressing an
alphanumeric key one or more times.

* iTAP - Letthe terminal predict each word as you press an
alphanumeric key.

You can use these methods in the languages programmed in
the terminal.
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In the text entry screen, select /=w\ > Entry Setup, and then

change to one of the methods and its related language (for
example: TAP English).

Icons

In the text entry screen, icons tell you which text entry mode
and method you are using. A character counter icon indicates
the number of entered characters.

Primary Icons Secondary Icons Description
abc 1 abc 2 TAP — no capitals
fAbc 14 Abc 21 TAP — capitalise next letter
only
ABC 1t ABC 21 TAP — all capitals
abc [Q abc iTAP — no capitals
Abc fAbc B iTAP — capitalise next letter
only
ABC [EE ABC E% iTAP — all capitals
Numeric Icon Description
173 Enter numbers.
Symbolic Icon Description
@ Enter punctuation and symbols.
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TAP Display

Press a key and the display
shows the following information:

« The icon indicating the current ~ Tapicen T 17 |Edit
' H Counter 1/Message:
text wr|t.|ng method - see icons. i foxt a
* The main text entry area that area —
will hold your message after Send [ Delete

you selected the desired words.

iTAP Display
Press a key and the display will show the following
information:
» The icon indicating the current text writing method — see
icons.
* The main text entry area that

will hold your message after
you selected the desired words.

iTapicon ___|
* Arow of.sugge_sted characters/ ~ Sounter
words will be displayed. area
Alternative
row
Keys Usage

Characters available for a key are examples and differ for each
NOTE language setting (see “Setting the Display’s Working Language”
on page 124).

J

List of Keys and Characters in Alphanumeric Mode
(TAP/ITAP)

» Except for keys 0 and 1, the top line for each key shows
numbers and upper case characters, and the lower line
shows numbers and lower case characters.

* Press and hold any numeric key to enter Numeric mode.
+ To exit Numeric mode in iTAP, select the word.

» To exit Numeric mode in TAP, press and hold any
numeric key.
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Key

Alphanumeric Mode (TAP/iTAP)

ON-!;‘

Press to cycle through single shift, caps
lock, and lower case

L2101@°7-() ) +&%x*=<>
€LS¥u[]{}\~"¢ §#

2abc

ABC2
abc2

DEF3
def3

GHI4
ghi4

JKL5
jk15

MNO 6
mnob6

PQRS7
pqrs7

8tuv

TUVS
tuv8

IR CIREIRC GG

WXYZ9
wxyz9

List of Keys and Characters in Numeric Mode:

Key Numeric Mode
« Press to enter digit at insertion point.
to » Press and hold any numeric key to enter

* To exit TAP alphanumeric mode, press and

TAP alphanumeric mode.

hold any numeric key.
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List of Keys and Characters in Symbol Mode

Key Symbol Mode

oF +ox* [\ []=<>§#
L?2l@ -+ &% xT=<>€L

D S¥a[]{}\~" ;84

@\

o

A

D) O

i~

=< >

€£$¥n

# % *




Other Keys

Key Description
Any * In TAP press any key to reject word completion and
numeric key | continue with text entry A new completion will be

displayed, if available, after the time-out for TAP expires.
* Press and hold to enter Numeric mode from TAP or iTAP
alphanumeric.

=y

* Press to insert a space.

* In TAP press to dismiss a word completion and insert a
space.

» Enter a newly created word into the user dictionary.

* Press and hold to enter a carriage return.

* Press once to cycle through all entry modes (symbolic,
numeric, primary and secondary if configured).
* Press and hold to return to the default entry mode.

Select Press to select the highlighted choice and place it in
the main text area.
Delete * Press once to delete the last entered character.

» Press and hold to clear the entire main text area.

* In TAP press to reject word completion and scroll up.
* In TAP press to change previously entered small letter to
capital.

* In TAP press to reject word completion and scroll within
the text area.

* In TAP press to change previously entered capital letter
to small.

* Press to navigate to the left. Press and hold to repeat
* In TAP, if a word completion is available, press to reject
the completion.

* Press to navigate to the right. Press and hold to repeat.
* In TAP if a word completion is available, press to accept
the word.

&
©
%)
Q
fu\

Opens the Context Sensitive Menu if a context
sensitive menu is active.
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Writing in iTAP Alphanumeric
For example, let's write “David 232!,

1. In the text entry screen, select /w=w\ > Entry Setup, and
then change to iTAP English. Press Back to return to the
text entry screen.

2. Inthe text entry screen, select /=\ >Entry Mode, and then
select Primary.

3. Press 3*). The alternative row opens up and shows DE
F 3. Continue entering the letters by pressing one key for
each letter. The row shows the suggested words. Scroll the
alternative row to the right until you reach David.

4. Press Select to select the word. It is displayed in the main
text area.
Automatic shift to upper case is used at the beginning of a

NOT message, after punctuation followed by space, or for the first

letter of a word created as a new Contact entry.

5. Enter the numbers by pressing one key for each letter. The
row shows the suggested numbers. Scroll the alternative
row to the right until you reach the required combination.

6. To enter the symbol, press @ . The row shows the
suggested symbol. Scroll the alternative row to the right
until you reach the required symbol. Press Select to select
the numbers. The numbers and symbol are displayed in the
main text area.
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Word Locking

You can use the partial or full word-lock feature to add words
that are not in the dictionary and/or to narrow down the list of
alternates to those that begin with a particular prefix.

1. Try to enter the word. Scroll the alternate line for a word
option. Each option is successively highlighted and partially
locked.

2. Enter the second part of the word. The first part remains
unchanged (locked). The newly entered letters are
highlighted and then locked while you scroll to the next
word option.

3. Press @ The word is placed in the text area with a
space and automatically added to the dictionary.

Writing in Numeric Mode

1. Press to scroll to numeric mode. (OR, press and hold
any numeric key to enter Numeric mode.)
2. Press the relevant numeric keys to insert the digits.

Writing in Symbol Mode

1. Press to scroll to symbol mode.

2. Press @ A series of symbols and punctuations appear
on the screen.
3. Scroll to the symbol and press Select.
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Writing in TAP Alphanumeric

1. In the text entry screen, select /=w\ > Entry Setup, and
then change to TAP and its related language. Press Back
to return to the text entry screen.

2. In the text entry screen, select /*\ > Entry Mode, and
then select Primary.

3. Press the key labelled with the desired character, once for
the first character, twice for the second, and so on. For
example, to enter “s”, press key four times. To enter
“7”, press the key five times. If you do not press a key for a
few seconds, the character is accepted, and the cursor
moves to the next position.

Adding Words to the Dictionary
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Each language comes with its own dictionary. You can create
words (including alphanumeric abbreviations). Once you
create these words and added a space, they are
automatically stored in the dictionary and appears as choices
whenever you press the same key combination in the future.



What to do if...

Your MTHB800 flashes the following messages:

Messages

Message Description

...-Rcvd

Call received but not answered, or rejected.

Attachment Failed

The MTHB800 could not perform talkgroup attachment. The
MTH800 keeps on trying. If it does not succeed, try another
talkgroup.

Authenticate The MTH800 could not register on an Authenticated system

Failure (for example, the Authentication key is incorrect, or
Authentication is disabled in the MTH800).

Battery Flat The battery is uncharged. Recharge the battery.

Call Canceled

Called MTH800 cancelled the call.

Call Ended

+ Faulty channel. Please try later.
+ Called MTH800 ended the call.

Call Preempted

Channel being used for priority.

Connection to

This is triggered by a WAP server sending session disconnect.

Server Lost
Emgcy In Use: The Hot Microphone feature is active, but the channel transmit
Wiait For Mic grant has been given to another Emergency Call on the same

talkgroup. The MTH800 microphone is not active during this
time, but the MTH800 will automatically try to regain talk permit
after a predetermined time.

Emgcy Mic Ended

The Hot Microphone timer has automatically expired, or the
user has pressed the PTT button to cancel the Hot Microphone
feature.

Emgcy Mic On The Hot Microphone feature is active, and the MTH800 is
automatically transmitting hands free emergency audio.
Empty Entry The speed number you dialled does not exist, or the number

exists but the group is non-selectable.

Faulty Unit Error...

Self-test failed. An operational fault has been detected with
your MTH800. Record the error number. Turn your MTH800 off
and contact service.
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Messages

Message Description

Group already
exists

The group you are attempting to add already exists in the My
Groups folder.

Insufficient Visible
Data

Your terminal is in the process of determining your location.
This may take several minutes to complete.

Insufficient Visible
Satellites

Your terminal is in the process of determining your location.
This may take several minutes to complete.

Invalid ID

The entered number is not valid.

Invalid Shortcut
position

The entered number is not valid.

Limited Service

Emergency Calls, Emergency Alarms and mobility operations
(e.g.: group attachment) are allowed. All other incoming and
outgoing call and data services are blocked.

List Empty

There are no programmed entries in the scrolling list. Type the
entry.

List not Attached

All talkgroups in the scan list are not attached.

List Partially The scan list is active, but not all talkgroups are attached to it.
Attached

Low Battery You have less than five minutes of talk time.

Message Indicates mail successfully delivered.

Delivered

Message Failed

Indicates mail delivery failure.

NI The MTHB800 is outside coverage. Return to coverage.

Y Mode No

Service

My Groups Is You cannot view/delete groups when the My Groups folder is
Empty empty.

My Groups Is Full

You are not allowed to add a group to the My Groups folder as
it already contains the maximum allowed number of groups.

Network Trouble

Network problems. Please try again later.

No Answer

The called party does not answer.

No Entries

This message is displayed when accessing an empty list.
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Messages Message Description

No Group Attachment failed. MTH800 detached from current talkgroup.
Please wait until the MTH800 attaches again to the current
talkgroup.

No Group + Displayed when you are out of the normal coverage area of
your selected talkgroup. Please select a new talkgroup that is
valid for your working location.

+ Indicates a favourite group was removed from the My Groups
folder.

No List The Network List is empty.

No New or Old Indicates there are no new or old messages in the Inbox.

Messages

No Selected Scan

List

You selected an empty Network List (No List).

No Service

The MTHB800 is out of coverage.

Not Allowed To
Start Call

You are not allowed to dial a number which is not in the
Address Book - if set up by your Service Provider.

Not Allowed To
Transmit

Release PTT and try again later.

* You are not allowed to send a text message or a status
message to a number which is not in the Address Book -
if set up by your Service Provider.

Only One Entry

There is only one programmed entry in the scrolling list.

Overcharging

The MTHB800 turns off. Remove MTHB800 from charger.

Overheating The MTHB800 turns off. Keep it turned off for five minutes.
Party Busy The called MTHS800 is busy.

Party Not * The called MTH800 is out-of-range. Please try again later.
Available * The called MTH800 is turned off. Please try again later.
Please Try Again | The MTH800 could not place the call.

Please Wait A message during startup.

Connecting

Registration

The MTH800 could not register within the system. Please try

Failure again later.
Request Timed Triggered by timer expiring - request was sent out properly but
Out reply was not received while no network error was detected.

Service Denied

Invalid number. Call your Service Provider.
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Messages

Message Description

Service Not
Available

This service is not available on the current network.

Service Restricted

This service has been restricted by your Service Provider, it
has not been purchased, or it is not available.

Speaker/Earpiece
Volume bars

Use Rotary knob to adjust volume level. (Rotary knob is
programmed to “Dual” or “Volume”).

Talkgroup ...Added

Group name added to the favourite talkgroup folder.

TG ... cannot be
deleted

You cannot delete this group from the favourite talkgroup
folder. Your Service Provider has set this group to non-
deletable.

Try Again Later

The requested service is temporarily unavailable.

Unit Disabled Check with Service Provider.
Unit is OK Self-test error. A minor fault has been detected with your
Warn... MTH800. The MTH800 is still fully operative. Should this error

recur, note the error code and contact service.

Unit Not Attached

The MTH800 could not attach to the system. The talkgroup
may not be defined in the system. Please try another group.
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Tones

[ ] = High Tone; [ = Low Tone

Description | Type Repeated
Idle
« Back to Home display ] Once
» Back to Rotary volume

use when Rotary scroll

timer expires
+ Back to coverage
« Back to full service
Clear to send ] Once
» Bad key press [ Once
» Good key press ] Once
+ MTH800 self-test fails at

power up
» From out-of-service to

in-service
In Call
« Call clear warning m Once
+ Call modified
Call waiting tone while | Every 6 seconds,
Phone or Private Call are until a callis
pending terminated
Data Connected or ] Once
Data Disconnected.
Talk Permit sounds upon -_-_-_ Once (Normal Tone)
pressing the PTT.

[ I Once (Short Tone)

Talk Permit without 1 1 Twice
gateway sounds upon
pressing PTT. The tone
indicates the gateway is [ Once
no longer available.
« Talk Prohibit el Until you release the
» System busy PTT
» Time-out timer expire
+ Called MTHS800 not

available or busy.
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[] = High Tone; [ = Low Tone

Description Type Repeated
Call disconnected or m Once

failed due to network

Wrong number dialled. No tone
DMO Entering ] Once

DMO Exiting Bl e e Once

Local site trunking — ] Once
Entering/Exiting

Phone ring back (sending) | e Every three

seconds, until the
called user answers
or call is rejected

Phone busy Bl Every 0.5 seconds
Pressing the key fo sen ] w[sonce =
I<the status to the R =
:gdispatcher ¥ =
<Statds essage sertfo™ T T T T T T T T T WlOnee T T T T T s
ﬁthe dispatcher ¥ ]
<Statis message is ot~ AN Bl B B Aeonee T T T T T M

cknowledged by the by =

) ) ] b
hedispatcher and the timer ] ]
[<expires | ]
I N N L N N, NP S SR P S S e P P P N S
;S?atus message’is L1 ] wnOnce ]
acknowledged k| =

Incoming Calls

Your MTHB800 received a C1 [ Once

Group Call without

gateway. (setup only)

High Priority Group Call 1 1 [1 1 Once

received

Emergency Alarm sent or 1.1 Twice

received

Emergency Alarm failed 1 1 01 [ Four times

Emergency Call received C 1 101 Once
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[] = High Tone; [ = Low Tone

Description

Type

Repeated

Phone ring (reception)
Duplex Private Call

According to the Ring Style
sub-menu setting.

Until you answer or
the call is rejected

Private Call received

According to the Ring Style
sub-menu setting.

Until you answer or
the call is rejected

Private Call ringing to the DEEE R Until the call is

caller answered

Simplex Private Pre- m o ] Every 4 seconds

emptive Priority Call until the call is

(PPC) ring. answered or rejected

Duplex Private PPC ring. C1L 1 [ Every 4 seconds
until the call is
answered or rejected

Limited Service . Once upon entering
limited service

New Mail Received [ . Once

New WAP Message m Once

New Group Call 101 Once

General

Volume setting (earpiece, :]_ Continuous

keypad, speaker)

Volume setting (Ringer) 1 While setting the
volume

Transmit Inhibit (TXI) il Once

1.

Rotary knob tone

Once, when toggling
from List to Volume

Low battery alert

Repeated

DTMF (0-9, #, *) during

Continuous, until the

the call 1 user releases the
key

Double PTT - Single Tone (| Once

Double PTT - Double i Once

Tone
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[] = High Tone; [ = Low Tone

Description Type Repeated
Double PTT - Triple Tone B Once
GPS

GPS in coverage ] Once

GPS out of coverage m Once

NOTE Call-Out tones cannot be muted by the user.
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Index

A

accessory connector [/
adjusting volume 24
air encryption

key deletion 7179
AL (ambience listening) 73
alias 26
alphanumeric key

entering text (letters and

digits) 17

ambience listening (AL) 35, 73
announcement talkgroup (ATG) 40
antenna attaching/detaching 9
ATG (announcement talkgroup) 40
audio

high/low 26, 126
audio accessory connector //

B
backlight adjustment, one-touch 25
backlight setup 127, 134
bandwidth /56
battery charging 7, 12
bottom microphone 71, 15
mute/unmute 36
broadcast group call 34
browser
Openwave mobile browser 95
browser menu 90
button/footswitch 50
buttons
emergency 23
push-to-talk (PTT) /2

C

call dial, one-touch 24
call queuing 67

calls

duplex 15
simplex 15
certificate authority (CA) 94
cleaning your unit /7
code changing /17
connectors
accessory [/
audio accessory /1
external antenna //
contact list 713
contacts sub-menu 773
contrast setup /35
covert mode, one-touch 25

D
data setup 125
date
display settings /29
one-touch 25
setting /30
setting format 7130
DGNA (Dynamic Group Number
Assignment) 49
dialed call history 144
dialed number list /44
dictionary /81
direct mode operation (DMO) 29
direct setup 32
display
contrast setup /35
home /8
language setup 724
TAP/TAP 176
text size setup 733
vertical flip setup 132
wallpaper setup /34
displaying long text messages /60
DMO (direct mode operation) 29,
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51
DMO group call
making 56
receiving 59
DMO SCK 121
DMO/TMO, one-touch 24
DTMF overdial 71
duplex call 15
duplex private call 62
Dynamic Group Number
Assignment (DGNA) 49

E

EE (energy economy) /35
emergency alarm

sending in TMO 77
emergency button 23
emergency group call 75

making in DMO &3

making in TMO 77

receiving in DMO 83

receiving in TMO 79
emergency private call 75
encryption

air encryption 7178

air encryption key deletion 779
end-stop rotary knob scrolling 44
energy economy /35
external antenna connector 7/

F

favourite group 39, 141

flip display, vertical via one-

touch 24

folder
favourite group 39, 52
scroll to next 44
selection 39, 52
stay in 44

forced call 47

four-way navigation key 77
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G

gateway 51, 54

global positioning system
(GPS) 101

GPS (global positioning
system) /01

GPS enable/disable /03

group setup /38

GW (gateway) 5/

H
handsfree speakerphone 35
high/low audio 15, 26, 126
history

dialed call 744

missed call /44

received call /44
home display /8
hook setup 32
Hot Mic (hot microphone) 78
hot microphone feature (Hot

Mic) 78

HTTP authentication 94

icons
battery strength 20
browser 85
contacts /173
data connected /8
data transmit/receive 18
direct mode /9
DMO gateway 79
DMO repeater 19
emergency 20
GPS 103
inbox 162
list scrolling 20
menu /08
new message arrived 20
new message(s) in inbox 20



no service 18
scan /8
signal strength (DMO) /9
signal strength (TMO) /8
speaker off (low audio) 20
TAP/TAP 175
vibrate and ring 20
vibrate on 20
inbox use /62
InterMNI call 517, 82
internet protocol (IP) 38
IP (internet protocol) 38
iTAP
display 176
icons 175
selecting /74
writing text 174, 179

K
K (key) 119
key deletion /79
keypad /7
locking/unlocking 7178
usage in alphanumeric
mode /76
usage in numeric mode /77
usage in symbol mode /78
keys
four-way navigation 7/
menu 22
on-off/fend/home /3
programmable numeric 24
programmable side 23
send /2
soft 21/
speaker control 26, 126
knob
end-stop rotary knob
scrolling 44
rotary 23

L

list of menu items 709
local area service 37

entering 37

exiting 37
local site trunking 37
locking/unlocking the keypad 718
low/high audio 15, 26, 126

M
menu 22
menu item /07
menu item list 109
messages sub-menu /13, 159
microphones
bottom microphone 71, 15
mute/unmute bottom
microphone 36
top microphone 10, 15, 16
missed call history /44
MSPD (multi slot packet data) 38
multi slot packed data (MSPD)
service 38
mute/unmute bottom
microphone 36
my info sub-menu /44

N

network list 739

networks sub-menu 752
non-tactical call 74

notations 5

numeric key, programmable 24

(0]
one-touch
backlight adjustment 25
call dial 24
covert mode 25
date 25
DMO/TMO 24
screen saver 25
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status message 24

talkgroup scan 24

talkgroup switch 24

text message template 24

time 25

TMO/DMO 24

transmit inhibit (TXI) 25

vertical flip display 24
on-off/fend/home key /3
open group 517, 82
Openwave mobile browser 95

P

PABX (private automatic branch
exchange) 69
PABX call 69
packet data (PD) service 38
PD (packet data) 38
phone call 69
one-touch dialing 7/
speed dial 70
phone number 26, 69
viewing and modifying /44
phone/PABX call
answering 72
dialing on receiving a call 70
dialing via contact list 70
direct dial 69
making 69
PIN (personal identification
number) 716
powering on/off /3
PPC
making a private PPC 67
PPC (pre-emptive priority call) 32
predefined template /68
pre-emptive priority call (PPC) 32
presented call 47
previous talkgroup switch 24
private automatic branch exchange
(PABX) 69

194

private call 62
dialing on receiving a call 66
dialing via contact list 63
direct dial 62
making a duplex call 62
making a simplex call 62
receiving 65
short number dial 63
private number 26
viewing /44
programmable numeric key 24
programmable side keys 23
proxy 93

PUK (personal unblocking key) 717

push-to-talk button (PTT) /2
R

received call history /44
receiving calls 32
recent calls sub-menu 744
repeater 51, 55
ring style of incoming call /23
rotary knob 23

end-stop rotary knob

scrolling 44
RUI 150
S
scan list 39

scan on/off in TMO group call 47
scan setup /38
scanning selection 39
SCK (static cipher key) 120
screen saver 27
screen saver setup /33
screen saver text /33
screen saver, one-touch 25
scrolling

end-stop rotary knob 44
security sub-menu 776
send key /2



Setting Volume Adjustment
Mode 726
short number dial 63
shortcuts sub-menu 747
side keys, programmable 23
simplex call 15
simplex private call 62
site wide call 34
site wide trunking 37
soft keys 2/
speaker /1
speaker control key 26, 126
speakerphone
handsfree 35
speed dial 70
speed number 42
status message 759
sending /70
targeting 171

status message, one-touch 24

T
tactical call 74
talkgroup 39

speed number 42
talkgroup scan, one-touch 24
talkgroup selection 39, 52

talkgroup switch, one-touch 24

TAP
display /76
icons 175
selecting 774
writing text /74
templates 759
text language 174
text message 159
sending 759
template
one-touch 24
text size setup 733
throughput 756

time
display settings 7129
one-touch 25
setting /30
setting format /30
setting offset /37
time&date 27
TMO (trunked mode operation) 28
TMO group call
making 45
receiving 45
TMO/DMO
one-touch 24
tones
setting 'clear to send’ 7128
setting all tones 127
setting keypad tone 727
setting talk permit tone 7127
tones setup 127
top microphone 70, 15, 16
transmit inhibit (TXI)
mode 48
one-touch 25
trunked mode operation (TMO) 28
TXI (transmit inhibit) 48

U

unblocking the terminal 777

unmute/mute bottom
microphone 36

user defined template /68

\'
vertical flip display, one-touch 24
vibrate 121

setup 122

w

wallpaper setup /34

WAP (wireless application
protocol) 85

WAP proxy 93
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WAP Tone /89

wireless application protocol
(WAP) 85

wireless transport security
(WTLS) 85

writing text /74

WTLS (wireless transport
security) 85
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OnwTn nHopmauum

Be36eaHocHM MHdopmauumn

Bapadu 6e36edHo Kopucmeme, nped
ynompeba Ha osue rpou3eoou, npoyumajme
20 ynamcmeomo 3a paboma, 8K/y4eHO 80
b6powypama 3a 6e36edHocm Ha rpou3eooom
U usrnoxeHocm Ha P® 6864117B25.

Ynotpebara Ha MTH800 e orpaHnyeHa camo Ha
npodecnoHanHa ynotpeba 3apaan 3agoBofyBake Ha
OaparbaTa 3a eHepreTcka uanoxeHocT Ha ICNIRP RF. MNpeg
KOpUCTEHE Ha NPOM3BOAUTE, NPOYNTAjTE M MHopMauunTe
3a P® eHepruja u ynaTcTBOTO 3a yrnpaByBake BO Opoluyparta
Be3begHOCT Ha NPOM3BOAOT U U3MNOXEHOCT Ha PP
(My6nnkaumja Ha Motorola 6poj Ha aen bBpouwypa 3a
0e3beanHocT 6864117B25) 3a ga ce ocurypu ycornaceHocT
CO OorpaHudyBaraTa 3a U3noXxxeHocT Ha P® eHepruja.

YyBajTe ro oBa YnatcTBO 3a ynotpeba n 6polwyparta
Be36eaHocT Ha NPOU3BOAOT U U3NOXEHOCT Ha P®

Ha 6e36egHO MecTo U Heka Buaat gocTanHu BO Cry4aj co
OOMOoNHUTENHMOT Npubop ga ynpaByBaar apyru nyre.

UHdopmauum 3a oTcTpaHyBame

OupekTtuBata Ha EBponckaTa yHuja 3a oTnag of
efleKTpU4YHa U eneKkTPoOHCKa onpema 6apa
mmm POM3BOAMTE LUTO CE NPOOaBaaT BO 3eMjUTE-UNEHKN

Ha EY ga nmaart o3Haka co npeyvkpTaHa kopna Ha
npoun3BodoT (Mn Ha ambanaxara Bo Hekou crny4vam). Kako
WwTo € geduHupaHo Bo ampektmeaTa 3a WEEE, o3HakaTta
CO NpedvKpTaHa kopna 3Hadu feka KIMUeHTUTE U KpajHuTe
KOpMCHULM BO 3eMjuTe-4neHkn Ha EY He Tpeba ga ja
OTCTpaHyBaaT eflekKTPoHCKaTa 1 enekTpuyHaTa onpema unm
[OOMNONMHUTENHNOT NpMbop Bo OTNaAOT 04 AOMaKUMHCTBOTO.

oiLmuQ




KnueHTnTe Unu KpajHUTE KOPUCHULM BO 3EMjUTE-UYNEHKN
Ha EY Tpeba aa KoHTaKkTMpaaT CO HMBHWOT NOKaneH
NpeTcTaBHUK 3a orpemara unu cepBUCHNOT LieHTap 3a
MHdOopMaLMmM BO Nornes Ha CUCTEMOT 3a Npubupane Ha
OTNajoT BO HMBHaTa 3emja.

UHdopmauum 3a aBTOpCKUTE npaBa

MpoussoauTe Ha Motorola onuiiaHn BO 0BOj NpupaqHuK
MOXe Aa coapaTt KommjyTepcku nporpamu Ha Motorola
3alUTUTEHU CO aBTOPCKO NpaBo, 3a4yBaHN BO MEMOPUUTE Ha
NonynpoBOAHMKOT UMK BO ApYr MeanyMu. 3akoHUTE BO
CoeanHeTtute AMepukaHckm [pxaBu n BO ApyruTte 3emju
npeasuayBaaTt ogpeaeHn ekckry3mBHM npaea 3a Motorola 3a
KOMMjyTepckuTe nporpamm 3alliTUTEHN CO aBTOPCKM Npaga,
HO He orpaHun4yBajkm ce Ha eKCKINy3nBHOTO NpaBo 3a
Konupake 1nu penpogyumpare Bo Koja buno gopma Ha
KOMMjyTEPCKUTE NporpamMu 3aluTMTEHM CO aBTOPCKU NpaBsa.
CneTtcTBeHoO, cekoja KomnjyTepcka nporpama Ha Motorola
3alTUTEHA CO aBTOPCKO NPaBO BKIyYeHa BO NpOn3BoAUTE Ha
Motorola, a onuwwaHa BO 0BOj NpvpadHuK, He MOXe fa ce
Konupa, penpoayuupa, Mogudurkyea, npeHameHyBa unm
auctpubyupa Ha koj 6uno HaunH 6e3 n3puyHa nucMmeHa
Aossorna Ha Motorola. MNoHatamy, HabaBkaTa Ha nponssoaun
Ha Motorola Hema aa Bkny4yBa AUPEKTHO MU MHCYUHUPAHO,
no ybenyBare Unv Ha Opyr Ha4uH, 4oaernyBake Ha Kakea
©uno nuueHua, Bo COrnacHoCT CO aBTOPCKUTE npasa,
naTeHTn UnNu NpUMeHeTH nateHTn Ha Motorola, oceeH Bo
cny4yanTe Ha HOpMarnHo, HEEKCKITY3MBHO KOPUCTEHE Ha
nuueHuarTa, WTo npousnerysa of npMMeHa Ha 3akoHOT BO
npogaxbaTta Ha NPoOn3BOAOT.

NMoce6HM nHopmauum 3a nponsBoaoT
* MakcumanHa BonTaxa 42V

* MakcumanHa ctpyja 0.5A

* MakcumanHa MokHocT Ha P® 1 Bat



+ MakcumanHo onToBapyBame

Ha 3BYYHWUKOT 0.5 Batn npu 8 omun
* OTnOpHOCT Ha aHTeHaTa 50 omum
» Oncer Ha onepaTuBHa
Temnepartypa- 30 °C po +60 °C
» PaboTtHo Bpeme npogomknTenHo /
CO NPEeKMHK

Onwmo, epememo Ha MPeHoC U Npuem Ha mepMuHaaom

m (8peme Ha orepamuseH Yukiyc) ce oOpedysa npeky
cucmemom 3a KoMyHukauyuja. lNpu npeonmoesapysarse,
rPeKyMepHO Kopucmere wmo oou Hadeop 00
crieyugukayuume Ha cucmemume rpu 8UCOKU
ambueHmarnHu memrepamypu, mepMuHaaom e 3awmumeH
CO Hezosama mepmarsiHa KOHmposa, Kojawmo ja npekuHysa
usnesHama MokHocm Ha P®, Ha moj Ha4uH Hamarlyeajku 2o
orice2om Ha roKpueHoCm Ha mepMUHanom.

I'Ipanma 3a UKOHUTEe

[lOKyMEHTOT e M3paboTeH Ha TOj HAUMH LUTO Ha YMTaTENoT My
AaBa BusyeneH onuc. CnegHuTe rpaduykn UKOHU ce
KOpWCTaT BO LIeNnMoT AoKyMeHT. OBMEe MKOHW U HUBHOTO
3HayeHe ce onuLLaHN BO NPOAOIHKEHME.

CueHanHuom 36op BHumaHue co nosp3aHama

be3bedHocHa UKOHa ynamysea Ha ughopmayuja

wmo GoKosIKy He ce 3eme rpedsud, Moxe 0a
pe3ynmupa co cMpm usnu cepuo3Ha rnosgpeda
unu cepuosHa wmema Ha rnpousgodom.

CueHanHuom 360p lNpedynpedysar-e co
rnospsaHama 6e36e0HOCHa UKOHa yramysa
/ i \ Ha ugopmayuja wmo AOKOIIKY He ce 3eme
npedsud, moxe da pe3ynimupa co rosecHa

unu ymepeHa noepeaa usiu cepuo3Ha
wmema Ha I'I,DOU.’J’SOOOITI.

oiLmuQ



CueHanHuom 360p lNpedynpedysar-e moxe Oa ce
Kopucmu u 6e3 6e3bedHocHama UKoHa 3a 0a ynamu

Ha MOXXHa wmema usnu noepeda wmo He e
rogp3aHa co I'IpOU36000m.

Babernewkume codpxxam uHghopMayuu wWmo ce rnogaxHu oo
ocmaHamuom mekcm, Kako Wmo ce Uckriydoyume unu
npedycrnosume. Vicmo maka, mue 20 ynamysaam
yumamernom 00 AonoAHUMENTHU UHghopmayuu, 20
rnomcemysaam Yyumamesiom Kako 0a 3ae8puu HeKoe
dejcmeo (Ha npumep, Koea He e 0enl 00 mekosHama
rnocmarika) unu 0a eo ynamam yumamersiom Kade ce
noyupaHu pabomume Ha ekpaHom. Hema Huso Ha
npedynpedysar-e nosp3saHo co 3abeneuwka.



[la 3ano4yHeme

Bu yectutame 3a kynyBarweTto Ha Motorola MTH800.
YHanpegeHute TETRA-04nMKM 1 HajMogepHaTa TEXHONornja
BM nomaraar ga bugerte nocTojaHo BO KOHTAKT CO CUTe
OENOBHMU M JINYHU KOHTaKTW.

Bawwnotr MTH800 moxe ga paboTu Ha aHIMNCKN, repMaHCKu,
dopaHLLyCKU, LLUNAHCKWN, XONaHACKM, LUBEOCKU, PYCKU jasuK Unu
Ha Opyr jasuk geduHUpaH o BalIMOT JaBaTen Ha yCrnyru.
CtaHpapaHaTa ¢habpuryka nocTtaBka e aHrmucku jasuk. 3a
noeeke nHgopmaLmm, suaete Bo JloctaByBame Ha
paboTHMOT ja3unk Ha ekpaHoT” Ha cTpaHuua 151.

Kako ga ro Kopuctute oBa ynaTrcTBo

YnatcTBoTO rv onuuwysa ognunknte Ha MTH800 kako wTo ce
NnocTaBeHN UK NPETXOOHO NporpaMmmpanun Bo habpukara.

BawumoT gaearten Ha ycrnyrv unv BallaTta opraHusauuja Moxe
Aa ro npucnocobat sawmotr MTH800 3apaan ontumarnHa
ynoTtpeba cornacHo Bawwmte notpedu. lNposepeTe Kaj
BaLLMOT AaBaten Ha ycryri unu opraHmsaumja 3a pasnukire
LUTO MOXE [a NocTojaT BO OQHOC Ha OBa ynaTcTBO.

Bo pamku Ha TekCTOT of oBaa nybnukauuja ke rm
3abenexuTte crnegHTe NOCEOHN HOTaLMK WTO ce KopucTaTt
3a NcTakHyBake Ha ogpeaeHn MHPOPMaLMM UNN CTaBKu:

aWaHhouee eff

Mpumep onuc

N UsBepeTe MpuTnckareTo Ha konyMHaTa
€ NpUuKaxaHo kako cMMBor 3a Kon4ye unu

co 3agebeneHun bykBu 3a PyHKUMMTE
Ha nporpamMmckuTe Kon4vnka.

MoBeke...> Mpexu YkaxyBa Ha ABWXKeH-e BO CTaBKUTe
> TXI-pexum > AKTUBUPaj | HA8 MEHUTO.
KoHTakTy McTakHaTUOT TEKCT yKaxkyBa Ha usbop.
¥ Bknyu YKaxkyBa Ha aKkTvBHa NOCTaBKa.




Mpumep onuc

JocTtaBeH cTtatyc MHdopmauumuTe WTO ce nojasysaar
Ha ekpaHoT Ha MTHB800 ce npukaxaHu
CO MOVHaKOB M3rneq Ha byksuTe.

<[eduHupan YkaxyBa Ha U3BeCTyBar€ Unun nopaka
LITO € KoHpurypupaHa og cTpaHa
Ha BaLLMOT AaBaTen Ha ycnyru.

UHcTanupawe Ha 6aTepujaTta
1. U3BageTe ja baTepujata of 3awiTUTHATa NposSUpHa
nnacTuyHa KyTuja.

2. [1okonky e noTpebHOo, OTCTpaHeTe ja MackaTa Ha
DaTtepwjaTta, Kako LITO € NpuKaXKaHo BO NPOAOSIKEHME.

3. BmeTHeTe ro ropHuoT gen o 6arepujata Bo o44enoT, Kako
LITO € NPUKaXKaHo.

4. BH/MmaTenHo npuTucHeTe ro cpebpeHoTo AHO Ha
Oatepujata Hagony 3a ga crnywHerte
KapaKTepUCTUYEH 3BYK.

5. 3ameHa Ha kanakoT Ha baTtepujaTa.

3ameHa Ha b6aTtepwmjaTa

1. 3a fga ro oTcTpaHuTe KanakoT Ha b6aTepujaTta, NpUTUCHETe
ro HaJony Kon4yeTo Ha kanakoT. ViaBageTe ro kanakot
CO nu3rame.

2. [puTUCHETE FO 3a4pKaHOTO KON4Ye Harope 1 NoaurHeTe
ro ropHuoT aen og 6atepwujata.



3. BameHerTe ja 6aTepujaTta.
C

NMonHewe Ha OaTepujaTa

s

MpasHa

MonHaunTe ogobpeHu of cTpaHa Ha Motorola oBoamoxxyBaaT
onTuMarHa nseegba. [ipyrute nonHadm Moxe Aa He ja
nonHart uenocHo Bawara Motorola nutuym-joHcka 6aTtepuja
Unu MoOXe [a ro Hamanar BeKOT Ha Tpaewe Ha baTepujaTa.

Bawwnotr MTH800 moxe ga 6uae BKITyY€H Ui UCKITyUYeH BO
TEKOT Ha MONTHEHETO.

1. BMeTHeTe ro NpuKny4oKOoT Ha NOMHAYoT BO
BAnNabHyBaweTo Ha ocHoBaTta Ha MTHB800. N36epeTe ro
cooaBeTHUOT aganTep (3a ObeanHetoTo Kpancteo nnm
€BpONCKK) 1 NOBP3ETE ro CO NornHavoT. lNMoToa npukny4veTe
ro NofiHa4yoT Ha COOABETEH LUTEKEP.

2. Ha ekpaHoT Ha MTH800 ce nojaByea nopaka MonHavoT
e npukny4eH camo ako MTH800 e Bknyu4eH npu
noBp3yBakEeTO Ha nonHavort. [Jokonky MTH800
€ UCKIy4eH, Ha eKpaHoT ce NnojaByBa MKOHA Ha baTtepuja
BO npouec Ha nonHewe. OtctpaHete ro MTH800 og
MOMHA4Y0T CaMO Kora eKpaHOT € MUCKITyYeH.

MkoHaTa co baTepuja ykakyBa Ha CTaTycOT Ha MOJTHEHE
(BMOeTe BO NpoAomkeHue).

L N

MonHa Mpasna MonHa
Kanayumem na damepujama Ilonunerwe na 6amepujama 6o

aWaHhouee eff



MUHcdopmaumm 3a kanaunTeToT Ha GaTepujaTta

WUHcopmaumn onuc
3eneHa vKoHa MonHa (kanaumtet 50% - 100%)
YKonTa vkoHa CpepgHa (kanauutet 20% - 50%)
LipBeHa mkoHa Cnaba (kanaumntet 10% - 20%)
MpasHa nkoHa MHory cnaba (kanaumntet 5% - 10%)
lMopaka 3a HACKO HUBO KanauwuteT og nomanky og 5%
Ha nornHewe Ha
6aTepujaTa

OppxyBawe Ha 6aTtepujaTa

N3BenbaTta Ha GaTepwujaTa CO MOXXHOCT 3a NOBTOPHO
NoJIHEHE UCMopaYaHa co BalMOT TEPMUHAS 3aBUCH
0l HAYMHOT Ha Koj ce TpeTupa baTtepujaTa.

3atoa, npounTajTe rv u NpuapXKyBajTe ce OO NpaBunaTa 3a
OfpXyBake HaBeAeHW Nogony BO COrMacHOCT CO
rapaHuujata 3a 6arepuute Ha Motorola 3a ga obesbegute
nobpa n3senba u Jonr XXMBOTEH LMKMYC Ha BallaTa batepuja
Ha Motorola Ha nonHemse.

Cknadupate

He cknagupajte ja Bawarta 6atepuja Ha mecTa co
TemnepaTtypu nosucoku og +65°C nnm noHucku og -20 °C.

HosuTe nutnym-joHckn batepun (T.€. batepumTe kon
HUKOraLl NpeTXo4Ho He Bune nonHeTn) Moxe aa ce
cknagupaat Ha nepuog o 2 roauHm (co HajMHory 50%
MaKCMMarnHo HMBO Ha NonHekwe) Bo 406po NpoBeTpeHHU,
nagHu 1 cyBM MecTa CO U3BECHO HamanyBahe Ha XUBOTHUOT
LMKITyC.

BatepuunTe Kou npeTxogHo Gune NonHeTn 1 notoa

cknaavpaHu Ha noseke of 2 meceuu Tpeba aa ce nonHat
npeky uena Hok (14-16 yaca) npeg ynoTtpeba.



lMpodomkxyear-e Ha eKkom Ha mpaer-e Ha 6amepujama
BatepujaTta e noTpoLleH gen u MoXxHo e ga Tpeba ga ce
3amMeHM 3a BpeMe Ha BEKOT Ha Tpaer-e Ha TEPMMHAIOT.

3a pa ce 06e36eagn makcuMarneH BeK Ha Tpaeke Ha
TepMMHaroT, ceKkorall 3aMeHyBajTe ja baTepujata

€O opurmHanHa barepuja og Motorola.

3a pa obesbegmTe MakcMmarneH BeK Ha Tpaekwe Ha Balwara
BaTtepuja, He NpuKkNy4vyBajTe ro TepMMHANoOT u/vnu
HaTtepujaTta Ha MONHAYOT, OCBEH [OKOSKY HaBUCTUHA cakaTe
[a ja HanonHuTe GaTtepujaTa.

Temnepamypa 3a nonHeHwe Ha 6amepujama

BawmoT nonHay Mmoxe Aa ja nonHu Balwata 6artepuja camo
BO TemnepatypHuot oncer og 1 go 37 °C.

Toa ce [OmKM Ha aKTOT LITO BHATpeELLHATa Kenuja Ha
baTtepwujata Moxe ga ce nonHu Ha Temneparypa oa 0 oo
45 °C.

Co cHmxyBameTO Ha Temnepatypata (brnmay 0 °C)
baTtepujata nma noman kanauuTeT Ha NoSHeHe.

[lokonky 3a Bpeme Ha NoMHeHeTo TeMnepartyparta e Haasop
of onceroT, 6aTepujata MoXe Aa He Ce HanomHU LIenoCcHO
Bunaejkn NoNHeHeTO NPUBPEMEHO Ce NPEKUHyBa Ce Aoaeka
TemnepaTypaTa He CTaHe COOABETHaA.

OnceroT Ha dyHKLMOHMpake Ha baTepujata ce OBWKM O
0 po +45 °C Bo pexumm Ha nonHewe n og -10 °C go +60 °C
BO PEXMM Ha npasHehe (NpumeHa).

lpeo nonHewe Ha 6amepujama

Cekoralu nornHerte ja Bawara HoBa b6aTtepuja/(og koj 6uno
BMA) Npeky uena Hok (14-16 yaca) npeq ynotpeba. OBa 3a
HapekyBa UHuLMjanusaumja u ke 06e3begn makcumaneH
noyveTeH kanauuTeT Ha GaTepujaTa.

aWaHhouee eff



Ynamcmea 3a nonHewe Ha 6amepujama

3a ga ro HamanuTte 6pOojoT Ha LMKITYCU Ha NOSHEHE KOSKY
LITO € MOXHO MoBeKe, YeKajTe fa ce nojaBu nopakaTa
,Cnaba batepuja“ 3a ga ja nonHuTe batepujata bugejku co
Toa ke ce ob6e3begn MakcnmaneH BeK Ha Tpaewe Ha
bartepujata.

He kopucTeTe ro BalWMOT NofHay 3a CMecTyBake Ha
TEPMWUHAnNOT M He OCTaBajTe ' BalMOT TEPMMHAN U LIENOCHO
HanonHeTaTta 6aTepuja NPMKyYEHN Ha NOMHAYOT AoAeKa He
ce BpLM nonHene. KOHTUHYMPaHOTO MOSHEH-E Ke o cKpaTu
BEKOT Ha Tpaeke Ha baTepujaTa.

MpukayyBawe Ha aHTeHaTa

mk]cmyqeme 20 MTHB800 nped uHcmanupare unu

10

omcmpaHyeare Ha aHmeHama.
BmeTHeTe ro JONHMOT Aen o aHTeHaTa BO OCHOBaTa 3a
3awpacpyBare Ha ropHuoTt gen Ha MTH800. BpTeTe BO
HacoKa Ha CTpenk1iTe Ha YaCOBHUKOT Ce AoAeKa He e cocema
cterHata. He BnoxyBajte cuna.

BpTeTe ja Bo Hacoka Ha
CTpenKknTe Ha YaCoBHUKOT
3a fa ja npukadmTe




KOHTPOJIN U UHAUKaATOPU

21. Konue 3a uTHu cnyvam
(Ha ropHuoT gen Ha MTH800)

20. Konye 3a poTuparse
(Ha ropHuoT Aen Ha MTH800)

19. Cnywanka

18. Konuye 3a PTT
(Ha CTpaHWYHWOT fen Ha
MTH800)

17a. CTpaHnyHo Konye wTo
MoOXe da ce nporpamupa
(Ha cTpaHWYHWOT Aen Ha
MTH800)
16.IMporpamckum
Konunka (2)

15. Konue 3a ucnpakare

14. Konue 3a HaBurauuja
BO YETUPW HacoKn

13. 3By4HMK
(nog Tactartypara)

12. KoHTpona
Ha 3BYYHUKOT
Konue

——1. AHTeHa

2.LED

3. TopeH MMKpohoH
4. HapgBopelueH
NPUKIY4OK 32 aHTeHa
(Ha 3agHuOT fen

Ha MTH800)

5. AnchaHymepuykm
eKkpaH

6. Konye 3a meHun

7. Konye 3a
BKITyYyBats€-
ncknyvysare/
npekuHyBake/MaTUyHO
Konye

— 8. MNpwukny4ok 3a
ayauo-npubop

(Ha cTpaHWYHWOT fen
Ha MTH800)

9. AncbaHymepuuka
TacTtatypa
10. AoneH MUKPOdOH

aWaHhouee eff

11. MNpunkny4ok 3a gononHuTeneH npubop
(Ha ocHoBaTa Ha MTHB800)

CrtaBKa onuc

1 AHTeHa

2 LED (vHaukaTop)

FopeH MukpodoH
AKTVBMpaH BO TEK Ha €AHOHaCOYHW NOBULIM, MOBULM
CO BUCOK 3BYK, KaKo LUTO Ce rpynH1TE NOBULM.

11



12

CraBka

onuc

NMPUKITYYOK 3a HaABOpeLLHA aHTeHa
Ce kopucTn co gurmtaneH npnbop 3a aBToMobun 3a
noep3yBake Ha P® curHan co HagBopeLlHaTa aHTeHa.
(Ha 3agHmoT gen Ha MTH800)

eKpaH Bo 60ja

OBo3MOXyBa Nprkas Ha andaHyMepuyku TEKCT U CIIKN
B0 65.536 6ou 1 130 x 130 nukcenu co 3agHUHCKO
OCBETIyBake 1 (DOHTOBU LUTO MOXe a ce
3rorieMmyBaar.

Konuye 3a meHu
Ce kopucTy 3a Bre3 BO [MaBHOTO MEHM U MEHUTO
npunNaroasiMBo Ha KOHTEKCT.

Konue 3a BknyvyBame-ucknyvyBame/
npeknHyBake/MaTU4HO Konye

3agpxeTe ro NPUTUCHATO 3a Aa ro BKIyunTe/ucknyymte
MTHB800.

MpuTncHeTe ro 3a Aa rv NpekMHeTe noBuumTe.
MpuTucHeTe ro 3a Aa ce BpaTuTe Ha MAaTUYHUOT eKpaH
(ekpaH BO MupyBaHse).

Mpukny4ok 3a ayano aononHuTeneH npuéop
(Ha cTpaHn4HnoT gen Ha MTH800)

AndaHymepuuka TactaTtypa

KopucreTe ja TacTatyparta 3a BHECYBah€e
andaHymepunykn 3Haum 3a bupare, 3anucu 3a
KOHTaKTW U TEKCTyarHu Nopaku.

10

[doneH mukpodoH

AKTMBMPaH BO TEK Ha QHOHACO4YHMN 1 BOHACOYHM
MoBULM, MOBULM CO HWU3OK 3BYK KaKo LITO ce
TenegoHCKUTE NOBULIN.

1

Mpukny4ok 3a gononHuTeneH npuéop
OBO3MOXYyBa NpuKNyyYyBake Ha OOMOMHUTENHOT
npubop.

(Ha ocHoBaTa Ha MTH800)

12

Konye 3a koHTpona Ha 3BY4HUKOT
OBo3moxyBa 6uparse Ha criyluanka (HU30K 3BYK) Unm
3BYYHMK (BMCOK 3BYK)




CraBka

onuc

13

3By4YHMK (Nop TacTaTypara)

14

Konye 3a HaBurauuja Bo 4eTUpu HaCoOKun
MpuTucHeTe ro Harope, Hagony, HaneBo UM HagecHo
3a Aa nuararte HU3 CMUCOKOT JoAeKa Ce OBMXKUTE HU3
Xnepapxujata Ha MEHMTO UK 3a ypeayBare Ha
andaHyMepuyKn TEKCT.

15

Konuye 3a ucnpakawe

Ce KOpUCTM 3a BOCMOCTaByBak-€ UM oArosapame
Ha [IBOHACO4YHM NOBMLM (KaKO LUTO Ce Tened)oHCKUTE
NoBULM) UNK 3a UCMpaKakse NMopaku 3a cTaTyc

N TEKCTyarHu Nnopaku.

16

MporpamMcku konunwa

MpuTucHeTe 3a ga nsbepeTe onumja LWITO ce NojaByBa
Ha eKpaHOT BefHall Haj 1eBOTO UMW AECHOTO
NpOrpamMcKo Komnye.

17

CTpaHuy4HM Konuukwa 1 1 2 WITO MOXe Aa ce
nporpamupaar

CrtaHgapAaHo nporpammpanse: ropHOTO CTPaHUYHO
KOMYe ro akTuBMpa/geakTuBmpa 3aHUHCKOTO CBETO;
OONHOTO CTPaHU4YHO Kon4ye ro aktnempa 3allTUTHUKOT
Ha eKpaHoT.

(Bupete n 6p. 20)

18

Konye 3a PTT (nputucHm ga 36opyBalu)
MpuTncHeTe 1 3aapXKeTe ro 0Ba CTPaHWYHO Kon4e 3a Aa
pasroBapare npv €4HOHaCO4YHWN MOBULW, OTNYLUTETE O
3a ga cniyware.

MputncHeTe ro 3a ga ncnpatute nopaka 3a craTtyc

N TEKCTyarHu nopaku.

19

Cnywanka

20

Konue 3a poTupate WTO MOXe Aa ce nporpamupa
CraHpgapaHo nporpamupanse: [BojHa dyHkumja“ —
NPUTUCHETE o KOMYETO 3a Aa npedpnare Mery ,javmHa
Ha 3BYKOT“ 1 ,cnuncok’. CTpaHuyHuTe konynnsa (6p. 17)

(bYHKLMOHMpAAT KaKo LUTO ce NporpamupaHm.

13
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CraBka onuc

21 Konye 3a uTHM cny4yau LUTO MOXe Aa ce nporpamupa
(Ha ropHmoT gen Ha MTH800)

MpuTucHeTe M 3appxKeTe ro 3a Be3 BO PEXMMOT 3a
WTHU Cryyam 1 ucnpakake anapm 3a UTHU cryyam (Kako
LITO € nporpamupaHo). MNpuTncHeTe n 3agpxeTe ro 3a
[a 3anoyHeTe NpUBaTEH MOBUK 3@ UTHM Criyyam
(eQHoOHaACOYEH UM JBOHACOYEH).

Kora MTH800 e mnckny4eH, NpuTUCHETE 1 3agpXeTe ro
3a [a ro BKIy4MTe BO PEXUM 3a UTHU CIlyyaum Unm BO
CcTaHfgapAeH pexuM (Kako LUTO € MporpamMmmnpaHo).

lped npe nam da 2o kopucmume MTH800, omcmpaHeme
Meo rnaacmuYyHUOM 3aWmumHUK Ha fiekama 00 ekpaHom

u HariortHeme ja bamepujama rpeky yena HoK 3a 0a

ocueypeme deka bamepujama Ke no4yHe co paboma co rnosiH

Kanayumem.

Yucmeme 20 donHUOM MPUKITY4YOK 4ecmo, a 0cobeHo nped
Mrlocmanmma 3a npoepamupar-e, Ha fp. co Meka Yemka (He

Kopucmeme mey4yHocmu).

Ce nipernopayysa UCKiy4ye8are Ha mepmuHanom rnpeo
MHoepsyea/-be CO Kakoe buio 0odamok.

BKNyJYyBawe/ucknydvyBare (Kon4ye 3a BKIyvyBaHe-
UCKNyJYyBare/npeKMHyBakbe/MaTUYHO Konye)

3a BknyvyBame, NpuTMcHeTe 1 3aapxeTe (. Bawmot
MTHB800 BpLn camonposepka u peructpaumja. o
ycnewHoTo npujaByBake, MTH800e Bo ynotpeba.

3a ucknyyyBame , MPUTUCHETE U 3agpXKeTe . Ke cnywHete
KpaToK 3BYK M Ha eKkpaHOT Ke ce MojaBu nopakata
UcknyuyBatmse.
TepmuHanom ce ekiy4ysa u Uckiy4yysa 6e3 sudnusu
m U 38y4YHU U38ecmysarba, ako e akmueupaH Pexumom
Ha npukpusate. (Budeme 80 ,Pexum 3a npukpusare” Ha
cmpaHuya 43).

14



BknydyyBame (kon4ye 3a UTHU crny4vam)

3a,qp>KeTe ro NPUTUCHATO KON4YeTo 3a UTHU Crly4aun 3a aa ro
BKIy4YUTe ypeaor.

MTH800 ke ce BKINy4YM BO peXuM 3a UTHU Criydam 1num Bo
CTaHOapOeH PeXuM (Kako LITO e MporpaMmpaH).

Bkny4yyBare CO akTUBMpaHO orpaHMyyBame
Ha npeHoc (TXI)

OrpaHudyBaH-€TO Ha NPEHOCOT € oAfiMKa LWTOo BU
OBO3MOXYBa ja ro NpeknHeTe NPeHOCOoT npes Bnes Bo
obnact 4yBCcTBMTENHA Ha pagunodpekseHuunja (PP). 3a
aKTUBMpaHe Ha oBaa oAnvka, NpuTUcHeTe /v=w\ 1 nsbeperte
Mogeke... > Mpexu > TXI-pexum > AKTUBUPA].

Co npumuckarse Ha Korn4emo 3a UmHu

A NPEOYNPEAYBAKE| C/7y4au, Oypu U ako e akmueupaHa o0iukama

3a cripeyysare Ha npeHocom, MTH800
s8edHalw 2o criposedysa npeHocom. MTH800
HE CMEE da 6ude 8o obnacm
yyecmeumersiHa Ha P® npu enezysare 60
PEeXUM 3a UMHU criydau.

TXI-pexxMmoT ke ocTaHe aKTUBEH ako anapaTtoT ocTaHe
BknyyeH. Ke Be npala ganu cakarte ga ro octasute TXI-
PEXUMOT BKMY4YeH UK He.

A NPEYNPEQYBAKE| Ocuaypeme Oeka cme ja Harywmune

obnacma yyecmeumenHa Ha P® riped
Oeakmueupar-emo Ha 02paHuvysar-emo
Ha rpeHoc.

MputncHete ro konyeto [a 3a aa ro geaktusuparte TXI-
pexunmot. Ako MTH800 6un npeTxogHO KOPUCTEH BO PEXUM
Ha BMpeXyBake€, Ke ce perncrpupa Ha mpexarta. AKo
MTH800 npeTxoaHO ce KOPUCTN BO AUPEKTEH PEXMM, ToraLl
Ke oCTaHe BO AMPEKTEH PEXUM.

MpuTtucHete He BO pexum Ha BMpexyBawe 1 MTH800 ce
ucknydysa; nputucHete He Bo DMO-pexum 1 ke octaHeTe
Bo DMO-pexum co usbpax TXI.

15
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OTtknyvyyBawe Ha MTH800
Bawwnor MTH800 moxe na buge 3aknyyveH npu BKNydyBake.

3a pga ro otknyunte MTH800 no BkIy4yyBaH€eTO, BHECETE ja
wundpaTta Kora Toa ke bmuae nobapaHo. MTH800 ce Bkrny4yBa
Ha CTaHOapAHUOT MaTUYEH eKpaH.

LLindbpaTa 3a oTkNydyBarke OpUrMHasiHoO € NocTaBeHa Ha
0000. Bawwmot gaBaTten Ha ycrnyrn Moxe Aa ro npoMeHu OBOj
©poj npen na ro nobuete TEPMUHANOT.

3aKknyJvyBake/oTKNyuYyBake Ha Konunmkbarta

MpuTucHeTe /v=w\ n (*5). 3a noBeke MHOpMaLK, BUAETE
BO ,3aKrny4yBaH-e/0TKINy4YyBake Ha TacTaTypaTta” Ha
cTpaHuua 143..

mBawuom Gasamen Ha ycriyau Moxe 0a ja 3aKiy4u

macmamypama co u 6e3 korndemo 3a PTT, @ u @ 80
mekom Ha 0ojdo8eH Mo8uUK, HO KOMYemo 3a pomupar-e

u ce cekoeaw docmariHu.

MKonqemo 3@ UMHU criyqau He e 3aKy4eHo.
lpumuckar-emo Ha Kon4emo 3a UMmHuU criydau 2u

OMKJ1y4dygea cume Kon4uka.

N3bupare Ha Bawarta mpexa

Mpen oa 3ano4vHeTe Aa ro kopuctute Bawmnotr MTH800, moxe
a ja n3bepere Mpexara Bo kojawTto cakate MTH800 ga
6uae npujaBeH. 3a noBeke nHPopmaLmmn, BUOETE BO
~.Mpexun” Ha cTpaHuua 184.

RUA/RUI

OanvknTe 3a HaszHavyBak€e KOPUCHMK Ha paamoTo (RUA)

N NOEHTUTET Ha KOPUCHUKOT Ha paguoTto (RUI)
06e36eayBaar ycnyra 3a noTBpAaa Ha npujasaTa.
O6e3benyBaat pnekcnbnnHOCT 3a KOPUCHMKOT Aa ' Mma
NCTUTE MOXHOCTM CO KOe Buno pagmo, Kako Co NIMYHOTO
paavo. 3a uernoceH npucrtan 4o CMCTEMOT, KOPUCHMKOT Tpeba
na obe3bean npujasa n PIN-0po;.

16



3a npujaByBare ogete o MeHum > MNoeeke... > RUI
> pwmjaBu ce

=)

Ke ro BuauTe eKpaHoT Kako LTO e o =
npukaxaHo, kage LWTO MOXe [a ro BHeceTe
BaLLMOT 6poj 3a uaeHTMdMKaumja e aLia o
(HajmHory 16 andgaHymepuykun 3Haum) .y
1 kopucHuukuoTt PIN (Haj mHory

6 Hymepu4kmM 3Haum). MNputucHete N3bepum
3a ga ce npujasute. Tpeba ga BuguTe

npukas 3a npudakarwe Ha npujasa.

PIN Ha KopucHuK:

Mnocmojaf-/o Ha ekpaHom ce rokaxyea dasnu KOpUCHUKOM

e npujaseH (cuHa b6oja Ha ukoHama) unu odjaseH (cusa boja
Ha ukoHama).

HauunH Ha apxewe HaMTHS800

TepMuHanoT uma gBa MMKpOgOHa: eeH ropeH MUKPOdoH
3a eIHOHACOYHW AUCNEeYepCKN NOBUUM U edeH JorneH
MUKPOChOH 3a ABOHACOYHU TenedOHCKN NOBULIN.

Moxe Oa ce BOoCnocTtaBu NOBUK CO BUCOK UITN HMU3OK 3BYK.
3a Oa aktmempare HU30K U BUCOK 3BYK, BUOETE
~npedpnawe Mery BUCOK/HM3OK 3BYK” Ha cTpaHuua 18.

Mpy BUCOK 3BYK KOPUCHMKOT 360pyBa BO FOPHUOT MUKPODOH
U crylua NpeKy BHATPELLHWNOT 3BY4HMK.

Mpu HM30K 3BYK KOPUCHWUKOT 360pyBa BO AOMHMOT MUKPOGOH
1 crnylwa npeky cnyliankara.

I'pynHMTe, Teﬂe(*)OHCKI/ITe n npuBaTtHMTE NnoBuUK ce
€HOHaCOo4HM NoBMUKM N MOXe aia Ce BOCNoCTaBaT CoO BUCOK
NI HA3OK 3BYK.

TenedoHcknte, PABX, 1 4BOHACOYHUTE NpUBaTHU NOBULN
ce BOCMocTaByBaaT CO HM30K 3BYK. OgnukaTta MHTepdoH
0BO3MOXyBa TenedoHckute, PABX 1 aBoHaco4yHuTe
npuBaTHM NOBMUM Oa ce oABMBaaT Npeky BHaTPeLIHNoT
3BYYHMK Ha MTHB800.

17
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KopucTtene Ha HU30K 3BYK (TenecdoHckn nosuuun, PABX
M ABOHACO4YHM NPUBaTHU NOBULN)

Kora BocnoctaByBaTte unu npumarte noBuK 1 Jodeka
3bopysarte, apxete ro Bawmotr MTH800 kako wTo 61 apxene
TenedoH. 36opyBajTe Bo AONHNOT MUKpPOoH. Cnywiajte
npeky cnywarnkaTa.

[pxeTe ja aHTeHaTa Gapem 2,5 caHTUMETpKU of BallaTa
rmaea v Tero.

Ynotpeba co BUCOK 3BYK (rpynHu, TenedOHCKU
M NpUBaTHU NOBULN)

Opxete ro MTH800 Bo BepTukanHa nosuumja , a HEroBUOT
ropeH mukpodoH Ha 5 go 10 caHTMMeTpK o4 BaluaTa ycra.
360pyBajTe BO ropHNOT MUKpOdhoH. CriyLuajTe npeky
BHaTPELUHMOT 3BYYHWK HA TEPMUHAIOT.

OpxeTe ja aHTeHaTa Gapem 2,5 caHTUMETpKU of BaLlaTa
rnaea v Teno.

npedpnawe mery BUCOK/HU30K 3BYK

18

KopucHukoT Moxe ga ce npedpnv o4 HagsopeLuHara
cryLwianka Ha rmaBHUOT 3BYYHMK KOPUCTEjKN €0HO KOMYe U He
Mopa a ja UCKny4u HaaBopeluHaTa cnywanka unnmn PHF.

CocT0ojbu Ha Haco4YeHUOoT 3BYK:

* BUCOK ykaxxyBa geka 3BYKOT € HaCOYeH
KOH FMaBHUOT 3BYYHUK.

Opnuka Ha BUCOK 3Byk
Ha 3BYYHUKOT

+ HU3OK ykaxyBa Aeka 3ByKOT € Haco4eH Eat W =
KOH cnywankata unu PHF-cnywankara,
a He KOH [MaBHMOT 3BYYHUK Onsa Ha HY3OK sayi

Ha 3BY4HUKOT




3a Bpeme Ha MOBMKOT, 03HaKaTa Ha NPOrpamcKoTo Konye
yKaxyBa Ha criegHata MoxHa npomeHa. CtaHgapaHo
nocTaByBak-€ Ha AONOMHUTENHUOT Npubop:

OsHaka 3a MocTaBKa 3a BUCOK/
NporpamMcKoTo Konye HU30K 3BYK
3By4HUK IMaBeH 3BY4HUK

(vkoHa 3a BUCOK 3Byk)

Cnywanka crnywarnka
(vkoHa 3a HN3OK 3Byk)

PHF JInyeH nHTepdoH 3a
cnobogHu paue (MkoHa
3a HN3OK 3Byk)

Ha 3ano4yHeme
» PHF e noBp3aH — ayano pexum PHF-mukpodoH/PHF-
cnywarnka
* [loBp3aHa e camo PHF-cnywanka — ayano pexxum ropeH
MukpodpoH/PHF-cnywanka
* He e npukayveH gononHuteneH npnbop — ropeH
MUKPOOH/BHATpELLEH 3BYYHUK

lMpukayyeare donosiHUMeneH npubop Ha paduo npexy

npozpamMcko Korn4ye:

* [pedpnare Ha 3BykoT og PHF Ha rnaBHMOT 3BYYHUK —
ayauo pexum PHF-mukpodoH/PHF-cnywanka Ha ropeH
MUWKPOCHOH/BHaTPELLEH 3BYYHMK 1 0OpaTHO

* pedpnare Ha 3ByKkoT of PHF-cnywanka Ha rmaBHMOT
3BYYHUWK — ayaAMO pexum ropeH MmkpodoH/PHF-cnywanka
Ha ropeH MUKpoOoH/BHaATpeLLEH 3By4YHUK U 0bpaTHO

Hocewe Ha peBep/pamo

3a rpynHu 1 NpuBaTHM NOBULIM CBPTETE ja rMaBaTa KoH
BaLLeTo pamo/peBep 1 36opyBajTe AMPEKTHO BO FOPHUOT
MuKpodpoH. CnyLuajTe Npeky BHATPELUHUOT 3BY4YHMK Ha
TEepMUHArOT.

19

aWaHhouee eff



Ynotpeba Ha uHTepcoH

Moctaeete ro Bawmotr MTH800 Ha 30 go 60 caHTumMeTpun of
Bac. Bo 6y4Ha cpeamHa noctaseTe ro BawmoT MTH800
nobnucky oo Bac 3a nogo6ap npeHoc.

rpuxa 3a sawumotMTHS800

He nanoxysajte ro sawmotr MTH800 nnun 6arepujata Ha
ekcTpeMHu Temnepatypu (Hag 60 °C) — Ha npumep, 3ag
BETPOOPAHCKO CTaKMO Ha MHOTY XeLlKka, AUPeKTHa COHYeBa
ceeTnuHa. He notonysajte ro Bawmotr MTH800 Bo BOAa.

3a yuctere Ha Bawwmotr MTH800, kopucTteTe BnaxHa unm
aHTucTatuyHa kpna. HE kopucTtete cyBa kpna unm kpna co
€NeKTpOCTaTUYKO NOMHEHE.

EkpaH

MaTunyeH ekpaH (BO MupyBaH-€)

BKﬂyLIeHI/IOT TepMunHan BO MnpyBaHl€ ro npukaxxyea

cnegHWoT BoobuyaeH MaTtuyeH eKpaH:
MaTuyeH ekpaH BO pexum Ha MaTu4eH eKpaH BO AMPEKTEH PEXUM

m—@‘i obnacT Ha ukoHaTa —————— w
3a cTaryc

Mpexa 1 pocrop 32

— npocT _)p

Manka 1 NIpUKaXKyBakbe TEKCT DMO-nanka 1
Ipyna 3a pasrosop 1 Ipyna 3a pasrosop 1

3apaso npocTop 3a 3apaso
4—— rporpamcte.
Onum |3 Kowtakmu Kon4nea Onumt [ E=1] Konraku

e MeHw/uKoHa npucnocobnmea
Ha KOHTEKCT

20



MKoHu 3a cTaTyc

WkoHuTe 3a cTaTyc ce nojaByBaar Kora BalIMOT TenedoH
BpLUM OOpeaeHa akTUBHOCT UK Kora CcTe akTuBupare
ogpeneHa ognuka.

WkoHa 3a
craTtyc

onuc

DYHKUMOHUPaHe BO PEXUM Ha BMpeXyBake

.:_t::lll

JauuHa Ha curHanot (TMO)

Bu oBo3MoOXxyBa Aa ja npoBepuTe jaumHaTta

Ha curHanor. [loronemmnoT 6poj Ha LPTK YKkaxKyBa
Ha nojak curHan.

HepocTtanHa mpexa

X
4

CKeHupame
YkaxkyBa neka MTH800e Bo npoLuec Ha CKeHupatbe.

H

MoBp3aHu nogaroum

Ce nojasysa kora MTH800 e ycneluHo nosp3aH
CO HaJBOpELLEeH ypea v e NOAroTBEH 3a NpeHoC
Ha nogaTouu.

ks

MpeHoc/npuem Ha nogaToum

Ce nojasysa kora MTH800 npeHecysa nogartoum
Ha/nMpyma nogaTtoum o HaABOPeLLEH ypen
(nanTon-komnjyTep unu 4ecKTon nepcoHaneH
KomMnjyTtep).

Hema 6poj — nogaTo4HaTta cecuja BO MUPYBaH-E.
BpojoT 1, 2, 3 nun 4— ykaxxyBa Ha akTUBHa
nogaToyHa cecuja co pekBeHTeH oncer o 25%,
50%, 75% vnn 100%.

DYHKLUMOHUPaHE BO AUPEKTEH PEXUM

JauuHa Ha curHanot (DMO)
YkaxxyBa Ha [0jO00BEH rpyneH NoBUK BO AWPEKTEH
pexuMm.

1=+l

[OnpeKTeH pexum
Ce nojasyBsa kora MTH800 e BO ANpeKTEH pexum.

21

aWaHhouee eff



22

WkoHa 3a
craTtyc

onuc

IL?

MpexeH npemuH npu DMO-pexum

YkaxyBa Ha nsbpaH mpexeH npemuH. MikoHata nma
Tpu cocTojou:

MocTtojaHa — kora MTH800 e cuHXpoHM3npaH co
MPEXHNOT NPEMMH.

Tpenka4ka — kora MTH800 He e cMXHpoOHM3MpaH
UNN BO TEK Ha NpUKavyBame.

Be3 nkoHa — BO TEKOT Ha NOBUK OA TEPMUHAr A0
TepMuHan u peneTuTop.

Il

DMO-peneTutop

Ce nojaByBa kora e n3bpaHa onuujata 3a
penetutop Bo DMO-pexum. OBaa nkoHa nma Tpu
cocTojou:

MocTojaHa— kora TepMMHANIoT nMa AeTEKTUPAHO
peneTuTop (T.e. kora TepMmnHanoT gobuea curHan
3a NpUCycTBO).

Tpenkayka— kora TEpMUHANOT HEMa AETEKTUPAHO
peneTuTop UNu BO TEK Ha NpuKadyBak-e.

Be3 nkoHa— BO TEKOT Ha NOBUK O TEPMUHAI J0
TEPMUHAN N MPEXEH NPEMMH.

OnwTH UKOH

N

CvTe TOHOBM UCKIy4eHM / npuayLLIeHO SBOHO 3a
ABOHACO4YHM N €4HOHACO4YHM NOBULIN

YkaxyBa Aeka cute curHanHu ToHosm Ha MTH800
Ce UCKIyYeHU UMK jaynHata Ha SBOHOTO Npu
eJHOHAaCco4eH NoBuWK e noctaBeHa Ha 0 1 jaynHaTa
Ha SBOHOTO NPV ABOHACOYEH MOBMK € NOCTaBeHa
Ha 0.

Y

MpuayLweHo SBOHO NpU eAHOHACcO4YeH NOBUK
YkaxkyBa [jeka jaymHaTta Ha SBOHOTO Mpu
e[JHOHaCo4YeH MoBUK e noctaseHa Ha 0, goaeka
jaunMHaTa Ha SBOHOTO MpU ABOHACOYEH NOBUK MMa
BpeaHocT noronema og, 0.

MpuAayleHo SBOHO Npy ABOHAcOYEeH NOBUK
YkaxkyBa feka jaynHata Ha SBOHOTO Mnpu
[ABOHaco4eH MoBUK e nocTaseHa Ha 0, gogeka
ja4ymHaTa Ha SBOHOTO MpW €4HOHACOYeH MOBMK MMa
BpegHocT noronema og 0.




WkoHa 3a
craTtyc

onuc

El'n
[

BknyyeHa BuGpauuja
Ykaxysa geka MTH800 ke Bnbpupa 3a ga Be
M3BECTU 3a 0j0BEH MOBUK.

=i
B,

Bubpauuja n sBoHO
YkaxyBa aeka MTH800 ke Bubpupa u ke SBoHM
3a Ja Be U3BeCTu 3a J0jO0BEH NOBUK.

i

WcknyyeH 3BY4YHUK (HU3OK 3BYK)
YkaxkyBa [jeka 3BYyKOT ke ce ornacu npeky
cnywarnkara. (Bugerte ro nogetanHoTo
objacHyBare Ha KOMYeTo 3a KOHTporna Ha
3BYYHMKOT)

f Hunsok 3BykK
YkaxkyBa geka pexXnMOoT Ha 3BYKOT € U3MeHeT
Ha HU3OK.

i BMCOK 3BYK

YKarkyBa [ieKka pexvMOT Ha 3BYKOT € U3MeHeT
Ha BUCOK.

MoepsaHa cnywanka
YkaxyBa [eka cryluankara e nospsaHa.

MpujaByBawe Ha RUI noa nceBaoHum
YkaxxyBa Jeka KOPUCHUKOT € npujaBeH nog,
NceBAOHUM.

HuBo Ha nonHewe Ha 6aTepujaTa
YKkaxkyBa Ha H/BOTO Ha NOMHEHETO Ha BalwlaTa
6atepwuja. MNonHaTta nkoHa 3Ha4m nonHa Gatepwuja.

UTteH cnyuaj
Ce nojayBa kora MTH800 e Bo pexum 3a UTHK
cnyyam.

® k| W B o

Jlnsrawse HU3 cNUCcoK

Ce nojaByBa 3a Aa ykaxe Jeka KonyeTo 3a
poTupare Ce KOPUCTU 3a N3rake HU3 crcouuTe,
ceé goaeka e nsbpaHa osaa ynotpeba.

[[=

MpucturHa HoBa nopaka
YkaxkyBa geka LUTOTYKY NpucTUrHana Hoea nopaka.
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WkoHa 3a
craTtyc

onuc

B

HoBun nopaku Bo caHpayeTo
YkakyBa eka umate HenpouMTaHu nopaku
BO BaLLETO caHAaye 3a NPMMEHU NopaKu.

&

HenpouutaHa (HoBa) WAP-nopaka

YkaxyBa feka He CTe ro oTBOpune caHaayeTo

3a WAP otkako 6una npumeHa nocnegHara WAP-
ropaka (Tpernka Kora NpMopuTETOT € BUCOK).

&

HenpouutaHa (HoBa) WAP-nopaka
YkaxyBa geka Ha NpenucTyBayoT e BiMTaHa HoBa
cTpaHuua.

MHaukaTop 3a crtatycot LED

MHuaukaTopoT 3a LED ykaxyBa Ha pyHKUMOHanHaTa
cocTojba Ha BawwmoT MTH800. Buaete Bo Tabenata
BO NPOAOIMKEHME.

WHaukaTop Craryc
MocTojaHo 3ENNIEHO Bo ynotpeba
Tpenkayko 3ENNEHO Bo mpexa
MoctojaHo LIPBEHO Hema mpexa
Tpenkayko LUIPBEHO MoBp3yBane co Mpexa /

Bnes Bo DMO-pexwum

MocTojaHo CnpeuyBarse Ha npeHoc (TXI) Bo ek /
MOPTOKANOBO B3adhateH kaHan Bo DMO

Tpenkayko [ojooBeH NoBukK

MOPTOKANOBO

Hema nngukatop WcknyyeH
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Mpernep Ha Konyukwarta

Mporpamcku konuuwa PR T
MputucHete (*/ unu \*\ 3a na usbepere Mpexa 1
onLyja LUTO Ce NOjaByBa Ha EKPAHOT BEAHALL | royra s seresop 1
Haj NeBOTO UMK AECHOTO NPOrPamcko 3apaso
kon4ye. Bo oBoj NnpumMep, KoHTaktn € Oruw [E[Kowax
npukaxaHa Hag konyeto. Co nputuckate D)

Ha Ce OBO3MOXYBa Bfe3 BO CMNCOKOT CO
KoHTakTu. Bo ynatcTBoTo 3a ynotpeba, oBa AejcTBO €
ONULLIAHO KakKo “nputncHeTe KoHTtaktu’.

Konue 3a meHu

MpuTucHeTe /¥&n\ 3a na BrieseTe BO:

* MEHUTO (Kora Hema akTUBHOCT BO TeK). MeHunjaTa Ha
MTHB800 B1 oBO3MOXyBaaT fa rm KoHTponupare
noctaskute Ha Bawwmor MTH800. MeHujaTa ce
Xnepapxmckm opraHnsmpanu. Bugerte Bo ,,Cnncok co
CTaBKu o MEHUTO” Ha cTpaHuua 134. OnumMnTe Ha MEeHUTO
obesbenyBaaT npuctan 4O AONONHUTENEH CMUCOK CO
OnNuUUKU HapeyeH NogMEHM.

* MeHuTO NpunaroanuBo Ha KOHTEKCT (Kora nkoHara =
€ aKTMBMpaHa) 3a npernes Ha CMCOKOT CO CTaBKM 3a
TEKOBHOTO MEHM.

lMpumepu Ha MeHU u NnodMeHuja:

MprMepoT BO NpodormkeHne BU yKkaxyBa Kako Aa ja
nocrtaesuTe (pyHkUMjaTa 3a BubpaLmja Ha TepMUHAnOT.

1-80 NoAMeHN 2-po nogmeHn 3-To nogmeHn
Ll [CH Ll [ Ll [ Ll [
BCpaia
Mpexa 1 2. lMopaku Bubpauvja Bubpauuja 1 SBOHO|
Manka 1 EC\ 2 Kowrtaktn I:’r\ HaumH Ha sBoHetbe I:‘F\) Camo subpauvja
l'pyna 3a pasrosop 1 /|| & Besbeatoct 4 Mocrasw ja jaunHara V||| ¢ Camo ssoro
3ppaBso & MMocrasysare Jaank Tetanu...
& Mosere... MocTasysatbe
Onywn_[FEI] Kowrakw Visbepn | [ Hasan Vabepn | [ Hasan Visbepn | [ Hasan

[EvE) (o) (o] CJ J
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Mpumep 3a meHu npucnocobueo HaKOHMeKcm:

OBoj npumep ro nokaxyea o = T =
NPUKasoT Npu ypeayBare Ha RTINS
[HoB koHTaKT] Ypenn

MMe HaBe[EeHO BO CMMCOKOT e 2 | i Viaconun
co KoHTakTn. O MaTuyHUOT ’;:Ze Pl /i20paI KOTKT
€eKpaH NpuTucHete U 2255 & Kanaumtet

. Mpern[[E@] Hasan| [MaGepn | [ Hasan
KoHTakTu. Jlnarajte go

MMETO LITO cakaTe Aa ro
ypeaute. MpUTnCHeTe /ey .

Ce 0TBOpa MeHV NPUNAarofAnMBO Ha KOHTEKCT LITO BU
0BO3MOXYyBa fa 6upate mery 3anucute.

Konue 3a poTtupame

MpuTUCHETE 1 3agpKeTe ro KOMYETO 3a poTMpame 3a Aa ro
3akrnyyunTe, NPUTUCHETE 1 3a4pXKeTe ro NOBTOPHO 3a Aa ro
oTkny4nTe. Co NCKNyYyBaHETO CE OTKITyYyBa 3aKMy4eHOTO
Konye 3a poTupatse.

3a geranHu nHgopmaummn Kako aa ro nocTaBuTe KOMYETO 3a
poTupame, Bugete Bo ,Konye 3a potupare” Ha

cTpaHuua 165.

Kon4ye 3a UTHU crny4vyaun

26

MpuTncHeTe 1 3agpXeTe ro oBa Konye 3a Aa Bresete BO
PEXMMOT 3a UTHU Criyyau.

Kora MTH800 e ucknyueH, 3agpxeTe ro npMTUCHaTo oBa
Konye 3a Aa ro BKIy4uTe BO PEXMM 3a UTHU cryvaun
(Ookornky e KoHurypmpaHo of cTpaHa Ha AaBaTternoT Ha
ycnyru).

Buaete “©yHKUMOHMPae BO UTHU criydan” Ha cTpaHuua 89.



q)YH KUMUCKU KOMYnHba

meeMemo wmo 8u e NompebHoO 3a npumuckare Ha
cmpaHu4Hume unu odesieHUMe KON4YuH-a 3a akmugupar-e

Ha ¢yHKUyujama co edeH donup ce nocmasysa cmaHOapOHO
Ha 0,1 (cmpaHu4HuU Konyurba) unu 1 (dodeneHu Kon4yuH-a)
cekyHOa. Mefymoa, oea epeme moxe da 2o nocmasu
sawuom dasamersi Ha ycryau.

m% uHgbopmayuu 3a pyHKyujama AodeneHa Ha cekoe
cmpaHu4Ho unu dodesneHo Kon4e, obpameme ce Kaj

sawuom daseamern Ha yenyeu.

CmpaHuqHu Kon4uha

I'IporpaMMpal-beTo Ha KOM4yeTo 3a poTupawe N CTpaHN4HOTO

Kon4ye ce CnoeHu:

Mporpamupare Ha
KOM4eTo 3a poTupame

Mporpamupame Ha
CTPaHM4YHOTO Konye

[lBojHa KOHTpona

MporpammpaHo Ha yHKUmjaTa co
efeH gonup

KoHTpona Ha cnucouu

(): BronemyBatbe Ha jaumHaTa
Ha 3BYKOT
{U: Hamanysare Ha jaunHaTta
Ha 3BYKOT

KoHTpona Ha jauvHata Ha
3BYKOT

[MporpamunpaHo Ha dyHKLmMjaTa
CO efieH gonup
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Kora kon4yeTto 3a poTvpare € NocTaBeHO 3a KOHTpona 3a
javymHaTa Ha 3BYKOT MMM [BOjHa KOHTpona, CTpaHWYHUTe
Konuuhsa ja nogap)kyBaaTt oannkaTa 3a eAeH Jonup LWTOo BU
OBO3MOXyBa Aa r'v n3bepete unu aktmeupare BOOOGM4aeHo
KOPUCTEHUTE OANMKMN CO NPUTUCKaHE M 3a4pXKyBare Ha
eaHo konye. CTaHgapAHO, FOPHOTO CTPaHUYHO KomnYe

€ NoCTaBeHO Ha ,UCKMYy4n/BKIy4M ro 3aHUHCKOTO
ocBeTnyBawe®, AofeKa JONMHOTO CTPaHMYHO Konye e
NocTaBeHO Ha ,BKIMyYEH 3alITUTHUK Ha ekpaHoT". lpoBepeTe
Kaj BaWwMOT fasaTten Ha ycryru, koja oanvka e gogerneHa Ha
Koe CTpaHM4HO Kon4ye. 3a geTanHu nHopmMaLmmn Kako aa ro
nocTaBuTe KOMYETO 3a poTupake, BuaeTe Bo ,Konye 3a
poTupake” Ha cTpaHuua 165.

Konyuna wmo moxe Oa ce npozpamupaam (0-9, * u #)

MTHB800 ja nogap>kyBa oanukaTa 3a eaeH Jonup LITO BU
0BO3MOXYBa Aa rvm nsbepere/aktusupare BoobnyaeHo
KOPUCTEHUTE OANMKN CO NPUTUCKakE 1 3apXKyBarke Ha
poneneHoTo konye. BawwoT aasaten Ha ycnyru Tpeba aa
nporpamupa cooaBETHU OANMKN HA KONYMH-aTa.

Bo cnegHata Tabena HaBedeHN Ce OANMKUTE LUTO MOXe Aa
ce nporpamupaar 1 HUBHaTa [OCTanHOCT BO OApeaeHU
MTHB800 cocTojon/pexxumun. 3a nogeTanHn nHgopmaumm 3a
oanvknTe, BUAETE BO COOABETHMOT OAeN BO yNaTCTBOTO 3a
ynotpeba.

Oanuka Onuc

BknyuyBatse rpyna 3a | BknydyBa ofpefeHa rpyna 3a pa3roBop
pasroBop

BknyuyBare Ja Bkny4vyBa nperxofHarta rpyna 3a
npeTxogHa rpyna 3a pa3roBop (4ypv 1 BO pasnuyeH pexum
pasroBop Ha paborTa)

CkeHupame Ha rpyna Ja Bkny4vyBa/uckny4vyBa oanvkarta 3a
3a pasroBop CKEHMpae Ha rpynarta 3a pasroBop
(camo Bo TMO-pexum)

DMO/TMO OBo3moxyBa npedpnawe mery DMO
n TMO




Oanuka

Onuc

Mopaka 3a cTaTyc

Ja ucnpaka HasHadyeHaTa nopaka 3a
CTaTyCc Ha Ha3Ha4yeHaTa agpeca

O6pa3sel 3a
TeKCTyarnHa ropaka

['o ucnpaka npetxogHo gednHNpaHNOT
obpaseu/obpaseloT gemHupaH og
KOPMCHUKOT Ha Ha3HadeHaTta agpeca

Bupate noBuk
(npvBareH,
TenedoHckun, PABX)

3anquyBa NoBUK OO0 NpeTxoaHo
AedunHMpaH 3anmc Bo CMUCOKOT CO
KOHTaKTn

BepTurkanHo npespTeH
ekpaH

"o BKIy4vyBa/MCKNy4yBa BEPTUKAIHO
NPeBPTEHNOT eKpaH

CnpeuyBame Ha
npeHoc (TXI)

OBo3mMoOXxyBa npedprawe Mery
aKkTuBMpaH n geaktusupaH TXI-pexunm.

3aWTUTHUK Ha EeKpaHoT

[0 akTMBMpPa 3aLUTUTHUKOT HA EKPAHOT.

MpucnocobyBane Ha
3aHUHCKOTO CBETINO

o BknyyyBa/ucknydyBa 3agHMHCKOTO
CBETNO

PexxuM 3a Npukpuearbe

"o BKIy4yBa/MCKy4yyBa peXxXuMoT 3a
npuKpuBare

Bpeme 1 gatym

n NpuKaxkyBa BpeMeTo 1 JaTyMOT.

AKTMBMpa curHan 3a
BpaKkare

Mcnpaka curHan 3a Bpakare

RUI npwjaByBane/
ofjaByBak-e

Be npujaByBa/ogjaByBa

Bucok/Hn3ok 3Byk

[0 akTMBMpPa HUCKMOT/BMCOKMOT 3BYK

AKoO npoepamuparbemo Ha Kondurama co edeH 0onup e
0803MOXKeHO, buparemo co edeH Aonup € OHEBO3MOXKEHO

(sudeme cmpaHuya 85).
3a KopucTtene Ha ofnukarta 3a eaeH gonup:

1. 3agpxeTte ro npuTncHaTo 6GapaHOTO KOMYe HEKOKY

CeKyHau.

2. Bawmot MTH800 ke cpyHKLMOHUPa cnopen
nporpammpaHara oanwka.
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MpuBaTHUTE NOBULM CO efeH AoNup M nocTaBysa
[aBaTeroT Ha ycryru.

1. Jokonky e noctaBeH Ha EqHoHaco4eH, Toraw u
NojoOBHUOT NpMBaTEH NOBUK ke buae eqHOHACOYEH.

2. [lokonky e noctaBeH Ha [IBOHacoYeH, Torall nojaoBHUOT
npueaTeH NoBukK ke buae gsoHacodeH B0 TMO-pexum,
enHoHaco4veH Bo DMO-pexum co 6pojoT Ha uHuumnjatopoT
Ha NoCcneaHNoT rpyneH NoBUK.

3. [okonky e noctaBeH Ha [1BOHaco4eH, Torall nojaoBHUOT
npuBaTeH NOBUK ke Buae gBoHaco4yeH Bo TMO-pexum v He

Ke Mmoxe aa ce Bocrnoctasu Bo DMO-pexnm, OOKOMKy ce
Oapa nHgekc Ha TenedOHCKNOT UMEHMUK.

Konu4e 3a KOHTpoOsa Ha 3BY4YHUKOT

MputncHete &) 3a fa ja akTMBMpaTe crywankaTa (H130K
3BYK) UMW 3BYYHWKOT (BMCOK 3BYK), BO 3aBUCHOCT Of
NocTaBKUTE HA MEHUTO.

B4 Ha NOBUK

noctaBkKa 3a MEHUTO

npuMmeHa Ha
KonyunwaTta

EnHoHaco4eH noBuk
(Mpynen*/npusareH)

Menwn > MocTaByBare
> 3Byk > [pedpname
Ha 3BYyKOT

> KoHTporna Ha
3BYYHUKOT

BknyyeH/ucknyyeH
3BYYHMK 3a rPYMnHU U
npuBaTHU NOBULYU

MeHu > lNocTaByBare
> 3Byk > [Npecdpname
Ha 3ByKoT > Cekoralu
rmacHo

BknyyeH/ucknyyeH
3BYYHMK 3a NpuBaTeH
NoBYK

[lBOHaco4YeH NoBumK
(MpwuBaTen/
TenedoHckn/PABX)

[0 koHTpOnupa
3BYYHMKOT/
crywiasnkara npuv noBuk
BO TeK.

* [pu rpyneH NoBKK 3a UTHM Cy4Yam ce ornacysa 3BYK Of, 3BY4HUKOT, 6e3
orneq Ha nocTtaBKaTa Ha 3BYYHWKOT.
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nceBAOHUMU (MMUHHA)

MceBooHUMUTE ce U3BOPHN MMUHLA LITO MOXe Aa '
Oo4enuTe Ha 3avyBaHu TenedOHCKU 1 NpuBaTHM GpoeBwm
(vnn 6poesu 3a naeHtTudukayuja). 3a ypeagysame Ha
nceesgoHMM, BuaeTe Bo cTpaHuua 140.

lMceBooHUMUTE MOXE Aa cogpat HajMHory 12 3Haum 1
MOXe [a BKnydyBaaT OykBu, OpoeBu 1 NpasHu MecTa.

MceBOooHMMMUTE ce NojaByBaat Ao4eka nmaraTe H13 CNIMCOKOT
CO KOHTaKTK UMK BO TEK HA OOjA0BEH NOBUK. [ceBooHMMUTE
ce KopucTaT npu andaHymepuydko npebapyBame 3a
nospakare Ha 6poeBnTe 04 MEMOPUCKMUOT CMMUCOK.

CnegnyBsaat npMmepu 3a HAYMHOT Ha KOj MOXKe Ja ce Npukaxe
NpUBaTHMOT GPO;j Ha NMOBMKYBAYOT Ha EKPaHOT.

npusareH 6poj 3a é unm é npusateH 6poj 3a

naeHTudgukaumja MpueateH MpusateH naeHTndukaumja
6e3 nceBaoHUM noBuK BO noBsuk BO CO NCEBAOHUM
ynotpeba ynotpe6a

CumoH

3alWTUTHUK Ha eKpaHoT

AKO BalLMOT gaBaten Ha ycrnyru ja kKoHdurypmupa oBaa
0f4f1Ka, 3alITUTHUKOT Ha EKPaHOT aBTOMATCKM Ke ro nokpue
ekpaHoT Ha MTHB800 otkako MTH800 ke octaHe BO
MUpYyBak€ BO TEKOT Ha NPETXOAHO NPOrpaMmpaHuoT
BPEMEHCKM nepuog. AKO NpUTUCHETE Kon4ye unu goduerte
MOBWUK, 3aLUITUTHUKOT Ha ekpaHoT ce geaktueupa n MTH800
NpoAoKyBa CO CTaHAapAHaTa onepauuja.

31

aWaHhouee eff



TeKCTyarnHa nopaka Ha MaTU4HUOT o E———
eKpaH

OBaa ognuka mMoxe Aa ja akTmBmpare n padHo, co
npuTUCKake Ha COOOBETHOTO NPETXOAHO NporpamMmmpaHo
Kon4ye (CTpaHU4HO NN HyMepu4Kko konye). Ha npumep,
OOKOIKY € payHO aKkTMBUPaH BO TEK Ha rpyneH NoBuK,
3aLUTUTHUKOT Ha eKpaHOT OBO3MOXYBa MPUKpUBaHe Ha
NMOEHTUTETOT Ha NOBMKYBAYOT 3apagu AOBEPIIMBOCT.
3aWTUTHUKOT Ha eKPaHOT ce COCTOM 0f NOoro U
andaHymepunyku TekcT. [poBepeTe BO onuumTe 3a MEHUTO
Aanv gaeaTtenoT Ha yCrnyrn MMa oCTaBeHO MOXHOCT 3a
BHECyBaH-€ Ball CONCTBEH TEKCT 3a 3aLUTUTHMKOT Ha eKpaHoT
(Bngete Ha cTpaHuua 162).

Bawwot MTH800 BknyyyBa ognuka Lwito My
0BO3MOXYBa Ha BalLWOT JaBaTesl Ha ycnyru <TeK°T:fp“;:IV‘““”°T
Aa vcrnpaka noce6HN TeKCTyarnHu Nopaki Ha o TaT Korrar

eKpaHoT Ha Bawmot MTHS800 .

lMopakata ce nojaByBa kora MTH800 e Bo mnpyBatse.

lMopakaTa ke ocTtaHe Ha ekpaHoT Ha Bawmnot MTH800, cé
Jogeka He buge npumeHa HoBa nopaka.

AKO e KOH(bUrypmnpaHo of CTpaHa Ha BalLMoT JaBaTer Ha
ycnyru, Ha ekpaHoT Ha Bawmot MTHB800 ke ce nojaBsu
WHTEPEH MaTU4eH Npukas, cé gogeka He buae npumeHa
HOBa Mnopaka.

Bpeme v patym

32

AKO BalLMOT gaBaTen Ha ycrnyru ja koHdurypmpan oBaa
0o4JfiMKa, Ha MaTUYHUOT ekpaH Ha MTH800 ke Guagar
npuKaxaHu TEKOBHOTO BpeMe 1 faTta.

WcTo Taka, Moxe Aa rv npoBepuTe BPEMETO U AaTYMOT,
ceKkafle BO MEHUTO, CO NPUTNCKake Ha COOABETHOTO KOMYe
CO efieH gonup.

MNpoBepeTe BO onuMuTe 3a MEHMTO Aany AaBaTenoT Ha
ycnyrm nmMa octaBeHO MOXHOCT 3a npucnocobysane Ha
noctaBkuTe 3a Bpeme u gatym (Bugete Ha cTpaHuua 157).



OHeBO3MOXyBaHe/0BO3MOXyBate Ha TepMUHaNoT

Bawwot MTH800 Bkny4yBa ognuka LUTO My OBO3MOXYBa Ha
BaLUMOT Aasaten Ha ycryrm npMBpeMeHo Aa ro OHEBO3MOXH
TEPMUHAarnOoT, BO cny4aj Ha kpaxkba. Kora Bawmotr MTH800 e
OHEBO3MOXEH, He MOXe [jla Ce BOCnocTaByBaaT unu npuMaat
NnoBuLM.

[oaeka Bawmotr MTH800 e oHEBO3MOXEH, CE YMHU U
PYHKLMOHMPA KaKo Aa € UCKITYUEeH.

Ako ce obngete Bawmotr MTH800 oa ro BknyumTeaoaeka e
OHEBO3MOXEH, ke (PyHKLMOHMPA KaKo LUTO € OMMULLIAHO
norope.

Hokonky Bawmor MTH800 e npoHajaeH, BalLIMOT AaBaTten Ha
YCINyrn MOXe NOBTOPHO Aa ro oBo3Moxku. OTKako BalnoT
MTHB800 ke O1ae NOBTOPHO OBO3MOXEH, MOXe Aa
nNpogommknTe co HopMarHa pabora.

TpajHO OHeBO3MOXyBaH-€ Ha TepMUHaNoOT
Bawwot MTH800 Bkny4yBa ognuka LUTO My OBO3MOXYBa Ha
BaLLMOT Aasaten Ha ycryrm TpajHoO Aa ro OHEBO3MOXM
TepMUHaroT, BO Cny4aj Ha kpaxkba nnu rybewe. Kora Bawumor
MTHB800 e TpajHO OHEBO3MOXEH, CTaHyBa HEedYHKLNOHAMNEH.
Mo TpajHoTO OHeBO3MOXyBawe, MTH800 He moxe aa Guae
MOBTOPHO BE3XMYHO OBO3MOXEH Of CTPaHa Ha BaluoT
AasaTen Ha ycnyru.

m Camo sawuom dasamern Ha ycrlyau Moxe mpajHo 0a 20
OHeso3MoXxu sawuom MTHB800.

N36upawse TMO nnu DMO-pexumm

onwTo

Mpu dyHKUMOHUpPaHe BO pexum Ha BMpexyBanwe (TMO),
MTHB800 ce kopucTh co ycnyrute Ha UHPPaCTpyKTypaTa BO
paMKK Ha MNOKPMEHOCTA Ha CUCTEMOT.
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Mpu byHKUMOHUPaHe Bo anpekTeH pexum (DMO), MTH800
ce kopucTtu 6e3 noTpebHnTe ycnyrn Ha nHdpacTpykTypaTta.
[Mpu DMO-pexum, npeHocom ce 8puiu OUPEKMHO 00

Maf-/mef-:ama Ha mepmuHanom 3a rnpeHoc 00 aHmeHama Ha
mepmuHanom 3a npuem, 6e3 nomow o0 Koja 6uno b6asHa
cmaHuua unu Kyna. 3amoa, oricezom 80 2oriemMa Mepa 3asucu
00 ro3uyujama Ha KOPUCHUKOM U aHmeHama. 3a
rnocmuezHysare Hajdobpu pesynmamu, Opxeme 20
mepMUHanom 8o paka, HajelUCOKO WMo € MOXHO U
ocuzypeme 0eka Ha HUMYy e0eH Ha4yuH He ja nonpevysame
aHmeHama. Ocueypeme d0eka aHmeHama e rnodasnexy 00
menomo, kabnume unu dpyau npeyku. budejku He nocmou
rnomowHa usdueHama ba3Ha cmaHuya u 0gama KopUCHUYU
Hajyecmo cmojam Ha 3emja, oriceeom e 4ecmo MOKPamox,
OMKOJIKY WMo 6u ce nocmuaHaso KOH Ky/a U 8UCOYUHKA.
Cume npeyku (pudosu, 32padu UMH.) Mery KopucHuyume
dononHUMenHo Ke 2o Hamanam orcezom. CripomusHo,
rnodueHysaremo Ha MmepMUHaIom fMoeucoKo Unu
npudsuXys8ar-emo KOH MO8UCOKa Jlokayuja Moxe 0a 20
rnodobpu oricezom.

MTH800 Bo DMO-pexum moxe ga KOMyHULMpPa CO BMPEXEH
cuctem (M obpaTHO) Npeky ypen 3a MpexeH npemMuH. 3a
KOpUCTeHe Ha OBaa oanuKa, OBO3MOXETE ja onuujata 3a
MpexeH npemuH Ha Bawmot MTH800 (Bnaete BO ,M360p Ha
MpEXeH nNpeMunH/peneTuTop” Ha cTpaHuua 63).

MBO DMO-pexum e MoxHo da ce gocriocmasysaam camo
apynHu no8uyu, 2pynHU MO8UYU 3a UMHU Crlydau U rpusamHu
©e0HOHaCcoYHU nosuyu.

Bne3 o TMO nnu DMO-pexum

Bnesete Bo TMO nnu DMO-pexum Ha egeH oa crnegHuTte
Ha4YnHWN:

+ O MaTMYHMOT ekpaH nputucHete Onuum n n3bepete
OupekTteH pexxum ako MTH800 e Bo TMO-pexunm.

« Opg MaTM4HUOT ekpaH npuTucHeTe Onuuun n nsbepete
Pexxum Ha BMpexyBawe ako MTH800 e Bo DMO-pexum.

* MputucHeTe /*=w\ 1 n3depete MoBeKe... > Mpexu > Pexum
Ha BMpexyBawe ako MTH800 e Bo DMO-pexum.
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« MputncHete [\ n n3depete Moseke...> Mpexu
> AupekTeH pexum ako MTH800 e Bo TMO-pexunm.

* [lpuTnCHeTe ro kon4eTo co eaeH gonuvp 3a TMO/DMO-
pexvM (QOKONKY e NporpaMmpaHo of CTpaHa Ha BaluMoT
Aasaren Ha ycrnyru).

MBawuom mepmuHarn Moxe O0a 8e uzgecmu 3a 00j008eH

MOBUK. M36epeme eu rnocmasekume 3a cueHasiom 60
MeHUmo 3a 6u6pauuu U MeHUmo 3a moHos8uU.

MoBuumn Bo TMO-pexum
Moxe ga ri BocnoctaByBaTe M NpuMMare crieqHuTe BUAOBU
noeuum kora MTH800 paboTn BO pexum Ha BMpeEXyBah-€e:
* [pynHu nosuum
* [puBaTHM NoBULMN
» TenedoHckn noBmLn
* PABX-noBuumn — nokanHu (KaHLenapucku) nosmnum
* [loBMUM 32 UTHK criy4au

noBuuun Bo DMO-pexum

Moxe ga BocnocTtasyBaTe U npuMate rpyrnHu noBuLM Kora
MTH800 pabotu Bo anpekteH pexum (DMO). Tyka ce
BKITYyYEHW U FPYMHN NOBULM NPU UTHU CryYan 1 NpuBaTHU
nosuuw.

MTH800 ce Bpaka Ha MaTUYHNOT eKpaH OOKOMKY HeMa
aKTMBHOCT BO Nepuog O HEKOIKY CEKyHAW.

[BojHO npuTUCcKawe Ha konyeTo 3a PTT

[okornky e oBO3MOXeHa of, CTpaHa Ha BallMOT JasaTen Ha
ycrnyru, oBaa ofnvka BU OBO3MOXYBa [a ucnpakare TOoH
Jofeka BaleTo pagmo e BO pexuM Ha MupyBake unm Bo
pexunma Ha rpyneH noBuK co ABOjHO NPUTUCKaHE Ha KONYeTo
3a PTT.

[okonky no ucnpakaheTto Ha ToHoT 3a D-PTT n noHaTtamy ro
ApXuTe npuTncHato konyeto 3a PTT ke nobuete go3sona 3a
pasrosop. ToHoT 3a D-PTT HeMa fa ce ornacu A0KOnky
paguoTo ucrnpaka.
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noeguHe4YeH NOBUK
Bupame rpyna 3a pasroBop no MHAEKC

Moxe fa ro nputucHete 6pojoT 3a 6p30 Bupare Ha rpynaTa
3a pa3roBop 1 notoa &) 3a fga ce NPUKIy4MTe KOH rpyna 3a
pasrosop. MNpuTtucHete Mpukaum 3a noTepaa.

noBuuun 3a HeMTHU cny4vyau:

* nputucKkawe Ha PTT

BawwmoT TepMuHan moxe oa Be U3BECTU 3a A0jO0BEH NOBUK.
N3BepeTe rn noctaBkuTe 3a CUrHanoT BO MEHUTO 3a
BUBpaLnM U MEHUTO 3a TOHOBW. AKO BUOOT Ha NOBUKOT

e ,rpyneH* nnu ,npusateH®, Torawl co NpUTMCKame Ha
konyeto 3a PTT ke ce BocnocTaBwu rpyneH, 0QHOCHO
npuBaTeH egHOHAcOYeH noBuK. Bo cnpoTuBHO, Ha
KOPUCHWUKOT My ce faBa nocebHa uHaukauuja.

¢ NMPUTUCKaHk€ Ha KoNn4yeTo MCI'IpaTVI

Ako BngoT Ha nosukot e ,PABX" unu ,tenedoHckn” nnm
LApuBaTeH, Toraw co NnpuTUckakwe Ha kon4deto ,Mcnpatn® ke
ce BocnocTtasu PABX, TenedoHCkM OQHOCHO ABOHACOYEH
npvBaTeH NoBuK. Bo cnpoTUBHO, Ha KOPUCHUKOT ke My buae
JageHa nocebHa nHaoukauuja.

00jAOBHM NOBULM BO TEK Ha Oupame
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MTH800 ocTaHyBa noBp3aH CO nocnegHaTa rpyna 3a
pa3roBoOp U r'v NpMmMa cuTe rpynHu noBnLUn. Ha KOPUCHUKOT ke
My Buge ykakaH [40jAO0BEH MOBUK M MPoLECOT Ha bupane ke
ouae npeknHart. [MoOBUKOT 3@ HEUTHM cinydan HeMa aa ro
npekMHe bUpareTo, HO KOPUCHUKOT Ke MOXe Aa CryLuHe
curHan 3a [ojaoBeH noeuk. Kora pagmoTto npuma npuBarteH
nnv TenedoHCKM NOBUK, PaANOTO Ke yKaxe U ke gage onumja
3a KOPUCHUKOT Aa ro otdpnv unm npudpatv NoBUKOT. AKO
KOPWCHMKOT ro npudpati NOBMKOT, MPOLECOT Ha bupame Ke
ouae npeknHat. Kora ro otdpna noBUKOT, KOPUCHUKOT Ke ce
BpaTu Ha NpoLecoT Ha bupatbe.



BneryBal-be BO PE€XWNM 3a UTHU cniyvHan BO TeK Ha 6Mpa|-be

MpouecoT Ha Bupare ke NpeknHe Kora KOPUCHUKOT Ke ce
obuae fa Bnese BO peXUM 3a UTHU Cny4vau.

AOjAoOBHA Aonra TeKcTyanHa nopaka 3a BpeMe Ha
OupameTto

,D,Oj,EI,OBHa nonra TekCtyarHa nopaka ce nojaByBa Ha eKpaHoT
M CO TOa Ce NpeKnHyBsa npouecoT Ha 6|/|pa|-be.

npomMmeHa Ha BU4 Ha NOBUK

Co bupatbe of ekpaH BO MMpYyBake, KOPUCHUKOT ke nma
MOXHOCT [ja ro NPOMEHW BMOOT Ha MOBUKOT.

MeHyBak€ Ha BUAOT Ha NOBUKOT

NHgpacTpykTypaTa MoXe Oa ro npoMeun BUAoT Ha
3ano4yHaTUoOT MOBUK.

Ha npumep, Moxe Oa 3anoyHeTe eHOHACOYeH NpuBaTeH
MOBUK U MH(PaCTpyKTypaTa MOXe [a ro NpoMeHu NoBUKOT
BO rpyneH NoBUK.

TepMnHanoT Ke Be U3BECTM 3a NPOMEHaTa U Ha eKpaHoT Ke
ce nojaeat cnegHUTe nopaku, BO 3aBUCHOCT 0f BUAOT Ha
NOBMKOT:
* NMpomMeHeT NoBUK (BO 4BOHACOYEH)
* NpomeHeT NOBUK CO KOpUCTEHE Ha konyeTo 3a PTT
(NMpomeHeT BO e4HOHACOY€EH)
MpopomkeTe CO N3MEHETUOT MOBWK BO 3aBMCHOCT Of, BUAOT
Ha MOBUKOT.
m » EOHoHaco4eH npusameH rnosuk ripomeHem 00 uUpeKmMHa
rnocmaeka Ha rocmaeKka Ha epckKa.
MOHOM 3a SBOHEH-E Ke 8e u3eecmu 3a rnpomeHama.
» EdHoHacoueH rpusameH noguk 00 nocmaeka Ha epcka

Ha dupekmHa rnocmaeka:
Hema Oa uma uHOUKauyuja 3a npomMeHama.
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Mpumawe noBuUmn

Bawwuotr MTH800 aBTOMaTCKM ro npuma A0jO0BHUOT MOBUK.

MoHaTamy, JOKONKY € OBO3MOXEH PEXUMOT 3a Bpakare npu
HeakTuBHocT, MTH800 aBTOMaTCKM Ce Bpaka Ha MaTU4YHMOT
eKpaH no NPeknHyBaHETO Ha MOBUKOT.

mPemumom 3a 8paKar-€e rpu HeakmueHoOCM Ke ce 8Ki1y4u

OoKorIKy e KoHgbueypupaH 00 eawiuom dasamerl Ha yciyeau.

Bawwuot MTH800 Be ussecTyBa 3a A40jOOBEH MNOBUK BO
3aBUCHOCT 0/ NnocTaBkaTa LTo cTe ja u3bpane Bo onuuunte
oA MeHuTO 3a Bubpauun (BuaeTe Ha cTpaHuua 149) u Bo
onuuuTe oA MEHUTO 3a TOHOBW (BUAETE Ha cTpaHuua 154).

Mpu ypegyBare nopaka uim KOHTaKT , CO Nn3rarwe HK3
MEHUTO 1 MPOMEHa Ha KoHdurypauujaTta ke buagete
n3BEeCTeHM 3a A0jA0BEH rpyneH/uTeH/npeHecyBaH rpynex
MOBWK, JOKOJIKY TOa € KOH(hUIypMpaHo O CTpaHa Ha BawmoT
JaBarten Ha ycnyru.

HPEBEHTVIBHO noBuKyBame
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[MpeBeHTMBHOTO NOBUKYBake € 0COBEHO BaxHO ako Tpeba
WTHO [a pasroBapaTe CO KOPUCHMK, YMjLLITO TEPMUHAN €
3adpaTeH CO HEUTEH MacOBEH MOBUK.

MpeBeHTMBHMOT NpuopuTeTeH nosuk (PPC) e rpyneH noBuk
npw nTeH cny4aj unun npmeateH PPC (egHoHaco4eH unm
[BOHACOYEH MOBMK).

OBaa ognuka Bu OBO3MOXYyBa Aa ro npeknHeTe TeKOBHUOT
NOBUK CO NMOHU3OK NPMOPUTET KU Aa Ce NPUKNydnTe Ha
,EI,OjD,OBHI/IOT NOBUK CO NOBUCOK NMPUOPUTET.

3a BocnocTtaByBake PPC, Bo ynatcTBoTO 3a ynotpeba
BMAETE BO oadenute yHKLMOHUPae BO PEXNM 3a UTHU
criy4aum v npuBaTeH MOBMUK.



Bawwot MTH800 ro npvma NnoBMKOT NPeKY 3BYYHUKOT MIK
crywarnkara, CorfacHo nocraBskara LUTO ce KOpUCTU Npu
npumareTo Ha PPC.

m&a cuz2Har 3a nosuk, sudeme au rnocmaskume 8o onuyuume
Ha MeHUmo 3a subpauyuu (cmpaHuua 149) u 60 MeHUmMo Ha
moHosu (cmpaHuya 154).

Mpumaneto PPC e ob6jacHeTo BO criegHMTE nacycu.
Bo npukasuTe, <cekoe> Bo ynotpe6a Ce OHECYBa Ha KOj

©1no o HEUTHMTE IMacoBHW NOBULN: TPYMNEH, NPUBATEH,
TenedoHckn unm PABX.

anMal-be rpyneH noBuK 3a UTHU criy4an BO TeK Ha NOBUK

MTH800 ro npuma rpynHMOT NOBUK 32 UTHW Criyvau, ro
NpeKnHyBa TEKOBHUOT HEWUTEH MTAacOBEH MOBWK U Ce
MoBp3yBa Ha rPYMHUOT MOBUK 3a UTHU CIyyau.

|:: N\ | Onuvja3a uren
g d" cnyyaj Bo

ynotpeba

Wpentucmukaumja: fasna
Ipyna 3a pasrosop 1

Onuum

<Cekoe> BO
ynotpeba

npumake npuBateH PPC Bo Tek Ha NOBUK

[lokonky e koHUrypnpaHo of cTpaHa Ha BalIMOT Aasaren
Ha ycnyrn, MTH800 ro npuma PPC, ro npekMHyBa TEKOBHUOT
HEeWTEeH rnmacoBeH NOBWK CO MOHM30K NMPUOPUTET U ce
noBp3yBa Ha NPMBATHWOT MOBWK CO MOBUCOK NPUOPUTET.

PPC co noHn30k nnn eaHakoB NpuopuTeT ke buae npekuHat
6e3 HMKakBa MHAMKaumja 3a NOBMKAHMOT KOPUCHUK U ke buae
BHECEH BO CMMCOKOT CO NPOMYLUTEHN MOBULIN.
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PPC co npnopuTeT Ha NOBKK 3a UTHU Crly4aun, Ha eKpaHoT Ke
ce nojaeu Kako ,UteH cnyuyaj” (HamecTo kako ,[1punoputet®).

NMpumeH eqHoHacoveH npuBateH PPC

[

Mosuk
CnpeveH

<Cekoe> BO I:i) Mpuoputet MpuTicHeTe
ynoTpeba TpuBaTeH NoBMK PTT

Lasvg

2234

NMpumeH pBoHaco4eH npuBaTeH PPC

=]

MoBuk
CnpeveH
<aHumauwja> g>
<Cekoe> BO Ei\) FipvoprTer MputuckHete
/ Kkoe 6uno
ynotpeba Dasug o
2234
Mpvaywu] [ 3ByuHuK

npeHecyBaH NOBUK
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lMpeHecyBaHWOT rpyneH NOBUK

(T.H. WMpoKonojaceH NOBUK) € rpyneH NoBUK
CO BMCOK NpMOpUTET 04 onepaTopoT (unu
AncneyepoT) 40 CUTe KOPUCHULM NoLumpaHm
Ha egHa unu noseke nokauuu. TepmuHanot
€ KOHUrypupaH Ha TOj Ha4MH LUTO ro crieam

é [Mpunoputet

MpvBaTeH NoBMK BO
ynotpeba

[Jlasun

2234

<aHumaumja>

Tpuopuer
[putBareH noBuK B0 yriotpeba
Fasna

I'IpvmyLum[ [ 3BYYHUK

npeHecyBaHNOT NMNOBUK, HO KOPUCHULNTE HE MOXKEe NMOBPaTHO

Oa 36opyBaar.

MoBuKKoT MOXe Aa buae NpMMEeH Kako
HopMarneH NpeHecyBaH MOBUK UM Kako
npeHecyBaH NMOBUK NPV UTHW crny4Yau.

[MpeHecyBaHNOT NOBUK CnpeyvyBa rpyneH
NOBMKK BO TEK CO UCT (MM MOHU30K)
npuopuTer.

Iy

=]

dj Onuvja 3a uTeH
cnyuaj Bo ynotpeba
[asug

[MpeHoc

Onyn_|

3a n3buvpatrbe Ha rpyna 3a pasroBop BO TEK Ha NMpPeHecyBaH
NnoBuK, BUAETE BO ,M30Mpare rpyna” Ha cTpaHuua 49.



3a M3mMeHa Ha narnka BoO Tek Ha NpeHecyBaH NOBWK, BUAETE
BO ,u3bupare nanka” Ha cTpaHuua 52.

AmOuneHTanHo cnywame (AL)

OBaa oanuka, AOKOMKY € OBO3MOXEHA Of, BalLMOT AaBaTen
Ha ycnyru, My oBO3MOXyBa Ha ornepaTopoT (11
AncneyepoT) Aa BocrnocTasn nocebeH noBuk co nocebeH
TepPMWUHan LWTOo Ke M crneau rmacoBHUTE akKTUBHOCTU BO
okonuHarta. lNMoBuKoT ce BocnocTaByBa 6e3 kakBa 6mno
MHAMKauMja KOH 3acerHaTtmoT TepMmMHar U CeKoj TEKOBEH
rnacoBeH NOBMK CO MOHU30K MPUOPUTET UNK TpaHcdep Ha
nakeT co nogartoum ke buae npekuHar.

Mo npudakakeTo Ha NOBUKOT, TEPMUHANOT NpPEHecyBa
efHoHaco4YeH npueaTeH noBuk 6e3 akumja of CTpaHa Ha Unu
UHOMKaumMja 3a KOPUCHUKOT. AMOVEHTaNTHOTO CrnyLuake
aBTOMAaTCKU ke Guae NpekMHaTo Kora KOPUCHUKOT Ke 3arnoyHe
[MacoBEH MOBWK M FO KOPUCTM TEPMUHASIOT HOPMaJTHO.

OTKa)KyBaI'be noBUK

N3BepeTe eaeH oa cnegHUTe HauymHMU, Kako LUTo
€ COOfBETHO:

* [NpuTucHete @ [okonky cakaTe ga BOoCrnocTaBuTe HOB
MOBUK, 3aMOYHETE rO BeAHAaLL.

* noyekajte oaroBop Ha NoBuKOT. OTKaKO Ke ncteye
BpPEMETO MOCTaBEHO 0 AaBaTenoT Ha YCryru, NOBUKaHNOT
Opoj ke Buae npocreneH BO CMCOKOT CO NPOMYyLUTEHU
noBuULMN.

* [lpuTtncHeTe ro nporpamckoTo konye OTdpnu (WTo ce
nojasyBa Npwv A0j40BEH ABOHACOYEH NOBUK). [MOBUKAHMOT
Opoj ke Buae npocreneH BO CMNMCOKOT CO NPOMYLUTEHU
noBuULMN.
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KOpuctemwe oaryinkm BO TeK Ha NOBUK
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uHmMepgoH 3a cs10600HU paye

Oanwvkata 3a MHTepdOH BU OBO3MOXYBa [a
OpXWUTe NMMPOBU3UPAHN COCTAHOLM MPK TereGon 0 et
TenedoHckn, PABX 1 gBOHaco4YHn npvBaTHU Boows
nosuuw.

T

1. 3a akTnBMpawe Ha MHTepoHOT
nputucHeTe 3BYYHUK. Ha ekpaHOT ce nojaByBa 3BYy4HUK
BUCOKO HMUBO.

2. lMocTtaeete ro BawmoTr MTH800 Ha 30 go 60 cm og Bac. Bo
Oy4Ha cpegmHa, noctasete ro Bawmnotr MTH800 nobnucky
[0 Bac 3a nogobap npeHoc.

3. 3a geakTuBMpame Ha MHTEPOH, NpUTUCHeTe Cnylwanka.
Ha ekpaHoT ce nojaBysa 3By4yHuk HUCKO HUBO.

<aHumaLmja>

Mpudywyeawe/omkaxyeame Ha npudyuwyeaH-emo Ha
30JIHUOM MUKPOGHOH

Bo Tek Ha TenedoHcku, PABX nnun gBoHacoyeH npusarteH
MOBUK, KOPUCTETE ja oAnMKaTa 3a npuaylyBame 3a:

* 3a4pXXyBare Ha pa3roBopoT 6e3 fa bugete cnywHaTtu og
CTpaHa Ha NOoBUKYBa4oT

* 3a NpuayLyBake Ha MOXXHW 3BYLIM Of Nno3agnHa BO
BaLlaTa obnact

1. MputucHete NMpuaywun. Ha ekpaHoT ce nojaByBa
MpuaywyBareTo eBKy4YeHO. MUKPODOHOT e
npuayweH. Moxe ga ro cnywarte A0jA0BHUOT 3BYK, HO
NMOBUKYBA4OT HE MOXe Aa CryLUHe roBop o4 BaLUMoT
MTHS800.

2. 3a pa 3bopysate npuTncHeTe OTKaxu npuaylwyBamwe. Ha
eKpaHoT ce nojasysa MpuaywysaweTto e UCKIy4YeHoO.
MWKpOOHOT e BKIy4eH.



Pexum 3a npukpuBame

AkO BalIMOT Aaeaten Ha yCcryru ro KoHdurypmpan pexmMmoT
3a NpuKpMBame, NCTMOT BU OBO3MOXYBA LIENOCHO Aa '
WCKINyYnTE CUTE BUAMMBU U 3BYYHWN CUTHANN N M3BECTYBaHa
Ha MTP850. Osaa oanuka ro npasn MTP850 edunkacHo
He3abenexnue, oypu 1 BO TMBKa U TEMHA cpeauHa.

3a Bnes Bo PEXUMOT 3a NpUKpuBaHe€:

* MpuTnCHETE ro KONYETO CO eeH AONUP 3a PEXUM 3a
NpuKpuBame (JOKOSKY € NporpaMmpaHo of cTpaHa Ha
BaLUMOT AaBaten Ha ycryru).

* N3bepeTe ro pexxmmoT 3a NpuKpuBake BO MEHWUTO 3a
©e3benHocT (BUaeTe BO ,Pexnm 3a npukpmBawe” Ha
cTpaHuua 148).

Bu1COK/HU30K 3BYK BO PEXUM 3a MPUKPUBAH-E:

* [IOKOMKY HUTY efieH of AONOMHUTENHUTE NpuBopn He
€ NoBp3aH CO PaamoTo, He € OBO3MOXEHO
np1cnocobyBaHeTo Ha BUCOK/HU3OK 3BYK.

* HapBopewHara cnywanka/PHF e noBp3aHa - co
npuUTUCKaHe Ha KOMYeETO 3a npedpriakbe o4 BUCOK Ha
HWM30K 3BYK, 3BYYHMOT PEXUM Cce npedpria o4 BHaTpeLleH
MUKpodpoH/BHaTpelUHa cnywanka Ha PHF-mukpodoH/
PHF-cnywanka

* [loBp3aHa e camo PHF-cnywankaTta - co nputnckarwe Ha
Kon4yeTo 3a npedprabe of BUCOK Ha HA30K 3BYK, 3BYYHMOT
pexum ce npedpria o BHaTpeLleH MUKPOdOH/BHATpELLHA
cnywanka Ha ropeH mukpodoH/PHF-cnywanka.
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INokanHa ycnyra

OBOj pexum yLuTe ce HapeKyBa U CUrypHOCEH NOBUK

1 0BO3MOXXYBa MoBeKke TepMuHanu of uctarta rnokauuja

[a KOMyHMLMpaaT Kora Bpckata Mefy fnokauujata u
LieHTparnH1OT KOHTPOIOpP Ha MpexaTa e HeycrneluHa. Bnesor
BO M M3nes30T o NokanHara ycnyra (ogHOCHO, Bpakatse Ha
CMCTEMCKU LIMPOKOMOjacHM yCcryrn) ce BpLUX aBTOMATCKMU.

m OSOj PEeXUM MOXXe 0a 20 OHEBO3MOXU 8awLuom Gagamer Ha
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yecnyeu.

eJie3 80 JIoKaslHa ycnyeaa
Kora MTH800 npuma nHaukaumja 3a nokanHa ycrnyra og
CUCTEMOT, Ke ce NojaBu CriegHoTo:

* MTHB800 ornacyBa TOH.

* Ha ekpaHoT ce nojaByBa nopaka 3a ,fokarnHa ycnyra“.

* VIKoHUTe Ha ekpaHOT 1 NPOrpaMckuTe Kon4Yuka ke ctaHat
3eneHu.

+ CeKoj NoBuMK BO TeK ke Guae NpekvHaT co BreryBaketo BO
PEXMMOT 3a riokarnHa ycnyra.

[okonky e koHbUrypnpaHo of, BalLMOT AaBaTen Ha ycnyru,

OBaa nopaka/curHan noBpeMeHo ke ce NOBTOPYBa 3a Aa Be

notcetn geka MTH800 cé ywTe dyHKUMOHMPA BO pPeXUM 3a
rnokanHa ycnyra.

Bo pexwum 3a nokanHa ycnyra 4OCTanHu ce cregHuTe
oanukm 3a sawmot MTH800:

* Pernctpauuija

* MNpuKayvyBahe

* rpyneH NOBUK

* MOBWK 3a UTHU Cnyyam

* anapm 3a UTeH Crny4aj



U3zne3 od nokanHama ycnyaa

Kora BpckaTa Co KOHTPONOPOT Ha LUeHTparnHarta Mmpexa ke
Oouae noBTOpHO BocnocTtaBeHa, MTH800 uaneryea of
rnloKkanHara ycrnyra v ce rnojaByBa CrieqHoTO:

* MTH800 ornacyBsa ToH

* CeKoj NMOBWK BO Tek ke Buae NpekuHaT npu pexxunm 3a
nokarHa ycnyra.

MakeT co nogaTouun

Ycnyrata 3a nakeT co nogatoum (PD) B 0Bo3MOXyBa Aa
npeHecysate nogatoum Bo TETRA-cuctem co kopucterwe
NHTepHeT npoTokon (IP). lNMpoBepeTe kaj BalwMOT AaBartesn Ha
ycrnyru 3a focTtanHocTa Ha oBaa oanuka.
3a npeHoc Ha nodamouyu 00 cmaHdapdeH KoMrijymep rpeky
m b6e3xuyHa epcka
rosp3eme 20 KOMIjymepom co akmugeH rnodamoydeH kaben
FKN4897 co sawuom MTHB800. Bawuom dasamern Ha
ycnyeu mpeba 0a nocmaesu 00rnoHUMeHU arnukayuu Ha
gawiuom Komrjymep.
[okornky e noctaBeHO oA BalLMOT JasaTen Ha ycnyru,
NPEeHOCOT MOXe Aa ce 3abp3a CO KOpUCTEHE Ha ycnyrata
noeeKekpaTeH naket co nogatoun (MSPD) (Buaete BO
.[1aket co nogatoun” Ha cTpaHuua 187).
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TMO-rpyneH noBuK

OnwTo

pyneH NoBUK € MHCTaHTHa KOMYHMKaLunja Mery Bac

n gpyruTe Bo nsbpaHaTa rpyna 3a pasroBop. YyecHuumte
Moxe (nogouHa) ga ce npugpyxar v aa ro Hanywrat
TEKOBHWOT rpyneH noBuk. [pynaTa 3a pa3roBop € NpeTxogHo
AeduHnpaHa rpyna Ha nNpeTnnaTHULM LWTO MOXe Aa
y4yecTByBa BO U/vnuv Aa NOTTUKHE rpyrneH NOBUK, MOCTaBEH 0f
BaLUMOT Aasarten Ha ycnyru.

lpynuTe 3a pas3roBop Ha BaLLMOT eKpaH ce nojaByBaaT Kako
umMmtba nunun 6poesu (Ha npumep: npoaaxba, cepsuc,
enekTpuyapw, rpyna 3a pasrosop10).

MpynuTe 3a pa3roBop Moxe Aa Guaat nodeneHy Bo noBeke
nanku. Cekoja nanka Moxe [Aa CoapXXu HEKONKY rpynu 3a
pa3roBop.

3a nonecHa ynoTpeba, Bawmor MTH800 ucto Taka
OBO3MOXYBa:

* Oa BpwuTe npebapyBare Ha NCeBAOHNUMUTE Ha rpynuTe
3a pasrosop Mo asbyyeH ped. Aa nuarate HW3 LenvoT
CNM1COK CO rpynu 3a pasrosop.

« OpraHusupajte rv BawmTe rpyny Bo Tpy nanku
(cTaHgoapaHWOT Has3uB 3a nNpeaTta oMmurieHa nanka e Mowu
rpynu, KojawTo e nocTtaBeHa of BawWoT AasaTten Ha
ycnyru).

BawmwuTe rpynu 3a pa3roBop MOxe Aa ce opraHuanpaar BoO

cnucoum 3a CKeHupame (NocTaBeHn of BaWMOT gaBaTten Ha

ycnyru, Unu og Bac npeky meHuTto). Kora ke aktusumpare
€0€eH o OBME CMMCoLM 3a CKeHupare, Bawmor MTH800

KOHTUHYMpaHO Ke v CrieAu akTMBHOCTUTE Ha nsbpaHute

rpynu 3a pasroBsop.
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Co foaenyBakeTo NpUOpUTETM Ha rpynuTe 3a pas3roBop
YyTBPAEHM BO CMIMCOKOT 3a CKeHUpawe, ke MmaTe MOXHOCT
3a NpuMarbe NoBULIM CO MOrofieM NPUOPUTET OTKOIKY
TEKOBHMOT MOBMUK.

ogeTe 0 rpyna 3a pasroBop, nanka uimn CKeHmpawe Ha
M360pOT Kora TepMuHanoT € BO peXum Ha MmpyBaH-e.

Co nputuckare Ha PTT Bo TekoT Ha u3bop Ha rpyna Ha
pa3roBop ce npedpna Ha Hosa rpyna v 3ano4YHyBa MOBUK.

Cekoja rpyna 3a pa3roBop MOXe Aa nma eaHa noBp3aHa
rpyna 3a pasroBop 3a HajaBa (ATG) wTo ja cneau (ako
€ MoCTaBeHO o BalIMOT AaBaTen Ha ycrnyru).

ATG e nocebHa rpyna noBp3aHa Co HEKOSKY rpynu 3a

pasroBop U MMa HMBO Ha HajBUCOK NPUOPUTET, CO LUTO

OBO3MOXyBa NPEHOC Ha NOBMKOT 4O CUTE TUe rpyni 3a
pasroBop.

Kora e nsbpaHa ATG, He e npukaxkaHa MkoHaTa 3a
ckeHunpare. Bawmnotr MTH800 ro cnegun cnMcokoT 3a
ckeHupare Ha ATG HamecTo Ha U3bpaHMOT CNNCoK 3a
CKeHunpare. CnmMcokoT 3a ckeHmpahe Ha ATG v coapxu
CuTe rpynu 3a pasroBop noBp3aHu co n3bpaHarta ATG.
Bawwmot gaBaten Ha ycnyru Tpeba fa Be U3BECTU KOU Ipymnu
3a pas3roBop ce NOBP3aHM CO Koja M3BECTYBayKa rpyna 3a
pasroBop.

Bawwuot MTH800 cekorawu ke rv cnegu rpynHnuTe noBuLm Bo
CMMCOKOT 3a ckeHupare Ha ATG. 3a ga BocrnoctaBuTe NoBuK
3a M3BecTyBame, Copes ynarcTeara Ha BalLMOT JaBaTern Ha
ycnyri npeo Mopa Aa ja n3beperte ussecTtyBadkara rpyna 3a
pasroBop, BO CMPOTMBHO Ke MOXe Aa y4yecTByBaTe camo npu
nNpvemMoT Ha U3BecTyBaYka rpyna 3a pasrosop.

AKTMBUPaAHETO N AeaKTMBUPAHETO Ha CKEHMPAHETO 3a
rpyna 3a pa3roBOp He Brnujae Bp3 CMIUCOKOT 3a CKEHUpaHe
Ha ATG.

Oanuka 3a ABoeH MUKPOOH
Bugete Bo ,HauunH Ha gpxewe HAMTHB800” Ha cTpaHuua 17.
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n3bupame rpyna

Moxe na nsbepete rpyna 3a pa3roBsop Ha efjeH o4 crnegHuee
Ha4nHN, CO KOPUCTEHE Ha!

Korn4ye 3a poTupake
Konye 3a HaBuraumja
npebapyBatrse no a3byyeH pea
npeGapyBare Mo nanku

BHecyBatbe Npeky HymepuykaTta TactaTypa — 6p3o
Guparse (ako e KOHUryprpaHo oa BalLMOT gaBaTen Ha

ycnyru)

3a koHdurypaumjaTa 3a nusrawse no rpynu, BuaeTe
cTpaHuua 53.
mKoea ce 0suXXume HU3 OMuIeHUme narku u u36epeme

DMO-epyna, sawuom mepmuHarn Ke ee npegpnia mery TMO
u DMO (u obpamHo).

Kopuctewe Ha KOon4yeTo 3a poTupame
(ako e KOHGUrypMpaHo of BalIMOT Aasarten Ha ycryru)
Op, MaTUYHMOT ekpaH KpaTKo NPUTUCHETE Ha KOMYETO 3a
poTupake 1 poTupajTe cé goaeka He ce nojasm bapaHata
rpyna.
Ce nojaByBa nsbop Ha rpynu:
* MO OOpeaeH nepuos
* Co nputuckane Ha N3bepun (Qokonky € KoHurypmpaHo

o[, CTpaHa Ha AaBaTenoT Ha ycnyru)

» Co nputuckame Ha PTT

Kopucterwe Ha KonyeTo 3a HaBuraumja

Opf MaTUYHWOT ekpaH nnarajTe HaneBo MM HaJeCHo Ce
poneka He ce nojaesu 6apaHara rpyna. MNotoa npuTncHeTe
U36epwm 3a notepaa Ha n3bopoT. Co nputuckamwe Ha PTT
rpynata UcTo Taka Ke ce usbepe aBTomaTtcku 1 ke ce 3arnodHe
NPEHOCOT.
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KopucTeHe Ha NnpebapyBakeTo No a3byyeH pea

Oa matnyHmnoT ekpaH nputucHete Onumun. N3bepete rpyna
npeky npebapysatse no a3dyyeH peg (,I'P no a3byyeH pea’).
Moxe foa BHeceTe HajMHory 12 3HauW, KOMLWITO AOAeKa M
BHecyBaTe ce NpuKaxyBaaT Ha HOTO Ha ekpaHoT. Ke ce
WCTakHe Ha3nBOT Ha Hajbrnuckarta rpyna 3a pasroBop.
MputucHete U36epu 3a fa BneseTe BO rpynara.

KopucTewe npebapyBate No nanka

Op maTU4HKOT ekpaH npuTncHeTe Onuun. N3bepete rpyna
co npebapysare no narnka (,I'P no nanka “). N36epete
Ha3uB Ha nanka u n3bepeTe rpyna.

lpu npebapysar-e rno a3byyeH ped u ro narka He ce
MHaseOyeaam dynnupaHume Hasusu. AKO KOPUCHUKOM

usbepe epyna wmo e noyupaHa 80 rnogexke o0 edHa narika,
paduomo ja u3bupa OHaa WMo e npuopumemHa criopeo:
1. mekosHama narka

2. Mamu4yHama narka Ha meKosHama narika
3. cmaHOapOHama narka 3a epyrna 3a pa3zoeop Wmo
e degpuHupaHa 00 Oasamesiom Ha ycrlyzama.

KOpUCTeH€e Ha HyMepu4kaTa TactaTtypa — 6p3o bupamwe

Op MaTUYHMOT ekpaH MoXe aa bupaTe rpyna co BHeCyBae
Ha 6pojoT 3a Op30 Bupare npeky Tactatyparta. OBaa oanuka
ce HapekyBa 6p30 Gupat-e Ha rpyna 3a pasroBop. bpojoT 3a
6p30 Brpare € NPeTXoAHO KOHMUIypUpaH BO TEPMUHATOT.
Moxe pa ro Bugute 6pojoTt 3a 6p30 Gupare HasHayeH Ha
ofpeneHa rpyna, AOKOMKY UCTMOT NOCTOMW.

npeaned Ha 6pojom 3a 6p30 6upaH-e
1. Og MaTUYHMOT ekpaH nNpuTucHeTe Onuun.

2. N3beperTe: e
_
+ I'P no nanka notoa nsbepete nanka - VisGepy rpyna
. pyna 3a pasroop1
M UCTakKHETE Ja cooABETHATA rpyna 3a Tpyna 3a pasrosop2
Ipyna 3a pasroBop3
PasroBop. Ipyna 3a pasroBop4
* TP no a36yqu peAa n notoa NCTakHeTe o Visgepn [EI]_ Feean

Ha3nBOT Ha cooaBeTHaTa nanka
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3. MNpuTuCHeTe [uee),

4. N36epeTe MNpernea 3a ga ro sBuguTe 6pojoT
3a 6p30 Bupare Ha rpynaTa 3a pasroBop.
Bo oBoj npumep, ,82“ e 6pojoT 3a 6p30
oupame. MNMputucHete Hasag 3a ga ce
BpaTWUTE Ha NPMKa30T Ha NpukaveHara
rpyna.

6p30 6upame 6poj
1. BHeceTe 6poj (Ha npumep: “82”).
2. MNpuTucHete Go.

3. MpuTtncHete Mpukaum 3a ga npukadnTe
HOBa rpyna unv NpUTUCHETE ro Kon4eTo 3a
PTT 3a ga npukauute rpyna v aa ja
noBukare.

Ll >

MeHu Ha cncokoT

Mpernen

W3bepun [E” Hasap

Ll [
Tpyna 3a pasrosop 2
706002
MNanka 3
Bpoj 3a 6p3o
Guparse 82*

Vabepu| [ Hasag

ﬁ MpvBaTeH
6p.:

g va M1 [ WsGpuum
Ll [
Bpoj 3a 6p3o bupatbe 82

Ipyna 3a pasrosop2
706002
Manka3

Mpukawn | | Hasan

N360p Ha rpyna co KOpucTewe Ha Konymwa 3a
HaBurauuja/npeb6apyBare no a3dby4eH pea/no nanku

Moxe HenpeyeHo aa usbepeTe nanka co rpynu npu

npnmMmaHl-€ 1 BO TeK Ha NOBUK.
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N36uparse rpyna npu npumare NoBuK

Ako nsbepeTte rpyna npu 4ojooOBEH NOBUK, EKPAHOT Ha
MTHB800 octaHyBa HENPOMEHET 3a BpeMe Ha NOBUKOT.

3a Bpeme Ha n3bopoT He MOXe Aa Buaute nHdopmauum 3a
noBuKyBayoT. [NMpuTncHeTe OTKaXM Kora rm Kopucture
KonuuhaTa 3a HaBurauuvja Hasapg kora kopuctute
npebapyBare Mo a3dby4eH peg/nanka n NoToa Ha eKpaHoT ce
nojaesyea MHGOpPMaLKja 3a CTpaHaTa LUTO NOBUKYBaA ,
[OOKOJKY CTe C€ yLuTe BO TEK Ha MOBUK.

Bupar-emo npekuHysa Koza ce rpuma rnosuK 3a UmHu
m cry4au u Ha ekpaHom ce rojasysa ,Pexum 3a UmHu criydau
80 yrnompeba“,

n3bupame rpyna Bo Tek Ha NOBUK

AKo 3anoYHeTe a u3bupare rpyna 3a BpeMe Ha NoBUK,
npuka3oT Mpyna Bo ynoTpe6a unv Onuuja 3a MTHU cnyvau
BO ynotpeba ncyesHyBa.

3a BpemMe Ha n3bopoT He MOXe Aa Buaute nHdopmaumm 3a
noBukyBayoT. MpuTncHeTe OTKaXM Kora rm KopucTure
Kon4ymkata 3a HaBurauuja n Hasap kora kopucTute
npebapyBare No a3byyeH pea/nanka u NoToa Ha ekpaHoT
NOBTOPHO Ce MnojaByBa MHGOPMaLuja 3a cTpaHaTa LTO
MOBUKYBa , AOKOSKY CTe CE yLUTe BO TEK Ha NOBUK.

n3bupamwe nanka

Opa matuyHmnoT ekpaH nputucHete Onumun. N36epete Manka
n nsbepeTe ja cakaHaTta nanka. Ha ekpaHoT ce nojaByBa
nocnefHo nsbpaHata rpyna Bo Taa narnka, no u3bopot Ha
nankara Ha rpyna.

nanku ,,Mou rpynmu*“

Moxe ga rm opraHn3unpare salinTe OMUJIeHU rpynu Bo Tpun
nanku.

N3bupare Ha nankaTa co Mou rpynu

Op MaTUYHMOT ekpaH NPUTUCHETE @ 3a 6p3 npuctan go
nankara.
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HopaBamwe/6puierse rpynu

3a noseke nHdopmauuu, suaete ,Mou rpynu (TMO/DMO)”
Ha cTpaHuua 173.

KoHdurypauuja 3a nusrarwe no rpynu

BawwmoT gaBarten Ha ycryrm Ha CregHMOT HaunH MoXe Aa ro
KOHOMryprpa nmaraketo Co Konye 3a poTupame UM Konye
3a Hasurauuja:

 Jlusrajre go cnepgHata nanka — Kora ke CTUrHeTe o
KpajoT Ha nankaTta npv nNu3rakeTo HU3 rpynuTe,
nn3rakeTO NOHaTamy NpeMrHyBa Ha CMIMCOKOT CO rpynu
BO HapegHaTa nanka.

Ha npumep: Npynute 11 n 12 ce Haoraat Bo nankara 1.
Ipynute 21 1 22 ce Haoraart Bo nankarta 2. 3a Bpeme Ha
nuaraweTo Ke ce nojasart rpynute 11, 12, 21 n 22.

nnn

+ OcTaHeTe BO namnkaTa — Kora Ke CTUrHeTe [0 KpajoT Ha
nankaTa npu Nu3rakeTo HXU3 rpynnuTe, HaTaMOLLHOTO
nu3rakbe ro pectapTvpa CnnCcOKOT CO Fpynu BO nankara.
3a foa npeMuHeTe Ha criegHaTta nanka, Tpeba aa ja
n3bepete.

Ha npumep: Npynute 11 n 12 ce Haofaat Bo nankaTta 1.
lpynuTe 21 n 22 ce Haoraat Bo nankarta 2. N3beperte ja
nankaTa 1: 3a BpeMe Ha nu3raweTo Ke ce nojasart rpynure
11, 12, 11 n 12. NpemunHeTe Ha nanka 2: 3a BpemMe Ha
nunsraweTo Ke ce nojaeat rpynute 21, 22, 21 n 22.

JononHutenHo, BaWwWMOT faBaTten Ha ycryru Moxe Aa ro
KOHUrypmpa Kon4yeTo 3a poTMpare Ha CregHNOT HaunH:

* MMpekMHyBake-3acTaHyBake Ha JIN3rakeTo co
KOM4YeTo 3a poTUpame — KOM4YETO 3a poTUpame ke
3acTaHe Kora ke CTUrHe o nocrnegHara rpyna Bo nankara
W Ke ce ornmacu curHan Koj ke Be U3BecTu feka cTe
CTUrHane go nocriegHaTa rpyna Bo nankara. Kopucrete ro
KOM4YeTo 3a HaBurauuvja 3a fa npogornkiTe Aa nuarate Hu3
CMNCOKOT.
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aKTMBUpake/AeakTUBMpame Ha CKEHUPaHEeTo

Bugete Bo ,[locTaByBate ckeHMpare Ha rpyna’ Ha
cTpaHuua 168.

BocnocTtaByBame rpyneH noBuk

1. N3beperte ja GapaHaTa rpyna 3a pasroBop =
N 04 MaTUYHUOT eKpaH NPUTUCHETE Mpexa 1
n nsbepete PTT. fanka 1
onuuuja
3apaBo

Onunn_[F=)[KoHTakTm

2. No4ekajTe ro TOHOT 3a A03BOMNa 3a
pasroBop (ako e KoHdUrypupaH) u notoa
360pyBajTe BO MUKpOdoHOT. OThnyLUTETE IO E)

ynotpeba

konyeto PTT 3a ga cnyware. Manc

Kora ke 3ano4HeTe NOBWK, CUTE YNIEHOBM Ha Ongmn | [ Tiania
nsbpaHata rpyna, Ha KOULLITO UM ce
BKIyYeHW egnHuumnTe, Ke gobujaT rpyneH nosuk.
lNopakama ,Hema epyna“ ce nojasysa koea cme Hadgop 00
mwnacma CO HopMarsiHa MoKpueHocm Ha eawama u3bpaHa

epyna. [Tomoa mopa da uzbepeme Hosa epyrna wmo Ke
bude saxeuka 3a eawama pabomHa fokauyuja.

mﬂOKOﬂKy cme 80 meK Ha epyreH rosukK, a cakame 0a
s8ocriocmasume Hos8 108Uk, npumucHeme (o) 3a 0a 20

UsHopupame meKoeHUoOm rnosuk. 3ano4yHeme 20 Hoguom
MOBUK.

MEupaHse Ha epyna 3a pa32080p o UHOeKc — ogaa 00nuKa ce
Kopucmu 3a 6p30 buparse Ha epynu. QyHKYUOHUpPa CO
npumuckare Ha uHdekcom Ha I'P u * Ha kpajom.

anMaI-be rpyneH noBUK

OonwTo

[okonky He e aHraxupaH co nosuk, sawmor MTH800 ke
npvmMu rpyneH nosuk. 3a ga 3bopyeaTte, NPUTUCHETE O
n 3agpxete ro kon4yeto 3a PTT.
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Bawwnotr MTHB800 ro nokaxkyBa Ha3uBOT Ha rpynara

N NpMBaTHUOT BPOj Ha NMOBMKYBAYOT UMW NCEBOOHUMOT,
[OOKOIKY € NPeTXo4HO 3a4yBaH BO BaLUMOT CMMCOK CO
KOHTaKTH.

CnepyBaart npyMepwu 3a HAYMHOT Ha KOj MOXe a ce NpuKaxe
NMOEeHTUTETOT Ha noBuKyBayoT (ID 124) Ha ekpaHOT.

npvBateH 6poj 3a ugeHTngukaumja
6e3 nceBaoHUM

E!j Ipyna go ynotpeba

=I| Bpoj3a
naeHTUdMKaLmja: Ipyna go ynotpeba
124 nnn VIMe Ha KoHTaKT
P4 P4

Onuun MNanka

Onuumn l l MNanka

npviBateH 6poj 3a naeHTuduKaumja
CO NCeBAOHNM

3a cueHan 3a dojodoseH nosuk, sudeme 2u nocmaskume 80
onyuume Ha MeHuUmo 3a eubpauuu (cmpaHuua 149) u 6o
MeHUmo Ha moHosu (cmpaHuya 154).

Cekoj 0oj0oseH epyreH NosuK cekoaaw ce npuma rnpexy
251asHUo0m 38y4HUK. [JOKOIKy e KoHgbuaypupaHa 00 sawuom
Odasamert Ha ycrlyaama, cmaekama Ha MeHUImo 3a 38yK Ha
epynama o803mMoxysa 0a ce rnocmasu 38yKom Ha
0oj0o8HUOM 2pyreH ro8UK.

AKo nocmasysar-emo e co KOHmMpPOsa Ha 38y4YHUKOM, MOXe
da 20 Haco4yume 38yKom Ha e0Ha akmueHa 2pyna 6o
criywarnkama (HU30K 38yK) Usu 251la8HUOM 38YYHUK (8UCOK
38yK). [pu HU30K 38yK 360pys8ajme 80 OOHUOM MUKPOGOH
u criywajme nipeky crywarskama. [lpu 8ucok 38yk
360pysajme 80 20pHUOM MUKPOGOH U crywajme npexy
38YYHUKOM.

Ha kpajom Ha nosukom Koj 6un Haco4YeH KOH criywasnkama
ce akmusupa majMmep 3a rNpekuHysar-e Ha 38yKom, OOKOJIKY
e 0803MOXKeH 00 sawuom Oasamen Ha ycrly2ama. Bo pamku
Ha rpemxodHO Npo2pamupaHoOmo epeme 3a MpeKUHy8aHe,
cume 00jO08HU 108UYU C€ ywime ce rnpumaam rpeKy
cnywankama. [lo ucmekom Ha epememo, ce oanacysea
HU30K MOH Kof 8e uzsecmysa 0eka HapeOHuUom 0oj0oseH
epyneH nosuk Ke bude npumeH npeky 38y4yHuUkom. Omkako
Ke 20 criywHeme 080j cueHarl, Opxeme 20 mepMUHaom Ha
008071HO pacmojaHue 00 38y4YHUKOM.

Koeza npumame epyrieH rnosuk, Ke crywHeme moH 3a ,H08
epyrneH nosuk” (ako e KoHguaypupaH 00 eawuom dasamern
Ha ycnyau).
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npumMame rpyneH noBMK co eKpaH BO MnpyBamwe
N UCKNYY4eHO CKeHunpamwe

Moxe aa npumuTe rpyneH NoBuUK eaNHCTBEHO
of usbpaHata rpyna 3a pasroBop unm
nosp3aHarta ATG.

Bawwunot MTH800 ke ro npumun rpynHUoT
MOBUK.

npumare rpyneH NoBUK CO eKpaH BO
MUpYBaH€e U BKIyYE€HO CKeHUpaHwe

56

Co BKITy4€HO CKEHMpaHE, OCBEH LUTO MOXETE
Ja npyMuTe rpyneH NnoBuK of nsbpaHata
rpyna 3a pasroBop vunu o noepaaHata ATG,
MOXXe Aa NPMMUTE TpyneH NOBUK U Of
CMMCOKOT 3a CKeHMpare LITO CTe o
nocTasuse.

d = |ynotpe6a
P4
Naentudmkau,
vja: dasug

Onum | [ Tlanka|

Ij = [Fpyna eo

= lynotpeba
P4
Waentudmkau,
vja: Jasupa,

Ongwn | [Mpexwtn

[MprMeMOoT Ha cKeHMpaH-eTO OYHKLMOHMPA KaKo NpuMane
Ha nosp3aHaTta ATG unu nsbpaH NoOBUK NP UCKIyYEHO
CKEHVpaHe € MOXeH, CO UCKINY4OK Ha CregHoTo:

+ TepMUMHanoT orfacyBa TOH KaKo LTo e 06jacHeTo BO

3abenelukaTa BO npoaosimkeHune.

» Koea npumame 2pyneH rnosuk co 8UCOK npuopumem, Ke
CrlywHeme mMoH 3a ,epyreH nosuK co 8UCOK npuopumem*

(ako e KoHgbuaypupaH 00 sawuom dasamer Ha ycriyau).
» Koea npumame epyneH nosuk 00 eawuom crucok 3a
CKeHUpaH-e, Kojuimo He e 00 epyra co 8UCOK
npuopumem, Ke criylwuHeme MmMoH 3a ,HO8 epyrneH rnosuk™
(ako e KoHuaypupaH 00 sawuom dagamers Ha ycryau).

» 3a ga brniokuparte npuem Ha rpyneH rnoBsuk, n3dbepete
Onuuun notoa Bnokupaj. Co ucknyyyBare/BknyyyBamwe
Ha TepMUHanoT MoXe Aa ce oabrnokupa NnpuemMoT Ha OBOj

rpyneH noBuK.

«



anMal-be rpyneH noBUK nNpu TeKOBeH rpyneH noBuK

Bo 3aBMCHOCT 0 HA4YMHOT Ha KOj AaBaTenoT Ha YCyrn
nma KoHUrypmpaHo LOjA0BHUTE NOBULM, A40jO0BHUOT NOBUK
MoXe Aa oupe:

* HaMeTHaT U Aa ro NpekMHe TEeKOBHWNOT MOBUK (OOKOSKY
[A0jOOBHUNOT MOBUK MMa NMOBUCOK NPUOPUTET Of
TEKOBHMOT).

%

* lMpukaxaH (ZOKOMNKY MMa NoBUCOK

NPUOPUTET Of, TEKOBHMOT NOBMUK).

EE

» 3a ga ro npudaTtnte NOBUKOT, oyna 50
nputucHeTe Mpuknyun ce. ynotpeta

+ 3a Ja ro oTkaxeTe NOBUKOT, NpUTUCHeTe  [Mewywl [ Mpex
MpeknHn.

npumare rpyrneH noBuK 3a UTHU criyyau
3a noBeke nHdopmauuu, BUaeTe BO cTpaHuua 39.

Mpumare npeHecyBaH NOBUK
3a noBeke nHopmauuu, BuaeTe Bo ctpaHuua 40.

CnpeyyBaHe Ha NpeHocC
Moxke foa ro akTuBMpare pexXuMoT 3a CnpevyBakbe Ha NPeHoc
(TXI) npen noa Briesete BO 06nacT YyBCTBUTENHA Ha P®, Ha
np. BoO 60onHMUM unu obnacTtn BO KOU MMa ONacHOCT 04
ekcnnosuja, kage pagujaumjata og npeHocot Ha MTH800
MOXe [a ja 3arpo3n 6e3begHocTa.
mPaOujauujama Ha MTH800 ce Hamarysa camo ako

e akmusupaH TXI-pexumom unu ako MTH800 He
€ MPUKIy4eH 80 cmpyja.

Kora e Bo TXI-pexum, Bawmotr MTH800 Hema aa BpLumn
NMPEHOC OCBEH MpU MOBUK 3a UTHW ClNy4aun, KOj MOXe aa ce
3anoyHe aypu ako MTHB800 e Bo TXI-pexum.
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Cute dpyHKumm n kondmwa Ha MTH800 co koumwTo ce
WHMLMpa NpeHoc, Ha Np. perncTpauuja BO MpexarTa,
npoMeHa Ha rpyna 3a pa3roBop Wnu narka, ucnpakame
nopaku, nputuckarwe PTT uUTH, ce oHeBO3MOXeHN. Bo 0BOj
Cny4yaj Ha ekpaHoT ce nojasysa ,He e nossoneHo Bo TXI-
pexum* n MTH800 ornacysa ToH 3a ,cnpeyyBare npeHoc.

Kora noBeke Hema onacHocT no 6e3beaHocTta (Ha npumep
[OOKOIKY ja HanywTuTe obnacra 4yyBcteBuTenHa Ha P®) TXI-
pexunmoT Moxe Aa ce aeaktusupa u sawmotr MTH800 ce
Bpaka BO pexvM Ha cTaHaapaHa pabora.

MocTtaByBaweTo Ha TXI-peXnMoT € onuLaHo BO
. 10CTaByBah€e Ha PeXMMOT 3a cnpedysare npeHoc (TXI)”
Ha cTpaHuua 186.

MopTokanosuoT noctojaH LED-uHaukatop nokaxysa aeka
€ aKTUBMpaHO CnpeYyBaHeTO Ha NPEHOCOT 1 Mery aBaTa
eKpaHu Tpenkaar:

ot i‘ TXI-pexum
n;;;::cj)a |:> TXI-pexum :> I'll-loEJl'lr:AKLTm;a
AKTUBMpaH bkions
Onywn[FEI[_Kowaw e

OuHaMmunyko Ha3HauyyBawe 6poj Ha rpyna (DGNA)

DGNA my 0BO3MOXyBa Ha MPEXHMOT onepaTop unu
OBMACTEHUOT KOPUCHUK AMHAMUYKM Aa Ha3HadvyBa HOBM UMK
a rv axypupa nocTojHUTe rpynu 3a pasroBop co u3bpaHute
TepMuHanu npeky 6eaxumyHa meryspcka. Co Kopuctere Ha
JononHuTenHn nopaku 3a yenyru (SS-DGNA) mpexHuoT
oneparop Moxe [a My Jafe KoMaH4a Ha BaluMOT TepMuHan
Ja fogane rpynu 3a pasroBop Unu aa rm axypupa
MOCTOjHUTE rPyNy 3a pa3roBop MIu Aa n3bpwiie rpynu 3a
pasroBop of cnncokoT. OBaa onepavuja ce BpLIM CO NPEHOC
Ha nopgatoumTe go Bawmot MTHS800.
Bawuom dasamen Ha ycriyau moxe 0a cobepe HEKOIKY epyrnu
m&’ﬂ pa32oe0p 80 e0Ha cyrnep-gpyna u 0a ja npeHece 00 8awiLoM

MTH800 kako DGNA. Bo moj criyyaj, ke moxe da y4ecmeysame
80 rosuyu 0o/00 cume 2pyru 80 cyrep-epynama.
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npvem Ha DGNA co nopaka 3a usBectyBamwe

Kora ce npuma DGNA nopaka u
nssectyBareTo 3a DGNA e KOHq)MrprpaHo EZﬁ?fo,ap
o[ BalUMOT faBaTen Ha ycnyru, ke ce ornacu cnvcok
TOH 1 Nnopaka 3a ussecTysame (,CnucokoT arypiparee
CO rpynu 3a pasroBop ce axypupa “),

a notoa ke bupgar NpUKa>kaHn HOBUTE Ha3dHa4dyBaH-a.

Moxe fa rv KopucTuTe NporpaMcKuTe
konuniba Mpernea, Mpukaun, Hasap, /v,
KOM4eTo 3a pOTUPaKe, (), U KOMYETO 38 UTHU || Tbynasa

pasrosop:
crny4yaun. 10 popaneHu
6 oTCTpaHeTn

Op ekpaHoTt 3a DGNA ce nanerysa co Mpernen] [ Hasan
NpUTUCKaHEe Ha e4HO Of TV KOMYuksa.

1. 3a npernen Ha gogageHNTe/M3OpULLIAHUTE  [Fa & |
AeTanu 3a rpynvTe 3a pasroeop,
nputucHete Mpernea. Moxe ga nuarate VP2

rP3
HU3 CMIMCOKOT. M
2. 3a ga ce BpatuTe Ha NPeTXoaHMOT Npukas owaw]E] asea

npuTtucHete Hasaa.
3. 3a pa n3bepere DGNA rpyna nputucHete Mpukaun. Nnu
nuarajte go Apyra rpyna u nputucHete Mpukaum.

m * [pukadysarmemo epyrnu He e do3eorneHo 80 TXI-pexum.
+ Koea Ke usnezeme o0 ekpaHom 3a uzeecmyear-e 3a

DGNA, usbepeme edHa 00 Hogo-0o0adeHume 2pyrnu
Kako wmo e objacHemo oede cmpaHuya 49.

Ako ce npumun nopaka 3a DGNA 3a
OpuLiere Ha cuTe rpynu 3a pasroBop, Ha
Bawmotr MTH800 ke ce nojaBu cneaHoToO: Cure rpynit 3

pasrosop:
W3bpuiwanu

Mpuem Ha DGNA 6e3 nopaka 3a
M3BECTyBa|'be Hasap

[okonky nssectyBaweto 3a DGNA He

€ KOHh1rypmpaHo of BalUMOT JaBaTten Ha ycrnyru, ke ce
ornacu TOH 1 nopaka 3a U3BeCTyBaH€ ako 1 camMo ako
nsbpaHata rpyna 6una npomeHeta og DGNA.
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ABTomaTCcKu nsdop Ha rpyna co DGNA

AKO aBTOMAaTCKMOT N360p e KOHUrypupaH of BalmoT
JaBaTten Ha ycryru, cekorall Kora BaluMoT TepMuHan Ke
npumun nopaka 3a DGNA, rpynata 3a pa3roBop aBToMaTCKu
Ke Buae noctaBeHa 3a n3bpaHa rpyna og BallMOT TepMuHarn.

Konue/goneH npeknHyBa4
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OBaa ofnuka My OBO3MOXXYBa Ha KOPUCHMKOT Aa ucnparu
ofHanpep nocTtaBeHa nopaka 3a CTaTycoT CO NPUTHCKae Ha
KOMYeTo/doNHNOT npeknHyBay. Bo TMO-pexum He Moxe Aa
ce vcrpaTtu anapm 1 aa ce 3anoyHe TMO-rpyneH/npmsarteH
MOBMUK.

Anpecupatrse 1 ucrnpakawe Ha nopakure:

» afpecarta MoXe fa buge npeTxodHo odpeneHa of
[AaBaTernoT Ha YCInyry, BO CNPOTMBHO ce ucnpaka Ao
TEKOBHO M3bpaHaTa rpyna.

* aKo He e n3bpaHa rpyna, nopakara ce ucnpaka Ha
pesepBHara agpeca

* rnopakara e ucnpareHa Aypu U ako KOPUCHUKOT € BKMyYeH
BO KOj OMMNoO aKkTMBEH MOBUK.

HaunHoT Ha n3BecTyBame 3aBUCK Of MNOCTaBYBaH-€TO Ha

BaLLWOT AasaTen Ha ycnyrn. Moxe aa ce oHeBo3MoXaT

BM3yenHWUTe/3BYyYHM MHAMKaLMM 3a nopakaTa 3a CTaTycoT.

Kora pagunoto e 3aknyyeHo co PIN, KOPUCHMKOT cenak moxe

a ro NpuTUCHE KOMYeTo/A0NMHNOT NPeKknHyBad 3a Aa ja

ucnpaTu nopakara.

AKo pagnoTo He paboTu, KOPUCHUKOT ke BUAM Camo
U3BeCTyBah€ [eka onepauujata He Guna ycnewHa.



DMO-rpyneH noBukK

OnwTo

Bo DMO-pexumot, MTH800 moxe aa ce kopuctu 6e3
WHGpaCTpyKTypaTa Ha BalLMOT gaBaTen Ha yCryru.

[NpEeKTHMOT pexrm 0BO3MOXYBa KOMYHMKaLuja co apyru
TepPMUHanM LWTO UCTO Taka (PyHKLMOHUPpaaT BO AUPEKTEH
pexunmM, KOULLITO ce Ha nuctata pekBeHLMja n BO uctata
rpyna 3a pasrosop co Baumotr MTHS800.

MBO DMO-pexum e MoxHO da ce gocriocmasysaam camo
epyrnHU Mosuyu, 2pyrnHU nosuyu 3a UmHuU criydau u
rpusamHu eGHOHacoYHU rosuyU.

Moxe ga npumMuTe NoBUK:

* of n3bpaHaTta rpyna 3a pasroBop

* 04 ApYrv KOPMCHULM KOU ce HaoraaT Bo obracT o kage
MOXe Aa BM oAroBopar (ako e KOHUryp1MpaHo of BallnoT
Aasaten Ha ycnyrun). OBoj noBuk ce Hapekysa InterMNI
(naeHTUTET BO MOBUITHaTa Mpexa).

» Op otBopeHa rpyna. (OTBOpeHaTa rpyna e cynep-rpyna Ha
Koja ? npunaraat cute DMO-rpynu.)

Kora BocnocTtaByBaTe NoBMK, YNEHOBUTE Ha n3bpaHara rpyna

3a pas3roBoOp KOM r'M MMaaT BKIy4YEHO CBOUTE Ypeaum 1 ce BO

paMKu Ha NPeTNNaTHUYKNOT UOEHTUTET Ha rpynaTta

(koHbUrypvpaH of gaBaTenoT Ha ycnyru), ke ro npumat

NMOBUKOT.

Bo DMO-pexum, MTH800 moxe fa koMmyHuLMpa co
CUCTEMOT 3a BMpexyBakhe (M 0OpaTHO), ako onuujarta 3a
MpexeH npeMuH e oBo3MoxeHa kaj MTHS800.

3a ga ce sronemun obnacta Ha DMO-nokpueHocCT Ha
TepmuHanot, DMO-rpynata moxe aa ce noBp3u Co peneTmTop,
[OOKOINKy ognvkara 3a peneTuTop € OBO3MOXEHa Kaj
TepMuHanoT. [Nokpaj Toa, MoXe Aa ce KOPUCTUN PEXUMOT 3a
komyHukaumja MI + penetTutop (MpexeH NpeMUH 1 peneTmuTop).
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[okonky ognvkarta 3a crnpeyyBahe Ha NpeHoCcoT e
aktmBunpaHa npu DMO-pexum Ha TepMyHanoT, ognvkaTa 3a
PTT e oHeBo3MmOxeHa. Moxe camo aa cnyware. 3a noseke
MH(OPMaLMKM OKOMy CrpedyBake Ha NPEeHOCOoT, BUAETE Ha
cTpaHuua 57. Moxe ga ce nsbepe rpyna 3a pasroBop BO
DMO-pexum Kora e akTMBUpaHO cripevyBare Ha NPEHOCOT.

Opanuka 3a ABOeH MUKPOGOH
Buaete Bo ,HaunH Ha gpxewse HAMTHB800” Ha cTpaHuua 17.

OmMuneHu nanku

Moxe ga rm opraHn3unpare salinTe OMUI1eHU rpynu Bo Tpun
nanku.

N3bupar-e Ha nankaTa co Mou rpynu

Op MaTUYHMOT ekpaH NPUTUCHETE @ 3a 6p3 npuctan go

nankara.

m CmaHdapdeH Ha3ue 3a rpgama omursieHa narika
e ,Mou epynu*.
HopnaBawe/6puiere rpynu o OMUNeHUTe nankm
3a noeeke nHdopmauun, suaete ,Mowu rpynu (TMO/DMO)”
Ha cTpaHuua 173.
aopaBake/opuerne/npemmMmeHyBakbe
Ha oMuUneHuTe Nanku

3a noeeke nHdopmauun, suaete ,Mowu rpynu (TMO/DMO)”
Ha cTpaHuua 173.

n3bupame rpyna
Bupete Bo ,M30upatrbe rpyna” Ha cTpaHuua 49.
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n3bupare rpyna co Kopuctewe Ha Konymmwara 3a
HaBurauymja/npebapyBare no a3dy4eH pen /
npebapyBaHe No nanka

Buaete Bo ,M300p Ha rpyna co KOPUCTEHE Ha KOM4YUHa 3a
HaBurauuja/npebapyBare no a3byyeH pen/no nankn” Ha
cTpaHuua 51.

n3bupamwe nanka
Bupete BO ,M30upare nanka” Ha cTpaHuua 52.

KOHcUrypaumja 3a nusrawe no rpynu

Bugete BO ,kOHUrypaumja 3a nusrawe no rpynu” Ha
cTpaHuua 53.

nM36op Ha MpexeH npemMuH/peneTuTop

Kopuctete ro nogmenuto Ha DMO T
KoHdmrypaumja 3a noctaByBare Ha OMO-nana 1
onuuuTe 3a MPEXHUOT NPEMUH Monmumja

N peneTUTopoT. 3Apaso

1. MNputncHeTe Onuumnsa ga Bresete BO ST T Formac

MeHUTO co onuun Bo DMO-pexumm.

DMO-nogmeHu co onuun

Manka

'P no nanka
'P no abs
Pexum Ha 1A
eupexyeaee oS 2 Komporon.
KorchyrypaLia 2 MpexeH p
npemuH
3 PenetuTop 1 ABTOMATCKU
4 MM + Pen 2 KoHkpeTeH
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2. Jlnzrajte no Kondmrypaumja
n nputncHeTe U36epwn.

M360p Ha DMO-rpyneH noBuk og MobunHa
cTaHuua Ao mob6unHa craHuua (MS-MS)

3a pa ce npedpnute o4 pPeXUM Ha MPEXEH NPEMUH Nnm
peneTuTop Bo pexunm Ha MS-MS (DMO-noBuk oa TepMuHan

00 TepMmuHan):

1. MpuTtucHeTe Onuuun, nusrajte go
KoHdmrypaumja n nputucHete U3depu.

2. Jlnzrajte po MS - MS 1 nputncHete
U36epu. CnegHaTa nopaka ke ce npukaxe
Ha Hekornky cekyHau: MS - MS ke 6uae Bo
ynoTtpeba.

1=+ [
Manka
I'P no nanka
I'P no abs
Ll PeXuM Ha BMpEXyBarbe
Kondurypauuja

Wsbepn | [ Hasaa

1=+] [mm;:
V'MS-MS
MpesxeH npemuH
Penetutop
MM + Pen

WN3bepn | [ Hasan

n36op Ha DMO-rpyneH noBUK NpeKy MpexeH NpeMuH

Bo ek Ha DMO-pexum, 3a fa n3bepete MpexxeH NpeMuH 3a
noctaByBaH-€ MOBUK NPEKY MpEeXeH NpeMyH 3a u3bpaHata
rpyna 3a pasroBop, crieeTe rv cregHvee ynaTcTea:

1. MputucHete Onuun, nusrajte go KoHdurypauumja
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n nputucHete U3bepwn.

2. Jlnzrajte 0o MpexeH npeMuH 1 nputnucHete U3Gepm.

3. Ha ekpaHoT ce nojaByBa nocnegHMoT MeTop, Ha U3bop Ha
MpexeH npemMuH. KopucTteTe ro KonyeTo 3a HaBuraumja 3a
Aa nvaraTte Ao BawmoT nsdop un nputucHete Ok:

ABtomartcku — MTHB800 ke ro kopuctu
NPBWOT JOCTaneH MpeXeH NPeMUH 3a Taa
rpyna 3a pasrosop. o n3boport Ha Taa
onuuja, NOYHyBa Aa Tpernka ukoHara 3a
MPEXEH NPEMMUH.

KoHkpeteH — MTHB800 ke ro kopuctu

Onuwym 3a MIM:

1=+ [

/ ABTOMaTCKN
KoHkpeTeH

W36epun Hasap

CaMO MPEXHUOT NpeMnH Co KOHKpETHa aapeca Ha MpeXeH

npeMunH 3a Taa rpyna 3a pas3roBop.



Mo n3dopoT Ha ,,KoHKpeTeH®, Ha ekpaHoT ke ce nojaBu egHa

oA cnegHuBe Nopaku:

* N3bpaHaTa agpeca Ha MpeXeH nNpemMuH
(Ha np., 1022), kojaliTo e NPeTxogqHo
nporpamupaHa of BalIMOT AaBaTten Ha
yCnyru Unm KojallTo NPeTXoaHo CTe ja
BHene npeky Tactartypara. [puTtucHete
Ypeau v notoa Ok 3a fa ja kopuctute
TeKOoBHaTa agpeca unu BHeceTe HoBa

|=+] [

W3bpaH
MpexeH
npemuH:
1022

Ypev | [ Hasap

azpeca npeky Tactatyparta u nputucHete Ok. Mo nsbopor
Ha MPEXHWOT NPeMUH, NOYHYBa Aa Tpenka MkoHaTta 3a

MpeXeH NPeMUH.

+ ,Huty eneH®, ykaxxyBa geka He e nsbpaH
MpeXeH NpeMuH 3a Taa rpyna 3a
pasrosop. [NpuTucHeTe Ypeau v BHeceTe
agpeca npeky Tactaryparta, NpuTUCHeTe
Ok. Mo n3bopoT Ha MPEXHMOT NPEMUH,
NnoyHyBa a Tpenka UKoHaTta 3a MpexeH
NPeMUH.

Kora MTH800 ke ro npoHajoe cooaBeTHMOT
MpPEXEeH NPEMWH, MKOHAaTa 3a MPEXeH
NpeMuH ke 6uae nocrojaHa.

n36op Ha DMO-rpyneH noBuK npeky

penetuTop

Bo Tek Ha DMO-pexum, 3a ga ja nsbepete

1=+1 [

W36paH
MpexeH
NpeMuH:

Ypem | [ Hasan

T

[T

DMO-nanka 1
Monwuumja
3ppaso

Onuwm [ Ij[ KoHTaktit

onuujaTa peneTuTop 3a BOCMOCTaByBaHEe NOBUK NPEKY
peneTuTop 3a u3bpaHaTta rpyna 3a pasroBop, cregeTe

crnegHuBe ynarcrea:

1. MpuTtucHeTe ONuKMK, KOpUCTETE M KONYMH-ATa 3a
HaBurauuja 3a nusrawe 0o KoHdurypauumja v nputucHerte

N36epwn.

2. Jlnsrajte go Penetutop v nputucHete U3bepu.
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3. MTHB800 ke ro KopucT1 NPBUOT AOCTamNeH
peneTuTop 3a Taa rpyna 3a pasrosop. 1o
n36opoT Ha Taa onuuja, NoYHyBa Aa
Tpenka ukoHaTa 3a peneTuTop.

Kora MTH800 ke getekTupa npucycTBO Ha
CWrHan Ha CoofBETEH peneTnTop, MKoHaTa
3a peneTMTopoT NOCTOjaHo Ke CBETMU.

n36op Ha DMO-rpyneH noBuK npeky
MpeXeH NPeMUH U peneTuTop

Y =

DMO-nanka 1
Monwuumja
3ppaso

Onum[IE][ Kowrakw

&l [

DMO-nanka 1
Monwuumja
3npaso

Onywn TEE] Korrakm

Bo Tek Ha DMO-pexum, 3a ga ja n3bepete onuujata 3a
MpEeXeH NPEMVH U PeneTUTop 3a BOCMOCTaByBaHe NOBUK
npeKky MpeXeH NPeMUH Unn peneTnTop (ce npenopadvysa
MpeXeH NpeMuH) 3a n3bpaHaTta rpyna 3a pa3roBop, cregere

' cnegHmee ynartcTBea.

1. MputucHete Onuun, nusrajte go KoHdurypauumja

n nputucHete U3bepwn.

2. Nnasrajte go MMM + Pen n nputucHete U36epm.

3. Ha ekpaHOT ce nojaByBa nocrnegHnoT B1A
Ha nsboport ,MI1 + Penetutop®. Kopuctete
ro KON4YeTo 3a HaBurauuja 3a ga nusrate go
BaLWMOT n3bop n nputucHete U3bepu:

ABtomartcku — MTHB800 ke ro kopuctu
NPBUOT JOCTaneH MpexXeH NpeMuH 3a Taa

I=+] [

Onuwu 3a MIM:

</ ABTOMaTCKY
KoHkpeTteH

W3bepun Hazapn

rpyna 3a pasrosop. o n36opoT Ha Taa onuuja, NoYHyBaar
[a TpenkaaT UKOHWUTE 3a MPEXeH NPeMUH 1 peneTmuTop.

KoHkpeteH — MTHB800 ke ro KOpucTM camo MpPEXHUOT
NPEMMWH CO KOHKpETHa agpeca Ha MpeXeH NpeMuH 3a Taa

rpyna 3a pasroBop.
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Mo n3dopoT Ha ,,KoHKpeTeH®, Ha ekpaHoT ke ce nojaBu egHa

oA cnegHuBe Nopaku:

» M3bpaHaTa agpeca Ha MpexeH NpemMuH
(Ha np., 1022), kojaluTo € NPeTXoqHO
nporpamupaHa of BaluMoT JaBaTern Ha
yCryru Unm KojaluTo NPeTXoaHo CTe ja
BHere npeky Tactarypara. [puTtnucHeTe
Ypeau 1 notoa Ok 3a kopuctewe Ha
TEKOBHaTa agpeca unv npuTucHeTe

'y 1l [

M
W36paH

MpexeH npeMuH:
1022

Ypeawu v BHeceTe HOBa adpeca Nnpeky TactaTtypara

n nputucHete Ok.

Mo n3bopoT Ha MPEXHUOT NPEMUH, NOYHyBaart ga
TpenkaaTt UKOHUTE 3a MPEXEH NPEeMUH 1 peneTuTop.

» ,HuTy egeH”, ykaxyBa geka He e n3bpaH MpexeH
NpPeMUWH 3a Taa rpyna 3a pa3roBop. BHeceTe agpeca
npeky Tactatypata v nputucHete Ok. o n3bopot Ha
MPEXHMOT NPEMMH, NOYHyBaaT Aa TpenkaaTt UKOHUTE 3a

MPEXeH NPEeMUH U peneTuTop.
Kora MTH800 ke ro npoHajoe coonBeTHUOT
MpeXeH NPeEMUH U/ peneTuTop, UKOHNUTE
3a MpEeXeH NPeMUH N/Mnu peneTmuTop ke
cTaHaT NnocTojaHu, COOOBETHO.

BocnocrtaByBatse DMO rpyneH noBuk
(MS no MS)

1. Bniesete BO [UpeKTeH pexum CO
nputuckamwe Ha Onumm n n3dop Ha
OupeKkTeH pexum.

2. OcurypeTe geka cTe ja nsbpane cakaHara
rpyna. MNMpuTUcHeTe 1 3agpxeTe
ro konyeto PTT.

T P |

DMO-narnka 1
Monuumja
3apaeo

Onuum | E]J KoHTaKkTi

1=+] [mm;:
V' MS - Ms
MpexeH
npemMmH
Penetutop
MM + Pen

/3bepete| [ Hasad

3. MNoyekajTe ro TOHOT 3a 403BOMa 3a Pa3roBop M NOoToa
36opyBajTe Bo MnkpopoHoT. OTnywTeTe ro konyeto 3a PTT

3a fa cnyware.
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BocnoctaByBawe Ha DMO-rpyneH noBuK nNpeky
MpeXeH npeMuH

1. Bo Tek Ha DMO-pexunm, nsbepete MpexeH NpeMmnH Kako
LUITO e onuLiaHo Bo ,mn36op Ha DMO-rpyneH noBuk npeky
MpeXeH NpeMunH” Ha cTpaHuua 64.

2. BocnocTtaBeTe ro noBuKOT 3a u3bpaHara rpyna 3a
pasroBop:

* AKO ro npuTucHeTe kon4yeto PTT gogeka MpexXHUoT
NpeMunH e HegocTaneH, ke 3anoyHete DMO-noBuk 6e3
MpeXeH NpeMuH. MIkoHaTa 3a MpeXeH NpeMuH Ke

ncyesHe.

» Ako nputucHeTte PTT gooeka
n36paHnOT MPEXEH NPEMUH € MS - MS
JocTaneH, HO NOBMKOT € 0abueH of nosmk
MPEXHUOT npemMuH, Bamot MTH800

Ke ormacu TOH U1 ke ce nojaBu crieqHnoT

npukas, Npeky Koj Be UHpopmMmmnpa aeka noBuKoT Ke ce
noctaeu 6e3 MpexeH npemMuH. VikoHaTa 3a MpexeH
NPeMuH ke ucdesHe.

* AKO ro npuTUCHeTe KonyeTo 3a PTT goaeka MpexHUoT
nNpeMuH e gocTaneH, ke 3anovyHete DMO-noBuk co
MpeXeH npeMuH. MikoHaTa 3a MpexeH npemMuH ke buge
nocTojaHa.

BocnoctaByBawbe DMO-rpyneH noBuk npeky
peneTutop
1. Bo Tek Ha DMO-pexum, nsbepete penetntop Kako LITO
€ onuuwaHo Bo ,m360p Ha DMO-rpyneH nosuk npeky
peneTntop” Ha cTpaHuua 65.
2. BocnocTtaBeTe ro NOBUKOT 3a nsbpaHara rpyna 3a
pasrosop:
* Ako ro nputucHete kon4deTo 3a PTT gogeka
peneTUToOpoT € HeaocTaneH, ke 3ano4yHete DMO-noBuk
6e3 penetuTtop. MIkoHaTa 3a peneTnTop ke UcHe3He.
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* AKO ro npuTuUCHeTe KonyeTto 3a PTT
aojeka n3bpaHnoT peneTmTop e MS - MS
AocTtaneH, Ho MOBUKOT € oabueH oa MoBUK
penetutopoT, Bawmotr MTH800 ke
ornacv ToH 1 ke ce nojasu CrnegHuoT
npukas npeky Koj Be MHopmupa geka noBuKoT Ke ce
noctaeu 6e3 penetutop. MkoHaTa 3a penetTutop ke
ncyesHe.

* AKo ro nputucHete Kon4deTo 3a PTT gogeka
peneTUTOPOT € JocTaneH, ke 3anovyHete DMO-noBuk co
peneTuTop. VikoHaTa 3a peneTutop ke buge nocrojaHa.

BocnoctaByBatse DMO-rpyneH noBuk npeky
MpeXeH NPeMUH U peneTuTop

1. Bo Tek Ha DMO-pexwum, nsbeperte ja onumjata MpexeH
NPEMUH 1 PeneTuTop Kako LITO e onuwaHo Bo ,M36op Ha
DMO-rpyneH noBuK NPeKy MpexeH NpemMuH 1 penetutop”
Ha cTpaHuua 66.

2. BocrniocTaBeTe ro NOBMKOT 3a nsbpaHara rpyna 3a
pa3roBop:

» Axo ro nputucHete konyeto 3a PTT gogeka MpexxHUoT
NPeMWH 1 peneTuTopoT ce HedocmariHu, ke 3anoyHeTe
DMO-noBuk 6e3 MpexeH NpeMuH 1 peneTuTop.
MkoHUTe 3a MpeXeH NpeMUH U peneTuTop ke ncyesHar.

» Axo ro nputucHete Konyeto 3a PTT fgoanexka MpexxHnoT
NPeMUH 1 peneTnuTopoT ce docmarHu, HO MOBUKOT
e ogbveH o4 MpexHNOT NpeMuH, ke criegm obua 3a
MOBWK NPEKY PeneTUTOpOT.

> Ako e ycrieweH Ha BawmoT MTH800 ke ce nojasu
nopaka MNoBuK Npeky peneTuTop 1 NOBMKOT NPEKY
peneTuTop Ke Npodormku. VikoHaTa 3a MpexeH
NPeMUH ke uc4esHe.

> Ako e HeycrieweH Ha Bawwmnot MTH800 ke ce nojasu
nopaka MS-MS noBuK 1 ke NpogoKnN NOBKK 0f,
TepMuHan 4o TepMuHan. VMikoHuTe 3a MpexeH
NPeMWUH N peneTuTop Ke ncyesHar.
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» Axo ro nputucHete Konyeto 3a PTT fgoaexka MpexxHnoT
NpPeMuH 1 peneTnTopoT ce docmarnHu, ke cnegm obua
3a MNOBWK NPEKY MPEeXeH NPeMuH.

> Ako e ycrieweH BawmotT MTH800 ke 3ano4yHe DMO-

MOBWK CO MpexXeH nNpemMuH. MikoHaTa 3a MpexeH
npeMuH ke 6uae nocrtojaHa. MikoHaTa 3a penetmuTop
Ke ncuyesHe.

> Ako CUHXPOHU3NPaAHETO CO MpEXEH NpeMnH

€ HeycrnewHo ke cnegm obug 3a NoBuK Npeky
peneTuTop.

> Ako e ycrieweH Ha Bawmnot MTH800 ke ce nojasu

npumame
Moxe

nopakata MoBUK NpeKy peneTuTop 1 ke NpoaoIKU
MOBMKOT MpeKy penetTutop. VikoHaTa 3a MpexeH
NpemMuH Ke NCHe3He 1 NKOHUTE 3a peneTuTop ke
6ugat noctojaHu.

Ako e HeycrieweH Ha BawmnoT MTH800 ke ce nojasu
nopaka MS-MS noBMK 1 ke NpoaokKn NOBUK Of
TepMuHan 4o TepMuHan. VMIkoHuTe 3a MpexeH
NPEMWUH N PeENETUTOP Ke ncYesHar.

AKO e usbpaH pexxumom ,MpPeXeH MPeMuH u perremumop”
u ako edeH 00 ypedume e HedocmarieH, rnocmasysaremo
Ha rnosuxkom rpodosxysa Kako 0a He bur usbpaH 080j ypeo.
[pumep: Bo cnyyaj koza MpexxHUOm rnpemuH e docmarieH,
a penemumopom e HedocmarieH, a o HeycrnewHuom obud
3a 108UK MPEKY MPEXEH MPEMUH, nosukom eedHall ce
8paka 80 pexxum MS - MS co nopakama MS-MS noeguk.

DMO-rpyneH noBuk

Aa npumate DMO-rpyneH noBuk camo Kora BaLumoT

MTH800 e Bo DMO-pexum.

Bawwmotr MTH800 ke ro npukaxke npmBaTHWOT Bpoj nnu
NceBOOHMMOT Ha NOBMKYBaY0T M MMETO Ha rpynara 3a
pasroBop.
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CnepyBaat npuMepu 3a Ha4MHOT Ha KOj MOXe [a ce NpuKaxe
WOEHTUTETOT Ha NOBKKYBAYOT Ha EKPaHOT.

MBa cu2Har 3a rosuk, sudeme au rnocmaskume 80 onyuume
Ha meHumo 3a subpayuu (cmpaHuya 149) u 80 MeHUMO Ha

moHosu (cmpaHuua 154).

npuman.e DMO-2pyneH noeuk (MS — MS))
all 1+ = ] all 1+ [

j Ipyna Bo
ynotpeba

pyna Bo
ynotpeba

ynotpeba
Vnenndmkaumja:

g Bpoj 3a
DMO 1
DMO F;zKa nnn WaeHTMdMKauvja: nnu [flasup
124 DMO P4
Onuwn | [ TManka
Bes ncespoHnm n npvBateH 6poj 3a npviBateH 6poj 3a
MpuBateH 6poj 3a naeHTudmKaumja naeHTuduKaumja
naeHTUdukaumja 6e3 nceBaoHUM CO NCEBOOHUM
all 1=+ [ all |+] [
=!| Mpyna so ]
o
g3 3] oo e
;I:::;Mdmkauma. U ”/5;92“;‘;" r—
OtBopeHa rpyna i’IP 4
Onuyw | [ Tanka Onumn] [ Mpexa
NnoBWK 10 OTBOpEHa rpyna InterMNI noBuk

Kora npumarte InterMNI noBuk, moxe ga nputncHerte
.Mpexa“ 3a ga ro Bugnte nceBLOHNMOT u/unu 6pojoT Bo
MpexarTa.
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lMpumamse 2pyneH noeukK (MPeKy MpexxeH nNnpeMuH /

MNanka 1
P4

Onuum | | Manka

Be3 nceBaoHuM u
MpuateH 6poj 3a

nnm

naeHTUdmKaumja: 1
24

P4

Onuwn | [ Manka

npueateH 6poj 3a
naeHTUdMKaLmja

nnm

penemumop)
Lol I=+1 [ Ll I+ [ all %1 [
o o El n
EE e CEfE

WpeHTudmkaly
vja: fasug
P4

Onuwn | [Manka

npuBsateH 6poj 3a
naeHTMduKaLmja

naeHTUdMKaLMja

(Ha np. NpeKy MpexeH NPeMuH)

6e3 NceBaoHUM
(Ha Np. NpeKy MpexeH NPeMuH)

€O NMCEBOHNM
(Ha np. npexy peneTuTop)

Ha ekpaHoT ce nojaByBa 6pojoT 3a ngeHtndmrkalmja Ha
nosukysayot B0 TMO-pexum.

NkoHuTe 3a mpexeH npemuH + DMO mnu 3a penetutop ce
npuviKa)kyBaaT COMMacHO BMOOT Ha TEKOBHUOT MOBUK (MpPEXEH
NPEeMUH NN peneTuTop).
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* Ako e usbpaH pexumom MS - MS (00 mobunHa cmaHuya
0o mMobusnHa cmaHuya) u mepMuHanom rnpuMuU rnosuk
rpeKy peremumopom, Ke ce rpuKkaxe ukoHama 3a
pernemumop (OOKOJIKY pexumom 3a peremumop
€ 0803MOXeH 00 Oagamersiom Ha ycriyau, 80 CrPOMUEHO
rnosukom Hema Oa 6ude npughameH,).

* AKO e usbpaH pexxum 3a MPexeH NPeMuUH, Ho moj He
e docmarieH, 80 cryyaj Ha 00jO08€EH MOBUK MPEKY MPEXeH
PemMuH UKOHama 3a MpexeH npemuH Ke bude
rocmojaHa.



DMO npuBaTeH noBUK

Moxe foa BocnoctaBute U NpUMUTE NpUBaTEH NOBUK BO
DMO-pexunmM A0KONKYy UCTUOT € KOHGUrypupaH of BallumoT
[aBaTen Ha ycnyru.

Cenak, ako onuunTe 3a MpEeXeH NPeMuH U/unm peneTuTop ce
aKTMBMpaHu, Tve He ce KkopucTtat 3a DMO-npuBaTeH NoBuK.
MpuBaTHMoT noBuk Bo DMO-pexum ke buge gupektHa
KomyHuKauuja nomery asa TETRA tepmuHanu (MS - MS).
3a noBeke UHdopmaLun, BUAETE BO ,MpMBaATEH NOBUK BO
DMO-pexum” Ha cTpaHuua 79.

FpyneH NOBUK NpU UTHU criyyam

3a noBeke nHdopmauun, Buaete Bo ,TeH criyyaj Bo DMO-
pexum” Ha cTpaHuua 101.

usnes3 ogq DMO-pexum

3a na usnesete og DMO-pexum, nputnucHete Onuum
1 n3depeTe Pexum Ha BMpexyBawe. 3a OPYIY HAYMHNU,
Bugete Bo ,M3buparwse TMO mnnm DMO-pexum” Ha
cTpaHuua 33.
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NMpuBaTeH noBUK

OnwTo

[MpuBaTeH NOBUK , yLUTE HApeyeH To4Ka A0 ToYKa Unu
nHOuBMAyaneH NoBUK € NOBUK Mery ABajua noeguHuu. Huty
efeH apyr TepMuHan He MoXe Aa ro crnyLuHe pasroBopor.
OBoj noBrk Moxe aa buae:
» 0soHaco4yeH noBuk BO TMO-pexum, (OKONKYy CUCTEMOT
[03BONyBa) unm
* eOHoHaco4eH nosuk Bo TMO-pexum nnv DMO-pexum.
Bo Tek Ha BOHaco4eH NoBUK, ABajuarta y4eCcHULM BO
pasroBopoT MoOXe Ada 36opyBaaT UCTOBPEMEHO, AoAeka 3a
BpEMe Ha eHOHacO4Y€eH NOBWK, BO AaJEH MOMEHT MOXe Aa
36opyBa camo efHO NnuLe.
Ako sawuom dasameri Ha ycriyau uma o2paHuyveH npucmart
00 crucoKom co KOHmMakmu, Moxxebu He e MOXHo 0a
Kpeupame HO8 KOHmMakm, Oa eu ypeayeame rnocmoeykume
KOHmMaKkmu usnu u36epeme 6poj wmo He e 80 CrucoKom co
KOHmMaKkmu.
3a cyHkumoHuparwe Ha MTH800 Bo obnacTt co P,
Buaete Bo ,CrnipeyvyBare Ha nNpeHoc” Ha cTpaHuua 57.

m,ﬂodem € akmuesupaHa odrukama 3a cripeyysare Ha
npeHocom, Ke ce jagu uHOuKkamop 3a 00j0o8eH npusameH

MOBUK, HO HeMa MOXXHOCM 3a o0208apar-e Ha roguKom.

Opanuka 3a ABOeH MUKPOGOH
Buaete Bo ,HaunH Ha gpxewse HAMTHB800” Ha cTpaHuua 17.

BocnoctaByBawe npuBateH noBuk B0 TMO-pexum

mﬂOKOﬂKy cme 80 meK Ha epyreH rosukK, a cakame 0a
gocriocmasume Hoe rosuk, rnpumucHeme (;0 3a da 2o

ugHopupame meKoeHUOM rosuk. N3bepeme 2o 6pojom.
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1. N3GepeTe 6poj 0 MaTUYHMOT eKpaH.

2. [1okornky NpnBaTHMOT HE € NPBUOT
npvKaxkaH BMA Ha MOBWK, NPUTUCHETE BUA
Ha N 3a ga n3bepeTe NpuBaTeH NOBUK.

3. 3a eGHOHaco4YeH NoBUK, MPUTUCHETE
1 oTnywwTeTe ro konyeto 3a PTT. Ke

é MpuBateH
6p.:

2234

B Ha N[ =] | Vsbpum

CnyLIHeTe TOH 3a SBoHehne. [MovekajTe bapaHoTo Nuue Aa
04roBopu Ha BawmnoT noeuk. (OBa ce HapekyBa

BOCMOCTaByBawe Ha Bpcka.) U

MputucHete n 3agpxete PTT. NovekajTe ro TOHOT 3a

[A03B0Or1a 3a pasroBop (QOKONKY e KoHduUrypmpaH) npeg aa
36opysate u oTnywTeTe ro konyeto PTT gogeka cnyware.
(OBa ce HapeKyBa 1 OUPEKTHO BOCMOCTaByBaH-€ Ha Bpcka.)

KopucHukom moxe da eocriocmasu MS-ISDN edHoHacoyeH
M08UK CO npumuckare Ha Kornyemo 3a PTT, OokosiKy oeaa

o0nuka e 0803MoxeHa 00 Gagamesiom Ha ycriyau.

3a deoHaco4YeH MNOBUK, MPUTUCHETE U OTNYLUTETE ® Ke
CnyLIHeTe TOH 3a SBoHehe. [NovekajTe bapaHoTo nuue aa

OoAroBopun Ha BaLUNOT NMOBUK.

4. 3a pa ro npeknHeTe NOBUKOT, NPUTUCHETE .

[lokonky 6apaHoTo nuue unu nHdpacTpyKTypaTa ro npekuHe
MOBMKOT, Ha eKpaHoT ke ce nojaeu nopakata MpekuHar

NOBUK.

[lodeka e akmusupaHa odnukama 3a cripeyysar-e Ha
npeHocom, Ke ce jagu UHOUKamop 3a npusameH rnosux,

HO 8ue He Moxeme 0a OOZOGO,DUIT?G Ha rnosukom.



OPYry Ha4YMHU Ha Gupame

EMpaI-be NnpeKy CANCOK CO KOHTaKTHU

Mosxe fa ro KOpMcTUTE M CNIMCOKOT CO KOHTaKTW 3a Aa
n3bepete OpOj LLUTO NPETXOOHO CTe ro 3adyBane. [putncHete
KoHTakTu 1 npebapysajte ro 3auyBaHuoT 6poj Co nusramwe
(&) wnn €3) nnm co BHecyBarbe Ha HajMHOTY 12 Byksu.

Lokonky Hema ume 3a4ysaHo nod odpedeHa bykea, MTP850
maemomemcw npebapysa Harnped rno azbydyeH ped, ce
0odeka He 20 npoHajoe credHomo ume. [JOKorKy noseKke 00
edHO UMe 80 CUCOKOm MoYHysa co ucma bykea, Moxe 0a
nuszame 3a O0a eu sudume Opyaume umurba unu 0a
npumucHeme HajmHoey 12 byksu.
AKO 3a KOHTaKTOT MMa 3a4yBaHO noBeke oA eaeH 6poj,

BOZETE Ce MO MKOHMTE 3a KOHTaKTOT. KopucTeTe @ / @ 3a
na ro n3bepete 6pojoT.
Oupame Ha KpaTKu 6poeBu

AKO e nocTaBeHa o BalLMOT JaBaTenN Ha ycrnyru, ycnyrara 3a
Buparse KpaTkm 6poeBu B 0BO3MOXYBa Aa bupaTte camo aen
of uenuot Bpoj Ha NMLETO Koe ro NoBUKyBaTe.

Bawwnotr MTH800 aBTOMAaTCKM Ke ro KomnrieTupa 0pojoT u ke
ro eMuTyBa Bp3 OCHOBA Ha MOEHTUTETOT Ha BaLLMOT
MTH800. Ha npumep:

1. Bupate 456 (HamecTo uenunoT Bpoj 4282456).
2. 3a BocnocTaByBaH€ Ha NOBUKOT, NputncHete PTT unun @ .

3. 3a NnpeknHyBaw-€ Ha NOBUKOT, MPUTUCHETE nnun @

HauunH Ha bupame

MpuBaTHMOT Opoj 3a naeHTUdUKaLmja Moxe ga nva
HajMHory 16 umdpu.

16-14 13-9 8-1
MCC MNC ISSI
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KopucHukoT Moxe fa n3bepe nomery ase onuuu:

* DUKCHO - KOPUCHUKOT MOXe [1a BHece HajMHory 16 uudpu
BO Kou cnaraat 6poesute MCC, MNC wu ISSI, a gokonky
ce BHecaT nomarnky oa 16 undpwu, ke ce BHecaT uudpute
nocTaBeHU of AaBaTernoT Ha ycryru.

« AsTomarcku - Tpeba aa BHeceTe HajMHory 8 undpu
(Dokonky BHeceTe noBeke, ke ce npedpnuTe Ha (PUKCHUOT
pexum). AKO BHeceTe nomarky of 8 unudpwu, TepMuHanoT
ro komnneTtupa 6pojot co conctseHUOT ISSI 6poj.
TepMuHanNoT aBTOMAaTCKM 0 fofaBa OCTaToKOT of 6pojoT
co 16 undpu.

Ako nsbepete noeeke og 16 undpwn, Ha eKpaHoT ke ce nojasu

npegynpenyBare AeKa CTe Hanpasuie rpeLuka npu

BHECYBaHETO.

Cnuncok co nocnegHu noBuUm
N36epeTe 6poj o cnMCOKOT CO nocriegHu nosuumn. Bugete
BoO ,llocnegHun noBuun” Ha cTpaHuua 176.

Eupal-be CO egeH gonup
Buperte Bo ,Konumka wto moxe aa ce nporpamupaar (0-9, *
u #)” Ha cTpaHuua 28.

Bupame 6poj Bo nopaka
Bupete Bo ,,0upane 6poj Bo nopaka” Ha cTpaHuua 199.

npumate npmBaTteH NnoBuk Bo TMO-pexum

1. MTHB800 ce npdpna Ha A0jAOBHMOT NpUBaTEH NOBUK.
Ha ekpaHoOT ce nojaByBa MAEHTUTETOT Ha NOBUKYBAYOT.

2. 3a ga oaroBopuTe Ha 00jA0OBEH €OHOHaco4YeH NoBUK,
nputucHete PTT. 3a na ogroBopute Ha 40jooBeH
080Haco4YeH NOoBUK (MpuKaXkaH Co MPOrpaMCcKUTE KOMUYnkba

3BYYHMK/cnyLanka), npuTUCHeTe @
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3.3aparo NpeKnHeTe NoBUKOT, MPUTUCHETE @.

mBawuom mepmuHarn Moxe 0a ee uzgecmu 3a 00j008eH
rnosuk. N3bepeme au nocmaskume 3a cuaHasaom 60
MeHUmMo 3a subpayuu U MeHUMo Ha MoHO8U

npuBateH noBuk Bo DMO-pexunm

Moxe fa BocnocTaBuTe 1 NpumMuTe NpMBaTEH MNOBKK BO
DMO-pexuM A0KOMNKYy UCTUOT € KOHUrypupaH of BallumoT
naearten Ha ycnyri. Moxe fa BocnocTaBute uUnuv npummuTe
npusarteH nosunk B0 DMO-pexum camo kora sawumotr MTH800

e B0 DMO-pexum.

MHe ce noddpxaHu npusamHu nosuyu rpexky DMO-
pernemumop u/unu DMO-mpexeH npemu.

MoBuKyBa4oT 1 NOBUKaHaTa cTpaHa Tpeba Aa buaat Bo
uctara rpyna 3a pasroBop.

BOCMNoCcTaByBake npuBaTteH noBuk B0 DMO-pexum
1. BHeceTe 6poj 04 MaTUYHUOT eKpaH. TR
Bupare npeky
g MpusateH
+ CnMCcOoKOT CO KOHTaKTV MUnu Bp.:
* CMMCOKOT CO MOCMeaHN NoBULM 2234

YHKLMOHMPA KaKo LUTO € OnNuLaHo BO v Ha 1] =1 [ VisGpwwn
»OPYIM Ha4nHM Ha Brpare” Ha
CcTpaHuua 77.

2. MNputucHete n 3agpxete PTT. No4vekajTe ro TOHOT 3a
A03BOMa 3a pa3roBop (AOKONKY € KoHurypupaH) npeg aa
3bopyBsate n otnywTeTe ro konyeto PTT gogeka cnyware.

3. MosukoT NpeKnHyBa No NCTEKOT Ha NpeTxogHo

NpOrpaMnUpaHoTO BpeMe, Unu ako nputucHete 2.

lpu npusamHume nosuyu 8o DMO-pexxum, He Moxe Oa ce

mnpoeepu npucycmeomo. Oea 3Ha4yu deka Hema Oa 3Haeme
darnu nosukaHama cmpaHa e docmariHa Koea Ke 20
3aroyHeme rMoguKom.
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npumake npusateH nosuk Bo DMO-pexum T

Kora ce npuma npusateH nosuk so DMO- ]7
pexum, NOBMKOT BeAHALLl 3arnoyHyBa 1 HeMa é
[MpuBaTeH NoBuK

noTtpeba nosukaHaTa cTpaHa aa ro npudartu. 80 yroTpeta

1. Mputucrete PTT 3a ga ogrosopuTe v ga Raeua
MOYHeTe CO Pa3roBop.

2. MNMoBukoT npeknHyBa Nno UCTEKOT Ha NpPeTXoaHo

NpOrpaMnUpaHoTO BpeMe, Unu ako nputucHete 2.

AKo rosukaHama cmpasa rnpumucHe npusamHuom
rnosuk 80 DMO-pexum ce npekuHysa Ha o0pedeHo speme,
a OOKOJIKY r108UKy8a4yom ce yuime e Ha JluHuja, nogukom
Moxe Oa ce npodosIKU.

Bupake npu npumare NOBUK

MpouecoT Ha Gupakre He ce MeHyBa Npu rpynHUOT NoBUK. Bo
CNPOTUBHO, EKPaHOT Ce MeHyBa COOZBETHO Ha BMAOT Ha
[10jA0BHMOT MOBUK 1 NMOTOAa eKpaHoT 3a NOBULM ce Bpaka

oHamy Kage LUTo 61n npekuHaT NpoLecoT Ha Bupatse.

mEupaHsemo npeKuHyesa Koaa ce fnpuma rnosuk 3a UmHu
c/lydau u Ha ekpaHom ce rojasyea ,BknydeHa odnuka 3a

umHu cnyyau®,

BOCMOCTaByBake Ha NPMBaTeH NpPeBeHTUBEH
npuoputeTeH noBuk (PPC)

M Oesaa o0nuka e docmarHa camo OOKOJIKY e rocmaseHa 00
sawuom dasamern Ha ycriyau.

1. BHecerTe ro npuBaTHUOT 6poj
v nputucHete PTT unn @.

2. AKO Ha eKpaHOT ce MojaBu geka g:ﬁ%
NOBUKAHNOT KOPUCHUK € 3aqbaTeH, MpeknHn?
nputucHeTe [la 3a ga ro npekuHeTe Ta Ho

TEKOBHUOT MOBUK.
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3. Ke cnyLuHeTe ToH 3a sBoHetse. MoyekajTe GapaHoTo nuue
[a 0OroBOpM Ha BalLMOT MOBUK.

4, I'Ipop,on>+<eTe ro MOBUKOT Kako BOOOMYaeH eqHOHACOYEH
UM ABOHACO4YEH NnpuBaTeH NOBUK.

noapeayBamke NOBUK

Bo dasaTa Ha noctaByBamhe, kora Hema MHPPAaCTPYKTYPHU
pecypcu 3a ocTBapyBak-e Ha NOBUK UMK Kora npu akTuBeH
MOBUK Ce BpLUM NOBTOPHO Bupare, NOBUKOT ke Guage
nogpeaeH. MTH800 ke octaHe nogpeaeH Ha ogpeaeHo
NPeTXo4HO NporpaMmpaHo Bpeme. [oBUKOT ke Npogorku
Kora pecypcute ke buagat NOBTOPHO Ha pacrnonarame.
[okonky no n3BeceH BpEMEHCKN Nepuos ceé ywTe Hema
pecypcu Ha pacnonarawe, MTH800 ke ro npekuHe NOBUKOT.
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TenecgoHckn n PABX-noBuum

OnwTo

TenedOHCKMOT NOBUK BU OBO3MOXYBa A NOBMKaTe
doukceH TenedoHckn 6poj unu mobuneH TenedoHcku 6po;.
MoBuKOT 3a pa3aMeHa Ha NpMBaTHa aBTOMAaTCKa rpaHka
(PABX) BM 0BO3MOXYBa bBupare Ha (kaHuenapuckm)
nokanu. OBoj BMA Ha noBuk Tpeba Aa buae akTMBUpaH og
CTpaHa Ha BalIVOT AaBaTesn Ha yCnyru.

Bo oBaa ny6nukauuja, TepMuHOT ,,TenedoHcku 6poj“ ynatysa
Ha oBue Gpoesu.

[lBaTta BMaa noBuUM rv Maat UCTUTE OOJIMKM 3a Oupamse.
3a ¢pyHKumoHuparwe Ha MTH800 Bo obnacTu 4yBCTBUTEMNHMU
Ha P®, Buaete Bo ,CnpeyyBake Ha NnpeHoc” Ha

CTpaHuua 57.

mﬂodem e akmuesupaHa odriukama 3a cripeyysar-e
Ha npeHocom, Ke ce jasu uHOukamop 3a 0ojdoseH

menegoHcku unu PABX-r1osuk, HO HemMa MOXHOCM
3a o0zoe8aparbe Ha roguKom.

Ako sawuom dasameri Ha ycriyau uma o2paHu4eH npucmart
9o criucokom co KOHmMakmu, Moxebu He e MOXHO Oa
Kpeupame HO8 KoHmMakm, da au ypedysame nocmoe4ykume
KoHmakmu usu usbepeme 6poj wmo He e 80 CrUCcoKom

CO KOHmMakmu.

Oanuka 3a ABoeH MUKPOOH
Bugete Bo ,HaumH Ha gpxewse HAMTH800” Ha cTpaHuua 17.
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BocnocTtaByBawe TenedoHckn nnm PABX-noBuk
m,ﬂOKOHKy cme 80 meK Ha epyrneH rnosuK u cakame da

eocriocmasume HO8 Mosuk, npumucHeme (£ 3a da 20
uzHopupame meKoeHUOM MosuK. N3bepeme 2o 6pojom.

1. N3GepeTe 6poj 0 MaTUYHMOT eKpaH.

2. Axko TenedoHckmoT unm PABX-noBuk He ce

=
NpBUTE HaBEOEHW BUAOBU Ha MOBWK, B
npuTtKckajTe BUA Ha M3a aa n3bepete

TenedoHckn unm PABX-noBuk.

03671234
BuA Ha T[] [ VisGpvum

3. MputncHeTe 1 oTnyLITETE IO @ Ke
CNnyLUHeTe TOH 3a SBOHeh-e. [MovekajTe bapaHOoTo Nnuue aa
OoAroBopu Ha BaLIMOT NOBUK.

4. 3a fa ro npekvHeTe NOBWKOT, NpUTUCHETE (9.

APYrn Ha4MHU Ha 6MpaH:e
Eupal-be NnpeKy CANCOKOT CO KOHTAaKTU

Mosxe fa ro KOpucTuTe M CNMCOKOT CO KOHTaKTW 3a Aa
n3bepete OpOj LLITO NPETXOAHO CTe ro 3adyBane. [putncHete
KoHTakTu 1 npebapysajte ro 3auyBaHuoT 6poj Co nusramwe

(@ mnm @) M CO BHecyBawe HajMHory 12 3Haum o
MMETO Ha KOHTAKTOT. AKO KOHTaKTOT MMa noBeke of efeH

6poj, kopuctete @ / @ 3a Aa ro usbeperte 6pojoT.

m,ﬂOKOHKy Hema ume 3a4ysaHo r1o0 odpedeHa
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bykea,MTH8006apa Harnped rno a3bydyeH ped, ce dodeka He
20 Hajde criedHomo ume. [okornkKy rnoseke 00 edHO ume 80
crucokom royHyea co ucma bykea, npumucHeme HajMHoay
12 6yksu.

AKO 3a KOHTaKTOT MMa 3a4yBaHO noBeKe o efeH 6poj,

BOZETE Ce MO MKOHMTE 3a KOHTaKTOT. KopucTteTe @ / @ 3a
na ro nsbepete 6pojoT.



Bp3o 6upamwe
Opnnwukata 3a 6p30 Gupare BM OBO3MOXYBa bupare Ha
ckpaTeH 6poj of HajMHory Tpu undpu, HamecTo Guparse Ha
uenunot 6poj. BpojoT 3a 6p30 Ompare e nokaumjata Ha
3anMcoT BO CMMUCOKOT CO KOHTAaKTW.

1. BHecerTe ro npeTxogHo nporpammpaHunoT 6poj 3a 6p3o
Oupame (Ha npumep: 5) u NpUTUCHETE .

2. 3a BOCNoOCTaByBaw€ Ha NOBUKOT, MPUTUCHETE ®

3. 3a npeknHyBar-€e Ha MOBUKOT, NPUTUCHETE @
M Osaa odnuka e docmanHa camo 80 TMO-pexum.

6Mpa|-be Ha rpyna 3a pa3roBop no MHAeKcC
BupareTo Ha rpynarta 3a pa3roBop no MHAEKC BU
O0BO3MOXyBa bupane Ha UHAekcoT Ha P n *, HamecTo
npebapyBare H1U3 MEHUTO U N3bupare Ha coodBeTHaTa
rpyna.

Oupame co egeH gonup

BupaneTo co egeH gonup B1 0BO3MOXKYBA Aa BOCTNOCTaBUTE
MOBMK CO NPUTUCKaHE N 3a4pXKyBake Ha e4HO Of
Konuunkwarta (1-9).

1. 3agpxeTe ro NnpuTUCHaTO 6apaHOTO Kon4e HEKONKY
cekyHaun. BawmotMTH800ke ro npukaxe 6pojoT u ke ro
n3bepe.

2. 3a npeknHyBaH€e Ha NMoBWKOT, MPUTUCHETE @

mAko rpozpamuparbemo Ha Kon4uskama co e0eH 0onup
€ 0803MOXeHO, buparemo co edeH G0ornup e OHEBO3MOXEHO

(sudeme Ha page 29).
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DTMF npeHeceHo 6upame

[okonky BalIMOT faBarten Ha ycnyru ro
noctasun, DTMF B1 oBo3MoOXyBa Aa

KOMyHMLMpaTe co aBTOMaTCKM ypeq 3a <ahmmaLvo>

oarosapamse (Ha npumep, rmacoBHa noLuTa Tenecho 80
6:

UNu cekpeTapka) 3a BpeMe Ha npuBareH, 12545467890

TenedoHckn unm PABX-noBuk BO Tek.

Mpn npuBaTeH, TenedoHckn nnn PABX-N0OBKK BO TeK,
NPUTUCHETE ' konunkata 3a DTMF (0-9, *, #). Kora
e nputncHaro, DTMF-konyeTo ke ormacu TOH U BHeceHaTa
uMdpa ke ce NpuKaxke Ha ekpaHoT.

MS-ISDN

Ogaa oanuka gogasa ISDN-6poj Ha paguoTo. KopucHuuuTe
Moxe aa nsbepat mefy MS-ISDN u ISSI 3a ga Bocnoctasat
MOBMK, McrpaTaTt nopaka unv npeTxoaHo AedunHupaH
obpasel,. DyHKUMOHMPaA M NPU €OHOHACOYHU 1 ABOHACOYHU
nosuuwn, Bp3 ocHoBa Ha gogeneHunot ISDN-6po;.

Cnucok co nocnegHyn noBULUM
WN36epeTte 6poj of CNMCOKOT CO NOCMNELHU MOBULIN.
Buaete Bo ,[locnegHu noBuumn” Ha cTpaHuua 176.

Bupame 6poj Bo nopaka
Bupete Bo ,,0upane 6poj Bo nopaka” Ha cTpaHuua 199.

Bupare Ha NnpuMeH NOBUK
Bupete Bo ,Bupare npu npumare NoBUK” Ha cTpaHuua 80.

oaroBapame Ha TtenedgoHcku unu PABX-noBuk
1. MTHB800 ce npdpna Ha pojoosHuoT TenedoHcku/PABX
NMOBUK.
2. 3a ga ogroBopuTe Ha LOjA0BEH NOBUK, MPUTUCHETE @ unu

Koe BUno Kon4e WTo e nporpaMmpaHo (Co MCKMY4oK Ha
MaTUYHO Konmye/konye 3a NpeknHyBare/BKIyYyBaHe-
UCKNy4YyBaHe).
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3. 3a Aa ro npekuHeTe NoBwKoT, NputucHete .

[okonky 6apaHoTo nuue Unu nHpacTpyKkTypaTa ro npekuHe
MOBMKOT, Ha eKpaHoT ke ce nojaeu nopakara MpekuHar
NOBMUK.

_3a cuzHan 3a rnosuk, sudeme 2u nocmaskume 6o onyuume
SABEJIELUKA Ha meHuUmo 3a subpayuu (page 149) u 80 MeHUMO Ha

moHosu (page 154).
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®yHKUMOHUPaHEe BO UTHU crny4vau

OnwTo

Hokonky MTH800 e Bkny4eH, onumjata 3a UTHU cnyyau
e pocTanHa Bo pexunmotr TMO n DMO.

BawuvoT faBaTen Ha ycryrv Moxe fa ro OHEBO3MOXW
WHAMKaTOPOT (CUrHaNHWTE TOHOBM) 32 PEXUMOT Ha UTHU
cnyyau.

Opnuka 3a ABoeH MUKPOOH
Buaete Bo ,HaunH Ha gpxewe HAMTH800” Ha cTpaHuua 17.

Bne3 Bo TMO vnn DMO-pexum

Bupete Bo ,M36uparwe TMO nnu DMO-pexum” Ha
cTpaHuua 33.
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BaxHu nHdopmauumn
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* Bpememo nompebHo 3a da npumucHeme Ha Korn4yemo 3a

umHu criy4au e cmaHd@apdHo nocmaseHo Ha 0,5 cekyHOu.
Bawuom 0asamen Ha ycnyau Moxe 0a 20 KoHguaypupa
8pemMemo (pexxumom 3a UmHuU criyyau Hema Oa ce
akmueupa ako epemMemo e rnokpamko o0
KOHGbu2ypupaHomo).

Co npumuckar-e Ha Kon4emo 3a UmHu cryqau ce
akmugupaam eOHa unu riogeke ycryau:

- PEXUM 3a UmHU criyyau

- ucripakar-e anapmM 3a UmeH cryyaj

- aKmueuparbe Ha ornepauyujama ,8Kiy4eH MUKPOQOH"

- 3arioy4yHysar-e Ha rnoeduHeYeH rnosuK 3a UmeH criyyaj

- BK/yyyear-e Ha mepmMuHamnom

- Ucnpakawe Ha GPS uHgopmayuu 3a fiokayujama,
O0KOJIKy 08aa oryuja e 0803MOXeHa 00 8aluUom
Oasameri Ha ycnyau

Co npumuckarbe Ha Korn4emo 3a UmHu crydau, 0ypu

U aKo e akmusupaHa o05ukama 3a cripeyvysar-e Ha
npeHocom, MTH800 sedHaw 20 cripogedysa rnpeHocom.
Bawuom MTHB800 He mpeba da 6ude 8o obriacm
yyecmeumernHa Ha P® ripu eneaysare 80 PEXUM 3a
ummHu cnyyau!

MTHB800 eo npekuHysa AL-rosukom Koza Ke 20
pumucHeme Kon4emo 3a UMmeH Cr1y4aj.

3a cueHan 3a nosuk, sudeme au nocmaskume 80
onyuume Ha MeHUmMo 3a subpayuu (cmpaHuua 149) u 8o
MeHUmMo Ha moHosu (cmpaHuya 154).



IPYNHMOT NOBWK 32 UTHW CryYan e KOHPUIYpUpaH Kako
HETaKTUYKU MU TaKTUYKK:

* HeTakTn4ikM noBuk ce BOCNOCTaByBa 3a rpynara 3a
pas3roBop ogpeneHa o4 BalnoT gaBarten Ha ycnyru.
prnaTa Moxe ga ouae pa3nnyHa oA rpynarta npukaxkaHa
Ha eKpaHOT Ha TepMUHaroT Kora ce 3arno4yHyBa NoBUKOT.
Mo n3neryBamheTo o HETAKTUYKUOT PEXUM 3a UTHU
cny4yau, TepMuHanoTt Ke ce nosp3e COo rpynara M36paHa
npen ga ce 3arno4yHe HETaKTUYKMNOT NOBUK. prnMTe 3a
pa3roBop He MOXe Oa Cce MeHyBaaT 3a BpeMe Ha
HETaKTUYKMOT PEXNM 3a UTHU CllyHan.

Mopaknte DGNA HemaaT edekT 3a Bpeme Ha
HETaKTUYKNOT PEXMM 3a UTHU Criydau, TyKy camo no
nanerysame ofj HETaKTUYKNOT PEXUM 3a UTHU Cryyau.

« Ce BOCMOCTaByBa TAKTUYK/ MOBMK 3a TEKOBHO M3bpaHaTa
rpyna 3a pasroBop.

MoBuUK 3a UTHU criy4yaun

Moxe ga BocnocTaBute NOBUK 3a UTHU CriyYan Npeky
kon4yeTo 3a PTT mnu kon4yeTo 3a UTHU criyyam (BO pexum 3a
WTHW Criy4an) OOKOSKY € OBO3MOXEH. TepMnHanoT
0be3benyBa MHOpMaLNM 3a TEKOBHMOT aKTMBEH MOBUK 3a
UTHW criyqan. [JoKomKy noBmuuTe 3a UTHU Criydaum ce
OHEBO3MOXEHW, Ha ekpaHoT ke ce nojasn ,PTT e ogbueH".

BknyyyBale BO UTHU crly4au 3a Bpeme Ha 3aknydeH PIN

Bes orneg fanu e BO oyHKUMja, TEPMUHANOT Bnerysa Bo
pexuM 3a UTHU criydam 6e3 ga ce nojasu ,3aknydeH PIN
TepMunHanoT ke ro BpaTu ekpaHoT 3a BHecyBawe Ha PIN kora
Ke nsnesete o peXMMOT 3a UTHU Criyyau.

Appecupare Ha anapmMmoT

,D,OKOJ'IKy ajgpecarta e rnpueartHa, nopakarta ce Mcnpaka no
NpeTxXxogHoO ogpeneHarta noeanHedyHa agpeca.

Appeca 3a rpyna:

+ TaKTU4KKM — NopakaTa ce Ucnpaka Ao nNpukadeHaTa rpyna
3a pasroBop
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» Hetaktuukm - nopakata ce ncnpaka 4o NpeTXo4Ho
ogpegdeHa rpyna geduHunpana Bo GSSI/ISSI

[okonky He e n3bpaH HUTY efileH, anapMoT ke ce UcnpaTtu Ha

appecata ob6e3beneHa of 4aBaTenoT Ha ycnyru.

UteH cny4yaj Bo TMO-pexum

Mpernep
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[MpoBepeTe ja koHMUrypauujata Ha BalWMOT TEPMUHAN Kaj
BaLLMOT AasaTen Ha YCnyru.

Bawwuot TepMunHan Moxe aa ce KOHd)VIprVIpa Ha eaeH oa
cnegHunBe Ha4YNHU:

MpyneH nosuk npu umHu cay4au

TepMVIHaJ'IOT Ke Briese BO PeXunm 3a NTHU crniy4yam Kora Ke ro
3agpXnUTe NpUTUCHaATO KONYEeTO 3a UTHU Clly4au.

PexxumMoT 3a UTHU criyyan B1 OBO3MOXYBA Aia ro KOPUCTUTE
PTT 3a npeHoc co NpMopuUTET Ha UTEH cny4aj (Npeky
BOCNOCTaByBak-€ Ha rpyneH NoBuK 3a UTHU cryYyan nnu
Bapare Ha NpUOPUTET 3a MPEHOC MPU UTHU Criyyaun).

Mo BrneryBaH-eTO BO PEXUMOT 3a UTHU CIlyyau, MoXe Aa
ucnpaTtute anapMm 3a UTHU criydam (ako e KOHUrypupaH)
1 NoToa Ja BOCNOCTaBUTE rPyNeH NOBUK 3a UTHU Cryvam

W Oa ro aktuempare ,BKIy4eH MUKPOGIOH® (JOKOMKY

€ KOHurypmpaH).

Anapm 3a UTHU crnyyaum e nocebHa nopaka 3a craTtyc
ucnpaTeHa 0o nHdpacTpykTypaTa npes aa ce BoCnocTasm
rPYNHUOT NOBUWK 3a UTHU cnydan. TepMrHanoT Moxe Aa
noyeka NOTBpAyBak-e Ha OBOj anapM of MHdpacTpyKTyparta
W oa npaeu NOBTOPHW obuan. TepMmmnHanoT ke ncnpartum
anapM 3a UTEH Crny4yaj cekorall Kora ke ro npuTucHeTe
KOMYeTO 3a UTHW criyyau.



Opnukata Bkny4yeH MUKpodOH B/ OBO3MOXYBa Aa
36opyBarte 6e3 ga ro nputucHete PTT. Co nputnckame Ha
kon4yeTto PTT gogeka e akTMBupaHa ognukarta ,BKny4YyeH
MUKPOOH", Ce NpPekMHyBa NPEHOCOT Ha ,BKMy4YeH
MukpodpoH“. Co npuTncKkake Ha NPOrpamcKoTo Konye
NPeKuHyBake Ce NPeKnHyBa akTUBHOCTA Ha BKITyYEHWOT
MukpodboH. Kora ognukaTta ,BknydYeH MUKPOOH"

€ OHEeBO3MOXeHa, 3a Aa 3bopyBaTte KOpUCTeTe ro Kon4yeTo
3a PTT.

lMpueameH noeuk Npu umeH cJiy4aj (€GHOHaco4YeH unu
080Haco4eH)

TepMnHanoT ke BOCMOCTaBM NOBUK 3a UTHU CrlyYau KOH
npeTxogHo aedunHMpaH 6poj 3a nagHTUdmKaumja kora ke ro
NPUTUCHETE N 3apXKNTE KONYETO 3a UTHU Crnyyvyau.
[okonky efeH npmBaTeH NOBUK 3@ UTHM Crly4an ce NPOMEHM
BO rpyneH MOBWK 3a UTHW Cly4aun, TEpMUHAnoT Ke Bre3e BO
PEXMM 3a UTHU CIlyyaun 1 Ke nanese of peXxvMoT 3a UTHU
cry4yam Kora NoBMKOT Ke 3aBpLuu.

MpuBaTeH NOBUK 3a UTHU CryYau U anapm 3a UTHU
cnyyam

[lokonky agpecara e noctaBeHa kako NpueaTHa 1 anapmoT
33 UTHU CryYan € OBO3MOXXEH, MPUTUCHETE o KOMYeTo 3a
WTHW Cny4au 3a Aa ro ucnpatute anapMoT 3a UTHU criyyau
[0 agpecata KoHurypvpaHa of Aasatenor Ha ycnyru. Kora
ce UCMOMnHeTH THe YCIoBM, Ce BOCMOCTaByBa NMOBMKOT 3a
UTHW cnydau.

MeHYBaI-be Ha nanka wnu rpyna

Bupete Bo ogaenor 3a rpyneH noBuK Ha.

Bnes n nsnes og PEXNMOT 3a UTHU crniyvyau

Mo BReryBarmbeTo BO PEXMMOT 3a UTHM CrlyyYaun CeKoj
MOCTOEYKM MOBWK UM YCIyra OCBEH ycnyraTta 3a nakeT co
nogartoum ke ce npekuHe.
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Bo pexumoT 3a UTHK criydyanm TEpMUHANOT aBTOMATCKM Ke
onbue TenedoHckn, PABX 1 npuBatHM NoBuumM 1 HeMa ga
cneaw rpynuTe BO CMMCOKOT 3a CKeHMpake n3bpaH og
kopucHukoT. Cenak, AOKONMKy e n3bpaHa rpynata ATG,
TepMUHarnoT Ke rv cneam nogrpynute nosp3aHu co ATG.
TepMnHanoT ke oCTaHe BO PEXUM 3a UTHM Crnydaun ce gogeka
He nsneserte of PEXUMOT.

[MpuUTUCHETE 1 3apPXKETe o KOMYETO 3a UTHU  [Fq & = |
cny4yau 3a fia BneseTe BO PEXUMOT 32 UTHU Wren cnyvaj
cny4vam. Manka 1

I'pyna 3a pasrosop 1
Kora MTH800 e uckny4eH, NpUTUCHETE ro 3ppaso
oBa kon4ye 3a MTH800 ga ce Bkny4m BO Onun | [Vianean
pPexunm 3a UTHU cny4daun (ako e
KOHUrypmpaH).

TepMUHaNoT M3neryea o PeXuUMoT 3a UTHU cryyaun U ce

npedpna Ha MaTUYHUOT eKpaH:

* AKO ro NpUTUCHETE 1 3aApXKUTe NPOrpamMckoTo Konye
M3neau Bo Tek Ha rpyneH NOBUK 3a UTHU criyYau.

* aKo MHdpacTpyKypaTa ro NpekMHe rpynHUOT NMOBUK 3a
UTHW cry4yau.

ucnpakake anapm 3a UTeH crnyuaj
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Bawwuot MTH800 ke ncnpatn anapm 3a UTeH cry4vaj 4o

ancneyvepoT (OOKOMNKy € KOHUIypupaH of cTpaHa Ha

JaBaTtenoT Ha ycnyrara):

* aBTOMAaTCKW, MO BNE30T BO PEXMMOT 3a UTEH Cry4aj.

* aKo ro NPUTUCHETE KOMYETO 3a UTHM Criyyamn gogeka
MTHB800 e Bo pexum 3a UTHK cry4aum.

* aKo ja NPOMeHUTe rpynara Aofeka ypeaoT € BO pexuM 3a
WTHW cryyau.

Ha ekpaHOT Ke ce nojaBu efeH oA criefHuTe U3BeLlTan 3a

ucnopaka:

* UcnpateH anapm

¢ AnapMmoT He ce BKIy4u



Bo aBata cnyyau, 3a HEKOMKY CEKYHAWU Ha ekpaHoT ce Bpaka
rMaBHUOT NPUKa3 Ha PEXMMOT 3a UTHU criyyau.

lMopagu HenocToewe Ha nNoTepaa 3a ucrnopaka so DMO-
pexuM, UcnpaTteH anapm vHgopmMauujata ce noTBpAayBa co
npakate anapm.

Nnwn - nokonky e kKoHdurypupaH of BalivoT JaBaTen Ha
ycnyru - sawmot MTH800 ke ncnpatu anapm 3a UTHu
cny4vau:

* [OKOJKY ro NPUTMUCHETE KOMYETO 3a UTHU crnydaun 6e3

NPETXOA4HO Aa BNe3eTe BO PEXMM 3a UTHU Criyyau.

- OpyruTte ycnyru 3a UTHU cny4daun, Kako LITO ce
3ano4yHyBaH-ETO Ha PEXMM 3a UTHU cnyyam Bo TMO unu
3anoyHyBar€ Ha NpmMBaTEH NOBUK 3a UTHW Criyyam ke
ovaart HegocTanHu.

- HeMma fa ce nojaBu BU3yerHa unv ayamo curHanusauguja
npu ncnpakakweTo Ha anapmoT 3a UTHK Ccriyyau.

MHemu cucmemu He ja no0dpxyeaam odnukama 3a anapm
MpuU UMeH crly4aj Koea KOpuCHUKOm e 80 obriacm 80 Koja
Moxe Oa Kopucmu JloKasnHa ycriyea (gudeme Ha
cmpaHuya 44).

mBucoxuom/Hucxuom 38yK He enujae Ha pabomama 80
PeXUM 3a UMHU criydau.

BOCHOCTaBYBaH:e rpyneH noBuK 3a UTHU Ccliy4dau

3a epeme Ha epyreH Mosuk 3a UMHU Criydau, ce ywme Moxe

Maa usspuwysame ornepayuu 3a epynama (Kako wmo ce
MeHysar-€e Ha epyna/narka, npebapysare Ha epyna unu
eneaysare 80 narkama ,Mou apynu®).

3a pa 3anovHeTe Uiy O4roBOpUTE Ha MOBUK BO TEK HA
PEXUMOT 3a UTHU Cryyvaum:
* [MputncHete n 3agpxete PTT.

+ [ModekajTe ro TOHOT 3a A403BOMa 3a Pa3roBoOp (AOKOMKY
€ KOHpurypupaH) un 36opyBajTe.
+ OTtnywrTeTe ro konyeto PTT 3a ga cnyware.
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3a usBewTanTe 3a 4OCTaBa, BUAETE BO ,MCMpakake anapm
3a UTEeH crnyyaj” norope.

WcTo Taka, BO PEXnMOT 3a UTHK Clydan nnum npu

CTaHOapAeH rpyneH NoBUK MOXE [a yYyecTByBaTe BO rpyneH
MOBWK 3@ UTHM CriyYau (3ano4HaT of Apyru).

Opnuka 3a BKiy4eH MUKpodoH Bo TMO-pexnm

AKo oasnimkaTa ,BKrydYeH MUKPOGOH“ € nporpammpaHa Bo
Bawmot MTH800 of cTpaHa Ha BalIMOT JaBaTen Ha ycrnyru,
MOXe Aa BOCrocTaBuTe rpyneH NoBuK 3a UTHKU cnydan 6e3 aa
ro gp>xxurte nputucHarto konyeto PTT.

Mo BrneryBare BO PEXUMOT 3a UTHU Criydaum Ke ce Cry4m

crnegHoTo:

1. Bawwuot MTH800 aBTOMaTCKM Ke ncnpatu anapm 3a UTeH
cny4aj [o oucnedepoT (QOKONKY € KOHurypupaH oa
AasartenoT Ha ycnyru).

2. Ke cnywiHeTe ToH 3a 403BONa 3a pas3rosop.

3. Ke ce nojasw crnegHmoT ekpaH: MukpodoHoT

ke ocTaHe BKIyYeH 3a oapeaeH BPeMEHCKU &
nepuoz, ofipeaeH 1 NPorpaMMpaH oz ]
BaLLMOT faBaten Ha ycryru. ama g e
Mo ncTeKyBaHeTO Ha BPEMETO 3a ,BKNy4eH fPyna 52 pasrosop |
Omyan | [Mpexutmn

MUKPOGOOH" NN AOKOSKY ro NPUTUCHETE
konyeTto 3a PTT BO Bpeme Ha ,BKNy4eH
MUKPOMOH" MNK ro NPUTUCHETE NPOrPaMCKOTO Konye
MpekunHun: ke ce nojasm nopakata Uckny4yeH MUKPOIOH 3a
MTHU cnydam. Co Toa 3aBpLUyBa cecujaTa Ha pa3roBop. 3a
Aa NpoaormKuTe, NOBTOPHO MPUTUCHETE MO KOMYETO 38 UTHU
cny4vau. BaweTo paguo Moxe aBTOMaTCKu Aa NPOAOSTKN CO
cecujaTa co ,BKny4YeH MUKPOOH® Kora € 0BO3MOXeHa
ognukata HanameHu4veH Bkny4vyeH MukpodoH. [lossonarta
3a pas3roBop ce gogernysa 6e3 kakBa 1 Aa 6uno nHtepakuuja
o[ cTpaHa Ha KopucHUKOT. Ce nojaByBa UCTUOT MHAMKATOP
Ha eKpaHoT, Kako 1 3a OBUYHNOT BKITyYEH MUKPOCOH.

meeMemo 3a pa3z2oeop U 8pemMemo 3a rnpodornkeHa cecuja
Ha 8KIy4eHuUom MUKpOogOoH 20 ymepdysa gawuom dasamerl
Ha ycrnyau.
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Ako My ce oafe 403BOMa 3a pasrosop Ha

OpYr YneH Ha rpynara, Ke CriyLLUHeTe TOH KOj 4.
o
O3HayyBa JeKa MOBUKOT 3a UTHU cnyyaun e =E Sn”y”qﬂf;ay”nﬁ:eﬁa
npumeH. [Jokorky e KoHdgurypupaH og i
BaLLMOT AasaTen Ha ycnyru, Bawmnot MTH800 | meodosor
Onuyum l [ Wanean

aBTOMaTCKku ke ce obuae NoBTOpHO Aa Aobue
[03Bora 3a pa3roBOp U Ha eKpaHoT Ke ce
nojasu nopakara lNoyekajte Aa ce BKIy4Yn MUKPOOHOT.

m Bo mek Ha epememo Ha Yekarse, MukpoghoHom Ha MTH800 He
€ aKkmugeH ce 00 MOMEHMOM Koaa MoBMOPHO Ke ce rnojasu
ropakama MuKpogOHOM 3a UMHU Criy4au € 8KJTy4eH.

m Odnukama 3a eKkiy4YeH MukpogoH e docmarnHa eo DMO
u TMO-pexum.

npumMmame rpyneH noBuK 3a UTHU cniy4vyaun

TepmuHan wto e Bo TMO-pexum npuma rpyrneH nosuk 3a
WTHM CrlyYan HaMmeHeT 3a n3bpaHaTta rpyna, noBp3aH co ATG
(CoonwTeHwne 3a rpyna 3a pasroBop) UNn CKeHMpaHa rpyna.
[okonky TekoBHO nsbpaHarta rpyna e ATG, TepMUHanoT Ke ro
NPVMMW rPYMHMOT NOBMK 3@ UTHM Cly4an HaMeHeT 3a rpynara
noep3aHa co ATG. (3a noseke nHgopmauun okony ATG,
BuaeTe cTpaHuua 47.)

Kora MTH800 npuma nosuk, Ha ekpaHOT ce nojasysa Onuwuja
3a UTHU cny4yau BO ynOTpeGa N NOEHTUTETOT Ha
NOBWKYBaYoOT.

AKO No BreryBakeTO BO PEXUMOT 32 UTHUM Crlyvau, BalnoT
MTHB800 npuma NoBUK 3a UTHU Cnyyawn, a ognukaTa ,BKIyYeH
MUKPOMOH* € OBO3MOXKEHA Of BaLLMOT AaBaTen Ha yCcnyru,
Ha eKkpaHoT Ke ce nojaBu nopakarta ,[lovyekajte ga ce BKy4n
mMukpodoHoT. Bawmotr MTH800 ke ce obnage aa nobue
[03BONa 3a pasroeop.

FMacoT Ha NOBMKYBa4OT ceKorall ke ce NpeHecyBa npeky
3BYYHMKOT (OCBEH aKo CO TEPMUHAMOT e MoBp3aHa
HaZlBOpeLUHa cryLianka).

3agHuHaTa Ha ekpaHoT ke Guae upBeHa ako
e KoH(UrypupaHa of BalLUMOT AaBaTern Ha yCryru.
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BOCHOCTaByBaI-be Ha npunBaTeH NOBUK 3a UTHU CllyHau

1. 3agpxeTe ro NPUTUCHaTO KOMYETO 3a UTHU Criyyaw.

2. TepMnHanoT ke ro 3anovHe NOBUKOT Kako eqHOHaCcOYeH
UN1 ABOHACOYEH NOBUK (aKO € MporpaMmpan).
NaoeHTUTeToT 3a UTHM Criyvam € NpeTXoaHO oapedeH U He
ce npuKaxyBa.

3. MNpoporxeTe co NOBUKOT Kako BOOOMYaeH eaHOHaco4eH
Wy ABOHACOYEH NOBUK.

Mpumarse Ha NnpuBaTeH NOBUK 3a UTHU Crly4yaun

1. NaeHTnTeTOT Ha NuuEeTo WTO 360pyBa Ce NpuKa)kyea Kora
TepMUHanoT ro npuma eaqHOHaCo4YHUOT NOBUK.

2. Kora TepMyHanoT ro npuma noBWKOT, HA EKPaHOT ce
nojasysa Onuuja 3a npuBaTeH NOBUK BO ynoTpeba
W NOEHTUTETOT Ha NMOBUKYBAYoT.
3agHunHaTa Ha ekpaHoT ke buae upBeHa ako
€ KoHurypumpaHa of BalLMoT faBaTern Ha yCnyri.

3. MpopormkeTe CO NOBMKOT Kako BOOOUYaEH eqHOHaCcoYeH
U OBOHACOYEH MOBUK.

MeHyBaHe Ha BUAOT Ha NOBUKOT

NHdpacTpykTypaTa MOXe a rv MeHyBa TEKOBHUTE MOBULM

Ha criefH1Be Ha4YuHMK:

* 0f rpyneH NoBMK 3a UTHU Criy4an BO MpUBAaTEH MOBUK 3a
UTHW cryyam n obparHo.

* CeKoj of ropHUTe ABa NoBMLUM MOXE Aa ro MeHyBa BO
TenedOHCKN NOBUK.

[okonky oanukara 3a BKIy4eH MUKPOMOH NpeknHe co

aKTMBHOCTa Kora ke ce U3BpLUX N3MeHaTa, Ha eKpaHoT Ke ce

nojasu nopakata Uckny4yeH MUKPOdPOH 3a UTHU Criyyau.

MpogormkeTe cO N3MEHETUOT MNOBUK BO 3aBUCHOCT 0f BUAOT

Ha MOBUKOT.
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NpuAayLeH peXxuM 3a UTHU criyyau

MpuAayLWEeHNOT pexMM NpW UTHU CRyYau e BUA Ha ycryra npu
WTHW ClyYam LWITO He AaBa 3BYYHM MHOMKALMM U TOH Npu
npuTUCKake Ha KonyukaTta Ha Tactatyparta. MpuayweHnoT
anapm 3a UTHU criyyaun ce ucrnpaka Ha rpyna unm KOpuCHuK
WTO ce AedMHMPaHW of AaBaTenoT Ha ycnyraTta. Cute
MHOMKALMU Ha eKpaHOT PyHKLMOHUpaaT Kako 1 npu
HOpMareH PexuM, HO TEPMUHANOT He MOXe Aa ' KOPUCTU
yCIyruTe, co UCKMy4oK Ha:

* npvMarbe aMbueHTarnHo cryluare.

* ucnpakawe NpuayLeHn anapmuy 3a UTeH cryyaj.

* ucnpakawe GPS-curHan, Bp3 ocHoBa Ha SDS-
annukauujaTta.

Bnes Bo npuayweHnoT pexunum 3a UTHU criyvdau
3a Bnes3 BO npnayweHUoT pexxmum 3a UTHU criy4dau,
KOPUCHUKOT Tpe6a Oa ro NpuTUCcHe Kon4eTo 3a UTHU crny4vau.

m Osaa odnuka mpeba da 6ude 0803MoXxeHa 00 sawuom
Oasameri Ha ycryau.

nines oa npnayweHmnoT pexnm 3a UTHU cnyvdau
3a nanes og npnayweHnoT PeXxXum 3a UTHU criyydan:

* KOPUCHUKOT ro MHULMpa co nputuckarwe Ha MeHu n notoa
kon4yeTo # BO nepuop of 3 CeKyHaw.
* NpUayLeHOoT anapM 3a UTHU Criydaun e HeycneweH unuv
onbuveH
M[laeamemm Ha ycryezama 20 rnocmasyea bpojom Ha obudu
u nepuodom Ha Yyekar-e 3a 002080p Ha anapmMom 3a
esawiuom mepmuHarsn. Moxe da ce npekuHe camo Koza
KOpUCHUKOM Ke u3ne3e 00 rpudyweHUuom pexum 3a UmHuU
criyyau.

* aMOMEHTaNHOTO CryLlake ce NPekMHyBa.
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MHTepakuuja Nnpu npuayLieH peXxuMm 3a UTHU criyyam

KOPUCHUKom 20 npumuckKa Korn4emo 3a umeH cnyqaj
npu npudyweH Pexum 3a UmHu ciy4dau

+ TepMUHanoT ucnpaka NnpuayLleH anapm 3a UTeH cryya;.
* TEPMUHASOT He AaBa 3ByYHa/BMANVBaA MHAMKaUMja.

m,ﬂomfmy 6amepujama ce u3eadu rpu npudyweH pexum 3a
UMHU criydau, mepMUHanom Ke ce 8Kr1y4u rMoemopHO 80
HOpMasieH Pexum.

npudyuweH pexxum 3a umHu ciydau u TMO/DMO-pexum

Buaejkn NnpuayweHnoT pexmnm 3a UTHU cryvyau e gocTaneH
camo Bo TMO-pexunm, TepMUHanoT Ke ro CMEHU PEXUMOT 04
DMO Bo TMO. Kora KOpUCHUKOT € BKIy4YeH BO NpuBaTeH nnm
rpyneH NoBUK, NPUAYLLIEHNOT PEXUM 33 UTHW CriyYamn vyeka
Hekoj o noBuuuTe Aa buae npekuHar 3a fa ro CMeHu
PEXVMMOT ¥ Aa Bre3e BO NPUAYLIEH PEXMM 3a UTHU CIyyau.
JlokonKy npudyweHuUom pexum 3a UmHuU criyqau ce
Makmusupa 10 rnosuKom, eduHcmeeHama rnpomeHa Ha

eKpaHom e UCYE3HY8aH-emo Ha u3gecmysar-emo 3a
rpusameH/2pyrneH rnoeux.

Ucknyyyeare npu npudyweH pexxum 3a UmHu cryyau

[okonky KOpMCHUKOT ce obuae aa ro UCKy4u pagmoTo npu
npuayLlweH pexum 3a UTHU crnyvyaun, TepMuHanoTt npeMmHyBsa
BO COCTOjba Ha naxHo uckny4vysare. Bo oBaa cocTojba,
cuTe 3BYYHW U BUANMBU MHOMKALWK Ce UCKIYyYeHU, foAeKa
TEPMUHArOT € CE yLuTe BKIyYeH BO NpuayLLIEH PeXuM 3a
WUTHW cryYamn, Kako U NPETXOAHO.

m,ﬂomnw mepmuHanom u3snese 00 npudyweHUOm pexum 3a

UMHU ciydau 1o UCKITydye8aH-emo, mepMuHanom ce
uckrnydyea be3 Hukakea UHOUKayuja.

Bknyuyearse npu 1ayKHO UCKJTyYy8aHse

KOpPWCHMKOT ro NpuTMcKa KONYeTo 3a UTEeH Cryya;j,
TEPMUHANOT MoKaXyBa BKMydyBake, HO Ce yLUTe e BO
NpUAYLLIEH PEXUM 33 UTHU CriyYau.
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npudyuweH pexxum 3a umHu cay4vau u PIN-3awmuma

[okonky TepMUHanoT Brieryea BO NPUAYLLEH PEXUM 33 UTHU
cny4yaun Bo coctojba Ha PIN-3awTuTa, KOpUCHMKOT Tpeba aa
ja BHece wundparta 3a oTknyyyBawe. Kora TepmuHanot
nsnerysa of NpyAyLIEHVNOT PEXUM 3a UTHU Cry4Yau, Cé ywiTe
Ke 6uae Bo coctojba Ha PIN-3awTuTa.

UteH cnyyaj Bo DMO-pexum
Mpernep

Moxe Oa 3arno4yHeTe rpyneH noBuK 3a UTHKU crnydaun 0o
oapeaeHa rpyna.

Mose aa npuMuTe rpyneH NOBUK 3a UTHU Criyvam:
* oA n3bpaHara rpyna 3a pasrosop

* 04 ApYrn KOPMCHULM KO ce HaoraaT Bo obracT o kage
MOXe Aa BM oAroBopar (ako e KOH(Uryp1MpaHo of BallnoT
Aasaten Ha ycnyru). OBoj noBuk € HapeyeH InterMNI
MOBUK.

+ o oTBOpeHa rpyna. (OTBopeHata rpyna e cynep-rpyna Ha
Koja ? npunaraat cute DMO-rpynu.)

MoBuuMTE 32 UTHM CryYam MOXe Aa ce BocrnocTaByBaar

npeky MpexeH NpeMuH 1 penetutop. 3a NocTaBku Ha

MPEXHMOT NPEMWH 1 peneTuTop, BuaeTe ,u300p Ha MpexeH

npemMuH/penetTnTop” Ha cTpaHuua 63.

Opnuka 3a BKIyYeH MUKpodoH Bo DMO-pexum

OBaa kapakTepucTuka My OBO3MOXYBa Ha KOPUCHUKOT Aa
Ouvae cnywHat npyu UTeH cny4aj, 6e3 nputnckamwe Ha
kon4yeTo 3a PTT. OBaa ognuka Tpeba ga buge oBo3moxeHa
of BalumoT gasaten Ha ycnyru 3a DMO-pexum. 3a
nogeTanHu nHopmMmaumm 3a Kapaktepuctukara, Bugete Bo
,OanuKka 3a Bkrny4yeH mukpocoH Bo TMO-pexnm” Ha
cTpaHuua 96.

mKaaa mepMUHaIom e 80 PEXUM 3a UMHU Cily4Yau u ce
npegpna 00 TMO Ha DMO (u o6pamHo), odnukama 3a

8KITy4eH MUKPOGOH Ke ocmaHe akmusupaHa.
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MeHyBaHh€ Ha nanka unu rpyna

MpoponxeTte kako WTO € objacHeTo BO 044enNoT 3a rpyneH
nosuk, ,TMO-rpyneH nosuk” Ha cTpaHuua 47.

BOCI'IOCTaBYBaI'be rpyneH noBuK 3a UTHU criy4vyaun
3a fa 3anoyHeTe unv oaroBopuTe Ha NMOBUK:

1. Bnesete BO pPexnmMmoT 3a UTHU crny4vyan Co NpUTUCKaH€
Ha konyeTo UTHKn cny4au.

2. MputucHeTe n 3agpxete PTT.

3. MNoyekajTe ro TOHOT 3a JO3BOMAa 3a Pa3roBOp (AOKOSKY
€ KoHdUrypupaH) u 36opysajTe.

4. Otnywrerte ro konyeTo PTT 3a ga cnyware.

Bawuom MTHB800 eneaysa 6o TMO-pexum co npumuckare
mHa Kkornyemo MmHu cryyau (ako e KoHgueypupaHo 00

sawuom dasamer Ha ycrnyau). TepMuHamom ce nospaysa co
npemxodHo o0pedeHama epyrna 3a pa3eo8op U 20 3aroyHysa
2pyrnHUOM Mo8uUK 3a UMHU ciy4dau. AKO npemxodHO
odpedeHama epyna e Hegaxeyka, mepMUHaom ce rnosp3ysa
co nocne@Hama u3bpaHa epyna 3a pa32080p.

npumMame rpyneH noBuK 3a UTHU cniyvyaun

1. Ha ekpaHoT ce nojaBysa Onuuja 3a UTHU cry4yan BO
ynotpeba 1 naeHTUTETOT Ha NOBUKYBAYOT Kako NpuBaTeH
6poj unm nceBoOHUM.

2. [NacoT Ha NoBMKYBa4OT CeKorall ke ce npeHecyBa npeky
3BYYHUKOT (OCBEH aKO CO TEPMMHAnOT e NoBp3aHa
HaaBOpeLUHa cnyLuanka).
3agHvHaTa Ha ekpaHoT ke buae upBeHa ako e
KOHpurypvpaHa og BallMOT AaBaTen Ha yCnyru.

* Ako gojaooBHMOT nosuk € InterMNI noBuk Bo pexxum 3a
WTHKW criyyan, MOXe Aa rv BUuauTe nHdopmMauuute 3a
MpexaTta Co npuTuckarwe Ha Onuumn n n3dnpamre
Ha Mpexa.

* Ako gojooBHMOT nosuk e InterMNI noBuk wmo He
€ BO PEXMM 3a UTHU Criyyau, MOXe Aa rm BuguTe
WHpopmaLnnTe 3a Mpexara co nputuckarwe Ha Mpexw.
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KOpUCTEH€e Ha NpefiucTyBa4yoT

WAP- (INpoTtokon Ha 6e3xu1yHa annvkaumja) npenucTyBaqoT
06e3benyBa ycnyru (kako LWITO e npuctan go 6asn Ha
nogartoum) 3a TepmuHanort. [poBepeTe kaj BawWmMoT gaBaTten
Ha ycnyrv 3a JocTanHocTa Ha OBaa oaJnKa.

NkoHM

WkoHa

onuc

&

MpenuctyBakbe npeky BesbegHocT Ha
6e3xunyeH TpaHcnopT (WTLS) go ctpaHuua
https://...

Bo Hebe3bedHa cecuja Ha npesiucmysadyom ce rojagysaam
m UKOHU 3a nakem co nodamouu. (Budeme eo ,MkoHu 3a

cmamyc” Ha cmpaHuua 21.)

Bnes/usnes on npenucTyBayoT o m
OBO3MOXYBak€ Bfie3 BO NpefiucTyBayor S Tiopa
. % KoHTakTy
D,OKOJ_le OaBaTtenoT Ha ycnyrarta ja & Mpenucrysay
KOH(Urypmpa oanukara 3a npenuctysad Ha U% nocrasyeare
BaLLMOT TepMuHan, onuwujata lNpenuctysay WsGepn | [ Hasan

Ke Guae HaBedeHa Kako TpeTa BO MMaBHOTO

MEeHW.

Ako He, onuujata be3beaHocT ke 6uae HaBegeHa Kako TpeTa.

Brne3/nanes on NnpenucTyBayoT

1. MNocTaeeTe ro nakeToT CO NogaTouu Ha rnac u nopaToum
unun camo nopartoum (Bugete Bo ,,[locTaByBawe Ha
noaaTtoyHaTta dyHKumja”’ Ha cTpaHuua 152).

2. Op rMaBHOTO MEHU, MPUTUCHETE [\ 1 n3GepeTte

MpenucTtyBau.
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3. Ha ekpaHoT ke ce nojaBu egHa of cneaHuTe nopaku:
* MpaseH ekpaH (NPBO akTMBMPaHE MO BKyYyBaHETO)
noToa BallaTa MaTM4Ha CTpaHuua.
* rocriegHarta cTpaHuua LWTOo CTe ja NOCETUIE, BO CryYa)j
MOBTOPHO [a ro akTuBupaTe Unu ga npoaorkmTe co
paboTa Ha NpenucTyBaYoT.

mqubopmauuume Ha rnocnedHama cmpaHuya ce rnogpakaam o0

Kew-memopujama, O0OKOJIKY 8peMemo Ha 08aa cmpaHuya He e
ucmeuyeHo u OOKOJIKy npenucmyeadom uma 0080/IHO MeMopuja
3a O0a a2u nospamu 00 Kew-mMemMopujama 80 mMoj MOMEHM.

* MEHMWTO Ha MPEenUCTyBa4oT, aKko ycrnyrarta 3a nakeT co
nogatoun He e gocTanHa. Buaete Bo ,,0HeBO3MOXeHa
ycnyra 3a nakeT nogatoumn” Ha ctpaHuua 107.

4. 3ano4yHeTe ro NPennCTyBakETO CO KOPUCTEHE Ha

TacTtartyparta, KOrn4eTo 3a HaBurauuja BO YETUPU HACOKM
W NPOrpamMcKmUTe Kon4nma.

5. 3a neakTMBMpar-e Ha NPenucTyBayoT, nputucHete 2 nnm
MCKIyYeTe ro TepMUHanoT.

Bnes Bo npo3opuuTe of MEHUTO Ha NPENUCTYBayoT

104

MeHWTO Ha NPenUCTyBaYoT BKITy4yBa NPO30pLIM CO CTaBKU
LUTO ce NoTpebHM 3a hyHKUMOHMPaHe Ha NPencTyBayoT.

1. Mo BNe30T BO NpenncTyBayoT, Kako LWTo e objacHeTo Ha
cTpaHuua 103, nputucHete MeHu nin /ven\

2. O6UYHO Ke ro nogurHe NPo3opeLoT 3a HaBuraumja unm
nocrnegHNoT Npo3opeL, 04 MEHUTO Ha NPENUCTYBaYoT Kage
WTO CcTe bune.

Ke ce nojaen npo3opeL; co onumm, JOKONKY UHTEPHET
CTpaHuLaTa LWTo CTe ja MoCcCeTurne uma aBse unv noseke
nporpamcky Konynksa/onumu.

OTTyka MOXe fa nuararte 4o ApYrUTe Npo3opLm CO NEBOTO
Unn OecHOTO Kon4ye 3a HaBurauuja.

nn moxe na nsbepete MeHM Ha npenucTyBay 1 noToa
Aa nusrate go 6apaHuoT nposoped,.



coBeTU 3a npennctyBame

KpeupajTe ro v kopucTeTe ro cnegHoTo 3a e4HOCTaBHO
npenucTyBatse.

Kpeupane mapkep npeky npo3opeyom 3a Haguzayuja

> O3Ha4vysaHse npo3sopey

O3HauyeTe MHTEpHET CTpaHuLUa 3a 6p30 NpesemMatse.

1. Bnesete BO npennctyBayoT 1 ogete Ao bapaHaTta
CTpaHuLa.

2. MputncHete MeHwu 3a ga BreseTe BO MEHUTO Ha
NpPen1cTyBayoT.

3. N3bepeTe O3Haum cTpaHuua.

4. Ha ekpaHOT ce nojasyBa Ha3neoT n URL Ha o3HayeHaTa
CcTpaHuua.

5. MNputncHete 3auyBaj (1 U36epwm) 3a aa ja 3auyBare
cTpaHuuaTa BO MapKepu.

Nnun n3bepete MeHu n n3bepete onuuja:
» 3a4yBaj - ro NOTBpAYBa KPENPAHETO HA MapKepOT.

* Ypeawm - 003BONYBa ypedyBake Ha Ha3ueoT, M3bopoT
Ha nanka n URL Ha KkpenpaHnoT mapkep.

» OTKaxu - ja OTKaxkyBa onepauujara.

Kpeupar-€ MapKep NpekKy rnpo3opeuyom 3a Mapkepu
> Hoe mapkep

1. BneseTe BO NpenncTyBayor.

2. Jlnsrajte 0o Npo30peLoT CO MapKepwu.

3. N36epeTe OpraHn3unpaj (4oKonky Hema 3a4yBaHu
mapkepwu) unu NMoseke...

4. N36epeTe MeHu.
. Ilusrajte no HoB mapkep.

6. BHeceTe ro Ha3mBoT Ha mapkepoT n URL n nsbeperte ja
HeroBarta fokauuja.

7. NputncHete 3a4yBaj.

[$)]
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KopucmeH-e Mapkep
1. BneseTe BO NpenncTyBayor.
2. Jlnsrajte 0o Npo30peLoT CO MapKepwu.

3. Ilnsrajte go 6apaHnoT mapkep 1 n3bepete AKTUBUPA;].
MapkepoT ja npesema n3bpaHaTta cTpaHuLa Of MHTEPHET.

KpeupaHhe Ha3Ha4eHo Korn4e
[opnenete mapkep Ha Ha3Ha4YeHo kon4ye

(konunma (0£)-E™)) 3a 6p3o Npesemar-e MHTEPHET

CcTpaHuua.

. Bnesete Bo npenuctyBavor.

. Jlnarajte 4o Npo3opeLoT co MapKepu.

. Ilusrajre no GapaHmnoTt mapkep.

. MputncHete MeHu. N36epeTe HasHavyeHn Konuukbsa.
. N3bepeTte HepopeneHo konye.

. MpucHete Dopenu. Ha ekpaHOT ce nojaByBa MapkepoT
W 0OOEeneHOTO Ha3HaYeHo Konye.

O A WON =

KopucmeH-e Ha3Ha4eHo Konye
1. Bnesete BO NnpenncTyBayorT.

2. 3agpxeTe ro NpUTUCHATO HAa3HAYEHOTO KoN4ye 3a Aa ro
npesemMeTe COOABETHNOT MapKkep o4 UHTEPHET.

3ayyeyean-e cmpaHuya

3auyBajTe cTpaHuLla (CHMMKa) 3a NpenucTyBake Jo4eKa He

CTe NoBp3aHW Ha UHTEPHET.

1. Bnesete Bo npenuctyBayoT u ogeTe Ao bapaHata
CTpaHuua.

2. MputncHete MeHw.

. Jlusrajte oo npo3opeLoT co anaTku.

4. N36epeTe 3auyBaj cTpaHuua. YpeaeTe ro npeasiokeHnoT
Ha3MB Ha CTpaHuuaTta QOKOSKY Toa € noTpebHo. Jluarajte
Hapgony n n3bepete 3auyBaj. CtpaHuuara ke buge
3a4yyBaHa BO Mankara co 3a4yBaHu CTpaHuLM Ha MapKepu.
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usbupanse 3a4yyeaHa cmpaHuuya
1. Bnesete BO NpenncTyBayor.
2. Jlnsrajte 0O Npo30peLoT CO MapKepu.

3. N36epeTe OpraHnaunpaj (AoKonky Hema 3avyBaHu
mapkepw) unu NMoseke...

4. 136epeTe AKTUBUPAj 3a Ja Bre3eTe BO Nankara co
3a4yyBaHuW CTpaHMLUM.

5. N3bepeTe 3adyBaHa cTpaHuua u nputucHete OK. Ha
€KpaHoT Ce MojaByBa 3a4yBaHaTta cTpaHuua. Bo 3aB1McHocT
o[ 3adyBaHaTa CTpaHuua, MoXxe Aa NpenuctysaTe rno
WHTEPHET of TykKa.

OHeBO3MOXeHa ycrniyra 3a naket nogatouu

[lokonky ycnyrarta 3a naket co NoAaToLM € OHEBO3MOXKEHa,
Ha eKpaHOT Ha TepMMHarnoT ce rnojasysa MpeLuka:
HepocTanHa mpexa npy NpBOTO BrieryBame BO
npenuctyeayoT. M3bepeTe ro neBoTo NPorpaMcko Konye 3a
NOBTOPHO Aa ce obuaeTe Aa Bnesete UM 4ecHOTO
MporpamMcKo Konye 3a fa BreseTe BO MEHUTO Ha
MpenuncTyBayor.

Mpy NOBTOPHMOT BNE3 BO npenncTyBayoT, Ha eKpaHOT Ha
TepMUHanoT ce nojaByBa nocnegHarta noceTteHa CTtpaHuua,
aKo ycnyrata 3a nakeT co nogatoun npeTxogHo buna
OocTtanHa unn nocnegHarta crtpaHumua WwTo CcTte ja nocetune
Jofeka He cTe Bune NoBp3aHU Ha UHTEPHET.
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OHeBO3MOXeEH Brne3 BO npennctyBa4vor
Bnesot BO npenncTyBa4v4oT € OHEBO3MOXEH:

BO TEKOT Ha KOj ©Onno rmacoBeH NoBUK, CO WCKITy4OK Ha
NMOBMK CO aMOMeHTarnHo cnywanwe

B0 DMO-pexum
BO TEK Ha PEXMM 3a UTHU Ccriyyau
3a BpeMe Ha 3aknyyeH PIN

[OKOMKY 4aBaTemNoT Ha YCryrv He ja KoHdUrypvpan oBaa
ofnuka

Kora TepMmnHanoT € OHeBO3MOXEH.

m * Bnesom eo npesnucmyea4yom e 0803MOXKEeH 80 mMeK Ha
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ambueHmarnHo crywarse (AL). Jokornky oOume Ha
npemxodHO 3a4yysaHume cmpaHuyu, cmamycom Ha AL
Ke ocmaHe.

» Koea 3a npe nam cakame 0Oa ja akmugupame ycry2ama
3a nakem co nodamouyu, AL e uckny4yeHo u umame
4y8cmeo Kako rnpemxodHo Oa He cme Kopucmerie AL.



CoapXuHa Ha Npo3opeLoT Ha MeHUTO

Ha NpenucTyBa4oT

— Hasurauvja

— Mapkepu

— Wcrtopuja —‘_

— Anatku

1 Joma

2 OTBOpYU
cTpaHuua

3 MNpebapysaj
4 O3Hauu
cTpaHuua

5 lNpeHacoun
6 Buntaj
NOBTOPHO
HanpegHo...

— 1 lNMocTasku...—|

3 U3bpun...

5 3a...

<HajmHory 9 3anucu>

<Manka co 3a4yBaHu CTpaHUL>

<HajmHory 9 3anucu>

1 Mpukaxun URL
2 3auyBaj cTpaHuua
3 lNpoHajamn TekcT
4 Vickonupaj TekcT

2 besbenHocT..4+—

1 MNpesematrba

2 PexuMm Ha nuarare
3 Mepay Ha BpemeTo 3a
npuTUCKake Ha
Kon4nkaTa

— 4 lNocTtaBun nocpeaHuk

1 WAP-
nocpegHuk 1
2 WAP-
nocpegHuk 2
3 WAP-
nocpeaHuk 3

5 lMNMopaka 3a kono

6 MpenpaTtu nogaToun

1 MNopaka 3a 6e3begHocT
2 TekoBeH cepTudukaTt
3 CA ceptudpukatu

4 WcnpaTtu ynatyBare

5 MoTtepayBame

— 4 ToBTOPHO aKkTUBMpaHe Ha NpPenucTyBadvoT
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KOPpUCTewe Ha Konynmwarta

Kora npenncTyBavyoT € akKTUBEH, yn0Tpe6aTa LITO e onvlliaHa
BO npoaomkeHne Moxe aa ce BpLin BO UK HaaBOp O
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ypenyBayor.
Mputuckawe .
P Akuuja
Ha Kon4yeTo
MNputucHerTe: » Bo ypenyBayoT: ce BHecyBa Ludpa u/unm 3Hak Bo

Q-

3aBUCHOCT 07} M36PaHMOT PeXuM 3a BHECYBaHe
TEKCT.

+ HagBop oa ypeayBayoT: BO HyMepUpaH Crcok,
u3beperTe ja cakaHaTa cTaBka Of CrIMCOKOT.

MpuTtncHeTe
n 3appxeTe:

Q-

» Bo ypeayBayoT: cTaHaapaHa ynortpeba

* HagBop of ypedyBayoT: HasHayeHo konye 3a
OBWXKere A0 HymMmepupaHnoT mapkep. (3a oBaa
ynoTtpeba, npBo AoAeneTe ro cooABETHUOT
Mapkep Ha KOHKPETHOTO Ha3Ha4YeHO Komnye Kako
LWTO e objacHeTo BO ,kpeupame HazHa4yeHo konye”
Ha cTpaHuua 106.)

MpuTtucHeTe nnn
npUTUCHETE

U 3appxeTe @

Bo ypenyea4doT, BHeCyBa Nnpa3HO MeCTO.

MputncHeTe unn
npuTUCHETE

1 3agpxeTe:

[0 nogurHyBa Npo3opeLoT 3a BHECYBaHE TEKCT BO
ypenyBayoT. Bo cnpoTtuBHO, ce jaByBa curHan 3a
NpUTMCKake MNOrpeLLIHo Konye.

JleBO 1 gecHo
nporpamcko Konye

Ja nsbwupa onuujaTa WTO Ce nojaByBa Ha eKpaHOT
BeflHaLLl Haf, NIeBOTO W AEeCHOTO NPOrpamMcKo Konye
(oen og cTpaHuuara).

o

[logeka cTe BO CMMCOKOT CO OMUMK, OOM €AeH pes
Harope.

MpuTtncHete

1 3appxeTe @

Opw Harope no cTpaHuuara.

&

[loneka cTe BO CMMCOKOT CO OMNUMK, OAN €AeH peq,
Hagony.

MpuTtncHeTe

N 3agpxete @

Opw Hagony no cTpaHuuara.

&

Oy Ha NPeTxogHMOT Npo3opeL.
Bo ypenyBayoT: ogu Haneso




Mputuckamwe
Ha Kon4yeTto

Akuuja

MpuTtncHete

1 3agpxeTe @

Cnyxwu 3a Bpakawe Ha3ag

3

Opam Ha cnegHuoT Npo3opeL,.

Bo ypenyBayoT: ro ABMXM KypCOpPOT HagecHo
1 BHECYBa Npa3HO MECTO kora ke CTUrHeTe 4o
KpajoT Ha 360pOoT.

1 3agpxeTe BO

LeHTapoT Ha @

MputucHete Cnyxu 3a ofere Hanpeq.
1 3appxeTe @
MpuTtncHete ABTOMaTCKO MOBTOPYBake

[\

o NnogurHyBa MEHUTO Ha NPENUCTYBaYOT.

@

[MpuTucHeTe 3a Aa ro geaktusmpare
npennucTyeBayor.

N

OHEBO3MOXEH Kora NpeniMcTyBayoT e BO aKTMBHa
cocTojba.

Konue 3a poTupatrse

Ce kopuvcTU camo 3a npucrnocobyBakse Ha jaumHaTa
Ha 3BYKOT.

WTeH cnyuyaj

[0 peaktusmpa npenucTyBa4oT. TepmuHanot

Breryea BO pexum 3a UTeH cnyqaj.

Mpernen Ha Nnpo3opuuTe Ha MEHUTO Ha

npenucTyBa4yoT

MeHuUTO Ha NpenncTyBadyoT M BKIydyBa CleaHUTE NPO30pLm:

nposopew Ha

onuc
MEeHUTO
Hasurauwja O6e3benysa npuctan 40 MaTvyHaTa cTpaHuua
1 YeCTO KOPUCTEHWUTE CTaBKWU.
Mapkepu O6e3benyBa onumu 3a npuctan, ypegyBawe

1 3a4yByBaHt-€ Ha 3a4yBaHUTE MapKepu
1 3a4yBaHUTE CTpaHNLN.
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nposopew Ha
MEeHUTO

onuc

O6es3benyBa npucTan Jo NOCNEAHO NOCETEHUTE
WcTtopuja CTpaHWLM 1 ja Nokaxysa nosuuunjata Ha
MOMeHTasIHO BYMTaHaTa cTpaHuua Bo uctopujara.

AnaTku O6esbenysa nNpucTan 4o annukauumTe u anatkute.

CnepHuTe Npo3opum ce NpukaxyBaaT cropes KOHTEKCTOT:

Onuun Ce nojaByBa camo Kora vma JOMONHUTENHN Onummn
3a MPO30PELOT UM cTpaHuuara.

Cnuka Ce nojaByBa camo Kora e u3bpaHa cnuka.
O6e3benyBa npuctan Ao getanute, 3a4yByBaHETO
M NPVKa3oT Ha crinkara.

BHecyBame TekcT | Ce nojaByBa camo BO pexvM 3a BHECYBaH-e TEKCT.
O6es3benyBa npuctan 4O PEXUMOT 32 BHECYBaH€
TEKCT (Ha np., cumbon)

npo3opeL 3a HaBuraumja
N3bepeTe eqHa o cTaBkMTE BO NMPOAOIMKEHUE:
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[oma - 3a BUMTyBare Ha MaTuyHaTa cTpaHuua.

OTBOpU cTpaHuuUa — 3a BHecyBarwe Ha URL wto Tpeba
Aa ce ByuTa.

MpebapyBaj — cTaBkaTa € OHEBO3MOXEHa.

O3Haum cTpaHuua — 3a Kpenparbe (3a4yByBah-e) MapKep
3a TEKOBHUOT oKyMeHT. Ce nojasyBaat Ha3meoT n URL 3a
MapKepoT 1 ce n3dbmpa opurnHanHara nanka 3a nokauuja.
MpeHacouu — 3a ABMXKeHe A0 JOKYMEHTOT NouupaH eaex
Yekop Hanpea BO UcTopujaTa 3a Hasuraumja. [JJokonky
Hema ucTopwja Hanpen, oBaa CTaBKka Ce OHEeBO3MOXYBa.
BuuTaj NOBTOPHO — 32 NOBTOPHO BUMTYBaHE Ha
TEKOBHUOT JOKYMEHT.

HanpepgHo... Buaete Bo cnegHnoT ogaen.




HanpegHo...
1. Op npo3opeLoT 3a HaBurawmja n3bepete HanpegHo...
2. Ha ekpaHOT ce nojaByBa CMMCOK CO CTaBKM 3a npuctan go

HanpeaHuTe oaNMMKN U NOCTaBKM Ha NPeincTyBadvoT.
WN3beperTe ja cakaHaTa cTaBka.

rnocmasku...

1. Op npo3opeLoT 3a HaBuraumja n3dbepete HanpegHo...
> NOCTaBKM...

WN3beperTe ja bapaHaTta cTaska.

* MNpesemama — 3a NOCTaByBakE€ Ha NPUOPUTETUTE 3a
npesemane. Moxe aa ro geakTusupare npe3emMakheTo
cnvikn n 0bjekTn. Ha npennctyBayoT Ke ce nojasu
nocebHa MKoHa HaMecTo CnnKUTe N 06jekTuTe.

* Pexxum 3a nusrawe — 3a NnoctaByBak€ HA PEXNMOT
n 6p3VIHaTa Ha nu3ramwe.

» [lo3BoneHo Bpeme 3a NpUTUCKaHE Ha KonYukarta —
3a NoCTaByBaH-€ Ha [O3BONEHOTO BpeMe 3a
npuTUCcKamwe Ha Kondunkwara. OBa Bpeme ce KOpucTu 3a
BHECYBaH-€ TEKCT.

* NMocTaBu nocpenHuk — n3bupare Ha WAP nocpegHuk
(1, 2, 3). MNMpenucTyBayoT ce NOBP3yBa Ha MHTEPHET
npeky n3bpaHnoT NocpeaHuK (MPOKCK) U MpeXeH
npemuH. OnepaTopoT Ha Mpexara ro MHcTanupa u
KOHMrypupa nocpegHuKkoT. 3a ga BocrnocraBuTe
6e3benHa cecuja, nsbepete 6e36eaeH NOCPeHMK.

MpalajTe Kaj BaWMOT gaBaTtes Ha yCryru Koj
nocpenHvk e koHurypmpaH 3a 6e3begHa cecuja.

Mako moxe fa ja n3bepete Bawata matmyHa CTpaHuua,
OaBareroT Ha yCnyrn Moxe fa OAnyyun Aa HaMeTHe
COMCTBEHA MaTU4yHa CTpaHuua Ha BalIMOT TEPMUHAT.

* MNMopaka 3a konoto - 3a BKITYHYYBAHE/
NCKITYYYBAHE Ha nopakara 3a KonoTo.

* MNopaka 3a NOBTOpPHO Ucnpakawe nogaToum —
3a BKJTYHYBAHE/NCKINYYYBAHSE Ha nopakata
3a npenpakakwbe nogaTouu.
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6e36edHocm...

1. Op npo3opeLloT 3a HaBuraumja n3dbepete HanpegHo...
> be3bepHoCT...
N3bepeTe ja bapaHaTta cTaBka.

 Mopaka 3a 6e36egHOCT — 3a Ja OBO3MOXMUTE/

OHEeBO3MOXMWTe npenucTysBayoT Aa Be nssectysa aeka
ja 3ameHun Hebe3benHaTa Bpcka co 6e3beaHa u
obpatHo.

TekoBeH cepTudmKaTt — 3a npernesg Ha AUTMTaNHUOT
cepTudukar 3a ngeHTndmrkalmja Ha cepeepoT LWTO '
AocCTaByBa TEKOBHUTE AOKyMeHTU. OpraHoT 3a
ceptndukaumja (CA) aurutanHo ro NoTnMLyBa 1 Ha TOj
Ha4vH ro noTBpAyBa 0BOj cepTudumkart. Bo
CTaHOapAHUOT CNUCOK CO MHCTanupaHn ceptudumkartu
MoXe da ce gogaaat HajmHory 10 4ononHUTENH
HapayaHn WTLS-ceptudmkatn. KoHTakTmpajte co
BaLLMOT AasaTen Ha ycryru, JOKONKy cakaTte aa rv
aopagete osue HapavaHu WTLS-cepTudmkaru.
CeptudbnkaTtu Ha CA - 3a nperneg Ha gurMtanHuTe
cepTuduKaT LITO Ce MHCTanMpaHu Ha NpenucTyBaYvoT
W ce guruTanHo noTnuwaHn of opraHoT 3a
ceptudmkaumja (CA).

UcnpaTtu ynatyBame — 3a BKITYHYBAHE/
NCKITYYYBAHE Ha ognukaTta 3a ucnpakawe Bpcka 3a
ynatyBaweTo Ao HTTP, kako aen og 6aparaTta 3a
HTTP. BpckaTa 3a ynatyBate My oBo3MOXyBa Ha URL
Ha BpcKaTa U3BOp OO CepBeEpPOT.

MorBpaa — 3a BKITYYYBAHE/NCKITYYYBAHE Ha
oanukaTa 3a Kelmpake Ha 3a NoTBpAa Ha
ceptudukarute 3a HTTP. HTTP-noTBpaarta Ha
aBTEHTMYHOCT ro 3alT1TyBa NPUCTanoT A0 CoapXMHaTa
Ha cepBepoT. [Jokonky ce obugeTte aa npucranute oo
3alWTuUTeHa cogpXuHa, of Bac ke bugaTt nobapaxu
nogatouu 3a notepaa (KOPUCHUYKOTO MME UIn
nosuHkara).



6puwetse...

1. Op npo3opeLoT 3a HaBuraumja n3depete HanpegHo...
> bpuwetnse...

2. N36epeTe Gpuliere Ha nogaTounTe of NPenUCTyBadyoT:
NcTopMja, KeLl, Konavnka Unm aBToOMaTCKO NMOMosHYBak-E.

MmoemopHO aKkmuseupaHe Ha rpesiucmyesadom

1. Op npo3opeLloT 3a HaBuraumja n3depete HanpegHo...
> [lOBTOPHO aKTUBUPaH€ Ha NPeriMcTyBa4orT.

2. MNpenucTyBayoT ke Buae NOBTOPHO akTMBUPaAH, NpuToa
BpuLejku ja nctopwmjata.

3a... ...

1. Op npo3opeLloT 3a HaBuraumja n3dbepete HanpegHo...
> 3a...

2. Ha ekpaHOT ce nojaByBa MHdOpMaLnja 3a TeKOBHaTa
BeEp3uja Ha OTBOPEHNOT MOBUIEH NpenucTyBau.

nposopeL co MapKkepu
,D,OKOJ'IKy MapkepuTe ce Haoraart BO opurnMHanHarta narnka,

nsbepete MosekKe... 3a ga npucTanmTe KOH NPO30PELIOT CO
onuuu.

[loKkonky opurMHanHata nanka e npasHa, uséepere
OpraHusupaj... notoa nputncHete MeHu 3a ga npuctanute
[0 MPO30PELOT CO ONLUN.

Mpo3opeLoT Co ONuMKU B OBO3MOXKYBA [a yrpaByBaTe CO
mapkepuTe.

[MankaTta co 3a4yBaHM CTPaHULU COOPXKM CHUMKM Ha
3a4yBaHUTE CTPaHULN.

pa60Ta CO Mpo3opeuoT Co onuun 3a M36paH Mapkep
1. Opg npo3opeLloT co mapkepu n3depete MoBeke...
2. Jlnsrajte oo mapkep.

3. N3bepeTe MeHu 3a ga ro oTBOpPUTE MPO3OPELIOT CO ONUUN
3a TOj mapkep.
4. N3b6epeTe onuuja:
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Hasap - 3a npvkas Ha cTpaHuuaTa nosp3aHa co
MapKepoT (CTpaHuuaTa ce npesema ako He e gocTtanHa
BO KeLl).

HeTtanu — 3a nameHa Ha Ha3neoT u URL Ha mapkeporT.
M36puim — 3a GpulLere Ha MapKepoT.

HoB mapkep - 3a kpenpare HOB Mapkep.

HoBa nanka - 3a kpenpare HOBa nanka.

MpeHecun — 3a NpeHecyBake Ha OBOj Mapkep BO HOBa
nanka (unun Bo Mapkepu).

M36puwm ru cute — 3a HGpuilere Ha cuTe Mapkepu.
Ha3Ha4yeHu Kon4umMkwa — 3a JogernyBake Ha3Ha4YeHu

konumra ((0F)-@™2)) Ha focTanHu mapkepu.

pa60Ta CO nanka co 3a4yBaHu CTpaHuuun
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1.

Op npo3opeLoT co Mapkepu n3depere ja nankara co
3ayyBaHU CTpaHWLM .

. Ha npenuctyBayoT ce nojaByBa cTpaHuuara (CHUMKaTa)

3avyyBaHa CO NOMOLU Ha oaJfinKaTta 3a 3a4vyByBaH-€
CTpaHuUKn BO NpPO30peLoT CO anaTku.

. Ilnsrajte oo n3bpaHa 3ayyBaHa cTpaHuLa.
. N36epeTe MeHum 3a ga ro oTBopuTe NPO30PELOT CO ONLUK

3a 3avyBaHaTta CTpaHuua.

. 13bepete onuuja:

Ha3ap — 3a npvka3 Ha oBaa CTpaHuUa 3adyyBaHa

BO KelL.

HeTtanu — 3a nameHa Ha Ha3meoT U URL Ha 3a4yyBaHaTa
cTpaHuua.

AXXypupare Ha cTpaHuLla — 3a 3aMeHa Ha 3adyyBaHara
Bep3uja co TekoBHaTa Bep3uja (Tpeba ga ce npeseme
o[, cepBeporT)..

U36puiwumn — 3a GpulLer-e Ha oBaa CTpaHuLa o KeLl.
M36puwim ru cute — 3a OpuLleHE Ha CUMTe 3adyBaHK
CTpaHMLM 0 KeLwl.

OTKaXu — 32 U3ne3 of NPO30peLOT U Bpakake Ha
nocrnegHarta npukaxaHa cTpaHuua.



lNMpo3opew 3a ucTopuja
Ha oBoj nposopeL ce nojaByBa CNMCOK CO NOCMNEeLHO
noceTeHMTe CTpaHMLM (MOXe Aa ce HaBeaaT HajMHOry AeBeT
3anucu Bo nctopujarta). 3a cekoj 3annc Bo Uctopujata ce
nojaByBa HEFOBMOT HACMOB, AOKOMKY MCTMOT NOCTOM.
(Bo cnpoTtuBHO, ce nojasysa ,be3 Ha3nB®)
3a pa ogute oo HeogamHa noceteH URL:
1. N3BepeTte URL.
2. MNpuTtucHeTe ro nporpamckoTo konye OK.
3a ga npuctanuTe o uctopwjara:
1. N36epeTe MNoBeke..., [loToa n3bepete MeHun 3a npukas
Ha NpO30peLIoT CO OMLUUN.
2. N3bepeTe onuuja:

* Mpukaxun URL - 3a npukas Ha URL Ha nsbpaHuot
3anuc og uctopuja.

* U36pun — 3a 6puiere Ha 3bpaHMoT 3anunc
of, uctopuja.

* N36puwm ru cute — 3a GpuLLEHE Ha CMCOKOT
CO 3anvcu og uctopuja.

* U3ne3u - 3a n3nes og Npo3opeLioT CO ONuumn.

» CnepHa cTpaHuua Bo uctopuja u NMperxogHa
cTpaHuLa BO UCTOPUja - 3a NpucTanysake A0
crnepfHara, O4HOCHO MpeTxogHaTa cTpaHuua co 3anucu.

npo3opel Co anaTtku
1. Opg npo3opeloT co anaTtku n3bepete MoBeke...
2. JlnsrajTe 0O JOKYMEHTOT.

3. M136epeTe MeHu 3a fa ro oTBOpPUTE NPO30PELOT CO ONLMM
3a TOj JOKYMEHT.

4. N3b6epeTe onuuja:

 Mpukaxun URL - 3a npukas Ha URL Ha TekoBHUOT
OOKYMEHT.

+ 3auyBaj cTpaHULa — 3a Kpeunpame CHUMKA 3a
TEKOBHUOT LOKYMEHT.
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* MpoHajaun TeKkcT — 3a NpoHaorake TEKCT BO TEKOBHUOT
OOKYMEHT.

* Nckonupaj TeKcT — 3a Konmpame TEKCT Of, TEKOBHUOT
AOKYMEHT BO KnnunbopAa-memopumjata Ha TepMUHarnor.

Mpo3opeu co onuun

OBoj Npo3opeL 1 BKIy4YyBa KapakTePUCTUKUTE
Ha NpuUKaxkaHaTa cTpaHuLa Unm npo3opeL,.

lMpo3opeu co cnuku

OBoj npo3opeL ce nojaByBa BO MEHWUTO Ha NPENUCTYBaYoT,
[OOKOrKY CTe ja OBO3MOXUIE oanvKara 3a npe3emarbe CInku
npeky Mpo3opeu 3a HaBurauuja > HanpegHo...

> MocTaBKM...

[ocTanHu ce cnegHUTE CTaBKuU:

+ 3ayyBaj — 3a 3a4yByBak€ Ha CrnvKaTa Ha TepMUHarOT.

* [McnpaTtu] — 3a ucnpakare Ha crnvkata Ha ogpeauLTeTo
no sawu nstop.

* B‘-IVITaj NMOBTOPHO — 3a NOBTOPHO BYNTYBaH-€ Ha CrinKara.
* Oetanu -3a NpuKa3 Ha getannte 3a Crinkara.

* Mpukaxu cnuka — 3a Npukas Ha crnvkaTa Ha corncTeeHara
cTpaHuua.

nposopeL 3a BHeCyBaHe TeKCT
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OBOj npo3opeL e BuanmB Kora MEHUTO Ha NpennucTyBadoT e
OTBOPEHO M NONETO 3a BHECyBaH€ TEKCT € aKTUBHO.
npeJ'II/ICTyBa‘-IOT MMa HEKOJIKY peXnmMn 3a BHECyBaH-€ TEKCT,
BO 3aBMCHOCT O CakaHWOT BU Ha BHEC.

Ha npumep, 3a ga BHeceTe ekcTeHsnja 3a URL npu
BHecyBahe Ha URL.:
1. BHeceTte URL.

2. MpuTucHete ro nporpamckoTo konye abc. Ce oTBOpa
Npo30peLoT 3a BHECYBah-€ Ha TEKCT.

3. lNusrajte oo www.



4. [puTUCHETE O NPOrpPamMcKOTO Kon4ye Www
5. Jlnsrajte go 6apaHaTa ekcTeH3nja (Ha npumep: .com).

6. MpuTUCHeTe ro NnporpamckoTo Konye .com. Ha ekpaHoT ce
nojaByBa URL co cakaHaTa ekcTeH3uja.

nporpamMmcko .
pexum akKumja
Konye
AndabeTckm 3Haum — abc BHeceTe TekcT co manu
manu 6yksu Byksu
AndabeTckm 3Haum — ABC BHeceTe TekcT co ronemu
ronemu 6ykeum BykBu®
Cumbonun Cum BHeceTte cumbonu
Hymepuukm 123 BHeceTe 6poesu.
http-pexum www BHecyBame

CaHpaue 3a WAP

m Osaa odnuka mpeba da ja 0803MOXU 8awuom dagamern
Ha ycnyau u He e 0ocmanHa 6o DMO-pexum.

MTHB800 moxe oa npyma nssecTtyBarba LUTO

., Ll [CH
rM ucnpaka BaluMOT AaBaTen Ha ycnyru.
. &
Coppxu URL po ycnyraTa, KojallTo Moxe = ;; rra—

Be[lHall Aa ce BYMATa UNW [a ce 3a4yBa Kako  |[E5'3) Hopwanko
nopaka Bo caHga4veto 3a WAP. [1o Hea moxe
[ia ce NpucTanu npeky Bresa Bo [MaBHOTO Moowra [E]__Hecen
MeHun > Mopaku > caHpaye 3a WAP.

Cute WAP-nopaku co Bpcka ce npeHecyBaar Ha
npenuctysa4yoT. [oBeke 3a
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CneaHuTe MKOHM yKaxKyBaaT Ha CTaTycoT Ha nopakaTta BO

caHpayveTo 3a WAP:

MkoHa 3a
caHpaveTo onuc
3a WAP
s UkoHa 3a WAP-nopaka
E= Ce nojaByBa BefHall 40 NPUOPUTETOT BO

npernegoT Ha NopaknTe Kako CNMUCOK.

CO TEeKCTOT.

UkoHa 3a HacnoBoT Ha WAP-nopaka
Ce npukaxyBa BegHall [0 HAcroBOT 3aegHO

WAP-nopaka - kpempaHa

Ha Kpevpatse.

Ce npukaxysa BegHall 4o A4aTyMOT

WAP-nopaka - ncteyeHa

& G| [

Ha NCTeKkyBaHe.

Ce npukaxyBa BegHall 4O AaTymMOT

lpeaned Ha nopaka

Ce npukaxyBa HacnooT, URL, BpemeTto Ha
JoCTaByBak€ 1 NEPUOAOT Ha UCTEKYBaHE Ha
nopakara.

MputucHete OAmM Ha 3a Aa ja oTBOpeTe
BpcKaTta Ha NpenucTyBadorT.

Lol (=

Hacrnos:

Wmare 4 Hosu
rnopaku

URL:
http://www.motoro

Onere wa[E=l[  Hasen

lModmeHumo Ha caHda4emo 3a WAP ekny4yea:

* /136epeTe OTBOPU BpCKa 1 NPUTUCHETE
MN36epm 3a ga ja oTBOpPUTE BO
NPenncTyBaYoT.

* N3bepete U3bpuwum 1 nputncHete Oa 3a
Aa ja nsbpuwetre WAP-nopakata. Kora Ha
eKpaHoT ce nojasysa “U3bpuiaHa:
Mopaka n”, TekoBHaTa nopaka
€ n3bpuwaHa og caHgadeto 3a WAP.

Ll >
leHn 3a caHaaveTo

OTBOpYM Bpcka
W36puwm
W3Bpuwum v cute
Ocsexun

Wsbepn| [ Hasaa




* N3bepete U3bpuwum ru cute n nputucHeTe fa 3a ga mm
n3bpuuete cute nopaku. Kora Ha ekpaHoT ce nojaByBa
“U3bpuwana: Cute nopakun”, cuTe Nopaku ce nsbpuLiaHu
of caHpadeto 3a WAP.

* V136epeTe OcBexu 3a npeypenyBake Ha CNNCOKOT 3a
caHpayeto 3a WAP v Bugete rv HoBuTe nopaku (GOKOSKyY
uma).

MpumeHa HoBa WAP-nopaka
Buaosun WAP-nopaku 1 HUBHU NpUopUTETH:

m,ﬂaeamenom Ha ycryeama 20 rocmasyea npuopumemom
Ha nopakama.

« Mopaka co Bpcka - &
> Bucok — aHMMaumjaTa 1 MKoHaTa (LTo Tpenka) ce
npukaxysaaT co ToH 3a HoBa WAP-nopaka
> CpeneH — aHMMaumjaTa 1 MKoHaTa ce npukaxysaat
co ToH 3a Hosa WAP-nopaka

> CpefeH — aHMMaLmjaTa ce NprKaxkyBa CoO TOH 3a
HoBa WAP-nopaka

> bpullere — onumjata e goctanHa caMmo ako
KOPUCHUKOT e BO caHpadveTo 3a WAP, ce nojaByBa
TekcToT MopakaTta e M3bpuiaHa oA faneymHa,
BO CNPOTUBHO HEMA MHAMKALM]a.

mAHumauujama Hema Oa ce MpuKkaxe ako KOPUCHUKOM € 80
MeK Ha MoBUK UJU 80 PEXUM 3a UMEH Crly4yaj unu 60 pexum
Ha rosukKysarbe usnu 60 ypedysayom Ha ropakxu umu rnpu
3aknyyeH PIN unu npu npegbpnarwe Ha DMO-pexum.
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* BunTyBatse Ha nopaka co Bpcka - 3
> Bucok — Ce oTBOpa NpenvcTyBaYvoT Co TOH 3a HOBa
WAP-nopaka
> Hu30Kk — ce nNpukaxyBa MKOHaTa Co TOH 3a HOBa
WAP-nopaka
mﬂpenucmy&aqom He ce omeopa aKo KOPUCHUKOM € 80 meK
Ha o8UK UInu 80 PeXXuM 3a UmeH Criy4aj uriu 80 pexxum Ha

rosuKysatr-e unu 8o ypedysadyom Ha ropaku umu npu
3aknydeH PIN unu npu npegpnare Ha DMO-pexum.

3a npoBepka Ha TOHOT nNoBp3aH co caHgadeTo 3a WAP,
opete Ha ,HoBa WAP-nopaka” Ha cTpaHuua 230.
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Ycnyra 3a nouupame npeky GPS

Opnvikata Ha BalWMOT TepMUHan 3a nouupawe npeky GPS
KOPWUCTU MHCpOpMaLIMKN Of caTenUTX Ha rnobanHmMoT cUcTem
3a nosuumoHmpame (GPS) kon opbutmnpaat okony 3emjata
3a Ja ja ogpenat npubnukHaTa reorpadpcka nokauuja Ha
BaLUMOT TepMuHan. [loctanHocTa 1 NpeLum3HocTa Ha oBue
nHdopmaumm 3a nokaumjata (M BpemMeTo NnoTpebHo 3a
HEj3WHO NpecMeTyBakbEe) ke Bapupaar BO 3aBUCHOCT 0f
cpeavHata BO Koja ro KopucTuTe TEpMUHArOT.

Ha npumep, moxe ga buae Tellko ga ce ogpeam nokauujarta
npeky GPS BO 3aTBOpEeH NpocTop, Ha NOKPUEHN MeCTa,
nomMery BUCOKM 3rpagu unu Bo Apyru cuTyaumum Kora Hemare
YMCT LUMPOK Nornes KoH HeboTo.

BugeTte: BAXXHO - pa6oTtu wto Tpe6a Aa ru 3anoMHuTe.

Ycnyrata 3a nouupatre npeky GPS moxe fa UM noMorHe Ha
BaLLMOT AMCMEYep UM KOMErn Ha MHOTY HauyuHK, Ha NpuMep
npeky noedurkacHa ucnopaka Ha pecypcu unm rioumpame Ha
BaLLMOT TEPMMUHAr SOKOMKY ja BKNy4uTe ycryraTta 3a UTHU
cny4yaum.

TepMMHaNoT MOXe [a ce KOHpUrypupa aa npukaxysa
MHpopMaLmm 3a nokaLmjata Ha eKkpaHOT Ha TEPMUHANOT UK
4a v eMnTyBa 4O BalLMOT gucneyep Kage WTo MoXe fa ce
npuKaxkaT BO KOHTPOMHMOT LieHTap (MpoBepeTe ja
KOH(purypaLmjata Ha BalIMOT TepMMHan Kaj BalwnoT gasaTen
Ha ycnyrm).

WHdopmaLmmTe 3a nokauumjata Moxe fia ce ucnparar Bo
TMO-pexum npeky nakeT-nogaToun, AOKOIKY KOPUCHUKOT ja
aKTMBMpa OBaa ofJfimka.
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BAXHO - pabotu wto Tpeba Aa ru 3anomHuTe

Bo cnyyan kora Hema QOBOJHO CUrHanNu o noBeke caTtenuTiu
(06ryHO Nopaam Toa LWTO BAMOT TEPMMHAI HEMA LUMPOK
BUOWK KOH OTBOPEHO Hebo), oanukaTa 3a GPS Ha BawwmoT
TepmuHan HEMA A PABOTW. Bo taken cutyauum cnaraar,
HO He Ce OrpaHu4eHu Ha:

* BO MOA3EMHU foKaLmu

* BO 3rpagu, BO30BU Uy ApYru BO3nna Co KPOB

* nof KakoB 61no metaneH nunm 6eTOHCKN NOKPUB UMK
rpagba

* BO B6rnnM3mHa Ha MoKeH paguonpenasaten unu TB
peneTuTop

 Bo cnyyau kora Bawarta GPS aHTeHa e nokpueHa
(Ha Nnpumep op BallaTa paka WUIU HeKoj NpeaMeT) Unu
€ Haco4yeHa KoH 3emja

* ?a eKCTpPEMHM TeMnepaTypu BO KOV BalUMOT TEPMUHAN He
MOXe Aa PYHKLMOHMpa

Oypu 1 kora nHcpopmauuuTe 3a nokauumjata Moxe fa ce

npecmeraaT BO TakBu CUTyauun, Moxe aa buae notpebHo

noeseke BpeMe. 3atoa, Npu CEKOj UTEH Cry4aj, cekorall

M3BECTYBajTe ro BaWMOT AUCTIeYEp 3a BallaTta flokauuja.

MNMoHaTamy, 3anomMHeTe Aeka Oypu 1 Ha MecTa Kage WwTo uMa
[JOBOIHO curHanu og noeeke carenutu, Bawara GPS ognvka
Ke ja yTBpAM camo npubrnimkHaTta fokauumja, Hajuecto Ha

20 po 100 meTpu opf BawlaTta pearsnHa fokauuja.

nogo6pysawe Ha nussepnbarta Ha GPS
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MoHekoraw e moxHo GPS ognukaTa Ha BalMOT TepMuUHan
Aa He MOXe yCneLlHO Aa M3BPLUN NpecMeTyBame Ha
nokaumjata. Bo TakoB cny4aj, ke ce nojasu nopaka kKoja Be
N3BeCTyBa [eKa BalLUMOT TepMuHan He MoXe a BOCMNOoCTaBn
KOHTaKT Co AoBoreH 6poj BuanNvMBm catenuTu.

Be monume npuapiKysajTe ce KOH crnegHuBe ynaTcTea 3a fa
ja nogobpute cnocobHocTa Ha BalLMOT TepMUHan 3a
yTBpAyBake Ha rnokauujara:



» OcraHete Ha oTBopeHo. GPS ognukarta Hajgobpo paboTu
Kora Hema HULITO NoMery BalMOT TEPMUHAN U LUMPOKOTO
OTBOPEHO HeGOo. [JOKOMNKY CTe BO MOXHOCT, U3re3eTe

1 opganevyeTe ce o4 BUCOKM 3rpagu v nucja. Nako
n3senbaTa BO 3rpaga ce nogobpyBsa kora ke ce
[OoGNMXUTE 4O NPO30pLUUTE, HEKOW CTaKMa Co TEHOK Croj
3a 3allTuTa 0f COHLE MOXe Aa rv nonpevysaat
caTenuTCKUTE CUTHanNW.

CoopnBeTHO NO3MLUMOHMPajTE ro BaLIMOT TepMUHAn 3a Aa
ro nogobpute npmemMoT. CurHanuTe oA catenuTute Ha
GPS ce emntyBaat po Bawata GPS aHTeHa, BrpageHa Bo
aHTeHaTa Ha BaluMOT TepMuHan. [ip>xeTte ro TepMmHanoT
noganeky of BalleTo Tero, CO LUTO Ke OBO3MOXUTE
cnobofeH npuctan Ha aHTeHaTa 40 caTenUTCKUTe
curHanu. He nokpueajTe ja aHTeHaTa Co BalUMTE NpCTH
nnu gpyro.

3actaHeTe BO MecTO. [JOKOMNKY € MOXHO, He ABMXETE ce
OO[eKa BalLMOT TEpMUHAI ro 3aBpLUM YTBPAYBaHETO Ha
BallaTta nokauuja. N3eegbata Ha GPS moxe 6utHO aa ce
Hamarnu LOKOMKY YeKopuTe CO BaLIMOT TEPMUHAM BO
MOMEHTOT Kora ja NpecMeTyBa Ballarta npubnmkHa
nokauuja.

Bo aBTomo6wun. Kora ja kopuctute GPS oanukarta Bo
aBTOMOOWI, NO3MLMOHMPA]jTE IO BaLLMOT TEPMUHAN Taka
wto GPS aHTeHata ke nma gobap npucrtan go GPS
curHanute. Bo aBTomobun GPS aHTeHaTa BooOn4aeHo
nma Hajgobap npuctan go GPS curHanuTte kora e
rnoctaBeHa BO GrM3nHa Ha Npo3opeLl.
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GPS ukoHa

Kora BalwumoT TepMmnHan npumMma BanngHu nogatouu 3a
nokaumjata npeky GPS, Ha ekpaHOT ke ce nojaBu UKoHaTa
3a GPS:

uz
Be Monvme 3anomHeTe Aeka 3a BpeMe Ha PeXUMOT 3a UTHU
cryyau, Ha BalLMOT TepMuHarn Hema fa ce nojaBu MKoHaTa
3a GPS gypu v kora npuma nogartoum 3a fokauujata npexy
GPS. Kora ke nsneserte of peXXumMoT 3a UTHU criydaun, GPS
MKOHaTa NMOBTOPHO Ke Ce MojaBu AOKOSIKY MMa BanuaHu
nogarouu 3a nokauujata gobmnexun npeky GPS.

OBO3MO)KYBaI-be/OHeBO3MO)KyBaI-be [l % = |
Ha GPS
, V BknyueHa
1. Oa rnaBHOTO MeHwn, nsbepete MoBeke... VicknyseHo
> Jlokauuja > MefyBpcka.
TexkoBHMOT n36op (Bknyuun/Ucknyum) Visbopn | [ Tasan
€ MUCTakKHarT.

2. HanpaBete HoB u3bop. Ha ekpaHoT ce nojaBysa:
» BknyyeHa ycnyra 3a nouupame
* VcknyyeHa ycnyra 3a nouvpare

BrieryBawke BO ycriyrarta 3a fiogqupame

npeky GPS

3a Bnes3 Bo nogmeHuto 3a GPS, I

npuTucHeTe /¥ n nsbeperte Moserke...
. nosuuuja

> nOKaU,Vlja. MeryBpcka
. MpeunsHocT

* Mo3uuwmja gasa nHopmaummn 3a

peanHaTa nosuuuja. Visoepn | [ Wiasan

+ MeryBpcka B/ 403BOMyBa Aa ja
OBO3MOXWTE/OHEBO3MOXMWTE ycrnyraTa 3a nouupare npeky
GPS.
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* lNMocTtaBkaTta Mpeun3HOCT BN OBO3MOXYBa Aa usbepete
roriema npeumnsHoCT UM PEXUM 3a LUTeaerwe eHepruja 3a
ycnyrata 3a noumpatne npeky GPS gokonky MTH800 He
€ MOBpP3aH COo ypeaoT 3a NornHewe (gurutaneH npubop 3a
aBTOMOOW UK NOMHay u cn.).

Jlnsrajte go Bawwmot n3bop u nputucHete N36epm 3a ga
npucTanuTe 40 CNegHUOT eKpaH.

OBaa npecmeTka Ha NpeuM3HOCTa Ha yTBpaeHaTa nokauuja
e camo efHa rpyba npecmeTtka 1 MoXe BO rofiemMa mepa Aa
Ce pasnvikyBa of, BUCTUHCKAaTa NpeLn3HOCT Ha AobueHute
nHdopmaumm 3a npubnkHaTa nokaumja.

m Osaa odnuka QyHkyuoHupa 8o DMO u TMO-pexum,
0oKoriKy e mocmaeeHa 00 0agamesiom Ha ycryaama.

Bapujayujama Ke ce pa3srnukyea coenacHo
m;mmpueypauujama Ha GPS nocmaseHa 00 eawuom

O0asamen Ha ycry2ama.

LocmanHocma Ha MeHujama 3a noyuparse rpeky GPS

3asucu 00 KoHhuaypayujama Ha eawuom mepmMmuHarl,

3a rogeKke UHghopmayuu KOHmMakmupajme co sawuom

Oasamen Ha ycriyau.

crnegewe Ha BallaTa nosuvuuja T =
.
1. Op rnaBHOTO MeHu, nsbepete Moseke... <BpeM2:’3” “a
> INNokauuja > MNo3uuumja. <Teorpatboxa WposHa>
. <leorpadpcka AOMmKUHA>
2. Jluzrajte 3a aa ro BuauTe LIENMOT eKpaH. d<0nenemawnmw>

Tyka ce npukaxkaHu ([OKOIKy ce AocTanHnu)  [Oceexn | [ Hasan]

cnegHnBe UHAPOPMAaLIMK 3a NOCNEAHWOT naT

kora 6una npecMeTaHa BallaTa nokawuja:

* 3a BpeMeTo Ha nocreaHarTa npecMeTka Ha Baluarta
nokauwja

* 3areorpad)cka LUMPOYMHa 13pa3eHa BO CTeNeHn, MUHYTH
N cekyHau
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* 3a reorpad)cka AOSMKMHA M3pas3eHa BO CTEMEHU, MUHYTU
N cekyHau

* 3a OpojoT Ha caTenuTH KOPUCTEHUN 3a NPECMETYBaHe Ha
nokauujata. Hajuyecto, noBeke catenut 0BO3MOXyBaaT
noronema npeumsHoct. MakcumanHuoTt 6poj Ha caTtenvTu
€ [JBaHaeceT.

3a NoBTOPHO Aa ja npecMeTarte Ballata fnokauuja,

nputucHeTe OCBEXM.

3a kopucHuumTe og ObeamHeToTo KpanctBo = & |
1 Mpcka ce noja.ysaar ase 6yksu (3a
O6epnuHeToTo KpancTso) unu 1 Gykea (3a onie>
<eorpadhcka WMposMHa>
Wpcka). Osaa oanvka Tpeba fa bune Mhodos Sorpmiaiie
OBO3MOXEHa Of AaBaTenoT Ha ycnyrara. <Cneper cate>
Ocsexu | [ Hasan

Ha BawumoT TepMmnHan moxe aa my tpebaar
HEKOMNMKy MUHYTW 3a Aa ro 3aBpLUM NPOLIECOT Ha YTBpAyBaH-e
Ha BaluaTa nokauuja. Bo T0j MOMEHT, Ha eKpaHOT Ha BaLLMOT
TepMuHan oBMYHO ce nojaByBa criegHaTa nopaka:

» HepgoBONHO BUANMBY caTENUTU UMK
« HepoBonHo BMANMBKM nogaToLm

3a coBeTn kako fa gobuete Hajoobpa npecmeTka Ha
nokauwjata, sugete ,nogobpysare Ha ussegbata Ha GPS”
Ha cTpaHuua 124.

Ha npuvkasoT 3a no3uumjarta ce nojaByBaaT axypvpaHuTe
MHdopMaLnu.

3a fa ja oTkaxeTe npecMmeTkaTa Ha fnokaumjata npeg Taa ga
3aBpLUM:

MpuTucHeTe Hasap 3a ga ce BpaTuTe Ha NPETXOAHUOT
npukas.

Cekoj nat Kora ke ce npecmerta npubnmxkHarta fokaumja Ha
BaLLMOT TepMUHAn, NocrneaHnTe MHopMaLunmn 3a nokaumjata
ce 3a4yByBaaT BO BalIMOT TePMUHanN 1 ocTaHyBaaT Tamy
Aypwv 1 Kora BalMoT TepMuHan e uckny4veH. OBaa
nHdopmauuja ke ja BuauTe CnegHNoT NaT Kora ke ce nojasu
npukasot Mo3uuumja .



[oKonKy npumuTe NOBMK NPEKY TEPMUHANOT UMK CUrHan
Jofeka ce obugysate ga ja yTBpaqTe Ballarta fokauuja,
Toraw npukasot Mo3uumja ke ncyesHe, HoO BaLMNOT
TepMuHan Ke NPO4OSKK co obuanTe 3a yTBpayBake Ha
cBojaTa nokauuja. [Jokornky e ycnewHo, nigopmaummTe 3a
nokauujata ke ce nojaeaTt CAeaHWOT NaT Kora Ke ce nojasu
npukasot Mo3unumja .

npeuyunsHoct Ha GPS B % = |

1. On rasHoTO MeHu, nsbepete MNMoBeke... v Cpeara
> INokauuja > MNpeyunsHocT. Bucoka
2. Hanpagete HoB n3oop:

+ CpepHa (cTaHgapaHa) — npeLmsHocTa V13Bepu Hasan
npv ogpenyBaHeTO Ha nosuuunjata
€ nomarna npuv pexxmMmoT Ha LTeAeHe eHepruja.

* Bucoka - npeLmsHocTa npu ogpenyBatkeTo Ha
nosuuujarta e noronemMa npu NOMarnky wreaewe
eHepruja.

MTHB800 aBTOMaTCKM paboTn BO PEXMMOT 3a Nnororiema
NPeLn3HOCT JOKONKY € MOBp3aH Co ypen 3a MorfHewe
(aurntaneH npnbop 3a aBTOMOGWI, MOMHAY U UTH.).

m Oesaa o0nuka e 0ocmarnHa camo OOKOJIKY e rocmaseHa 00
gawuom Oasamer Ha yciyau.
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MeHuTO

3a Bne3 Bo cTaBKkuTe o, MEHUTO

Moxxe aa BneseTe BO CTaBKUTE Of MEHMTO BO TEK HA MOBUK.
,D,OKOJ'IKy pasrnenysarte MeHU Npu BoCnoctaBsyBalk€ HOB
NOBUK, TEPMUHANOT Ke nanese og MEHUTO.

1. MputncHeTe [wen),
2. lNnsrajte go 6apaHaTa cTtaBka, NnpuTuUcHeTe U36epm

unm @ 3a fa ja n3bepere.
Nnn kopucTeTe KpaTeHKN 3a npucTtan 4o YeCcTo KOPUCTEHUTE
cTaBku o MeHuTO. (Bupete “KpateHkn” Ha cTpaHuua 178.)
[loKkonKy cTaBkaTa 0f MEHUTO COAPXM AOMOMHUTENHA rpyna
CTaBKM Of, MEHUTO, Kako BO MPMMEPOT LUTO CreayBa,
NMOBTOPETE IO BTOPMOT YEKOP.
Lsuxxere HU3 crmaskume 00 MeHUmo

1-B0 NogMEHN 2-po nogmeHn 3-To nogmMeHn
Ll (8 Ll (- Ll (- Ll (-
rMaBHO MEHU MocTtaByBake Bubpaunja )
Mpexa 1 & [lNopakn Bubpauuja Bubpauvja 1 SBoHO
MNanka 1 I:Lr\ £ Kowtaku |j;> HauuH Ha |j;> Camo su6paumja
pyna 3a paarosop 1 /||| & BesbegHocT / MocTasu /1|  Camo seoHo
3apago & Mocrasysake Jaank Dletan...
{3 Moseke... TocrasyBatee nogarouy
Onunm [T Korraku W3bepn | [ Hasan MaGepn | [ Hasan Wsbepn | [ Hasan
O) ) (oJ J

Mpwn nu3rawe Harope/Hagony HWU3 CTaBKUTE O MEHUTO,
npobajTe Aa nuaraTte n HagecHo/Haneso. (Ha Toj HauuH ke
n3bepeTe cTaBka uUnm Ke ce BpatuTe Ha NPETXOAHOTO HUBO).

Bo cnmncok NPUTUCHETE N 3apXeTe @ 3a aBTOMaTCKO
n3rame.

3a aa ce BpaTuTe Ha NPETXOAHOTO HUBO

MputncHete Hasag unu @
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3a ga nanesete o4 cTaBKUTE 04, MEHUTO

MpuTucHeTe @

mBawuom MTHB800 moxe Oa usnes3e ako Hema rnPUMUCKaHe
Ha Kon4Yurama 3a 00pedeH rnepuod.

MNKOHM Ha MeHMTO

CnegHnTe NKOHWU To onecHyeaart I/ID,eHTI/Id)I/IKyBaH:eTO Ha
CTaBKUTe 04 MEHUTO Ha MnpB nornea.

MkoHa Ha
MEeHUTO

Onuc

CTtaBKM of, rMaBHOTO MeHU/MeHu
NpPUCNoco6/IMBO Ha KOHTEKCT

Ce nojaByBa Haa [\ [OKONKY CTaBKUTE Of
rMaBHOTO MEHW/MEHUTO Npucrnocobnieo Ha
KOHTEKCT Ce aKTUBHM.

Mopaku

* Ncnpakare nopaku 3a cTaTyc,

* Vicnpakarse TekcTyanHu nopakv (cnobogeH TekcT unm
cnopeq AeuHnpaHTe Unn NPeTxogHo
AedunHnpaHnTe obpacum Ha KOPUCHUKOT),

* Mp1MMeHn nopakn Bo caHAa4eTo 3a MPUMEHN Nopaku.

KoHTakTtn

Honaeatbe, Npebapysare, ypedyBarse Unm
GpuLLerbe 3anmcy BO CMIMCOK CO KOHTAaKTHU.

BesbegHocT

Bu oBO3MOXYBa BKIy4YyBake/UCKNyyyBare
1 NOTBpAYBake Ha oanvknte 3a 6e3begHocT
N nNpomMeHa Ha NO3NHKUTe.

MoctaByBake

Bu oBoamoxysa npucrnocobysane Ha BaLIMOT
MTH800.
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MkoHa Ha
MEHMUTO

Onuc

@

MoBeke...
Coapxu noeeke CTaBkuM Of, MEHUTO LUTO MOXe
Aa ce npucnocobar.

JleHTa 3a nu3ramwe
YKax(yBa Ha OBMXeHwe HNU3 CTaBKUTEe LWTO
3adpakaat noeeke of efeH ekpaH. [Jokonky cute
CTaBKW ce MojaBaT Ha efieH ekpaH, feHTaTa 3a
nu3rare e npasHa.
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Cnucok co cTaBku o4, MEHUTO
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% Mopakun
KoHTakTun
BesbeaHoct
Mocrasysatbe

| —
BupeTe Ha cneaHaTa

Hoea nopaka

caHpaye 3a NprUMeHu Nopaku
Camnpave 3a ncnpaTeHn nopakn
CaHpaye 3a NOBMKyBat-e
O6pacum

MpeTxoaHo AeduHMpaH
Wcnpatu cratyc

<Hoe KoHTakT>
<UNme 1>
<UNwe 2>

PIN sawtuta
Bknyuena
UcknyueHo
MpomeHa Ha wudpa
Baknydyeatrse Ha konuuwaTa
3aknyuyBarse Ha Tactatypata
ABTOMATCKO. 3aKny4yBare
Opanoxysawe
3aknyuyBare Npu BKIyUyBake
BeaxniHo koanparse
MoTtBpaa Ha K
Motepaa Ha TMSCK
Motepaa Ha DMSCK

DMO SCK
Pexum 3a NpuKpuBarse
Bknyuu/vcknyun
Bubpauwja
Brnyuena
WcknyyeHo
[aneunHcku ynpasysay
Bknyuena
UcknyueHo
Bubpauvja
BuBpauuja na SBoHO
Camo suGpauvja
Camo sBoHO
Oetanm...
[lBOHACOUHN MoBULIN
EaHoHaco4Hu nosuum
MpyneH noBuk
Bubpauvja 3a nopakun
cTpaHuua

Bub6pauwvja na sBoHO
Camo subpauvja
Camo sBoHO

Bubpauuja na ssoHo
Camo BuGpauvja
Camo sBoHO

Bknyuena suGpaunja
UcknyyeHa subpauvja

Bu6paumja u sBoHO
Camo BuGpauvja
Camo sBoHO



——— MMocTaByBame
| E—

— Jasuk

— 3Byk

— Tonosu

BuaeTe Ha crieaHaTa cTpaHuua

— HauuH Ha sBoHerse

— AHraxvpare

[lBOHacO4eH noBumK

<9 HauYMHK>
EfHoHacoueH nosuk
<10 HaumnHN>

— [ocTaBu ja jaunmHaTa Ha 3BYKOT

aHIMUCKU jasnk

<[AenHUpaH KOPUCHUK>

MpudaTteHo aHraxupawe
OpbueHo aHraxvipate
— TocraBysatse noaatoun

Cawmo rnac
Camo nogatoumn
nac v nogatoun

Mpedpnatbe Ha 3ByKOT
Cekoral rnacHo
KoHTposa Ha 3By4HUKOT
Pexum Ha npucnocobyBate Ha jaunHaTa Ha 3ByKOT
TNnyen
OnwTt

TOH Ha Konunkba Ha TacTaTypata
BknyuyeHa
WcknyyeHo
CwuTe TOHOBM
Bknyuera
WcknyyeHo
[Hossona 3a pasrosop
Bes ToH
Kpatok ToH
HopmaneH ToH
Moxe pa ce ucnpatu
Bkny4yeH ToH
WcknyyeH ToH
MepuvoanyeH curan

|—|: CurHan
Mepwvop
D-PTT
D-PTT
BknyyeHa
WcknyueHo
Bupa Ha ToH
EnHokpaTeH
AsoeH
TpoeH
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Mocrasysatse
= L——— Expan
—  Bprete Ha expaHoT
Brnyuena
UcknyueHo
—  ronemuua na Texctor
3ym
CraHgapaeH
F—  Bawrurhuk Ha exparor
Axtusupaj
TekcTt
—  3aamumoko ceetrio
AsTomaTcka
OneBoamoxena
MonyasTomarcka

'—‘: BknyueHa
WcknyyeHo

—— 3agHuHa

L—  Kowtpact

— Bpeme u gatym
L——— Expan

Bpeme u gatym

Camo speme

Camo natym

UcknydeHo

— ®opmar

®opwmar Ha BpemeTo

dopmaTt Ha AaTymMoT

Mocrasu speme
BpemeHcko useaHadysarbe
Mocrasw patym

'—  Axypupaise Ha cucTemoT

VicknyueHo
Cawmo Bpeme
Bpewme 1 nseanadysarbe

Craryc na WE
Va6op Ha LIE

[— [ocrasu

— LWrenere enepruja

Brnydena
VicknyueHo

—  Konue sa potuparse
L———  Pexum Ha poTupatse

Neoen
JaumHa Ha 3ByKOoT
Nuarajte

— Baknyuyeame Ha konueto sa potupare

3aknydeHo
Orknyueto
OHeBo3aMOXkM

—  Mpu saknyuena Tacrarypa

He aaknyuysaj HuwTo
Baknyuysarbe Ha 3ByKOT
3aknydysarbe Ha OANMKATA 33 NM3rarbe

Baknyun rm asete
— 3asurkaj
Bknyuena
UcknyueHo
—  nNuaraj uus oncer
Ocraru Bo oncer
Nuarajte fo cneaHoTo
— Motepaw us6op wa P
Bknyuena
Vicknyuero

L—  ®yHKkuMcKkM Konunkba
ABTOMaTcka
MpucnocoBysatse Ha jaunHaTa Ha 3sykoT
OTB-opnuka

Moseke...
=) '—_I Mocrasysatbe rpyna
3 Crenuparse

Cretuparse
Brnyun/ncknyan
NaGepu crmcok
AKTUBEH CrInCoK

BupeTe Ha crieanata cTpanmua Ckenupaj r crucoumTe

<40 cnncoun>
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—— MMoseke...

9
3

&l

=l

@l

Mocrasysarbe rpyna
| E—

Mow nHdopmauumn

X

nocneaHu NosvumM

KpaTeHKM

RUI

Mpexwu

TNokauuja

MakeT co nogaToum

MO rpyni

Moj npuBateH 6poj
Moj TenedoHcku 6poj
CepBycHa cTpaHuua

Bupahnun
MpumeHn

MponywTexn

[Hos 3anuc]
<Ha3uB Ha KpaTeHka>

MpujaByBarbe
OpjasyBatbe

W3Bpanu mpexu

J

[HoBa nanka]
<Hasws Ha nanka>
<Hasws Ha nanka>

Cawmo pgoma
W3Bepu mpexa

Pexum Ha BMpexyBarbe

[npekTeH pexum
TXI-pexum

nosuuuja

o

MeryBpcka

J

MpeuusHocT

|

VicnpaTenu nopatouy
MpumeHn noparoum
®dpekBeHTeH oncer
Kopwvpare

AkTnBMpaj
[eakTneupaj

<Bpeme>

C:<reorpaccka Ww1puHa>

W:<reorpachcka nomkuHa>

KopvicTenu catenut:<Crienenu catenntin>

BknyyeHa
WcknyyeHo

CpepHa
Bucoka

Osa e cmaHOapdHuom usened Ha MeHumo. Bawuom
maaeamen Ha ycnyau Moxe 0a 0803MOXKU/OHEBO3MOXU

Hekou 00 crmaskume 00 MeHUMmo unu 0a au U3MeHuU

HUBHUME Ha3usu.
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Mopaku

3a nogetanHun nHdopmauun, Bugerte Bo lopakn” Ha
cTpaHuua 191.

KoHTakTn

OnwTo

Bo koHTakTW ce 3a4yByBaaT nNpmBaTHU, TenedoHckn n PABX-
B6poeBu. Cekoj 3annc Bo KOHTAKTN MOXE [a COOPXU HEKOIKY
6poja. 3anmMcoT BO KOHTaKTU COOPXKM:

Mme — nmeTto e noTpebHO AOKOMKY cakaTe fa 3adyBaTte
noseke oA efeH 6poj 3a 3annc; BO CNPOTUBHO, Toa €
n3bopHo none. BoobuyaeHo, Toa e Me Ha NULETO,
YMULITO MHGOPMALIMKM 33 KOHTAKT ce 3a4yBaHu BO 3aMuCoT.

BUA Ha KOHTaKTU — 3a CEKOj 3a4yBaH 6poj Mopa Aa tuge
AoJereH B Ha KOHTaKTu.

Bpoj — cekoj 3annc Bo KOHTaKTM Mopa Aa cogpxu 6po;.
Moxe noa buae kakoB 6uno Bug Ha TenedgoHckn 6poj

1 npuBaTeH 6poj 3a ngeHTUdUKaumja.

Opoj 3a 6p30o bupame — Kora 3avyByBaTe TeneOHCKU
©poj, Ha UCcTMOT My ce aoaenysa Bpoj 3a 6p3o Guparse.
Moxe aa npudatute ctaHgapaeH 6poj 3a 6p3o bupare
UnNn aa ro uaMeHuTe.

MOOKW/W e rnocmaseH 00 cmpaHa Ha eawuom dasamer

Ha ycrnyeu. He e MoxHo 0a kpeupame unu ypedysame
KoHmakmu unu 0a bupame 6poj WMo He e 80 CrUCOKom
co koHmakmu. Cmaskume Ha MeHUMO 3a Kpeuparse,
ypedysar-e u bpulieHre KOHmakmu He ce 0ocmariHu.

mEpojom 3a 6p30 bupar-e He ce doOerlysa Ha rpusameH eud
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MKOHM 3a KOHTaKTHn
Bo nprkasoT Ha CNMCOKOT CO KOHTaKTU CreaHUTE MKOHU
MOXe Aa ce nojasaT Ao bpoeBuTe Ha KOHTaKTUTE 3a Aa
yKaxkaT Ha BUAOT Ha 3a4yBaHWOT 6po;j.

WkoHa 3a
onuc
KOHTaKTun
é MpuBaTteH 6poj 3a uaeHTUdUKaumja

Bpoj Ha mo6uneH TenedoH

Bpoj Ha nomaweH TenedoH

Bpoj Ha cnyx6eH TenedoH

PABX-6poj

Opyr TenedoHcku 6poj

B |6 |CF|00 | B

{] E’ Mpynu
YkaxkyBa [jeka 3a e[leH KOHTaKT e 3a4yBaH
noeeke of eaeH 6poj.

Kpeunpame KOHTaKT |
1. O4 MaTUYHNOT ekpaH NpUTUCHeTe
KoHTakTn. 36epete [HoB koHTaKT]. Rasun ?
Wnn — Op rnasHoTO MeHun nsbepete Paze o
KoHTtakTun. M36epete [HoB koHTaKT]. Viabepy [ _Hasan

Wnu — npu ypeaoyBare Ha CMCOKOT 0f
MEHUTO CO KOHTaKTK, n3bepete [HoB KOHTaKT].

2. BHeceTe ume. (3a noeeke getanu 3a ynotpebarta
Ha ypeayBadoT Ha TeKCT, BuaeTe Bo l1nwyBarke TEKCT” Ha
ctpanuua 211). NMputucHete OK 3a noTBpAaA.

3. Nnzrajte HaneBo unun HagecHo 3a ga nsbepete Bug
Ha 3a4yyBaH 6poj (kako Ha Np. NpMBaTeH).

4. BHeceTte 6poj (#). MputncHete OK.
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5. Insrajte Harope n Hagony HK3 3anucuTe. Npogonxerte
CO BHECYBak€ Ha Apyr1 BUOoBu n 6poesu, bugejku
MOXe [a 3a4yyBaTe HekosKy 6poja (mpuBaTeH, MobuneH,
AomalueH, cnyxoeH, PABX, opyr) 3a ucto nuue nog nctoto
MMe 3a KOHTaKT. 3a ncrnpaska Ha 3anuc, NnpuTucHeTe
MpomeHn.

6. OTKako ke 3aBpLUMTE, NPUTHUCHETE 3aBPLUEHO.
MputncHeTe Ha3ap 3a ga ce Bpatute Ha
MaTUYHUOT EKpaH.

ypeayBaH-€ KOHTaKT

1. Op CNUCOKOT CO KOHTaKTW, Nn3rajte 40 3anucoT LWTO

cakaTte ga ro ypeaure.

2. MputucHeTe /*=\ 3a fa rv BHeceTe KOHTakTUTe. N3bepeTe
Ypeau. Ha ekpaHoT ce nojaByBaat geTanu 3a 3anucor.
3. Cnepete 1 ynatcTBata BO ,Kpeunpare KOHTakT” Ha
cTpaHuua 139 3a ypegyBare Ha pasnmMyHMTE NONUHa.
Bpuwene 6poj

1. Oa CNMCOKOT CO KOHTaKTK, Nn3rajTe A0 CTaBkaTta LITO ro
coapxu 6pojoT WTO cakaTte aa ro nsdpuiete.

2. JlnarajTe HaneBo UM HageCcHo 3a Aa ce NnojaBu BUOOT Ha
KOHTaKT 3a 6pojoT WTO cakaTte ga ro nsdpuiere.

3. MpuTucHeTe /w=w\ unm nsbepete Mpukas n notoa /w=w).
4. N36epeTe U36puimn 6po;j.
5. MputncHeTte [a 3a noTBpaa.

MAKO 3anucom codpxxu camo edeH 6poj, mozaw co bpuwer-e
Ha 6pojom ce 6puwe u 3anucom.

EpVI lweHe KOHTaKT

1. O CNMUCOKOT CO KOHTaKTU, Nn3rajTe Ao CTaBkaTta LTo
cakaTte Ja ja usbpuiere.

2. MputucHete /=n\ unu n3bepete Mpukas 1 notoa [w=w),
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3. 3a 6puwerse Ha uenuoT 3anuc, nsdepete U3GpuLLn

KOHTAaKT.
4. MputncHete [a 3a notepaa.

npoBepKa Ha KanauuTeToT

3a pa BmauTe Kornky 6poeBu ce 3a4yBaHN BO KOHTAKTU:

1. Of CNIMCOKOT CO KOHTaKTU, MPUTUCHETE /¥ew),

2. N36epeTe Kanauurer.

3. N3bepeTe KoHTaKT 3a npoBepka. N3bepeTte Hasag 3a ga

naneserte.

Be3begHocT

Op rmaBHOTO MeHU u3bepeTte BesbegHocT
unu > MNMoBekKe... > Be3begHocT (BuaeTe ja
3abenelukarta Ha cTpaHuua 137).

PIN 3awTuTa

3awwTuTaTa 3a npucrtan oo Mpexara ja
KOHJMrypvpa BalLMOT AaBaTten Ha yenyru:

Ll >

PIN sawrima

Tpomera Ha Wwwppa
3aknyuyBarbe Ha Konubara
Be3KUHHo Komvpatbe
Morepga Ha K

Wsbepere| | Hasap

* Hema npuctan o hyHKUMOHNPaHETO Ha MpexaTta — MOXe
camo fa npakaTe 1 npumarte NoBULM 3a UTHU CriyYyan U aa
ro npucnocobyBaTe HUBOTO 3a jayMHa Ha 3BYKOT.
3akry4yBat-€eTO Ha eAMHMLaTa ce akTUBMpa npu

CnegHOTO BKIly4YyBaH-€.

3a 3awTnTa Ha NpUcTanoT 40 YHKUMOHMPaHe Ha Mpexara:
1. Opg rmaBHOTO MeHM n3bepete BesbegHocT > PIN

3awTuta. BknyyeHa e ncrakHaro.
2. MpuTtucHete U3Gepu.
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3. Kora ke ce nojaBu nopakata LlLUndppa? BHeceTe ja
4-undpeHata umdpa (pabpunuka noctaska 0 0 0 0).
3a ga ce usberHe oTkpmBame Ha Wwudparta, HAMecTo
undpute Ha WndpaTa ce nojaByBaat SBE3ANYKN.

Ha ekpaHoOT Ke ce nojaBu cnegHarta nopaka:

EpuvHuMuaTa e 3akny4eHa — 03HayyBa BHECYBame Ha TOYHa
wndppa. Ha ekpaHoT ce Bpaka noaMeHuTo 3a 6e36eHOCT 1
ce nojaByBa aKTVMBHaTa nocTaBka: Bknyum.

3a otknyyyBawe Ha MTH800 npeg ncknydvyBame:

1. Opg rmaBHOTO MeHN n3bepete BesbegHocT > PIN
3awTunTa. McknyyeHa e ncrakHaTo.

2. MpuTtucHete U3Gepu.

3. Kora ke ce nojasu nopakata LUudpa? sBHeceTe ja
4-uncppeHata wWndgpa. Ha ekpaHoT ke ce nojasu
crniegHarta nopaka:

EavHnuarta e oTkny4YeHa — 03Ha4YyBa BHECYBaHE Ha TOYHA
wundpa. Ha ekpaHoT ce Bpaka nogMeHUTO 3a 6e36egHOCT
1 ce nojaByBa akTUBHaTa nocraska: Ucknyum.

3a pga ro otkny4nte MTH800 no BknyyyBaweTO, BHECETE ja
wmndpaTa kora Toa ke buage nobapaHo. MTH800 Bnerysa
BO MAaTU4YHNOT eKpaH.

[okonky He ycneeTe Aa ja BHeCceTe BUCTUHCKaTa wndpa,
Ke ce nojaBu cnegHaTa nopaka:

BHeceHa norpeluHa wudpa — Be n3BecTyBa da ce obugere
nosTtopHo. OTkako Hema Aa ycneete, Bawmotr MTH800

Ke 6uge brnokunpaH. NposepeTe kaj BawWMOT gaBaTen

Ha yCrnyru Konky HeycnewHn obuan Bu ce O3BOMNEHMU.

Kako aa ro og6nokupare MTH800
Ha ekpaHoT ce nojaByBa EaMHuuaTa e 6nokupaHa.
Moxe ga BocnoctaBuTE CaMo MOBUK 32 UTHK Criyyau.

3a pa ro ogbnokupate MTH800, BHeceTe ro PUK (nnyHuoT
kny4 3a gebnokupatwe). PUK e ocymundpeHa rmaeHa
wudppa wro Tpeba Aa ja fobueTe og BawWMOT AaBaTen

Ha ycnyru.



Mo ycnewHoTo BHecyBawe Ha PUK-0T, ke Guaete nssecrenm
Aa ja 3ameHuTe 3abopaBeHarta wudpa.

Kora ke ce nojasu nopakata HoBa wudpa? sHeceTe ja
4-undbpeHaTta Wwndpa 1 NoBTOpeTe ja 3a noTepaa. AKo
WwundpaTa He oaroBapa, ke buaeTe M3BecTeHU [a ja BHeceTe
NOBTOPHO, C& JOAEKa HoBaTa Wwundgpa He ce npudatu.

NMpomeHa Ha wundpa

Op rmaBHOTO MeHu n3bepete Be3begHocT > MpomeHa
Ha wudpa.

m CmaHdapdHama PIN-wugpa e 0000.

Kora ke ce nojaeu nopakata Ctapa wudpa, BHeceTe ja
4-uncpbpeHata wndpa. AkKo ctaparta wudpa He ogroeapa

Ha BHeceHaTa Wwudpa npy NoTBpAa, Ha EKPaHOT Ke ce Nnojasu
rnopaka 3a NoBTOPHO BHECYBak€ Ha cTapara wudpa.

Ako BHeceHaTa wundpa ogroeapa Ha ctapaTta wudpa,
Ha eKpaHoT ce NnojaByBa Nopaka 3a BHeCcyBake Ha HOBa
4-undbpeHa wndpa 1 Hej3MHO NOBTOpPYBake 3apaam
notepaa. Ako WwndpaTa 3a NoTBpAa He oaroBapa Ha
HoBaTa Lundpa, Ha ekpaHoT ce NnojaByBa nopaka 3a
NOBTOPHO BHECYyBak€ Ha HoBaTa Lumdpa.

Kora HoBaTa wudpa ke buae npudpareHa, Ha ekpaHoT
ce Bpaka noamMeHuTo 3a 6e3begHOCT.
mﬂomnxy € 0803MOXeHa olnukama 3a 3awmuma co PIN,
npomeHama Ha PIN-ko0om Ke dosede 0o bpuwiere

Ha cume ropaku 00 caHOa4emo 3a npuMeHuU rnopaku/
caHO0a4emo Co ropaku 3a ucrpaKkar-e.

3aknyJyBame/oTKNy4yyBaHl€ Ha TacTaTyparTa

3a ga cnpeunTe HecakaHo NpUTUCKaHe Ha (g |
-
Konynwara: ST
éﬂmﬁ;z :asmvazsawe‘ BXVUEHO
MpuTucHeTe /v=\ X2 3a fga ja 3aknyunte/ e R——
OTKNy4YnTe Tacrtatypara.
Vis6epete] | Hasan
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[asatenot Ha ycnyrn moxe ga nsbepe nsBectyBame 3a
3aknyJvyBare Ha TactatypaTa u ganu ga ce 3aknyyu PTT.

MKOFNGWIO 3a UmHU crlydau He e 3aKry4eHo. Brneszom eo

PEeXUMOM 3a UMHU Clydau 2u OmKsy4yyea cume Komyutba.

U3eecmyesamse 3a 3akilyvyyea-e Ha macmamypama

Kora Tactatypara e 3akny4eHa, Ha eKpaHoT ce rnojaByBa
€0HO o4 cnegHuUTe ynatcrea:

* Hema — He e npvkaxaHo n3BecTyBam-e.

+ Camo usBecTyBane — ce nojasysa Konuuwara ce
3aKny4eHm.

* VI3BecTyBat€ 1 yNaTcTBO — Ce NnojaByBa 3akny4eHu
Kon4uuma, nputucHete MeHu 1 * 3a Aa oTkny4uTe.

Aemomamcko 3aKny4dyeaHe Ha Kondukwama
Ha macmamypama

OBaa ofinuka 0BO3MOXYBa aBTOMAaTCKO 3aKIyyyBake

Ha TacTaTypaTa, OTKako ucTaTa Hema Ja ce KOpUCTy 3a
NPETXOAHO YTBPAEHWU MUHYTW. 32 BKIyYyBare/UCKIyYyBake
nctakHeTe ABTOMaTcko. 3aknyuere U NnputncHete Uamenm
notoa n3bepete BKNyun/uckny4u. 3a npomeHa Ha
O/NOXYBaHETO Ha 3aKIy4yBaETO Ha TacTaTyparta
nctakHeTe OanoxyBake 1 npuTucHete U3meHu. MocTasete

ro BpEMeTo CO npuTUcKare Ha &3 nnu € v npuTuCHeTe
3aBpueHo.

3aknyyyear-e Ha macmamypama rnpu eKsy4yyeame
KopucHUMKOT MOXe fa nocTtasu TacTaTypara fa ce 3akny4vysa
npuv BKMyYyBakwe Ha TepMuHanoT. 3a BknyyyBake 3a
BKIyYyBahe / UCKIydyBawe UcTakHeTe 3aknyvyBaHwe npu
BKIyJyBake n nputncHete U3ameHun. N3bepete BknyyeHo/
MCKIy4eHo 1 nputucHete U3bepm.

BknyyeHo/uckny4yeHo 6e3X1MYHO Koaupame
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MNMoameHNTO BM OBO3MOXYBa nperneq Ha cocrojbara Ha
Be3XMYHOTO Koampare (BKNYy4YEHO/MCKYy4YeHO).
Koauparerto Ha noBuk o6e3beagyBa OBEPNMBOCT Ha
ycnyrarta mMefy Bac ¥ CUCTEMOT.

[okonky ognuvkarta 3a Kogvpare € BKIly4yeHa 1 Bre npumuTe
4YnCT (HekoampaH) NoBuK, Ha ekpaHoT Ha MTH800 ke ce
nojasu nopakata HekogupaHu NoBUK U nogaTouUM.

He moxe payHo Oa ja oHegosmoxume odnukama 3a

m b6e3xuyHo kodupare 00 meHumo. Osa NOOMEHU yKaxysa
aKko odnukama 3a 6e3)XU4YHO KoOupaH-€ € 0803MOXKeHa
80 MOMeHMmom.

M Odnukama 6e3)Xu4yHo KodupaH-e ce 0803MOXy8a caMo
80 3asucHocm 00 eawuom Gasamern Ha ycnyeu.

Bpuweke Ha Kny4yoT 3a 6e3)XUYHO Koaupahe

lMpoBepeTe Kaj BaWMOT AasaTtern Ha ycnyri ganu

TepMUHaroT BKMy4YyBa KnyyeBu 3a MefyBpcKa Ha

Be3XMYHO Koavpakse.

Moxe fa rm nsbpuiierte knyyeBuTe 3a MeryBpcka Ha

Be3xn4HO Koanpare o TEPMUHANOT CO BHECYBaHE

Ha criegHuTe 3HaLUM Npeky Tactatypata: * * 0 0 # #.
mﬂompema e eOHa MUHyma 3a ogaa 00ruka 0a au usbpuwe

cume kny4yesu 3a kodupare 00 paduomo. Bo moj nepuod
Hemoj Oa ja eadume bamepujama.

Kopucmeremo Ha osaa odriuka Ke 20
A _m OHEBO3MOXU MepMUHanom u eawuom
Oasamen Ha ycryau ke mpeba rnosmopHoO

Oa 20 0803MOXU MePMUHaIom.

mEpuweHsemo ce 8pwiu rnpu Mupysare Ha yHKyuume
3a TMO/DMO unu umHu cnyyau.
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MorBpaa Ha K
Opn rmnaBHoTO MeHUn u3bepete besbegHocT > MNoTBpaa Ha K.

K (krny4) e TaeH KIyy LWTO ro KOPUCTM MHpaCTpyKTypaTa 3a
notepaa Ha MTH800 Bo cuctemoT. Toa e gen og notspaarta
LUTO OBO3MOXXYBa AOBEPSIMBOCT Ha ycryrata Mery BalimoT
MTHB800 n cucremor.

3a noTtBpAa Ha BanuaHocTa Ha K, nputucHete U36epu. Ha
€KpaHOT Ke ce NnojaBu efHa oA criefHUTe nopaku:

* K e BanuaeH — nHpacTpykTypata Moxe fa ro noTepamu
Bawmot MTHS800.

* K e HeBanuaeH — MHpacTpyKTypaTa He MOXe Aa ro
notepau Bawmot MTHB800. NosukajTe ro BawmoT JaBaTen
Ha ycnyru 3a ga ro nospatu K Ha Bawwmot MTHS800.

MorBpaa Ha TMSCK

Op rmaBHOTO MeHu n3bepete be3begHocT > MoTBpAa Ha
TMSCK.

SCK (cTaTuykMOoT Knyd 3a Wwndpupame) € TaeH Knyy LwTo
WH(ppacCTpyKTypaTa ro KOpUCTU 3a KoaMparwe Ha NOBUK U
nogarouu Bo cuctemort. MeryBpckata Ha 6e3KN4HO
Koanpawe obe3benysa JOBEPNMBOCT Ha ycrnyrata Mery
Bawumotr MTH800 n cuctemot. Bawmnor MTH800 Tpeba aa
BKry4yBa Husa SCK.

3a noTtBpaa Ha BanugHocTa Ha SCK 3a TMO, nputucHete

N36epu. Ha ekpaHoT ke ce nojaBu egHa of criegHUTe

nopaku:

*» TMSCK e BanugeH — Bawmotr MTH800 moxe aa pabotu
BO kogupaH pexum so TMO.

* TMSCK e norpeweH — sawmor MTH800 He moxe aa
paboTu Bo kogmpaH pexum Bo TMO. NoBukajTe ro BawmoT
Aasaren Ha ycnyru 3a ga ru nospatn SCK Ha Bawwmot
MTHS800.

MorBpaa Ha DMSCK

Opn rnaBHoTO MeHUn u3bepete be3benHocT > MNoTBpAa Ha
DMSCK.
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SCK (cTaTnykMOoT Knyd 3a Wwudprpame) € TaeH Knyy wTo
WH(ppacTpyKTypaTa ro KOpUCTn 3a Kogmpare Ha NoBuK
1 nogaTtoun BO CUCTEMOT.

MeryBpckaTta Ha 6e3xn4HO Koampake 06e3benyBa
[oBepnuBOCT Ha ycnyrata mery sawmotr MTH800
n cuctemot. Bawmor MTH800 Tpeba aa BknyyyBa Husa SCK.

3a notBpaa Ha BanugHocTta Ha SCK 3a DMO, nputucHete
NU36epu. Ha ekpaHoT ke ce nojaBu egHa of cnegHUTe
nopaku:

* DMSCK e BanupgeH — Bawumotr MTH800 moxe aa pabotu
BO KoaupaH pexum Bo DMO.

* DMSCK e norpetueH — Bawmotr MTH800 He moxe aa
pabotu Bo koaupaH pexum Bo DMO. NosukajTe ro
BaLLWOT JaBaTten Ha ycnyru 3a ga ru nospatn SCK
Ha Bawwmot MTH800.

DMO SCK

Opn rnaBHOTO MeHu u3bepeTte Be3begHocT > DMO SCK.

Bep3uja Ha kny4oT ce nojaByBa Kora Ke ja nsbeperte

onuujaTta.

BeaxunyHoTo kKoguparwe 00e3benyBa LOBEPNMBOCT Ha

ycnyraTta mery sawmot MTH800 wTto dyHKUMoHMpa BO

OVPEKTEH PEXUM W ApYr TEPMUHAMN UNn rpyna Ha TepMuUHanu

LITO (PYHKUMOHUPAAT BO ANPEKTEH PEXMM.

Moxe ga ro uameHuTe TEKOBHUOT KyY, OOKOSKY

onepauujata 3a NnpoMeHa Ha Kryy e 403BOfieHa of cTpaHa

Ha BallMOT JaBaTen Ha yCcnyru.

3a npomeHa Ha KIy4oT, JOKOJIKY He CTe BO TEK Ha MOBUK,

n3depete CneneH. Ha ekpaHoT Ke ce nojaBu cnegHara

nopaka: NpoMmeHu Ha Bep3uja...

* V136epeTe Oa 3a npoMeHa Ha Kny4oT. Ha ekpaHoT ke ce
nojasn U3ameHeTa Bep3unja Ha KNy4oT.

 V136epeTe He 3a ga ro octaBuTe Kny4oT. Ha ekpaHoT Ke ce
nojasu Bep3uja Ha Kny4oT.
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Pexum 3a npuKpunBamwe

On rnaeHOTO MeHun n3bepeTte F T

Be36eaHocT > PeXum Ha NpUKpuBam:e.
Bubpauuja

eKJIyYyeaH-e Ha peXxumom 3a

npuKkpueare

N3bBepeTe Bknyun. Cute TOHOBY ce Asbepn | | Hasan

WCKMy4YeHn n 3agHuUHCcKoTo ceeTno u LED
Be[HaLl ce OHEBO3MOXYyBaaT. 3BYKOT 3a rpynaTta ce
npeHaco4yBa KOH cnyliarnkara.

UCKITy4yeaH-€e Ha pexxumMom 3a rpuKkpueame

N36epeTe Ucknyumn. Cute noctaBku 3a TOHOBUTE,
3aQHWHCKOTO CBETIO U 3BYKOT Ce NnoBpakaar.

LED e 0BO3MOXeEH 1 ce nojaByBa nopakaTta
PeXXMMoT 3a npuKpmBaHe e UCKNYyYeH.

lMocmaeyean-e subpayuja

Opa nogmeHunTo 3a 6e36eqHOCT n3bepete Pexnm 3a

npukpuBame > Bubpaumja.

* N3bepeTe Ucknyumn 3a ga rv OHEBO3MOXMUTE CUTE
Bnbpaumn.

» V136epeTe Bknyum 3a ga rim nopatute cute Bubpauumn.

lNocTtaByBawe
On rnaBHOTO MeHun nsbepeTte FO R
MocTaByBakse.
. Bubpauvja
OBa nogmMmeHun B OBO3MOXYyBa Aa ja Hesi a ssoHetee
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ocTaH ja jasiHara Ha 3gyKor

NpoMeHNTe KOHUrypaumjata Ha BalnMoT i

MTH800: Bubpaumja, Ha4H Ha SBOHEHE, mseg;“a““f“’eT“”“"“ﬁlw
nocTaByBatbe Ha jaunmHaTa Ha 3BYKOT, ja3uK,

nocTaByBatbe Ha NoJaToLmTe, 3BYK, TOHOBW, eKpaH 1 Bpeme
n paTym.




nOCTaBYBaI'be Ha oAJinkKkaTta 3a BMGpaLIVIja

Osa noAmMeH B/ OBO3MOXYBa A1a YTBPANTE |
Aanu sawwmotr MTH800 BuGpupa, SBOHU uUnu
BMBPMpa 1 SBOHU Kora NprvMa noBuK. ggg‘f;‘m”gi;j:jg”
3a fa ro UsmMeHuTe NocTaByBaHETO Ha v oo ssoko

oanvkara 3a subpauuja: osanr | [

1. Oa rnaBHOTO MeHW n3bepete
MocTtaByBawe > Bubpauun.
2. Jlnarajte HM3 NnocTaBKkuUTe.
3. V136epeTe ja bapaHaTa noctaBka u npuTucHeTe Hasap 3a
Aa unanesere.
[opecnomeHaTuTe NOCTaBkM 3a BUbpauuja Baxkar 3a cuTe
nosuuun. Bawmotr MTH800 moxxe oa nogoenu pasnuyHm
nocTaBku 3a BMOpaLmja Ha pa3nnyHn NOBULLM.
3a pa ogpenuTe nocebHM noctaBku 3a Bubpaumja 3a
pasnnyHN NOBULIN:
1. Op rnaBHoTO MeHU u3bepete MocTtaByBawe > Bubpauuja
> NeTtanw.
2. N36epeTe ro BMAOT Ha MOBUK, YNULLITO NOCTABKK 3a
Bubpauuja cakate ga rm usmeHuTe n nputncHete ,M3bepn*.
m » [leoHaco4yHu nosuyu — meneghoHcku nosuuu, PABX
u 080HACOYHU rnpusameHu riosuuyu
» EGHOHacoYHU nosuyu — eGHOHaCO4YHU rpueamHu
nosuuu
* pyneH nosuk
* [lopaku co subpayuja (lMopaku co eubpayuja) — nopaxku
3a cmamyc u meKkcmyarsiHu riopaku

3. N3bepeTe ja GapaHaTa noctaBka u nputucHeTe U3bepu.
MputncHeTe Hasap 3a aa nsneserte.
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]
Sl [
[lBOHaCcO4HM NoBULM

Bu6pauuja u sBoHO
Camo BubpaLvja

V/ Camo sBoHO

' Binyuena subpauya

M361 H .
3oepn [ l asap N Camo Bubpaumja/
I:'v/ BKMyYeHa
Lol - Wsbpan

Weknyyena eubpauvja

Vsbepn | [ Hasan

Hokornky usbepeme [JeoHaco4yHu nosuyu, EGHoHaco4YHu
noesuyu unu Mopaku co eubpayuja, docmarHu ce

crnedHume nnocmasku Bubpauuja na seoHO (3a ropakume
Bu6bpauyuja u seoHo), Camo esubpayuja urnu CaMo S8OHO.
Jokonky usbepeme epyneH nosuk, docmarHu Ke budam
camo rnocmaskume eKJly4eHa eubpauyuja unu Uckny4deHa

eubpauyuja.

nOCTaByBaI-be Ha HAYUHOT Ha SBOHEHE

150

OBa nogmeHu B 0OBO3MOXYBa Aa o
NOCTaBUTE HAYMHOT 3a SBOHEHE MpPU
nojooseH nosuk. Bawmnotr MTH800 uma
[EBET HAa4YMHM Ha SBOHEHE LUITO MOXE Aa ce
Ovpaat 3a BOHaCOYHUTE N OECET 3a
e4HOHACO4YHUTE NOBULN.

Ll 3]

LIBOHaco4eH noBuK

+ BputaHckm
HaunH 2
HaunH 3
®paHuycku
epmaHcku

Vsbepete] | Hasan

Op rmaBHoTo MeHu n3bepeTe MocTtaByBawe > HaunH Ha

SBOHeH-e > [IBoHaco4eH nnn EgHoHacouyeH.

OTkako ke BneseTe BO 0OBa NOAMEHU, HA EKPaHOT Ke ce

I'IOjaBI/I TEKOBHMOT HA4NH Ha SBOHEH-€.

Jlnarajte 4o cakaHWOT Ha4MH 1 NnpuTucHeTe U36epu. Hosrot
Ha4MH Ha SBOHEH-E BeHaLl Ke ce Oorfacu Bo BpeMeTpaeke
o[ HeKorky cekyHau. [lokonky e notpebHo, npucnocobere ro

HUBOTO Ha ja‘-IMHa Ha 3BYKOT.



NMocTtaByBa

OBa nogmeHu B/ OBO3MOXYBa Aa ja T =]
npuUcnocobuTe jaumHata Ha SBOHOTO Npu
a4 Ha 3BT T BORACO4EA TOBHE ()
eJJ,HOHaCOLIeH n ﬂ,BOHaCOqu I'IOBI/IK, a4k Ha 30 TP ECHOHaCO4EH noBiE |
. Ja 1
jaynHaTa Ha 3BYKOT Ha cnyluankara, qu::::jjzﬁj:m”ﬁi
3BYYHUKOT M TOHOT Ha TacTaTypara. o )

Hbe Ha ja‘-IVIHaTa Ha 3BYKOT

Wamen ] [ 3aspLuvt

3a noctaByBah-€ Ha jauMHaTa Ha 3BYKOT:

1. 0Opn

rmaBHOTO MeHu nsbepete MocTaByBawe

> MocTtaByu JaunHa Ha 3BYKOT.

2. Jlus

rajTe HN3 CMUCOKOT.

3. M136epeTe ja bapaHaTa cTaBka u nputucHete U3meHn.

4. MNocTaBeTe ro HUBOTO CO NPUTUCKaHE Ha NeBarta cTpenka
3a HamarnyBake 1 Ha JlecHaTa 3a 3rofiemyBakbe Ha
jaunHaTa Ha 3BykoT. Ce ornacyBa TOH Kako nosparHa
WH(opMaLja 1 ce nojaByBa feHTaTa 3a HUBOTO Ha
jaunHaTa Ha 3BYKOT.

5. MputucHete Hasap 3a ga nsneserte.

[LlokornKy Ha ekpaHom ce rojasu camo edHa onyuja ja4yuHa
Ha 38yKom, KOPUCHUKOM MoOxe 0a au rpucrnocobu cume
eopeHasedeHu rnocmasku o0edHaw. KopucHukom uma
MOXHOCM noeduHeYHo d0a au MeHysa rnocmaskume Koaa
pexxumMom 3a npucrnocobyeaH-e Ha jaduHama Ha 38ykom
e nocmaeeH Ha lMoeduHe4Ho. 3a noseke uHghopmauuu
ol0eme Ha ,[Tocmasysare Ha pexxumom 3a
npucrnocobysar-e Ha ja4yuHama Ha 38ykom” Ha

cmpaHuya 154.

JayuHama Ha 38yKom 3a ropakume 3a Mo8uUKys8ar-e
He Moxe da ce ripucriocobysa.

NMocTaByBawke Ha pabOTHUOT ja3nK HA eKpPaHOT

On rnaeHOTO MeHun nsbepeTte P
MNocTaByBaks-e > Ja3uk.
aHINCKY ja3nk
Deutsch
Frangais
Espafiol
Nederlands
W36epun l [ Hasag
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Ha ekpaHOT ce nojaByBa TEKOBHO KOPUCTEHUOT ja3nk. Moxe
Aa ro npucnocobute Bawwnor MTH800 ga pabotn Ha
aHIMMCKKN, repMaHckn, hpaHLyCKu, LUMNAHCKW, XONaHACKN UIn
Opyr jasvk geduHUpaH of CTpaHa Ha JaBaTenoT Ha ycryru.
CtaHpgapaHaTa habpuryka nocTaBka € aHrMCKN jasuk.

JInarajte go cakaHuWoOT ja3uk u npuTnucHeTe U3Gepwu.
Ha ekpaHOT ce nojaByBa M30paHWOT ja3nk BO BpeMeTpaeHe
O HEKOSKY CeKyHaM.

MocTtaByBak-€ Ha nogaTtoyHaTa hyHKuUMja

152

Moxe aa ro nospsete MTH800 co HagBopelleH ypen,

(kako WTO e NanTon-KoMMjyTep Unv A4eckTon nepcoHaneH
komnjytep). Toraw MTH800 ke moxe Aa npeHecysa 1 npuma
nogatoum o HagBOPELHUOT yped. 3a NoBp3yBake Ha
NPUKIY4YOKOT 3a AononHuteneH npnbop Ha MTH800

CO HaABOPELLHMOT ypea, kopucTtete kabden FKN4897.
HapBsopellHWOT ype Mopa Aa KOpUcTy annvkauumja LTo € BO
cornacHocT co TETRA-cTaHgapauTe.

Op rmaBHOTO MeHU usbepete Tl |

MocTtaByBakwe > [locTaByBawe ——C”Waﬂyme
amo rmac

nogatouu. Camo nopatouy

[nac v nogatoun

Ha ekpaHoT ce nojaByBa TekoBHaTa

nocraBka: Viaepn | [ Fiasaa]
1. Camo rmac - MTH800 npuma un
npeHecyBa camo rmacoBHU NOBULIN.

2. Camo nogatouu — MTH800 cpyHKLMOHMPaA KaKO MOAEM.
MTHS800 rn otdpna AojoOBHMTE M NOjOOBHUTE FMAaCcOBHU
noBuLM (CO UCKINYYOK Ha NMOBULMTE 3@ UTHU Cry4daum),
rnopakuTe 3a cTaTyc 1 TeKCTyarnHuTe nopaku.

3. Mmac n nogatoun — MTHB800 dyHKUMOHMpPaA Kako MoaeM,
HO r11acoBHUTE NOBMLUM Ke nmaaTt NpuopuTeT nNpea
nogaTtovyHMTe NOBULM U Ke T NPeKMHaT.

Jlnsrajte oo cakaHata noctaBka u nputncHeTe U3bepwu.




Bo pexxumort ,Camo nogatoumn” u ,[mac u nogatoumn, MkoHarta
3a NoBp3aHn NogaToum ce nojaByBa OTKAKO Ke ro nosp3eTe
MTHB800 co HagsopelHuoT ypeg u MTH800 e nogroTeeH

3a NpeHoc Ha nogaTtouu. VikoHaTta 3a npeHoc/npuem Ha
nogatoum ce nojaByBa Aa yKaxe Ha npeHoc/npnem Ha
nogatoumn o HagBOPELLHWNOT ypea.

MTHB800 ro npeknHyBa MOBUKOT 3@ aMBMEHTaNHO criyluane
(AL) n mukpodpoHoT ce 3atBopa kora MTH800 e Bo eaHa of
cnegHUTE cocTojou:

+ Bre3 Bo obracT kage LWTo HeMa Mpexa

* MOCTaByBah-€ NOjAOBEH MOBMK CO NAKET CO NodaToum

3a n3nes og nogarouuTe, BpateTe ce Ha NMocTtaByBake
nopatoum n nsbepete Camo rnac.

MTHB800 aBTOMaTCKM Ce Bpaka Ha rmacoBHa KOMyHuKauuja.

mﬂodamowume ycnyeau ce docmanHu camo 80 TMO-pexum.
lModamoyHume ycnyau ce brokupaHu 80 TXI-pexum.

mKoea e rnocmaseH 8o pexxum ,,Camo anac”, eepadeHuom
rnodamoyveH MoOeM ce OHE803MOXKy8a 3apadu co4ysysaH-e
Ha eHepeujama Ha bamepujama.

MocTtaByBaHk-€ Ha 3BYKOT

On rnaeHOTO MeHun nsbeperte T =]

MoctaByBame > 3ByK.
Tpechpnatbe Ha 3sykoT

OBa nogmMeHu B/ OBO3MOXYBa Aa Ponu utane

npucnocobute NnocTaBkuTe 3a 3BYK

Ha MTHS800. Masepn | [ Hasan

lNocmasysam-e Ha npegpra-emo

Ha 38yKom

Modke Aa ro KoHTporMparte Haco4YyBaHETO Ha 3BYKOT
(3By4HMK/cnywanka) 3a koj 6uno npueBateH unu rpynex
MOBWK NPEKY HAMEHCKOTO KOMYe 3a KOHTPOMAa Ha 3BYYHUKOT
(Bugete ctpaHmua 30.)

153

OLUHB



WcTo Taka, npeky MeHUTO MOXe Aa rm geduHnpare cute
rpynHY NOBULM CO BUCOK 3BYK @ Ce KOHTpormpaar co

KOM4YeTo 3a KOHTpOra Ha 3BYYHUKOT.

1. Op rmaBHoTO MeHu n3bepete MocTaByBakwe >

Mpedpnare Ha 3BYKOT

2. Ha ekpaHOT ce nojaByBa TeKOBHaTa NocTaBka 3a 3Byk. Kora
€ nocrtaBeH Ha ,Cekoralu rmacHo®, 3ByKOT Ce orfnacyBsa of
3BYYHUKOT (BUCOK 3BYK). Kora e noctaseH Ha ,KoHTpona Ha
3BYYHUKOT", 3BYKOT Ke Ce orfiacu og criylankata unm
3BYYHWKOT, NPY KOPUCTEHE Ha KONYETO 3a KOHTpona

Ha 3BYYHUKOT.
3. N3bepeTe ja cakaHaTa nocTaBka.

lMocmaeyear-e Ha pexxumom 3a
npucnocobysaHne Ha jaHuHama

Ha 38ykom

JaunHara Ha 3ByKOT MOXe [ja ce MocTaBu Ha
MoeanHeyHo vnn Ha OnwTo. [JoKomnKy
nocraeseH Ha NoeanHeYHO, 3BYKOT Nnpwu
[BOHACOYHWN 1 €OHOHACOYHM NOBULIM, 3BYKOT

el C]J) (=
|| Jauna Ha aByKoT I

JaiHa Ha 38yKOT MH ABOHACO4EH
0BHK:

Jasa Ha 38yKOT NPH ef1HOHaCD4eH
n0BHK:

Ja“Ha Ha 38yKoT Ha cnywankara: 11
Jauva Ha 38yKoT Ha agydHMKOT: 11
JauHa Ha 3syKoT Ha Tactarypara: 11

Mpomerara e ] Eﬂ Viaspuena

Ha cnyLuarnkara, 3By4YHUKOT U TacTaTypata Moxe Ja ce
rnocTaByBa CNopes, XenbuTe Ha KOPUCHUKOT. [JOKOrNKy NOCTaBeH
Ha OnwTOo, 3BYKOT MMa eHa NoCTaBKa 3a CUTe CTaBKM.

1. Og masHoTo MeHn n3bepete MNMocTtaByBawe > 3BYK >
Pexum 3a nocTaByBatbe Ha jaymHaTa Ha 3BYKOT.

2. N3bepeTe ja bapaHaTa nocTtaska u nputucHete N36epm

unu nputncHete Hasap 3a fa nanesete.

nOCTaBYBaI-be Ha TOHOBUTE
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Opf rmaBHOTO MeHU n3bepeTte
MoctaByBake > ToHOBM.

OBa nogmMeHu B/ OBO3MOXYBa Aa
aKkTuBupaTe/geakTusuparte TOHOBUTE
Ha MTHS800.

3a fgertarneH cnMcok co TOHOBU, BUAETE BO
,TOHOBW” Ha cTpaHuua 227.

Ll 5
ToH Ha Kon4utba Ha TacTarypara
Curre ToHoBY
[lossona 3a pasrosop
Moxe ga ce npatu
Tepuopyien curHan

Mabepu | [ Haaan




lNocmasysaw-e moH 3a macmamypama

3a aKTMBMpaI—be/,D,eaKTI/IBVIpaH:e Ha TOHOT Ha TacTtaTtyparta
Nnpun cekoe NpuTnckakbe Ha Kon4eTo:

1. Og masHoTO MeHn n3bepete MNMoctaByBawe > TOHOBU >
ToH Ha TacTaTypara.
2. Jlnsrajte H13 noctaBkuTe (Bknyun/Ucknyum).

3. N3bepeTe ja bapaHaTa noctaBka n nputucHeTe U36epu
unun nputncHeTe Hasap 3a aa maneserte.

Mocmaeyean-e Ha Cume moHoeu

3a aKkTMBMpare/aAeakTMBNpaHe Ha cuTe TOHOBK (TOHOT 3a
Tacratyparta v TOHOBUTE 3a APYrh aKTMBHOCTU LLUTO I
kopucTtu Bawwmot MTHB800):

1. Opg rmaBHOTO MeHu n3depete NMocTtaByBawe > TOHOBU >
Cwute TOHOBM.

2. IlnsrajTe HU3 NOCTaBKUTE (BKIYYU/UCKIYUHM).
3. M3bepeTe ja bapaHaTa noctaBka u nputucHete N3bepm
unu nputncHete Hasapg 3a aa nsnesere.

mKaea cume moHOB8U ce OHEBO3MOXeHU, sawuom MTHS800

ce npechpria 80 PEXUM 3a MPUKpUsar-e U cume 38yyu ce
fpeHacoyysaam KoH crywasnkama HaMecmo KOH
38YYHUKOM 3a (hYHKUUOHUPaH-e CO HU30K 38YK.

He 3abopaseme da ja 0He803MOXUMe 08aa 00ruKa Koaa Ke
3aspwume co paboma 80 pexxumom 3a npukpusarse, 3a oa
20 8pamume sawuom MTH800 da pabomu co 8UCOK 38YK.

I'Iocmaeyeal-be Ha moH 3a do3eoJia 3a pa3coeop

MocTojaTt 3 nocTaBku 3a TOHOT: T =]
« Be3 TOH (He ce cnyLla ToH no o
nputuckawe Ha PTT). Kparrok Ton
HopmaneH ToH
» KpaTok TOH (Ce crnyLua KpaToK TOH Mo
nputuckawe Ha PTT). Visbepn | [ Hasan

* HopmaneH ToH (ce cnywa gpabpuyku
NoCTaBeHWOT CTaHZapAeH TOH Mo npuTuckamwe Ha PTT).
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3a npomeHa Ha NnocTaBkuTe Ha TOHOT 3a 403BOSa 3a
pasrosop:

1. Op maBHoTO MeHn n3bepete MNMocTtaByBawe > TOHOBU >
[JosBona 3a pa3roBop.
2. IlnsrajtTe HWU3 NOCTaBKUTE.

3. N3bepeTe ja GapaHaTa nocTaBka un nputucHete U3bepu.
MputnucHete Hasap 3a ga nsnesere.

lMocmaeka 3a ,,Moxe Oa ce ucnpamu*

ToHOT 3a ,MOXe Aa ce ncnpartu“ My ykaxkysa Ha TepMunHanor

LUTO NPeHecyBa Aeka TEPMMHArOT LWTO NpuMa € NOAroTBeH

Ja ro npudpat NpeHoCcoT.

3a aKkTMBUpake/OeaKkTMBNpaHe Ha TOHOT 3a ,MOXe Aa ce

ucnpartun®:

1. Oa masHoTO MeHn n3bepete MNMocTtaByBawe > TOHOBU >
Moxe na ce ucnparu.

2. N3bepeTe ja GapaHaTa nocTaeka u nputucHete U36epu.
MputncHete Hasap, 3a ga nsnesete.

lMocmaeyesaH-e nepuodu4yeH cuzHa

[MeprMognyYHMOT CUrHan ykaxkyBa Ha NponyLTeH NoBULIA,
Henpo4unTaHu nopaku u cnaba 6atepuja. Cekoj curHan 3a
Henpo4dMTaHa nopaka BKiy4dyBa TOH K 6oja Ha kunnbap
Ha LED.

3a akTuBMpare/geakTmBnpare Ha NepnognyHNOT TOH:

1. Opg rmaBHOTO MeHu n3depete NMocTtaByBawe > TOHOBU >
MepuopgunyeH curHan > CurHan.

2. N36epeTe ja bapaHaTa nocTaBka U NpUTUCHETE U3bepu.
MpuTncHeTe Ha3ag 3a oa uaneseTe.

3a noctaByBah-€ Ha NepMogoT Mery TOHCKATE MHOUKaLUN.

1. Og rmaBHoTo MeHn n3bepete MoctaByBawe > TOHOBM >
MepuogunyeH curHan > MNMepuogp.

2. N3bepeTe ja GapaHaTa nocTaska 1 NPUTUCHETE M3GepM.
lMpuTncHeTe Ha3aA 3a Aa nsneserte.



lNocmasysar-e Ha moHoeume 3a D-PTT

3a akTuBMpame/geakTnBmpame Ha ToHoT 3a D-PTT:

1. Oa masHoTO MeHu n3bepete MNMocTtaByBawe > TOHOBU >
D-PTT-toHoBM > D-PTT-pexum.

2. N3bepeTe ja GapaHaTa nocTaeka 1 NPUTUCHETE U36Gepu.
MpuTncHeTe Ha3apd 3a ga usneseTe.

3a pna n3bepeTte TOH:

1. Opg rmaBHOTO MeHu n3depete NMocTtaByBawe > TOHOBU >
D-PTT-toHoBM > Bua Ha TOH.

2. N36epeTe TOH Mery Tpy OnuuMuK: eAHOKpaTeH, ABOEH UK
TpoeH. Opete o ,[BoeH PTT — egHokpaTeH TOH” Ha
cTpanuua 230 3a npernea Ha KapakTepUCTUKUTE Ha

TOHOBUTE.

m Cume nocmaseku Ke 6udam 3a4yeaHu o UCKITy4yearemo
Ha paduomo.

Oanukn 3a Bpeme 1 aaTym
MeHnuTo 3a BpemMe 1 AaTyM ' KOHTpOInunpa npukaxaHmte
Bpeme un aaTtym.
Op rmaBHOTO MeHu n3bepete MocTtaByBakwe > Bpeme
M paatym.

lNTocmaeku 3a npuka3 Ha epemMe U damym

Opn rnaBHoTO MeHU u3bepete MNMocTtaByBawe > Bpeme

u aatym > EkpaH.

Ha ekpaHOT ce nojaByBa TekoBHaTa NnocTaBKa:

1. Bpeme n gatym — Ha ekpaHoT Ha MTHB800 ce nojaByBa
BpEMETO U AaTyMOT.

2. Camo Bpeme — Ha ekpaHoT Ha MTHB800 ce nojaBysa camo
BpeMerTo. [MNogMeHnTo 3a popmaTuparse Ha AaTymMoT
€ OHEBO3MOXEHO.

3. Camo gatym — MTH800 ro npukakyBa camo AaTyMOT.
MoomeHuTO 3a hopmaTupam-€ Ha BpemMeTo
€ OHEBO3MOXEHO.
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4. Uckny4eHo — Ha ekpaHoT Ha MTH800 He ce nojaByBaaT
HUTY Bpeme HUTY aatym. MeHuTo 3a cpopmaTtupame
€ OHEBO3MOXEHO.

Jlnsrajte go cakaHarta nocrtaBka u nputucHete U3bepwn.
MputncHete Hasap 3a ga nsnesere.

lTocmaeysaHn-e Ha popmamom 3a epememo

3a MeHyBah-€e Ha (bopMaToT Ha NpUKaXaHOTO BpeMe of,

24-yacoBHa Ha 12-4acoBHa ckana:

1. Op rmaBHoTO MeHn n3bepete MocTtaByBawe > Bpeme
v aatym > ®@opmart > PopmaTupale Ha BpeMme.

2. IlnsrajtTe HWU3 NOCTaBKUTE.

3. N3bepeTe ja GapaHaTa noctaBka u nputucHetTe U3bepu.
MputnucHete Hasap 3a ga nsnesere.

nocmaeyeaw-e Ha popmamom 3a Gamymom

3a n3meHa Ha npukaxaHuoT cpopmart Ha gatymot mery 011/

MM/TT, MM/OO/TT, BO-MEC-IT v F'T/MM/OL;

1. Op rmaBHoTO MeHn n3bepete MocTtaByBakwe > Bpeme
¥ aatym > ®@opmart > PopmaTvpame Ha gaTym.

2. InsrajtTe HWU3 NOCTaBKUTE.

3. N3bepeTe ja GapaHaTa noctaBka u nputucHete U3bepu.
MputucHeTe Hasap 3a aa nsneserte.

meememo u 0amymMom ce CUHXPOHU3Upaam npeky
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UHpacmpykmypama. BpedHocmume moxe 0a eu
rocmaesume pa4Ho Koza ypedom He e 80 oricee Ha
cugHarom Ha uHgpacmpykmypama.

llocmaeysar-e Ha epememo

3a noctaByBah-€ Ha BpEMETO:

1. Op rmaBHOTO MeHU n3bepeTe MocTaByBawe > Bpeme
n gatym > [ocTtaBu > NocTtaBu Bpeme.

2. BHeceTe ro BpeMEeTO CO KOPUCTEHE Ha HAaBUIraLnCcKoTO
Kornde n/unmn Hymepuykarta Tacrtatypa U NpuTUCHETe
3aBpuwu. [NputnucHeTe OTKaXu 3a 4a naneseTe.



lMocmaesyeaw-e Ha damymom
3a MocTaByBame Ha AATYMOT:

1. Op rnaBHOTO MeHU n3bepeTe MNocTaByBawe > Bpeme
n patym > lNocTtaBu > lNocTtaBu gatym.

2. BHeceTe ro BpEMETO CO KOPUCTEHE Ha HAaBUraLMUCKOTO
Komye u/vnu HymepuykaTta TactaTypa v nputucHeTe
3aBpuwm. MputucHeTe OTKaXu 3a Aa n3nesete.

Mocmaeyeam-e Ha uzedHayyeaHemo
3a nocTaByBat-e Ha U3edHaYvyBaHETO MO fOKanHO Bpeme:

1. Op rmaBHoTO MeHn n3bepete MocTtaByBawe > Bpeme
v aatym > lNocTtaBu > BpeMeHCKo nsegHavyBame€.

2. BHeceTe BpeMEHCKO M3eHavyBame CO KOPUCTEH:E Ha

HaBUrauMCKOTO Kon4ye N NnpuTnucHeTe 3aBpum. rlpI/ITVICHeTe

OTKaxu 3a fa nsnesete.

mMoxe Oa ja npucriocobume spedHocma Ha

usedHa4vysar-emo, co 15-MuHymHu Yekopu, 00 HajMHoay
14 yaca Hanped unu Ha3ao.

AXypupaH-e Ha cucmemMom

Moxe fa nusbepeTe HauvH Ha aXypupare Ha BPeMeTo 1
AaTyMOT LUTO Ce NMpUKaXkaHu Ha pagmnoTo:

1.

3a ncknydyBane Ha oruujata 3a aBTOMaTCKO axypupame
o[ CTpaHa Ha uHpacTpykTypata NocTtaByBawe > Bpeme
n gatym > Axypupamwe Ha cuctemot > Ucknyuu. Cute
npeHeceHy nHopmauumn ke buaat UrHopmpaHu.
TepMUHanNoT KOPUCTU BHATPELLHO BpeMe U BPEMEHCKO
nopamHyBahe.

. 3a NCKIy4dyyBaH€ Ha OﬂLI,I/IjaTa 3a aBTOMATCKO axypupame

camo Ha BpemeTo MNocTaByBawe > Bpeme u gatym >
Axypupame Ha cuctemot > Camo Bpeme. [1pukaxaHoTo
BpeMe ce NpecMeTyBa of, MOYETOKOT NporpammupaH oz
CTpaHa Ha JaBaTenoT Ha yCcnyru 4o4afeH Uy oa3eMeH
o[ BpEMETO Ha Mpexara.
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3.

3a BKMy4vyBare Ha aBTOMAaTCKOTO aXxypupare
lNMoctaByBawe > Bpeme u aatym > Axxypupame Ha
cuctem > Bpeme n usegHavyBame. 1o npnemMoT Ha
npeHeceHata MHopmauuja ce axypupaaT BpemMeTo
W BPEMEHCKOTO NopaMHyBah-e.

OAanuKn Ha eKpaHoT

160

MeHuTo Ha €KpaHOT o KOHTponunpa nNpuKkasoT

Lol (=
Ha eKkpaHoT.
Tpesprex expax: Mcknyyero
Opf rmaBHOTO MeHu n3bepete Tonewwsa o ek Cangennes,
. BaLTATHIK Ha expaxor
n ocTa By Bame > E Kpa H: 3aHMHCKO CB.TO: ABToMaTCKA
SapHuna Biysena
* MNpeBpTyBatbe Ha €KPAHOT — 0 NPEBPTYBA  [iow | [ aapun

€KpaHOT Haonaky.
[onemMuHa Ha TEKCTOT — OBO3MOXYBa NOCTaByBaH-e

Ha rorieMmMHaTa Ha TeKCTOT Ha eKpaHOT.

3aWTUTHWUK Ha eKPaHOT — ro NPeKpMBa eKpaHoT Ha
MTH800 otkako MTH800 e Bo MupyBah-e BO TEKOT Ha
NPETXOAHO NPOrpaMMpaHMoT BPEMEHCKM NEPUOA (JOKOSKY
€ KoHurypmpaH of BalIMOT AaBaTen Ha ycnyru).

3afHMHCKO CBETMO — 3a/HMHCKOTO CBETIIO 0 OCBETNYBa
€KpaHoT 1 TacTaTypaTa npu BOCrocTaByBake Unu
npyvMare Ha NOBUK UMW NPUTUCKakE Ha KoNYuH-aTa.
3afHVHCKOTO CBETNO MoXe Aa buae noctaBeHo Ha
aBTOMAaTCKO, NOyaBTOMATCKO UMM OHEBO3MOXEHO.
3aHuWHa — ja MeHyBa 3agHuWHaTa LITO ce MnojaByBa npu
ekpaH BO MUpyBak-e.

KoHTpacT — 0BO3MOXyBa MOCTaByBake Ha KOHTPACTOT Ha
€KpaHoT.

Mocmasysar-e Ha odnukama 3a eéepmukKasiHoO
npespmyeaH-€e Ha eKpaHom

Kora e akTvBMpaHa oBaa oanuka, coapXvHaTa Ha eKkpaHoT
e npespTeHa Haonaky. Oanvkata e ocobeHo KOpUCHa kora
KOPMCHUKOT koj Tpeba ga ro Hocn MTH800 Ha pamo, nojac
Uy peeep UCTOBPEMEHO CaKa [a unTa of eKpaHoT NpeBPTEH
Haonaky.



3a pa ja akTMBupare/geaktusmpare:

Op rmaBHoTO MeHu u3bepete MNocTaByBake > EkpaH >
MpeBpTyBawe Ha ekpaHoT > Bknyuu. Nnu 3agpxete ro
NPUTUCHATO MPETXOO4HO NPOrpamMMpaHoTO KoMye 3a efeH
Jonup (QOKOMKY e KOHUIypupaHo of CTpaHa Ha BaLMoT
Jasarten Ha ycnyrm).

3abenexere ja nonoxbaTta Ha NPOrpamcknTe Konvmkba Ha
BEPTUKanNHNOT eKkpaH.

Bl [ nmdgeg [ wHemey
Tpesprex expat: Meknysero ETALEMOLEY 0LL3E0 0XOHAHTeg
TonewiHa Ha Texcr: Crannapaka. 10HRd48 BH WHLLMES
SaLUTHTHI Ha expaoT E> "EHTGETHeL?) .L0¥AL BH BHINALO |
‘3a0HMHCK0 CaeTno; ABTouarcka OHBRATOY] Hedye Holdead |

Vavenn | [ 3aspum - [

G (=) 1 G [\

3a KopuCTeHe Ha KOMYETOo 3a poTMpare Npu NPeBpPTEH
eKkpaH, BuaeTte cTpaHuua 26.

3a KOpUCTEH€ Ha KOn4eTo 3a Hasmraumja npwn npeBpTeH
eKpaH, BngeTe BO NpogoInkeHne.

JNnusrambe Hagony n Harope KOPUCTEjKN ro KON4yeTo 3a

HaBurauuja.
nmdeeg | L VHAWE}| vmdseg | | VHOWE vmdeeg | L VHIWE|
BRI ‘eHiTeg ERORAING BHHHTeE EHORTING EHHHIE
EOIEOLEY [OULO80 OXHUHITEE ETOIENOLEY 01880 OKHHHTES ETOIEMOLEY [0L1860 OYOHHHES
104edl eH WHLILEG, 104 BH YHHLALMe 104edl eH YHLILME,
ERTORTREL) LVoL BH BHHNALO) |:> “EHUOEFEL,) :L0JoL BH BHANLO ) “EHIRTHL) L9%aL B BHANALO)
OFRRALIOY] Hedka Haldead OHARATINY] Hedya HaLdaad| | L OHGRAIIN] :Heda Haldead)|
Hedy3 Hedy3 Hedy3
(L | [l ) [

G AR &
o o o
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Jlnsrame HaneBoO N HaAeCHO KOPUCTEjKN ro KONYeTo 3a
HaBuraumja

mudgen [ eH tma

mudgey [E] eH e

mudgen [E|[ eH e

'dg HaLeaud| |

I

'dg Horeand||

F

'dg HoLeand||

& [
Q

& [ )
& &

3a pa nsnesete og NPEBPTEHNOT EKpaH:

Opn rmaBHOTO MeHUn u3bepete MNMoctaByBawe > EkpaH >
MpeBpTyBawe Ha ekpaHoT > Ucknyuum.

lTocmaeysaH-e Ha 2osileMUHama Ha mekcmom
1. Og masHoTo MeHn n3bepete MocTtaByBawe > EkpaH >
FonemuHa Ha TEKCTOT.

2. MpuTtucHete U3ameHn. N36epete CtaHaapaHa unu
3ymupaHa 3a ga ro rnegate TEKCTOT Ha eKpaHOT BO ABe

ronemMnHu.

I'Iocmaeyeahbe Ha 3aWlmumHuKom Ha eKpaHom

1.

Oa rnaBHOTO MeHM V|36epeTe

MoctaByBawe > EkpaH > 3aWwlTUTHUK Ha

€KpaHoT.

. MputncHete U3meHu. MputnucHeTe

M3meHu NoBTOPHO 1 n3depeTe ja
nocraBkaTa 3a 3alWTUTHUKOT Ha EKPaHOT:
ABTOMaTCKM U OHEBO3MOXEH.

fibe 14 | 3aWTUTHYK
5

Ha eKkpaHoT:
3npaso

Ok 2| VisBpmium

. I'lusrajte no TekeT. NputncHete U3meHu. MNuwysane/

ypeayBake Ha TEKCTOT Ha 3aLUTUTHMKOT Ha EKPaHOT
CO NoMoLL Ha TacTaTtypaTta. (3a noBeke geranu 3a
ynotpebaTta Ha ypeayBa4yoT Ha TEKCT, BUAeTe BO
S IMLyBare TeKCT” Ha cTpaHuua 211).




4. MpuTtucHTe N3b6epm 3a aa nsneserte.

m Onyuume Ha MeHUMO Ke 20 rpuka)xxam 3awmumHuUKom
Ha ekpaHom, OoKosiKy 0agameniom Ha yciyau rnpemxo0HO
Ja npoepamupas ogaa 00ruKa.

lNTocmaeysaHn-e Ha 3a0HUHCKOMO ceemJio

Bawwnor MTH800 nma 3 noctaBku 3a 3aHUHCKOTO CBETO:

ABTOMaTCKM:

Bo 0BOj pexvmM 3aAHMHCKOTO CBETNO Ce BKMy4dyBa CO

BKMy4yBake Ha paamoTo U CO NPUTUCKaHe Ha Koe buno

Konye Ha anapaTtoT unu ononHUTenHMoT npmbop. BoegHo,

nonHewe 1 Aobueake curHan og cepBucy kako wTo ce: Call-

Out nopaka, RUA nobapysate, DGNA u TX no uctek Ha

BPEMETO BO TEK Ha NPUOPUTETEH MOBUK Ke ro BKNyyar

3a[IHMHCKOTO CBETMO.

NMonyaBTOoMaTcKo:

Co nsbupatre Ha oBaa onuuja 3agHUHCKOTO CBETINO ce

BKMy4yBa Kora KOPUCHUKOT ro BKMy4yBa paguoTo, npuTtucka

Ha3Ha4yeHo Konye 3a oAnuka Ha 3aHMHCKOTO CBETMO UM ro

NOMHW.

M.S’aOHUHCKomO ceemjsio ocmaHyea 8Kily4eHo ce 0o ucmexkom

Ha npemxodHO NpoepamupaHomo epeme.

OHeBO3MOXeHO:

Opnvkarta 3aHUHCKO CBETIIO € OHEBO3MOXEHaA.

3a n3meHa Ha nocTaBkUTE 3a 3aHMHCKO CBETIIO:

1. Op rmaBHOTO MeHU n3bepeTe NMocTaByBawe > EkpaH >

3agHWHCKO cBeTIo.

2. MpuTtucHete U3meHn.

3. N3bepeTe ja GapaHaTa nocTaeka.

4. MputncHeTe 3aBpLUEHO 3a Aa U3neseTe.

nocmaeyeam-e Ha 3a0HUHama
1. Op rmaBHOTO MeHU n3bepeTe MocTaByBawe > EkpaH >
3agHuHa.
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2. MNputucHete N3ameHn.
3. N3bepeTe ja GapaHaTa nocTaBka (BKNy4YU/MCKNyYum).
4. MNpuTtucHeTe 3aBpLUEHO 3a [a U3re3eTe.

llocmaesysar-e Ha KOHMpacmom

1. Op rmaBHOTO MeHU n3bepete MocTaByBawe > EkpaH >
KoHTpacr.

2. MpuTtucHete U3meHn.

3. KopuicTeTe ro neBoTo 1 JECHOTO KOmMYe 3a HaBurauuja 3a aa
ro MeHyBaTe KoHTpacToT. [MputucHete OK.

4. MNpuTtucHeTe 3aBpLUEHO 3a Aa U3reseTe.

LLTenewe eHepruja Tl =
LLtenereTo eHepruja (LLUE) e pexxum Ha
paboTa npu KojLITo, CO Lien Aa ce 3awrteau Vis6op Ha LLE
TpaeweTo Ha 6atepujata MTH800 He ru
crneguv cute BPEMEHCKN MEepUoamn Ha
rMaBHNOT KOHTPOJIEH KaHan 3a npuem Ha
MPEHOCOT 0f caTenuT. AKO TEPMUHAIIOT € NPUKITYyYEeH Ha

MOITHaYyoT, PEXMMOT 3a WTeAeHe eHepruja He e NoTpebeH.
Opn rnaBHoTO MeHU u3bepete MNMocTtaByBawe > Lltenewe
eHepruja (4OKOrKy € NocTaBeHOo o BalUMOT AaBaTtes Ha
ycnyru).

Cmamyc Ha odniukama 3a wmedere eHepauja

1. O noaMeHWTO 3a WTeaeke eHepruja, n3bepete
craTtyc 3a LUE.

2. Ce nojaByBa CTaTyCcOT Ha offvKaTa 3a LuTefeHe eHepruja:

» OgnukaTa 3a wreaewe eHepera € TEKOBHO nogap>aHa
o4 CUCTEMOT.

1%

» OgnukaTta 3a wreaewe eHepera HEe € TeKOBHO
noggpxXaHa o4 CUCTEMOT.
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N360p Ha pexum 3a wmedew-e eHepauja

1. Op noamMeHuUTO 3a WTeaere eHepruja, n3bepete
n36op Ha LUE.

2. N3bepeTe ja GapaHaTa nocTaska (BKIYUYU/UCKIYUN).
3. MputncHete Hasap 3a na nsnesete.

Konue 3a potupame

Tyka MoXe Aa rv noctaBuTe CUTE NOBP3aHN g @ |
(PYHKLIMOHANHOCTUN Ha KOMYeTo 3a
IM Ha pOTHPatbe:
poTupamwe. Oa rmaBHOTO MeHN nsbepete \/;amwyaawawemawpame
low 3aKnyseHa Tacrarypa
MocTtaByBame > Konue 3a potupatse. forc
IM3ra) Hi3 oncer
Pexum Ha poTupame Vepere | [ Hasan

BawwuTe onuuu ce:

« OBOeH — gocTanHu ce ABaTta pexuma. 3aBpTeTe ro
KOMYeTo 3a poTMparbe 3a Aa ja npucnocobuTe jaumHaTa Ha
3BYKOT 1 MOTOA BpTeTe 3a Aa ce npedpnare HU3 pasnuyHu
rpynu 3a pasroeop.

» JaumHa Ha 3BYKOT — KOMYETO Cce ynoTpebysa camo 3a
KOHTpOSIa Ha jaynHaTa Ha 3BYKOT; CBPTETE ro BO NpaBeL Ha
CTPEenKUTE Ha YaCOBHUKOT 3a Aa ja 3ronemMuTe jadnmHarta Ha
3BYKOT

* J1V|3raj — 3aBpTeTe ro Kon4eTo 3a poTupat€ 3a NSMEeHa Ha
rpynarta 3a pa3roBop ummn Kora cte BO MEHUTO, KOMYETO Ce
KOPUCTHU 3a Jin3rakbe HM3 cnucoumTe Uinn CtaBkuTe o
MEHUTO.

mﬂomm(y uzbepeme Jluszaj u Ha ekpaHom ce rojasysa:
* U36paHo nusz2ame - mpeba 0a o0ume 80 e/1a8HOMO

meHu, usbepeme lNocmaesyeam-e > [locmagyeaH-e Ha
jayuHama Ha 3eykom 3a nocmasyear-e Ha HU8OMO Ha
jayuHama Ha 38ykom.

* QyHKUUCKUMeE KOMYUH-a ce MNocmaeeHU Ha
lNTocmasyeate Ha jayuHama Ha 38yKom - Moxe 0a au
Kopucmume cmpaHUu4yHUMe KOM4uk-a Wwmo Moxe 0a ce
npozpamupaam 3a rpucrocobysar-e Ha jadyuHama Ha
38yKom.
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3akny4yyBaHe Ha KON4eTo 3a poTupamwe
BawwTe onuum ce:

+ 3aKnyy4eHo — ro 3akny4yyBa KOM4eTo 3a poTMparke, MOXe
Aa ro oTKny4nTe co n3bunpare Ha OTKIy4YeHo Unn co
npuTUCKare 1 3afpXKyBake Ha KOMYETO 3a poTUpame.

* OTKNy4eHo — ro OTKMy4yBa KOMYETO 3a poTUpaHe, MoxXe
Aa ro 3aknyumte co nsdmpare Ha 3akry4eHo unm co
npuTUCKame 1 3aAp>KyBake Ha KOMYeTo 3a poTupame.

+ OHeBO3MOXeHO — (hyHKLMjaTa 3a 3aKIy4vyBare
e HefocTanHa. BaweTo konye 3a poTvpare e NocTojaHo
OTKITyY€EHO.

Mpu 3akny4eHa TacTatypa
Moxe fa ro noctaB/Te OAHECYBaH-ETO Ha KOMYETo 3a
poTupake Kora TactaTtypara e 3aknydyeHa. BawunTe onuum ce:

* He 3aknyu4yBaj — goctanHu ce dyHKLMOHANHOCTUTE 3a
nm3srakbe U NocTaByBak-€ Ha jaumHaTta Ha 3BYKOT

+ 3aknyuu ja jaumHaTa Ha 3BYKOT — KOMYETO 3a poTMpare
MOXe [1a Ce KOPUCTU CaMO 3a NU3ram-e.

+ 3aKknyuu nuarake — KON4eTo 3a PoTHpake MOXe Aa ce
KOPUCTU 3a NOCTaBYyBak-€ Ha jaumHaTa Ha 3BYKOT.

* 3aKl1y‘-IVI r'm gBeTte — beHKLI,VIOHaJ'IHOCTVITe 3a nm3rake
M noctaByBak-€ Ha jaHVIHaTa Ha 3BYKOT Ce€ HeJOoCTanHu.

3aBuTKaj

[Hokonky e noctaBeHo Ha Mckny4yeHo, Nn3rakeTo HN13
CNMCOKOT CO Fpynu 3a pasroBop NpekMHyBa OTKaKo ke ce
OOCTUrHe NpBaTa UnK nocreaHara rpyna 3a pasroBop BO
TekoBHaTa n3bpaHa nanka. Bo cnpotneHO, Mo
OOCTUrHYBaHETO Ha nocneaHaTa unu npasata rpyna 3a
pa3roBOp BO TEKOBHATA Narnka fn3rakeTo NPOAoKyBa UNn
npemnHyBa Ha crnegHaTta narka.

Camo koza oOnukama 3aeumkaj e nocmaeeHa Ha

M Bkny4yeHa u Oncezom Ha siu3zz2ahse e rnocmaseH Ha Jluzaaj
do cnedHa, Ke Moxe Oa fiuszame HU3 cume 2pyrnu Ha
pas32080p U narku.
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Oncer Ha nNu3rawe

Ako ro noctaBsuTe Ha OcTaHM BO ONCer, N13rakeTo € caMo
HWU3 rpynnTe 3a pasroBop BO TEKOBHAaTa nanka. [Jokornky
npetnoynTaTte Aa nuarate HM3 cuUTe JOCTarnHKU rpynu 3a
pasroBop 1 nanku, n3bepete Jlusraj po cnepHara.

lMomepdu u3zbop Ha P

Ako e noctaBeHa Ha BknyydeHa, Tpeba ga ro notepauTe
n360pOoT Ha rpynaTa 3a pasroBop co nputuckamwe Ha N3bepum
Unu co npuTuckawe Ha konyeto 3a PTT 3a BegHaw ga
3anoyHeTe Co NOBMK Ha HOBa rpyna 3a pasrosop. Bo
CNPOTMBHO, PaAMOTO Ce NpuKayvyBa Ha nsbpaHata rpyna 3a
pa3roBop 6e3 OONONHUTENHU NopakKu.

PYHKLUUCKN KONYUHA
BawwuTte onuuu ce:

* ABTOMaTCKM — (DYHKLMCKUTE KONYMHa Ce NocTaByBaaT
crnopes NocTaBKUTE Ha PEXMMOT 3a poTuparse. [Jokonky
€ NocTaBeHo Ha:

> [BoeH unv JaunmHa Ha 3BYKOT - Ha eKpaHoT ce
nojaBsyea aBToMaTcku nsbpan (OTB), jaunHara Ha
3BYKOT MOXe [a ce NoCTaBu caMo MpeKy KonyeTo 3a
poTupame.

> Jlnsraj - Ha ekpaHOT ce NojaByBa aBTOMAaTCKU
M36paH (jauMHa Ha 3BYKOT), jauMHaTa Ha 3BYKOT
MOXe [a ce NocTaBu camo Npeky yHKLUCKUTE
Konuyumma.

* MpucnocobyBawe Ha jaunHaTa Ha 3BYKOT —
PYHKLMCKNTE KON4YMHa MOXeE Aa ce KopucTaT 3a
npucnocobyBake Ha jaynHaTa Ha 3BYKOT.

+ OTB-opnuka — PyHKUMOHANHOCTUTE Ha (DYHKUUCKMTE
Kon4yuha ce AodeneHn o4 BalnoT JaBaTen Ha yCnyru.
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Bne3 Bo ,,noBekKe...“

Ll L3
7
Ogn rnaeHoTO MeHu, nsbeperte Moeeke... . %rfg;re“"
OBa noamMeHy coapxu noseke CTaBku 0f, B Koacr
e30e4HOCT
MEHMTO LITO MOXe [1a ce npucrnocobar. & Mocrasysaree
INosexe...

Bnes Bo noctaByBaweTO rpyna

Bne3 BO MeHUTO 3a CKeHunpamwe

On rnaBHOTO MeHun nsbepeTte T =]
Mogeke... . > MocTaByBawe rpyna.
Osa nogMeHn B 0OBO3MOXYBa Aia oty
nocTaBuTe OANVKUTE 3a CKEHUpaHe 1 Mou

rpynu.

Wabepn Hasan

Opn rmasHoTO MeHu n3beperte MoBeke... T

> Mpyna MocTaByBatbe > CkeHUpaj.
Ckehvpatbe

OBa nogmeHun BM 0BO3MOXYBa fia ro AvTvBeH ok

Ckervpaj  cnncowmTe

akKTMBUpaTe/deakTMBUpaTe CKEHNPaHETO,
[a ro npernefyBarte akTMBHUOT CMWCOK 3a
CKeHUpare 1 fa N ypegyearte cnvcouuTe 3a
CKeHupame.

W3bepu l [ Hasag

mHe € MOXHO Oa ce 0803MOXU USTU OHEBO3MOXU CKEHUpaH-e

Ha epyna eo TXI-pexum.

MocTtaByBawe ckeHMpake Ha rpyna

168

OBa nogmeHu B OBO3MOXYBa Aa ro aktusupare/
JeakTuBMparte CKEHMPaHETO Ha CMUCOKOT CO MPETXOOHO
neduHupaHnu rpynu nporpammpann so MTH800. MTH800
Ke ce NpUVKITyYM KOH KOj Mo rpyneH NoBMK, JOKONKY oBaa
rpyna e geduHnpaHa Bo CMMCOKOT 3a CKEHUpPaH-e

N CKEHUPAHETO € BKIy4EHO.

Op rmaBHOTO MeHu, nsbepete MNoBeke... > MNpyna
MocTtaByBawe > CkeHupaj > CkeHupame.

Mo KOMMNNEeTnpakeTO Ha NOCTAaBKUTE, HA EKPAHOT Ce Bpaka
NOAMEHUTO 3a CKEeEHupaHe.



Bknyyyear-e Ha CKeHupaH-emo
CKkeHupah-eTO € UcKIy4eHo. N3bepete
Bkny4yun. Moxe ga ce nojasu nopaka LUToO Ke
YKaXKyBa [Jeka cuTe CMCOLM 3a CKeHNpambe
ce npasHu. N36epete Cnucoum 3a
CKeHMpaHe3a NonosiHyBake Ha CNMCOKOT
(cnncouuTe) 3a CkeHUpame.

Ha ekpaHOT Ke ce nojaBu cnegHaTa
cocTojba:

Ll 3

Bxknyuun
Wabepu cnvcok

Msﬁepw[ [ Hasag

lMoToa, Ha ekpaHOT ce nojaByBa nopakara (Ha npumep)
Cnucok 3a ckeHupame 1 . TepmmHanoT ke ce obuge pa ce

NpuKa4vn KoH OBOj CMUCOK.

Ucknydyeare Ha CKeHUpaH>emo
CkeHupamneTo e Bky4veHo. V13bepeTte
Ucknyuun. Ha ekpaHoT ke ce nojasu
cnegHata coctojba:

MoToa, Ha ekpaHOT Ke ce nojaBu nopakara
CKeHMpaHeTo e UCKIY4€eHO.

Ll 3

Wcknyun
W36epm cnmcok

Vlaﬁepm[ [ Hasag

UN36upamse crnucok co 8KJ1y4eHO CKeHupaHe

1. N36epeTe N36epu cnucok.

2. 3a n36op Ha CNUCOK LUTO € pasnunyeH o
NCTaKHATMOT Nn3rajTe u NpuTUCHeTe
MN36epu. Ha ekpaHoT Ke ce nojasu
nopakara (Ha npumep) CnUcok 3a
CKeHupawe 1. TepmuHanoT ke ce obuge
[a Ce npuKaym KOH 0BOj CMUCOK.

Lol 3
Crucok co Mpexv

Crucok 3a ckeHmpatbe 1
Crucok 3a cKeHvpatbe 2
CIMcoK 3a ckeHuparbe 3

U36upaH-e CriucoK co UCKITy4eHO CKeHUpaH-e

1. N36epeTe U36epu cnucok.

2. 3a n36op Ha CMMCOK LUTO € pasnuyeH of UCTakHaTnoT
nusrajte un nputucHete U3bepu. Ha ekpaHoT Ke ce nojaBu
nopakara (Ha npumep) N36paH cnMcoKoT 3a

CKeHupamwe 1.
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Cnucok co Mpexu

BawmoT TepmmHan moxe ga ckeHvpa (Mnv ga ce npukadu
Ha) CMMCOK LTO Npunara Ha apyra nHdpacTpykTypa,
pasnuyHa of uHdpacTpyktypaTta Dimetra:

* [lo npuTuckaneTo Ha U36epu, JOKOMNKY CUCOKOT CO
Mpexu e n3bpaH, camo 0BOj CMNCOK ke Buae npukayeH.
[okonky e n3bpaH CNNMCoK CO KOPUCHULMK, Toraww ke buaat
npuKayeHn 1 CNMCOKOT CO MPEXU U CMIUCOKOT CO
KOpUCHULN.

» Bo Hekown cny4dau, gen of rpynuTe BO CAMCOKOT 3a
CKeHVpakbe Moxe Aa buaaT norpeLuHn 3a ogpeaeHu
cTpaHuumn. Bo oBoj criyyaj, kora TepMuHarnoT Ke ce obunae
Aa Ce NprKaym KOH CMIMCOKOT, MH(ppacTpyKTypaTa Moxe
AernyMHO Aa ro oTdprnum npvkadvyBaheTo. Ha ekpaHoT Ha
TepMUHanoT ce nojasysa: ,CnMcoKoT e AenyMHO
npukaveH".

* AKO CMMCOKOT CO MpEeXW € Npa3eH, Ha ekpaHoT ke ce
nojasu Hema cnucok. Co nsbvpare Ha Hema cnucok Ha
eKpaHoT Ke ce nojaBu nopakata Hema nsbépaH cnucok 3a
CKeHupame.

Mpernen Ha aKTUBHMOT CNMCOK 3a CKEHUpahe
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OBa nogMeHu B OBO3MOXYBa Nperneq Ha akTMBHUOT CNINCOK

3a ckeHupake (Bo 0BOj npumep ,Cnncok 3a ckeHnpawe 1°).

1. Op rmaBHOTO MeHU, n3bepete MNMoBeke... > NocTaByBake
rpyna > CkeHupaj > AKTUBEH cnucok. NputucHerte
Mpernen.

Ha ekpaHOoT Ke ce nojaBu egHa o criegHUTe COCTOojOu:

* N3bpaH e HeaKTMBEH CMUCOK 3a ckeHnpare (CNUcokoT 3a
CKeHupame 1 He e akTuBeH). CKkeHNpah-eTo e
UCKITy4YeHoO.

* CKEHVpPaHETO € UCKITYYEHO N N30paH e CNNCOKOT CO
Mpexu (CMMCOKOT CO MPEXU He e aKTUBEH).

* N3bpaH e akTUBEH CNNCOK 3a CkeHupare. CkeHUpaHEeTO e
BKITyY€EHO.



lMoToa, Ha eKpaHoT Ke ce MnojaBn NOAMEHUTO & |

3a cnucoLuTe 3a CKeHVpaH-e.
i Crmcok 3a ckeHmpatse 1
2. lnsrajte go 6apaHMOT CNMCOK U CrcoK co pei

NpUTUCHETE nperne,q 3a aa rm suauTte
rpynmte WwiTo npvlnafaaT KOH CMUCOKOT.

Mpernes E[ Hasan

. I'lusrajte no 6apaHara rpyna v nputucHeTe

Mpernepn 3a fa ro BuAUTE CTaTyCcoT Ha rpynata (npukadeHa
Unun HenpukadeHa) n NpUOpPUTETOT (JOKONKY € NPETX0AHO
nporpammpa).

. rlpl/ITVICHeTe Hasap 3a ga ce BpaTtuTe Ha NpeTrxoaHnoT

npukas. Motoa, ako e NoTPeGHO, NPUTUCHETE /v, Moxe
Aa nsdeperte Aa nsdpuiueTe rpyna o CNmcokoT 3a
CKEeHVpaH-€e U [1a ro U3MEHUTe NPUOPUTETOT.

MAKO CIrucoKom Cco MpeXxu e rnpal3eH, ucmuom Hema Oa ce

rnojasu Ha ekpaHom.

Ypen.yBaI-be Ha cnucouuTe N Ta = |
3a CKeHupame

Cnicok 3a ckenvpatse 1 Mpeumenysaj

1. Og rmaBHOTO MEHMU CIVicoK 3a ceHupatbe 2 Kanauuter

, ’ Cn1cok co Mpexvt M3Bpuwum cnncok

I/I36epeTe MoBeke... > e.o,uap,m rpyna

pev
HOCTaByBaH’e Mpernes [FEl]  Hasan Wsbepn | [ Hasan
rpyna >

CkeHupame > CkeHuUpaj cnucoum.

2. Jlnsrajte oo 6apaHMOT CNMCOK 3a CkeHupare. MNMpuTucHete

I'Iperne.q 3a aa rm suaunTe rpynmte WTo ce KOpucTtat BO
CMNCOKOT 3a CKeHUpaH-e. rlpl/ITI/ICHeTe Hasap 3a ga ce
BpaTtuTe Ha NpeTxogHNOT NpukKas.

. 3a ypenyBamwe/npernes Ha cogpXXuHarta Ha CrUMCOKOT 3a

CKEHMPatbe, MPUTUCHETE /¥Eny\,
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4. Bo meHMTO 3a CKeHupawe, nuarajte o 6apaHaTa onuuja
n nputncHeTe U36Gepwn.

m Onyuume 80 npodosmkeHue He MoXke 0a ce Kopucmam 3a
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CMUCOKOM CO MPEXU.
AKO Ccriucokom co Mpexu e rpaseH, ucmuom Hema Oa ce
rnojasu Ha ekpaHom.

MpenmeHyBale Ha aKTUBHWOT CMIUCOK 3@ CKEHUpake.
(3a noeeke getanu 3a ynotpebarta Ha ypeyBa4oT Ha
TeKcT, BuaeTe Bo [nwyBare TekcT” Ha cTpaHuua 211).
BHeceTe HOBO MMe (nceBaoHUM) U nputnucHete OKk.

Ha ekpaHoT ce nojaByBa HoBaTa NOCTaBKa.

MpoBepeTe ro KanayMUTeToT Ha aKTMBHMOT CMMCOK 3a
ckeHupatrbe (6poj Ha rpynu 3ayyBaHu BO CMIMCOKOT).

3a bpuwere Ha cuTe rpynu of M3bpaHNoT CMNMCOK 3a
ckeHvparse, nputncHeTe fa. Ke 6uaete nssectenn aa
M OTCTPaHUTE cuTe rpynu o n3bpaHnoT CNNCOK 3a
CKEHMpatbe.

HopapeTe rpyna KOH M3bpaHMOT CMUCOK 3a CKEHUPaH-E.

Cekoja gopageHa rpyna (Bkny4yBajku ja U omurneHata

rpyna ) uma cBoja narnka, Ha3us unu 6poj u npnoputet

(mokornky ce NnpeTxogHO NporpammpaHu).

> 3a 13bop Ha nanka, NuarajtTe HU3 CIMCOKOT CO Narnku.
CrmMCcOoKOT He v nNpuKaxkyBa nankute YMmLLTO rpynu
Ce LernoCcHO UCKOPUCTEHM BO M3BpaHUOT CNNCOK 3a
ckeHupame. MNMputncHete Ok 3a ga n3bepete nanka.

> 3a n3bop Ha rpyna, nimarajte H1U3 CMCOKOT CO Ipymnu
BO paMKu Ha n3bpaHaTta nanka. OBoj CN1cok
MoKaKyBa rpynu LUTO He ce BO M3bpaHMOT CUCOK 3a
ckeHupatbe. [MNputncHete OK.

> 3a nocTtaByBaH€ NPUOPUTET Ha rpynara, J'II/|3I'ajTe
HWN3 CMUCOKOT CO NPUOPUTETU: BUCOK, CpedeH Unm
HWU3OK.

MoBMKOT of rpynaTta co BUCOK NPUOPUTET Ke o
NpeKkMHe TEKOBHMOT MOBWK CO CPeEH UMK HU30K
NpUOPUTET.



Mowu rpynu (TMO/DMO) T = |
OBa nogMeH By OBO3MOXYBA Aa ro e
nsbepeTte/ypesyBaTte BaLLMOT CMIMCOK CO wow rpy

OMUNEHN rpynn.

DopnaBawse rpyna

MoBUKOT of rpynaTta co cpefeH NPUopuTeT ke ro
NpeKknHe TEKOBHUOT NOBUK CO HWU30K NMPUOPUTET.
MoBUKOT of rpynarta co HM30K NPUOPUTET HEMA Aa
NPEeKVHe HATY efeH NOBUK BO TEK.

* YpeayBame Ha rpynute of CMCOKOT 3a CKEHMpaHse.
> J'ImsrajTe 00 rpynarta LWTo Cakate fa ja OTCTpaHuUTe o4

N36paHMOT CMMUCOK 3a CKEHNpam-e,

nputucHeTe /vw\ 1 U36puim. Ke Gugete nssecteHu
Ja ja otcTpaHuTe usbpaHarta rpyna. o Hekonky
CeKyHOM, Ha eKpaHOoT ke ce nojaBu axypupaHuoT
CMUCOK 3a CKEHMpPaHe.

3a npomeHa Ha NpMopUTETOT Ha rpynaTa,
npuTtucHete Mpuopwurer. Jlnsrajte 4o n3bpaHmoT
npuopwuTteT u nputucHete N3Gepu.

W3depn | [ Hasan

1. Op rmaBHOTO MeHu, n3bepete MoBeke... > NocTaByBawe

2.

rpyna > Mowu rpynu > <Hasus Ha nanka> > [HoBa rpyna].

WN3bepeTe rpyna co npebapysake no nanka (,TMO/DMO
no nanka “). 136epete nanka n usbepete rpyna. lpynarta e
AofajaeHa KoH nankara ,mou rpynu‘. Ui/ nsbepete rpyna
npeky npebapysane no a3dyyeH peg (,TMO/DMO no
a3byuyeH pen “). Moxe aa BHeceTe HajMHory 12 Byksu o
Ha3MBOT Ha rpynaTa.

Bpuwekwe rpyna
1. Og masHoTo MeHu, n3bepete MoBeke... > MNocTaByBakwe

rpyna > Mou rpynu > <HasuB Ha nanka>.

2. VlcTakHeTe ro Ha3MBOT Ha rpynaTa 3a pa3roBop LUTO cakaTte

Aa ja n3bpuwerte n n3bepete U36pun.

3. N3bepeTe pa 3a noTepaa.
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Bpuwewe Ha cuTe rpynu
1. Op rmaBHOTO MeHu, n3bepete MNMoBeke... > NocTaByBake
rpyna > Mowu rpynu > <Haaus Ha nanka>.

2. MputucHete /= N36epeTe U3GpuLLM ru cUTe.
3. N3bepeTe Oa 3a noTepAaa.

Osaa onyuja e docmarHa camo OOKOJIKY ja 0803MOXU
Oasamesiom Ha ycryau.

JopnaBawe oMmuneHa nanka

1. MpuTucHeTe /*=v\ n n3bepete Moseke... > MocTaByBake
rpyna > Mowu rpynu.
2. N36epeTe [HoBa nankal.
3. lNo BHecyBah-eTO Ha HA3MBOT Ha nankarta nputucHeTe Ok
3a noTepaa.
MpenmeHyBawe Ha OMUIIeHa nanka

1. MpuTtucHete /**\ n nsbepete MNMoBeke... > NocTaByBawe
rpyna > Mowu rpynu.

2. VIcTakHeTe ro Ha3uBOT Ha rpynHarta nanka u NnpuTUCHeTe

3. M36epeTe MpenmeHyBake nanka.

4. Mo ypenyBaweTo Ha Ha3MBOT Ha nankarta nputnucHete Ok
3a noTepaa.

Epumel-be Ha OMUIIeHa nanka

1. MpuTucHete /xw\ 1 nsbepete Moseke... > MNocTaByBake
rpyna > Mow rpynu.
2. /cTakHeTe ro Ha3MBOT Ha rpynHaTa nanka

U NPUTUCHETE [ven),
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3. N3b6epeTe Bpuwere nanka.
4. MputncHete fa 3a notTepaa

MHe Mmoxe Oa ja usbpuweme rocriedHama oMusieHa narka.

Mpernea/npomeHa Ha NU4YHUTE MHOpMaL K

KopucTeTe ja oBaa ognuka 3a nperneg Ha e
COMCTBEHWNOT NpuBaTeH unu tenedoHCKn
i Moj 6poj
6poj Bo cekoe Bpeme. i o
1. Op raBHOTO MeHU, n3bepete MoBeke... > || Heopuaumsapazio
Mowm nH .
¢opmauun ssenr | [

2. N36epeTe Moj npuBaTeH 6poj, Moj

TenecdoHckn 6poj nnu UHdopmauum 3a paauo.
MpukaxxaHNoT NpuBaTeH 6poj He MOXe Aa ce U3MEHWN.
3a npoMeHa Ha NpuKaXxaHMoT TenedoHCKkn 6poj,
npuTUcHeTe Ypeau.

Ypeaete ro 6pojoT u nsbepete Ok 3a notBpaa.Hosuot
TenedoHckn 6poj He ro meHyBa 6pojot Ha MTH800 Bo

CUCTEMOT.
NHdopmauum 3a paavo rv 3adyByBa T |
all

WHpopmMaLmnTe 3a:

Motorola
* [Mponssoguten MTH800

ISSI:

* Bug Ha npousBog 8582:
* |SS] Hasag Moseke
* TEI

» Cepuckn 6poj
OPTA (MHdbopMaumm WITO ce gocTanHu camo
aKo e oBO3MOXeHa oanukarta BSI).

M Osaa o0nuka e docmariHa caMo aKo ja 0803MOXU
Odasamersiom Ha ycriyau.
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MocnegHun noBuUMn

Moxe fa ja npernefare uctopujata Ha cUTe
noBsuLM:
Bupanun
* Bupann nosuum Mpymeru
MponywTexn
* [pyMeHn NoBULM — MOBULM HA KOULLTO U
CTe oarosopune Mabepn | [ Hasan

+ MNponyLwTeHn NoBMUM — NOBULIUTE LLTO Ce
NMPUMEHU, HO He Ce OAroBOPEeHMn Unun ce oabueHn og
MTHS800.

Cekoj CnMcoK CO NOBULN MOXeE Aa COAPXKMW HajMHOTY
50 6poja, Npu WTO NOCNEAHNOT MOBMK € MPB Ha CMNCOKOT.

Ako 6pojoT Ha NocnegHNOT NOBUK € 3a4yBaH BO CMMCOKOT
CO KOHTaKTW, MMEeTO NoBp3aHO co B6pojoT ce nojaByBa BO
CMUCOKOT CO MOCMEeHN NOBULM.

Ce nojaByBa MKOHa NoKpaj MMeTO UM 6pojoT KojallTo
yKaXKyBa Ha BUAOT Ha KOHTAKTOT Ha BpojoT LITO ce KopUcTU
BO NoBUKOT. Buaete Bo ,KoHTakTn” Ha cTpaHuua 138.

Crtapute noBuuUM ocTaHyBaaT BO CMMCOKOT CO NMOCMEAHM
NnoBULUM C& foaeka He v n3bpuLleTe Unn He CTUrHaT o
KpajoT Ha CMMCOKOT.

BpojoT wT0 € BmpaH noBeke oA egHall ke ce nojaBu camo
efHaLl BO CMMCOKOT.

Mo nobuBake Ha N3BECTYBaH-ETO 33
nponyLITeH NOBUK, Ha ekpaHoT Ha MTHB800
Ke ce nojaBu nopakaTta 3a NponyLUTEH NOBUK.

Kora noBMKOT ce npuma BO TEK Ha aKTUBEH
NnoBuK, OPOjoT ke Guae BHECEH BO CMIMCOKOT
CO nponywTeHn nosmuun. MNopakarta 3a
nponyLTeHNTEe NOBULN Ke ce nojasun
aBTOMAaTCKW Ha KpajoT Ha NoBUKOT. [NputncHete Ok 3a npukas
Ha CNUCOKOT CO NPOMYLUTEHU MNOBULMN.

Llokonky eawuom dasamesi Ha ycryau 20 UMa 0epaHUYeHO

anucmanom 00 crucokom co KOHmMakmu, Hema 0a Moxe
Oa ce bupa bpoj WMo He e 80 CrUCOKOM CO KOHMaKkmu.

1 NpOMyLUTEH NOBUK

Ok [ [I/IaﬁpMLum
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Mperneg Ha nocnegHn NOBUUM
1. Oa rnaBHOTO MeHun, n3bepete Moeeke... > MNocnegHu
noBuuM.
2. Jlnsrajte 0o cakaHMOT CNMCOK (BupaHn, NPUMEHU UMK
NPONyLUTEHN NOBULN) U NpUTUCHETE U36epu.
3a noseke nHdopmaL MM 3a NOCNegHMUOT NOBUK:
Opf cnmMcoKkoT co nocrnegHu noBuum n3bepeTe ro NOBUKOT 3a

KojLUTO cakaTe noeeke nHdopmauun. MNMputucHerte Mpernea
Unun ako 6pojoT He e BO CMMCOKOT CO KOHTAKTU NPUTUCHETE

[\ 1 n3bepete Mpernep. Ce npukaxyBaat nHbopMmaLmm
KaKo LUTO € MMETO NOBP3aHO CO MOBUKOT, BPOjOT Ha MOBWMKOT,
BPEMETO Ha MOBMKOT U BPeMeTPaeHEeTo Ha NOBUKOT.

MMHd)opmauuume 3a epemMemo Ha nogukom ce docmariHu
camo ako epememo U damymom ce rnocmaseeHu Ha
paduomo. Bpemempaeremo Ha Mogukom He docmariHo
80 CMUCOKOM CO MPOyWmMeHU Moguyu.

3auyByBaHl-€e Ha NocriegHUTE NOBULIU BO KOHTAKTU

1. Op cnNMCOKOT CO NocrneaHu NoBULUM nnarajte 4o 6pojoT WTo
cakaTte ga ro sadysarTe.

2. MNpuTtucHete 3auysaj.

MAKO onyujama 3a4vyeaj He e doderieHa Ha 1e80MO
npoepaMcKo Kornye, 6pojom e eeke 3ayyeaH 80 KOHMaKkmu.

3. 3a 3auyByBane 6poj kako HOB 3anuc, n3depete [HoB
KOHTaKT]. /nu 3a ga ro 3a4yBaTe 6pojoT BO MOCTOEYUKM
3anuc, n3depete ro 3anucoT co n3buparme Mperneg nortoa
Ypeam..

4. Kora noneTo co BUOOT Ha KOHTaKT € UCTaKkHaTo, Nnarajte
HaneBO MMM HaJecHOo 3a Aa ro BuauTe BUOOT Ha KOHTaKT
LWITO cakaTe Aa ro gogenvre Ha 6pojoT. 3a noeeke
MHdOpMaLMM OKOMy BUOOBUTE HA KOHTaKT, BUAETE
cTpaHuua 138.
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5. Ako cakaTe ga gopgazerte noeke nHcopmMaLlmm 3a 3anucor,
BuaeTe cTpaHuua 139.

6. NputncHeTe 3aBpLun.
Bpuwere Ha nocrnegHU NOBULUM
1. Op cnUCOKOT CO NocneaHn NOBULM N3rajTe 40 NOBUKOT
LUTO cakaTe Aa ro n3bpuLuete.

2. MpuTtucHete /*=w\. BHecyBarbe GupaHu nosuun. N3bepete
M36puwun. NputncHete fa 3a notepaa.

3a pa rv n3bpuieTe cute NOBULMK:

1. Of CNMCOKOT CO NOCNEAHN MOBULM, MPUTUCHETE [uen),

2. N36epeTe N36puwim rn cute. NputncHete fa 3a notepaa.

Bupame op nocnegHn noBMLU

1. Moxe pa BocnoctaBuTte TenegoHckn, PABX nnun npueateH
MOBUK Of 3anuc, BO 3aBUCHOCT Of 3anuncoT LWTO ro
n3bupare BO CMIUCOKOT.

mnponywmehr unu npumeH nosuk 6e3 nosukysayku bpoj Ke
bude 3a4ysaH 80 CMUCOKOM KaKo ,Herno3Ham"”. He moxe da
eocrocmasume rosuK KOH makoe 6poj.

2. o 3aBpwyBakeTo Ha nosukot, MTH800 ke nanese og
CMWCOKOT CO NPMMeEHU/NPONyLUTEHN/GUPaHN NOBULN.

m OO0 Mamu4HUOmM eKkpaH npumucHeme ® 3a 0a

rnpucmanume 00 crucokom co nocriedHo 6upaHu rnosuuyu.
KpateHku

KopucTeTe kpaTeHku 3a npuctan 4o YecTo KOPUCTEHUTe
CTaBKWN 01 MEHUTO.
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MomoLl 3a Kpenpawe KpaTeHKU T =]
[0 MeHujaTa
[Hoe 3anuc]
1. Oa rmaBHoTO MeHun, n3beperte MNMoBeke... > }) Dosete
) MocTaByBake
KpaTeHkn. 3) fletanu...
4) IpyneH noBuk
2. N3bepeTe [HoB 3anuc] 1 npountajTe ja Wabepn JEI Hazan

npBearta cTpaHuua of ynaTtcTBOTO.
MputucHeTte MoBeke 3a ga ja npounTarte BTOpaTa
CcTpaHuua.

3. MNputncHeTe 3aBpLun 3a Aa nsnesete of NPO3opeLoT 3a
NMOMOLLI.

Kpeunpame KpaTeHKa A0 MEHUTO
Ha npumep, kpeunpajte kpaTeHka 4o onumjaTta ,cute TOHOBU®.

1. Op rnaBHOTO MeHu n3bepete MeHu > lNocTaByBawe >
ToHoBM, NoToa nctakHete CUTe TOHOBM.

2. 3agpxeTe ro NPUTUCHATO KOMYeTo /¥ cé aofeka He ce
rnojaBu npukas 3a norepaa. MNputucHeTe Oa 3a noTBpAa.

3. MNpeaTa cnobogHa nosuumja ce goaenysa kako Konye 3a
kpateHka. Ce nojaByBa npwukas 3a notspaa. [putnucHete
3aBpLuum 3a noTepaa.

Mpernen Ha cNIMCOKOT CO KpaTeHKU [0 MeHMWjaTa

1. MputncHeTe [rem),
2. N36epeTe MoBekKe... > KpaTeHkN. Ha ekpaHoT ce nojaByBa
CMUCOKOT CO KpaTEHKMW.

Mﬂomnky dasameriom Ha ycryau au KoHguaypupa

KpameHKume, Hema 0a ce rojasu onyujama [Hoe 3anuc].

YpenyBame KpaTeHKU (T

1. Og rmaBHOTO MeHu, n3depete MNMoBeke... > T
KpaTeHku. 1) Vpean
2) N36puium
3) fetanu...
4) [pyneH noBwK

Ommao |E| Hasan
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2. JlnsrajTe 0o KpaTeHkaTa LITO cakaTe Aa ja ypeauTe.

3a npomeHa Ha nocmaska 3a MeHUMo Uu Kpeupare Hoea
MKpameHKa 00 080 YeKop, UCmaKkHeme ja onuyujama 3a

meHumo u usbepeme OAu do. Bo cnpomugHo, odeme

0o Yekop 3.

3. MNpuTtucHete /x=\ 1 n3depete Ypeam.

4. BHeceTe ro 6pojot (1-20) wTo cakaTe ga ro gogenvrte Ha
oBaa kpaTteHka. [putucHete Ok 3a notBpaa. Moxe ga ro
n3bpuLLeTe BHECEHNOT M NpuTNcHeTe OTKaXu 3a aa ro
NPeKNHETE ypeayBaHETO.

Bo cnyu4aj 6pojoT Aa e Beke foaeneH Kako KpaTeHka 3a
Apyra onuuja, o4 Bac ke buae nobapaHo Aa ro saameHuTe
TEKOBHMOT Bpoj 3a KpaTeHkaTa CO HOBO-KPEUPaHWOT.
Bpuwere KpaTeHKU
1. Opg rmaBHOTO MeHun, n3depete MoBeke... > KpaTeHKu.
2. JlnsrajTe 0o KpaTeHkara LWTOo cakaTe Aa ja usbpuwere.
3. MpuTucHete /*=v\ n n3depete U36puwmn. MputucHete Oa
3a Ja ja n3bpwuwete kpateHkata. MNputucHete He 3a ga
oTKaxerTe.
M36puieTe rm cute KpaTeHKn
1. Op rmaBHOTO MeHuU, n3depete MoBeke... > KpaTeHku.
2. Jlnsrajte 0o KpaTeHkuTe.

3. MNpuTtucHete /x=\ n n3depete U36puwwm ru cute.
MpuTucHeTe Oa 3a Aa M U3GpULLETE KpPaTEHKUTE.

MputncHete He 3a ga oTkaxeTe.
Mopakn 3a NPMKa30T Ha KPaTeHKN

Ha ekpaHOT MoXe fa ce nojaBu efHa Of CriegHuUTe nopaku
Ha HEKOIKY CeKyHAau:

* MonH cnucok co KpPaTeHKWU: CMMCOKOT CO KpaTEHKN
€ MOJIH.
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MputncHete Oa 3a ga noTBpAMTE Aeka cakaTte Aa
AojenvTe KpaTeHka 3a onuujaTta. BHeceTte HoB 6poj Ha
konye. Bo cnyyaj OpojoT Aa e Beke 4ofeneH Kako KpaTeHka
3a gpyra onuwja, of Bac ke buge nobapaHo ga ro saameHuTe
TEKOBHMOT Bpoj 3a KpaTeHkaTa CO HOBO-KPEUPAHWUOT.

* He e po3BoneHa KpaTeHKa 3a oBaa CTaBKa

* MorpewHa no3uumja Ha KpaTeHKa: BHeceTe HOB 6poj o
NpUKasoT 3a BHeCyBawe bpoeBu.

KOpMCTeI-be KpaTeéHKun 4o MeHUTo

OA MaTUYHWOT eKpaH, MPUTUCHETE /v4\ N HYMEPUYKOTO
Konye (Kon4Mhsa) Ha3Ha4YeHu 3a KpaTeHkaTa.

RUI

OB03MOXXyBa nororiemMa rieKCMOUITHOCT Ha KOPUCHUUMTE Aa
nsbepat koe GMNO paamo 1 co Hero Aa ce npujaeat v Aa
“MaaT uenoceH npuctan go ycnyrata. Cute ycnyru ce
npocneaeHn 40 paguoTo Ha KOeLTo CTe NpujaBeHHu.

MAKO Oasamesiom Ha ycrlyau ja OHe803MOXU 08aa 00sIuKa,
ce dolerysa uernocHa ycnyea bes npujasysarse.

m » [okornky cme npujagseHu Ha Opy2 mepMuHar,

u3sewmajom 3a rnopakama 3ayysaj u npenpamu Moxe
0a He saxu 3a 080j mepmuHarn. Ce npernopayysa
ucrnpakaH-e eKkcrauyumHa ropaka 3a nomepda Ha
npuemom.

» Ce npenopayysa bpuwere Ha nopakume o0 CaHda4e
3a ucnpameHu nopaku rped odjagysar-e 00
mepmuHanom.

CocTojoun Ha paguoTo

* LlenocHa ycnyra — npujaByBaH-€TO/aHraXxXnpamero
Ha KOPWCHMKKOT e ycnewHo. PagnoTo nma uenocHa
dYHKLNOHAMNHOCT.

° OrpaHVMeHa ycnyra — KOPUCHUKOT He e I'Ipl/ljaBeH.
yTBp,Cl,eHO oA CTpaHa Ha gaBaTterioT Ha yCnyru.

* npujaByBat€ Noa ncesaoHNM
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[ocTtanHa e uenocHa (OyHKLMOHANHOCT 3a paguoTo
(BO 3aBMCHOCT Of AaBaTernoT Ha YCryrn) Co UCKIy4oK

3

Ha HeKoW yCryri, Kako LUTO e NpocneayBakse NMoBULN.
Manata ukoHa (LITO e NpuKaXkaHa) yKaxkyBa kora paguoTo e

BO peXuM Ha npujaByBare No4 NCeBAOHUM.
MNMpujaByBame
Opn kpaHOT Bo MupyBak-e Tpeba aa

nputucHete /ww\ > MNoseke... > RUI >
Mpwjasu ce.

1. W3bupame naeHTudukaumja
Ha KOPUCHMUK.

* 32 ypedyBare Ha ngeHtTudukaumjata Ha
KOPWCHWKOT, oeTe Hadony 4o BTOPUOT
peg v npuTucHeTe Ypeawu.

* 33 BHECYBaHh€ HOBa MaeHTuduKaumja Ha
KOPWCHUK NpuTucHete U36epu
Hanuwerte ja Bawarta naeHtudukaumja Ha
KOPUCHMK N nputucHete OK

* 3a n3bop Ha Bawata ngeHTudmrKauymja
Ha KOPUCHMUK NCTakKHEeTe ja ToYHaTa
naeHTndmrKaLlmja Bo CnMCoKoT
n nputncHete U3Gepun

Ll [
RUI npujaByBatbe

VnexTuchnkaLmja Ha KOpUCHHK._

PIN Ha KopUCHMK:

Vabepete | | Hasag

Ll [
RUI npujaByBatbe

VneHTucKaLuja Ha KOPUCHMK,_

PIN Ha KopuCHMK:

Ypeau | | Hasap

Ll [
[Hoe Gpoj 5 nermichalifa Ha Koprct]
JoeaH

Nerap
Vapto

Visbepere | | Hesan

a0 [emsl
Lall [
Cricok co WaeHTHGMKaLIM Ha KOPHCHHK

[Hos Bpoj 3a ericepia Ha sopucrn]
Josat

Nerap
Mapio

VisBepere | | Heaan

meKe Oa npumucHeme [vew\ 80 cexoe epeme 3a npearned

Ha demariHUom crucok (KopucHo 3a doneume
udeHmucgbukayuu Ha KOPUCHUK WMO He ce UesI0CHO

npukaxatu). [loemopHo npumucHeme 3a 0a ce

epamume Ha nPemxo0HUOM CUCOK.

182



2. Hanuwerte ro BawmoT KopucHu4ku PIN

Kora kopucHuukmot PIN ke 6uge ncrakHat
nputucHete U36epun BHeceTe ro BalLIMOT
KopucHnyku PIN Bo cnegHWoT npukas

n notoa nputucHete OK.

3. T[lpujaByBamre
Op oBaa Todka 6apar-eTO 3a NpujaByBakE €
ucnpareHo. Moxe aa ro npekMHeTe npouecoT
Ha npuvjaByBare CO NpuUTUCKake OTKaXW.
Kora npouecoT Ha npujaByBare Ke 3aBpLuu,
€eKpaHoT npemMuHyBa BO MUPyBaH-€.

RUI npujaByBatbe

B
Ll
VneHTuchKaLuja Ha KOPUCHMK,

PIN Ha KopUCHMK:

V3bepete | | Hasan

Ll >

Logging ...

b
[OTvaxw]

m CuHama boja Ha ekpaHOmM 03Ha4yyea 0eKka KOPUCHUKOM € 80
pexumMm Ha uerocHa ycnyaa. Bo cume dpyau cnydau

eKpaHom e cus.

Cnucok co MAeHTMq)MKaLIVIVI Ha KOPUCHUK

KopuvcHMKOT MOXe Aa NnpoBepu KOj ro KopucTen pagmnoTo
NpeTxoagHo Npeky MeHu > noBeke > RUI > npujaBu ce

> npeHtTndukaumja Ha KOpucHuk. Noa [maeHTudmnkaumja
Ha HOB KOPUCHMUK] Ce nojaByBa XPOHOMOLLKM CMNCOK.

OpjaByBame

Moxe fa ja cmeHuTe cocTojbaTta Ha KojallTo CTe NpujaBeHn
CO npuTUCKare Ha /ww\ > [oBeke... > RUIl > OpjaBu ce of
eKpaHoT BO MUpyBahe nputucHete. Pagmoto Be n3BecTtyBa
a ja npucbatute coctojbata Ha ofjaByBat-e UnNu Aa ja

onbuete (QOKOMKy CcTe ja nsbpane no rpeLuka).

AHraxupame

Koe 6uno paguo (ookonky gaesartenoTt Ha
YCIyr ro 0BO3MOXMIT aHraXnpameTo) MoXxe
Oa buae godeneHo o cTpaHa Ha AasaTtenoT
Ha ycnyru Ha egHo nuue. Ke suante camo
npukas co BallaTa npujasa u o 0BOj MOMEHT
BW € JoJerneHa uenocHa ycnyra.

Ll >

AHraxupatse kako
<JoaH>
[onenex npeHoc

nepvop o4 6 yaca
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lNocmasyeaHr-e Ha aH2akMaH

MeHu > [NocTaByBake > [locTaByBakwe Ha
aHraxmaH

Wmarte oBe onuumu:

* AHraxxupaneTo e npndaTteHo — paguoTo

Ke v npudpatn cute bapara 3a
aHraxupame.

Lail 1]

MpucbateHo aHraxvparbe
Op6ueHo aHraxmpatse

W3bepete . Hasap

* AHraxupaweTo e OTPNEHO — paanoTo Ke rn otchpnu cute
Dapatba of faBaTenoT Ha yCrnyrm u KOPUCHUKOT Hema Aa

BMON HUTY €4HO U3BecTtyBaH-€.

MAKO odnukama 3a aHaaxxupar-e € OHeg80o3MOoxeHa 00
OGasamersiom Ha ycriyau, KOpUCHUKOM He Moxe 0a au MeHyea

rnocmaseKkume 3a aHsaxxupame.

MpucunHo ncknydyyBamwe

[aBatenoT Ha ycryrm Moxe Aa ro ofjaBu
KOPVCHMKOT. PagnoTo ro useecTyBa
KOPVCHUKOT 3a pe3ynTaToT M NpudMHaTa
3a cocTojbaTa Ha NPUCUITHO UCKITyYyBake.

Mpexu
BneryBawe BO NOAMEHUTO 3a MPEXMU

Opn rnaBHOTO MeHu u3bepete MoBeke...

> Mpexu.

OBa nogmeHu BM 0BO3MOXYBa Aia u3bepete
Ha KOja Mpexa Ke ce npujasu BalInoT
MTHB800 n Bo Koj pexum ke paboTu.

184

Ll [T

Ll >

MpucunHo
VICKNyyyBatbe
VcTekyBatbe Ha
BpeMeTo

o]

W3bpanv Mpexu

PeXuM Ha BMpeXyBatbe
[upexTex pexum
TXI-pexum

Vsbepn ] [ Hasan




M3bupame Ha BawaTa Mmpexa

OBa nogmeHu B/ OBO3MOXYBa Aa ja T
n3bepeTe mpexara Ha KojallTo ke buae
npujaseH Bawmot MTH800. T

H

I/I36epv|[ [ Hasap

U36upame npujaea camo Ha doMaulHa Mpexa

Op rnaBHOTO MeHU, n3bepete Moeeke... > Mpexu > N36op
Ha Mpexu > Camo MaTU4Ha.

N3bumpareTo Ha oBa NogMeHn 0BOo3MOXyBa Bawimot MTH800
[a ja npeno3Hae npearta Mpexa camMo Of CMMCOKOT CO
[03BOMEHN MPEXU 1 Aa Ce NpujaBu Ha Hea.

Kopucmeme pecucmpayuja co usbop Ha Mpexa
[lokornky e KOH(urypupaHo of BalumoT gasartes Ha ycnyru,
OBa NOAMEHU BM OBO3MOXYBa pavHO Aa u3bepere mpexa og
CMUCOKOT CO J03BOMEHN MPEXM, Ha KOjalLTO cakaTe da ce
npwvjasu Bawmnot MTHS800.
1. Opg rmaBHOTO MeHWU, n3depeTe MoBeke... > Mpexu
> U360p Ha Mmpexu > U36epu mpexa
2. Ce nojaByBa CMMCOKOT CO A03BONEHN Mpexu. Jlnarajte oo
cakaHaTa mMpexa.
Mpexata Moxe Aa uma nceBaoHUM. MNputncHeTe /xw\ 3a
nperneq Ha naeHTuduKaumjata Ha mpexara. Notoa
nputucHete N36epu.
3. BpateTe ce Ha MaTUYHUOT ekpaH. Ha ekpaHOT ce nojaBysa
naeHTudurkaymujata unm NCeBAOHMMOT Ha MpexarTa.

mBawuom Oasamen Ha ycriyau mpeba Oa ocuzypu Oeka
udeHmumemom Ha sawiuom MTH800 moxxe Oa ce

peaucmpupa Ha Opyaume MpPexu 60 8alLILIOM CIUCOK.
Hekou epynu moxe da He ce docmarHu Ha Opyau MpeXu.
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N3bupame pexum Ha BMpexyBaHte

OBa nogmeHun BM OBO3MOXYBa Aa ro T =
nsbepeTte PeXMMOT BO KOjLLTO Ke
dyHKUmnoHmnpa saumot MTHB800. a00an Mook

Pexum Ha BMpEXyBarbe

[vpexTeH pexvm

3a nocrtaByBak-€ Ha pa6OTHVIOT peXnm: TXI-pexim

1. Op rnaBHOTO MeHW, n3depete MNMoBeke...
> Mpexa > Pexxum Ha BMpexyBakse.

2. MTH800 ce npedpna BO pexunm Ha BMpexXyBatse.

Mﬂpetppnafbemo 00 QUPEKMEH PEXUM 80 PEXUM Ha
sMpexysare He e MOXHO ako MTHB800 e eo pexum

Ha cripeyygare MpeHocC.

MN36upare QUPEKTEH pexnm

OBa nogmMeHu B/ OBO3MOXYBa Ja ro F

nsbepeTte PeXMMOT BO KOjLLTO Ke

cyHKUMOHMPa BawwmoT MTH800. e
[vpexTex pexum

3a nocraByBak€e Ha pabOTHMOT PEXNM: TX-peron

1. Op rmaBHOTO MeHW, n3depete MNMoBekKe... Vibeon | [ Hesan

> Mpexu > [IupeKTeH pexum.
2. MTH800 ce npedpna Bo AUPEKTEH PEXNM.

mﬂpeqbpnaf-bemo 00 QUpPEeKMEH PEXUM 80 PEXUM Ha
sMpexysare He e MOXHO ako MTHB800 e 6o pexum Ha

crnpedyear-e rpeHoc.

MNocTtaByBawe Ha peXXMMOT 3a cnpevyBare npeHoc (TXI)

OBoj pexxum Tpeba Aa ce nocTaByBa Cekorall  [py—— @ |

npen Brierysake Bo 06ractu Kage LTo
KTUBN

npeHocoT e 3abpaHeT, Ha np., BO 6OMHULM Lieaxriompai

UnK BO NOTEHLMjarHo eKCno3uBHU obnactu.
3a aktuBupame Ha TXI-pexxumor:

1. Opg rmaBHOTO MeHU, n3bepete MoBekKe...
> Mpexu > TXI-pexum.

2. N3bepeTe akTMBUPA].

MaGepn | [ Hasan
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MTHB800 ke ornacu ToH 3a “cnpevyBare NpeHoc”.
Ha ekpaHoT ce nojasysa TXI-pexum Bo NpBUOT pea,
n noctojaHoTo LED-cBeTno co 60ja Ha knnmnbap ykaxysa

Ha TXI-pexum.

m Cume cmasku 00 MeHUmMo wmo rpedu3suKysaam rnpeHoc
ce 6rokupaHu npu TXI-pexum. Hema MoxHOCM 3a rnpomeHa

Ha epynama.
3a geaktuBmpane Ha TXI-pexxumoT, Ha Np. 00 HanyLITakeTo
Ha obracta Kaze LUTO npeHecyBakeTo e 3abpaHeTo:

1. Opg rmaBHOTO MeHWU, n3depeTe MoBeke... > Mpexu
> TXI-pexum.
2. N36epeTe [leakTMBUpa;.

MTHB800 ke ornacu ToH 3a “crnpevyBake NpeHoC” n Ke nsnese
of TXI-pexxumor.

Nokauwmja
3a nogertanHu nHdopmauuu, BUaeTe BO ,Ycnyra 3a
nouupare npeky GPS” Ha cTpaHuua 123.

MakeT co nogaTouu

OBa MeHM B1 0BO3MOXYBa Npuka3s Ha T m |
CTaTUCTNYKNTE BPEAHOCTUN NOBP3aHu CO
CripaTexu nogaroun
BpCKaTa 3a nakeT co nogatouu. Ycnyrata 3a Mo ogerouy
y . DEKBEHTEH oncer
noBeKkekpaTeH nakeT Co NojaToum ja Komupatee
OBO3MOXXYyBa BaLLMOT AaBaTen Ha ycnyri, | [ Vo

npw LUTO Ha eKpaHoT ce npeTcTaByBaaT
UHcpopmaumm 3a

* W3HOCOT Ha ucnpaTeHu nogaToum,

* W3HOCOT Ha NPMMEHN nogaTouu,

* (OpEKBEHTHMOT OMCer Ha nogaTtoyHaTa cecuja
* CTATyCOT 3a KoAupawe Ha nogatouuTe.
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mﬂodamowume ycnyeu ce docmanHu camo 80 TMO-pexum.

Onyujama 3a noGamouu mopa 0a bude nocmaseHa Ha
Lnac u noéamouyu* unu ,,Camo nodamouu®. (Budeme
80 ,llocmasyeaw-e Ha nodamo4Hama hyHKyuja” Ha
cmpaHuya 152).

Mpernen Ha cTaTUCTUKUTE 32 UCMIPATEHU NogaToLm

1.

N3bepeTe UcnpaTeHn nogaToum BO NogMEHUTO 3a NakeT
€O noaaToum.

Ce npukaxysa 6pojoT Ha knnobajtu
ucnpareHu nNo aKkTMBUPaHETO Ha
TEKOBHWOT NakeT co nogaToum.
[JononHuTenHo ce nojaBsysa

W KanauuTeToT:

Ll 2 (mm:
Vcnparenu nogatouv

Wcnpatenu: 100KB

Kanauurer:
9kbps

9 kbps (Ha np.) — akTUBHa cecuja co naket
CO nogaroum.

He e OO0CTanHo — cecmja CO MakeT Cco nogartoumn
BO MUpyBaH-€.

I'Ipernen, Ha CTaTUCTUKUTE 3a NPpUMeHu nogatouu
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1.

2.

NabepeTe MpumeHn nogaToLm BO NOAMEHUTO 3a NAKET CO
nogaTouu.

Ce npukaxysa 6pojoT Ha kunobajtu Ta |
NPUMEH NO aKTUBUPAHETO Ha TEKOBHUOT
Mpumenn: 100KB
nakeT co noaaToLy.
. Kanauuter:
[lononHnTenHo ce nojasysa OKbps
Y KanauuTeToT:

Hasap

9 kbps (Ha np.) — akTUBHa cecuja co nakeT
CO nogaroum.

He e JocTanHo — cecuja co NakeT Co NoAaToLm
BO MUpYBat€.



Mpernep Ha cTaTycoT Ha (hpPEKBEHTHUOT oncer

[MpoLeHTOT Ha PpEKBEHTHMOT ONncer npeTcraByBa 6poj Ha
pacnpeneneHn BpeMeHckn nepuoaum (,kaHanmn®) BoO TEKOT Ha

nogartovHaTa cecuja.

1. VI36epeTe q)peKBeHTeH oncer BO NOAMEHUTO 3a NakeTt

€O nogaTouMu.

2. Ce npukaxysa MpoLEHTOT Ha
dpEKBEHTHNOT oncer
75% (Ha np.) — aKkTMBHa cecuja Co nakeT
CO nopaToum,
He e JocTarHo — cecuja co nakeT

PpekBeHTEH
oncer
75%

Hasap

CO nogartoun BO MmnpyBaH-e€.

mBawuom 0asameji Ha ycryau 20 umMa nocmaseHo
MakcumanHuom bpoj Ha epeMeHCKU nepuodu wmo mpeba

Oa ce pacripedenam Ha 1, 2, 3 u 4. [lpoueHmMom Ha
hpekseHmMHUOM oricea ynamyea Ha MOXHUom 6poj

Ha nepuodu (1, 2, 3 unu 4) kako 100%.
lMpumep:

Ce nojasysa ,50%" ako ce pacripedeneHu 2 00 MOXHU

4 nepuodu.

Ce nojasysa ,,100%"“ ako ce pacripedenieHU 4 00 MOXHU

4 nepuodu.

Ce nojasysa ,100%", ako e pacripedesneH 1 00 MOXeH

1 nepuod.

Mpernen Ha cTaTycoT Ha Kogupake

1. Bo NnoAMeHNTO 3a NakeT co nogartouu
n3bepete Koaupame.

2. Ce nojaByBa cocTojbaTa Ha kogupane Ha
TEeKOBHaTa cecuja Co MakeT Co nogaToum:

* KogMpaH

KopvpaH naket
co nogatouyn

Hasag |

* HeKoAupaH (4YucT)
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Mopaku

OnuwTo

Opnukata 3a ucnpakare nopakv B OBO3MOXYBa:

* Vcnpakahe TekcTyanHu nopaku (cnobogeH TekcT unm
crnopen gedvHMpaHuTe v NPETXoAHO AedrHupaHuTe
obpacum Ha KOPUCHUKOT).

* ucnpakare nopaku 3a craTyc.

* NprMMaHe Nopaku.

CTatyc e 6pojoT LUTO cooABETCTBYBA Ha NPETXOOHO

nporpammpaHnTe nopaku Bo CAMCOKOT LUTO O Npeno3HaBsa

BallaTa rpyna. TekcTyarnHa nopaka e TEKCT LUTO CoapXu

HajmHory 1000 3Hauw. [NocTojaT ABe MecTa kae LUTO MOXe

a HajaeTe TeKCTyarnHu Nnopaku:

» CaHpade 3a NpUMeEHM Nopakn — ce 3a4yByBaaT cuTe
A0jO0BHU Mopaku.

+ CaHpade 3a HeucnpaTeHu Nopaku — ce 3a4yByBaar cuTe
HencnpaTeHn nopaku.

mﬂomnxy € KOHghuaypupaHo 00 cmpaHa Ha gawuom
Oasamern Ha ycryau, MOXHO e Oa ce ucrpamu ropaka Ha

rnpuseameH 6p0j wmo e 3a4yeaH 80 CITUCOKOmM CO KOHmMaKkmu.

Mcnpakare TekcTyanHa nopaka

* He e moxHo Oa ce ucripamu ropaka 3a cmamyc unu
m mekcmyariHa rnopaka 8o TXI-pexum.
* He e moxHo da ce ucnpamu nopaka 3a cmamyc unu
mekcmyarHa ropaka 80 mek Ha rnosuxk 60 DMO-pexxum

Moxe ga ucnpakarte HOBY nopaku, Aa ucnpakare nopaku
LUTO ce 3acHoBaaT Ha obpacuuTe AeuHMpaHn of cTpaHa Ha
KOPMCHUKOT Mnu ga ncnpakaTte nopaku LWTo ce 3aCHOBaaT Ha
npeTxogHo AeduHnpaHuTe obpacum.
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MpeTxogHo aeduHnpannTe obpacum ce nporpammpaHn Bo
Bawwmotr MTH800 of cTpaHa Ha BalMOT gaBaTten Ha ycnyri.
O6pacuute genHMpaHn o CTpaHa Ha KOPUCHMKOT MOXe Aa
Ovpart nopaku of caHOA4YeTo 3a NPUMEHW NOPaKN UMM HOBU
ropaku BO caHOa4yeTo 3a McnpaTeHn Nopaku LTo cTe ogbpane
[a rv 3ayyBaTe BO MeMopujaTa Ha Balumot MTHB800.
Mopakute aemHMpaHn og cTpaHa Ha KOPUCHUKOT UCTO Taka
MOXe Aa ouaat nporpamupanu Bo Bawmot MTHS800.

Moxe pa rv ypenysaTe BalMTe nopaku npeg ga rm
ucnpatute. Moxe oa ucnparture nopaka kora TepMuMHanoT
€ BO MUpyBah-e Unu BO TeK Ha rpyneH/uteH/npeHecyBaH
NOBMK (AOKOSIKY € KOH(UIyprpaHo).

[okonky e koHurypnpaHo, nopaka ke Bv curHanmsmpa
[00jOoBeH rpyneH/vTeH/npeHecyBaH NoBKMK 3a Balle
npuapy>xxyBarwe, OQHOCHO NPEKMHYyBake Ha NOBUKOT.

MBO DMO-pexxum mekcmyasiHume riopaku ce ucrpakaam Ha

ppekseHyujama Ha

mekosHama epyna 3a pa3zoeop. Ocueypeme Oeka Ke ja
usbepeme cakaHama 2pyna 3a paszoeop npeod da ja
ucnpamume riopakama. NoGemarnHo 3a u3bupar-e epyna,
sudeme 80 ,usbupar-e epyna” Ha cmpaHuya 49.

Ucnpakar-e mekcmyasiHa nopaka 60 mek Ha 2pyneH nosuk
(Ookonky e KOH¢huaypupaHo)
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MputncHete @ Ha ekpaHOT MOXe fja ce nojaBu egHa of
cnegHUTE Nopaku:

+ [ToBMKOT € 3anoyHaT npepg 3anoyHyBaHETO CO ypeayBae
Ha nopakaTa. TepMuUHanoT Ke ro HanyLTV NOBMKOT U Ke ja
ucnpatu nopakata. [JoKonKy NOBMKOT CE yLUTE € aKTUBEH,
TEPMUHANoT MOBTOPHO Ke My Ce MpUapPY>Xu.

* MOBMKOT € 3arnoyHar Mo 3ano4YHyBaH-ETO CO ypeayBame Ha
nopakarta. TepMnHanoT ke ro HanyLuTu NOBUKOT U Ke ja
ucnpartu nopakarta. TepMuHanoT ke ce BpaTh Ha NpUKasoT
3a ypeayBame.

* MOBUKOT € 3ano4HaT npea Unm no 3anoyHyBaHEeTO CO
ypeayBahe Ha nopakarta. TepMuHanoT ke ja ncnpatu
rnopakara u ke oCTaHe BO NMOBUKOT.



Ucnpakarwe mekcmyasiHa nopaka 60 mek Ha umeH/
npeHecyeaH nosuk (OOKOJIKy e KOHghu2ypupaHo)

MputncHete @ Ha ekpaHOT MoXe fa ce nojasu egHa o4

crnegHuNTe Nopaku:

* NOBUKOT € 3anoyvHaT npes 3ano4yHyBaHkEeTO CO ypeayBare
Ha nopakata. TepMMHanoT Ke ro HanyLTy NOBUKOT U Ke ja
ucnpatu nopakara. TepMuHanoT ke ce BpaTu Ha NpUKasoT
3a ypegyBakse.

* [1oBMKOT € 3ano4yHaT Nno 3arno4yHyBaH-ETO CO ypeayBah-e Ha
nopakara. TepMunHanoT Ke ja ucnpartu nopakara u ke
OCTaHe BO MOBUKOT.

npukKa3 Ha A0JNrn TeKCtyariHu nopakun

Bo npuka3ot 3a npernen Ha nopakara, nputucHeTe MNoBeke
3a aa ja npountate crnegHata ctpaHuua n Hasap 3a ga ce
BpaTtuTe Ha nperxogHaTta CTpaHuua.

Bnes BO nogMeHUTO 3a Nopaku
Op rmaBHOTO MeHu n3bepete Mopaku.

MoaAMEHNTO BU OBO3MOXYBA YnTake "
TeKCTyarnHu nopaku, ncrnpakakwe TEKCTyarnHu
ropaku 1 ucnpakare nopaku 3a craTyc. o oran
. CaHpave 3a
Jlnsrajte oo BawmoT M36op 1 NpUTUCHETE Canpave 3a
O6pacuu
M36epu 3a ga npuctanute 4o crneaHuoT Vet [EI] i

eKpaH.

m&awuom MTHB800 moxe da npuma nosuyu 0odeka cme 80
noOMeHUMo 3a ropaku.
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HoBa nopaka

Kpeupare nopaka

1. Oa rnaBHOTO MeHK n3bepete Mopaku
>HoBa nopaka. Ke ce otBopu npaseH
npukas.

2. NuwysajTe/ypeanyBsajTe ja BawaTa nopaka
CO KOpUCTEHE Ha TacTaTypara. (3a noeeke
aetanu 3a ynotpebarta Ha ypeayBadoT Ha

TekcT, BugeTe Bo ,[luwyBare TekcT” Ha cTpaHuua 211).

MpuTucHete /ww\. N3bepeTte 3auyBaj 3a ga
ja nonapeTe BallaTa nopaka KoH CNUCOKOT CO
obpacum (Ha3MBOT Ha 06GpaseLOT Moxe Aa
6uae aebuHMpaH of cTpaHa Ha KOPUCHMKOT).

Mcnpakawe Ha nopakara
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1. NputucHete Ucnpartu.

« Jlokorky e nocTaBeHo of cTpaHa Ha
BaLUMOT AaBaTtes Ha ycnyru, umare
MOXHOCT Aa ucnpaTtuTe nopaka Ha
npuBaTeH, TenedgoHckn 6poj Unu rpyna
3a pasroBop.

» Bo cnpotuBHo, n3bepete npmmay Ha

Abc i YpenyBare
0 |nopaka:

WcnpatyEl[ Orkaxu

Ll [T
3auysaj
PexvM Ha BHecyBatbe
MocTasysatbe Ha
BHECYBAETO
TocTasyBatbe Ha nopaki

W3bepu [E|  Hasap

Ll R

MpuBateH
TenedoH
Mpyna

Wabepn [[El]  Hasan

nowTaTta no Ball M360p O CMNCOKOT CO KOHTaKTu nnun

[MPEKTHO BHeceTe ja agpecara.

2. MNputucHete Ucnpatu unu PTT nnm @ 3a fajawucnparturte

nopakara.

Ha eKpaHoT Ke ce I'IOjaBVI €[€eH o4 cneagHuTe n3BellTan 3a

AocTtaBa:

» MNMopakaTa e poctaBeHa — 3a fja ce YKaxe aeka
nopakarta e ycnewHo ncnpareHa n npumeHa.



+ MNopakaTa e HeycneLHa — nopakara He e npMMeHa.

m Odnukama MS-ISDN my 0803M0xXy8a Ha KOpUCHUKOM,
ucmo maka, da ucrnpaka rnopaka Ha meseghoHom.

ucnpakame, 3avyByBake U npocrnenyBatke NOopaku

Mo nuwyBaHeTO Ha NopakaTta NPUTUCHETE .
N36epeTe MNocTaByBawe Ha nopakaTa U
n3bepete egHa og onumuTe. MNpBata e 3a
ucnpakare Ha TeKcTyanHa nopaka o
OHIajH-KOPUCHUIK.

BTopata onuuja e 3a ucnpakame Ha

Lol K
( I'Iocmsisarbe Ha )

Camo KopuCHULM
KDpVICHI/ILLVI wTo ce

Wsbepn| | Hasan

3a4yBaHa U npocregeHa nopaka. lMoeeke 3a ,3a4yByBame U

npocnenyBakwe” Ha cTpaHuua 206

Mo ncnpakareTo Ha nopakara, sawmot MTH800 ke ce BpaTu
Ha CMMCOKOT co obpacLm Unu Ha NPUKa3oT Ha ypeayBayoT Ha

nopakara.

m Ce npeniopayysa 0a npudekame 3a nomepda 3a rnopakama

nped da ucnpamume Hoga ropaka.

KOPUCTEeH-e Ha cCaHOa4YeTo 3a NPUMMEeHMU Nopaku

CnuncokoT Ha BaLleTo caHaade 3a NPUMEHN NMOPaKN CoOOpPXU
HOBW UInn ctapu ,El,Ojﬂ,OBHI/I TEeKCTyallHu nNopakn n Moxe aa

cogpxu go 100 nopaku.
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MKOHMU 3a caHAa4YeTo CO NPpUMeHU nopaku

CnegHnTe NKOHN YKaXyBaaT Ha CTaTyCOT Ha nopakuTte BO
caHOa4yeTo 3a NpMMeHN Nnopaku.

WkoHa 3a
caHga4vyeTo
co
NPUMeHN
nopaku

Onuc

B

HenpouutaHa (HoBa) nopaka
YkaxyBa geka cé yliTe He CTe ja npouuTane
nopakara.

MpouunTaHa (cTapa) nopaka
YkaxkyBa feka CcTe ja npountane nopakara.

MHdopmauumm 3a ucnpaka4yoTt Bo npernegoT Ha
nopakara
YkaxkyBa Ha MHcpopMauuute 3a ncnpakador (Mme
unu 6poj).

Bpeme u gaTym Bo npernenoT Ha nopakara
YkaxxyBa Ha BpeMeTo U AaTyMoT Ha
NPUCTUTHYBakE Ha nopakara.

=

MpumeH cTaTyc Ha gocTtaBa

yKa)KyBa Ha CTaTyCOT Ha OOCTaBa 3a 3a4yBaHUTe
1 npocneaeHnTe nopaku.

lModmeHuUmMo Ha caHOa4Yemo 3a MPUMEHU Mopaku yKaxyea Ha
m bpojom Ha nopaku 8o Hezo. Ha npumep, ako nokaxyea 2/4,

moa 3Ha4u 0eka 80 caHOa4emo 3a rpPUMeHU rnopaxku uma

2 Henpoyumaxu u 4 npo4yumaxu rnopaku.

Brie3 BO cCaHAa4YeTo 3a NPUMEHU Nopaku T
Op rnaBHOTO MeHw n3bepete Mopaku BT T
> . 2) ¢ Metap

CaHpaye 3a NpUMMeHu Nopaku 2
CraTycoT Ha CNM1COKOT ce NnojaByBa Ha
HEKOJIKY CeKyHawu: I'Ipoqma]EI[ Hasapn

* Hema HoBU unun CTapun Nnopakun — Ha
€KpaHOoT ce Bpa|'<a NpeTxXoaHNOT NpUKa3 BO POK O HEKOJIKY

CeKyHaOW.
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* UHdopmaumm 3a caHAa4eTo Co NPUMEHU Nopaku —
CaHpayeTo CO NpUMEHU Nopaku e nonHo. [putucHete
Ok 3a notBpaa.

Yutame nopaka on caHAAYeTo 3a NPUMEHU NOpPaKu
1. Jlnsrajte go nopakara.
2. MNpuTtucHete MpouuTa;j.

NMpumeHa HoBa nopaka

Hokonky nputucHete Hasap, ja otchpnate p——
HoBaTa nopaka. Moxe ga npucranuTe Ao Thosa opaka
nopakara nogoLHa of caHgaqeTo 3a

NPUMEHN Nopaku. Mpowra] [ Faoan

1. N3GepeTe MNMpounTaj 3a ga ja npountarte
LenaTa nopaka. YUntakweTo Ha HOBaTa TEKCTyarnHa nopaka
ro MeHyBa CTaTycOT Ha ucTata o4 HoBa BO cTapa.
lMpounTaHaTa nopaka ce YyyBa BO caHAa4yeTo 3a NpuMeHu
nopaku.
2. Ha ekpaHoT ce nojaByBa OpojoT, ncnpaka4yot v 0o 4 pena
Of TEKCTOT Ha AojaoBHaTa nopaka.
mke 20 crywHeme cuaHanHuom moH ,llpumeHa e Hoga
nowma“ Kkoea Ke npumume Hoea riopaka, 0odeka sawuom
MTHB800 e aHzaxupaH 80 Mosuk (DOKOIKy e KoHghugypupaHo
00 sawuom Gasamer Ha ycriyau).

* 3a cueHan 3a nopaka sudeme au rnocmaskume 80
m onyuuume Ha MeHumo 3a subpauuu (page 149) u so

MeHUmo Ha moHosu (page 154).

» AKo sawuom 0aeamersi Ha ycriyau ja 0803MOXUIT
olnukama 3a PTT-nospamHo nosukyeame, moaaw
co npumuckare Ha PTT ke 3ano4yHeme nosuk 0o
cocmasysa4yom Ha ropakama. Bo cnipomusHo, PTT Ke
bude npeHaco4yeH KOH MEKOBHO u3bpaHama epyna
3a pa32060p.
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npukKa3 Ha AoJNrn TeKCtyariHu nopakun

Bo npukasoT 3a npernen Ha nopakara, nputucHeTe MoBeke
3a aa ja npouuTare criegHaTa ctpaHvua u Hasap 3a ga ce
BpaTuTe oo CaHAaveTo co npumeHu nopaku. Moxe aa ja
npernegysaTe Ballata nopaka pef no pef co KopUcTere Ha

konunksara €% u @

ynpaByBak€ CO NopakuTe
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[opaeka ce Haorate BO caHOA4eTo Co = =

all
NPUMEHN MOPaKN NN N0 YNTaHETO Ha
3auyBaj

nopakara, NnpuTucHeTe /vw\ 1 nsbepete egHa || Vsopum

W36puwm rv cute

oA cnegHuTte onunn: Oarosopy

Mpocnean

* V3BepeTe 3auyBaj n nputucHete N36epwn  [sbepn [E] Hasan
3a da ja 3a4yyBaTe nopakaTta Kako obpaseu
BO CMUCOKOT co obpacum.

* N3bepete N3bpuwum 1 nputncHete fa 3a ga ja
n3bpuwerte nopakarta. Kora Ha ekpaHOT ce nojaByBa
,/130pu1LwaHa: nopaka n“, TekoBHaTa nopaka ce bpuve og
CaHpgaveTto co npumMeHun nopaku.M3bepete N3Gpuwm rm
cute 1 nputucHeTe [a 3a ga rv n3bpuwete cute nNopaku.
Kora Ha ekpaHOT ce nojasysa “U3bpuiuaHu: cute
nopaku’, cute nopaku ce n3bpuviaHn o caHga4yeTo co
NpvMMeHun nopaku. Ha ekpaHoT Ke ce nojaBu NogMEHUTO
Mopaku.

* N3bepeTte OgroBopu. Ha 0Boj Ha4YMH ce 0TBOpa NpuKasoT
3a ypegyBawe. [MaBHUOT Aen Ha cTapaTta nopaka Criyxm
KaKo cTaHaapAHa nopaka U CocTaByBayoT Ha nopakara
e ogpeauwiteto. Kora ke 3aBpLumTe co ypeaysare/
aopasarbe TekcT nputucHete Ucnpatm, PTT nnun ,
3a [aja ucnpaTtute nopakara.

* N36epun NMpocnean. Ha oBOj HauMH ce oTBOpa NpuKasoT
3a ypegyBawbe. [MaBHMOT Aen Ha ctapaTta nopaka Cryxm
Kako cTaHgapgHa nopaka. BHecete ro 6pojoT Ha
npumayoT un nputucHete Ucnpatu, PTT vnu @ 3a pfaja
ucnparture.




* N3bepeTte OcBexwu 3a NpeypenyBake Ha CMMCOKOT Ha
caHga4veTo 3a nNpuMeHn nopaku 1 npernegyeawke Ha HOBU

nopakwu (QOKONKy nva).

* rlpl/ITVICHeTe Hasap 3a ga ce BpaTtuTe Ha NpeTrxoaHnoT

npukas.

mPaOuomo 8e usgecmyea Koza ropakama e ripedoriaa.

HenocpeaHa nopaka

Kora ke ce npumu HOBa HenocpeaHa nopaka,
Ha paguoTo ce penpoayumpa ToH ,[pumeHa
HOBa MoLuTa“ U ce NpuKaxysa CogpXuHaTa,
npeknonyBajku ro NPeTXo4HMOT npukas. Cute
HernocpeaHW Nopaku ce 3a4yBaHu BO
caHOa4yeTo Co NPUMEHU Mopaku.

Eall &
Hosa nopaka:
On:
<TekeT>

BpemeHcku
nevar

Hasan

Ako PIN-kogoT Ha pagmoTo e 3akny4yeH, HenocpegHata
nopaka ce nojaByBa OTKako ke ce BHece To4yHMoT PIN.

Gupame 6poj Bo nopaka
Moxxe fa BpaTuTe rnacoBeH NoBUK Ha
ucnpakadoT Ha nopaka unu Ha Koj 6uno 6poj
LUTO € BMETHaT BO TEKCTOT Ha rnopakara.
Bawwvot gaBaten Ha ycryru moxe aa ja
KOHcUrypupa osaa oanuka.

1. BO CNUCOKOT Ha caHAa4veTo co NnpUMeHN
nopakun, NCTakHETE Mnopaka.

wuim

Ll [0

Mopaka 6p. 1
Jasun mu ce B0
15:00
6poj 6743 unn
6677

Oprosopf=l[  Hasag

npoynTajTe Nopaka LWTo coapxum 6poj (bpoesn).

2. MputncHete PTT nnn @

3. Ha ekpaHoT ce HaBegyBaaTt 6poeBuTe (BKIydyBajku ro n

©pojoT Ha ucnpaka4vor).
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4. 3a noBuKyBare€, Nn3rajte 4o BaWMOT N306Op 1 NpUTUCHETE

PTT unn @

3a pa ja 3avyBaTte, nusrajte 0o BawmoT n3bop n nsbepete
3auyBaj 1 nsbepete NOCTOEYKN KOHTAKT UMK Kpenpajte
HOB (3a JeTanu Kako Aa kpevpaTte KOHTaKT, BuaeTe BO
-Kpeupame KoHTakT” Ha cTpaHuua 139).

5. NputncHete BuA Ha M 3a ga ro n3deperte BMOOT HaA NOBUK
(npuBateH, TenedgoHcku unu PABX). lNMoToa nputucHeTe
PTT unn ®

Ako e noTpebHo, 3a4yBajTe ' 3anucuTe BO CMMCOKOT CO

KOHTaKTW.

mﬂomnxy € KOHghuaypupaHo 00 cmpaHa Ha gawuom

Oasamer Ha ycriyau, He e MoXHO Oa ce nosuka 6poj Wmo He
€ 80 CMUCOKOM CO KOHMaKmu.

CaHpaue 3a ucnpareHu nopaku
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Cute ncnparteHn rnopakuy ce 3av4yBaHu BO CaHOa4YeTo 3a
ncnpareHun nopaku. 3a ga ognTte [o caHOadeTo 3a

“cnpaTeHu nopaku, NpuTucHete /ww\ > lMopakn > CaHpade
3a ucnpaTeHn nopaku.
MoaMEeHUTO Ha caHA4AYeTo 3a UCMpaTeHn Nopaky BKNyYysa:

* M3GepeTte 3auyBaj 1 nputicHeTe U3bepU
. all
3a [a ja 3a4yyBaTe nopakaTta Kako obpasel| |(ssmens e
BO CMMCOKOT CO obpacuy. Vtin
N36
* WN3bepete N36puwm 1 nputucHete [a 3a Moemparn
Aa ja n3bpuwwete nopakata. Kora Ha Mpocneau
Ws6epu [El] Hasan

eKpaHoT ce nojasysa ,M3bpuiaHa:
nopaka n“, TekoBHaTta nopaka ce bpuwle
on, Canpgaueto co npumeHu nopaku.N3bepete U3bpuLumn
ru cute v nputucHete fa 3a ga rm nsbpuwete cute
nopaku. Kora Ha ekpaHoOT ce nojasysa “UsbpuluaHun: cute
nopaku”, cuTe Nopakn ce nsbpuLlaHn of caHaa4veTo 3a
ucnpaTeHu nopaku. Ha ekpaHoT ke ce nojaByM NOAMEHUTO
Mopaku.



* N3bepeTte MpenpaTtu 3a ga ja ypeouTe nopakata v ga ja
ucnpaTtute 4O UCTUTE YYECHUUM.

* N3bepete Mpocneaun. Ha oBoj Ha4UMH ce oTBOpa NpUKa3oT
3a ypegyBare. [MaBHUOT gen Ha cTapaTta nopaka Cryxu
Kako cTaHgapgHa nopaka. BHecete ro 6pojoT Ha
npumadyot n nputucHete Ucnpatm, PTT nnu @ 3a paja

necnparuTe.

* N3bepeTte OcBexu 3a nNpeypenyBake Ha CMMCOKOT Ha
caHOa4yeTo 3a ucnparteHy Nnopaku 1 npernegyBakbe Ha
HOBM nopaku (JOKOMKy nva).

+ CtaTyc Ha ncnopaka (Kkako LTo

€ npuKaxkaHo)

Mo NnoKaXxyBa AaTyMoT U BpEMETO Ha
MCHpakane, AocTtaByBak-€, HnTamw:e,
NCTEeKyBaH-€ Nnopagn HeycnewHa gocrtaea,
NCTEKYBaH-€ Nnopaan Hedntawe, Heycnex Ha
nopakarta. cekorail Kora Ke ce NPpOMEHN
CTaTycCoT, ke pobuete HoBa nopaka 3a Toa.

Cute nopakun ce onniaHum co Tp NKOHWU:

Ll [CH]
Mopaka 6p. 2

Topakara e cnparea
4 maj-18 10:17
Mopakara e focTaseHa
14-maj-18 10:18
Mopakara e npouuTaHa

Vsbepn [El]  Hasan

UkoHa 3a
caHga4veTo
3a
ucnpaTteHu
nopaku

onuc

g

UcnpakaweTo e BO TeK

N 4 UcnpakaweTo e 3aBpLU€HO
<

‘ HocTaBara e HeycnellHa
285

M3BeluTajoT 3a gocTaBa ce 3a4yByBa BO caHAaveTo 3a
NPVYMEHN NopakK 1 BO NOBp3aHaTa Nopaka BO CaHOa4yeTo 3a
ucnparteHu nopaku. Merytoa, ce 6puiue og caHoaveTo 3a
NPYMEHN NopakuK No Nperneaor.
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O6pacuu gechmHupaHm on cTpaHa Ha KOPUCHUKOT

O6pacuuTe 3a nowwta gednHNpaHn og T |
CTpaHa Ha KOPUCHUKOT Ce NPUMEHM, HOBY,
a3el
“cnpaTeHn UNu NPOrpaMmUpPaHi NOPak LLUTO 2) Obpasel 2
ce 3a4yBaHu BO CMIMCOKOT CO 0BpacLy 1 %) Obpasen 3

MOXe i@ Ce KopuCTaT 3a Ucrnpakake nopaku.

Wabepn [IE]  Hasan

1. Opg rmaBHOTO MeHU n3bepeTe Mopaku
> O6pacuum. Ce nojaByBa NpBUOT 0Opa3seL, BO CMIMCOKOT CO
obpacumw.

m Obpacyume moxe da umaam Hasugu 0echuHUpaHuU 0d
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KOpUCHUKoOm.

2. Bo cnncokoT co obpacum, nusrajte o o6paseLoT WTo
cakaTe ga ro kopucrture.

MpuTtncHeTe /v U U3bepeTe eaHa o CNeAHNTE ONLMK:

* Mpernea 3a nperneq Ha nopakaTa Bo obpaseLoT

* Ypeau TeKCT 3a [a ja ypeauTe nopakarta Bo obpaseLoT
crnopef Bawute notpedu. (3a noseke aetanu 3a
ynoTtpebarta Ha ypedyBa4voT Ha TEKCT, BUAeTe BO
L IMLlyBare TeKCT” Ha cTpaHuua 211).

MpuTuCHeTe /ww\ 3a Aa BRe3eTe BO MEHWUTO Ha
ypenyBadoT. N3bepete 3auyBaj 3a ga ro 3avysare
ypeneHnoT obpasel, kako HoB. Ce gofenyBa cTaHoapaeH
Ha3ue (Obpasey 1, Obpasel 2, ...). N3bepeTe 3avyBaj
NPOMeHMU 3a [a ro 3avyBare ypefeHnoT obpased.

* Ypeau Ha3uB 3a ypeayBare Ha Ha3MBOT Ha o6paseuoT
LWITO e 3a4yBaH. Mo ypeayeaweTo nsbepere Ok 3a ga ro
3a4vyBaTe Ha3uBoT. U36puwum n nputucHete fa 3a ga ro
n3bpuiete obpaseuoT. Kora Ha ekpaHOT ce nojaByBa
“U3bpuaH: obpasey N”, Toa 3Ha4YMN geka TEKOBHUOT
obpasey e n3bpuwaH og caHAayeTo 3a NPMMEHN Nopaku.
Ha ekpaHoOT ce nojaByBa CnMcok co obpacuum.

3. Ucnpakane obpasel. Buagete BO ,Mcnpakawe Ha
nopakata” Ha cTpaHuua 194.



MNMpeTxogHo aecdmHUpaHu obpacum
MpeTxoaHo oeduHMpaHMTe obpacum 3a
nowTa ce obpacum WTO Ce NporpaMmmpaHu BO
Bawmot MTHB800 og ctpaHa Ha BawwmMoT
naearten Ha ycnyrn. Moxe ga BpwuiTe
OrpaHU4eHn onepaumm Ha ypeayBake Ha

Ll [
1) Moja IP (reprer npotoxon) apeca.
2) CocTaHoK BO...

3) Perucrap ABC 27

W3bepu [ Ij[ Hasan

npeTxogHo aedunHMpaHMoT obpasel, u aa ro ncnpakare, HO
He e MOXHO Aa ro 3avyBaTe ypeaeHvoT obpasey nnum aa ro
n3bpuLLIETE 0 CNMCOKOT CO NPETXOAHO AeUHMPAHK

obpacum.

1. Opg rmaBHOTO MeHn n3depete Mopakun > MpeTxogHo
pednHupaHu. Ce nojasysa NpBMOT obpaseL, BO CIMCOKOT
CO NpeTxoaHOo AedrHupaHn obpacum (BOKONKy Hema
npeTxoaHo aeduHnpaH obpasel, Ke ce nojaBu nopakara

Hema npeTxogHo aeduHMpaHm).

2. JlnsrajTe HU3 CNMCOKOT U U3GepeTe ro GapaHMoOT obpasel.
WcTo Taka, moxe Aa ro 6apate o6paseLoT criopeq
HeroBuoT Ha3ue. KopucTeTe ja TacTaTypaTa 3a ga BHeceTe

Jo 12 3Hauu.

MpuTUCHeTe /| 3a fa BNe3eTe BO MEHUTO 3a NPETXOAHO
neduHnpanun obpacum n ga n3bepete eagHa of cnegHuTe

onuuu:

 Mpernepn 3a npernea Ha nopakaTa Bo o6pa3seLoT

* Ypeaum (Bo NnpumepoT, Ce nojaBysa
nopakara 3a perucrpavuja)

Ypedyeamwe npemxodHo de¢huHupaH obpasey

—

Perucrap
ABC 27

Mcnpa‘rm[ [ W3bpuium

I'IpOBepeTe Kaj BalUMOT OaBartern Ha ycnyrm Kom ce snaosute
Ha NpeTxoaHo ypeaeH o6pa3eu, BO BaALUMOT TeEpMUHarl.
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MocTojaTt Tpy BUAa Ha NpeTxoaHo AedumHupaHu obpacum:

* AndaHymepuyku — BHecyBake 3HaLuM 1 uudpu

* Hymepuuku — BHecyBawe Lmdpu

* MewaH - BHecyBahe undpu, * n #

N3bepeTe Ypeau og MeHUTO 3a NpeTxoaHo AedUHUpPaHN.
KypcopoT ce Haora Ha nocrnegHuoT 3Hak. 3a fa ro
NpUABUMXNUTE KYpCOPOT Hasafd, npuTucHeTe @ Moxe pa
BHeCyBaTe caMO OHOSKY 3HauW KOrKy LUTO nMano
opurMHanHo Bo obpaseLorT.

O6paseLoT MOXe Aa ro ucnpatute no HEroBoTO ypeayBahe .

Ucnpakawe npemxodHo de¢huHupaH obpasey

mAdpecama Ha npemxo0Ho OechuHupaHama ropaka ja
degpuHupa sawiuom dagameri Ha ycryau 80 MeKom Ha
npoepamupar-emo U He Moxe 0a ce U3MEHU.

1. NputucHete Ucnpatm, PTT unun @ Mnn cooaBETHOTO
HYMEpUWYKO KOn4e Co eieH Jonup 3a Aa ja ucnpature
nopakarTa.

2. Ha ekpaHoOT ke ce nojaBu efeH o cregHuTe nsseLlTam 3a
JocTaBa:

» MNopakaTa e gocTaBeHa — 3a [ja ce yKaxe Aeka
nopakara e ycrnewHo ucnpaTteHa v npumeHa.
» MNMopakaTa e HeycneluHa — nopakaTa He e npumeHa.

3. Mo ncnpakaweTo Ha nopakaTta, Bawmotr MTH800 ke ce
BpaTX Ha CMUCOKOT CO NPEeTXodHo AecmHmpaHn obpacum
UIn Ha NPUKa3oT Ha ypeayBayoT Ha nopakara.

M Ce nipeniopayvyea 0a npudekame 3a nomepoa 3a nopakama
nped da ucnpamume Hosa ropaka.

Mcnpakal-be Ha nopaka 3a cTaTtyc A0 rpyna

1. lNpedpneTte ce Ha cakaHaTa rpyna 3a pasroBop, Ha
KojawTo cakaTe ga ucnpatute nopaka 3a craTyc.

2. Op rnaBHOTO MeHu n3bepete Mopakn > UcnpaTtu craTyc.
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3. Bo 0BOj npumep, Pyyek e nocneaHnoT
ucnparteH ctatyc. [lokornky cakaTe Aa
ucnpaTtuTe pasnuyeH cratyc, nuarajte go
BaLUMOT n360p BO CMMUCOKOT CO NPETXOAHO
nporpaMmmpaHu ctaTycu unm BHecete 5-
umdppeH 6poj Ha cTaTyc N NPECKOKHETE ro
CNegHNOT YeKop.

% =

1) Pyuek
2) Beuepa
3) CocraHok

Wsbepu [El] Hasan

4. NpuTncHete /v n n3bepete Mpernepn 3a nperneq Ha
nopakara 3a ctaryc. [lpuTucHeTe Ha3az 3a ga ce BpaTuTe

Ha CNMUCOKOT CO CTaTyCu.

5. MputncHete U36epun, PTT nnu @ n nusbepete Npyna kako

Len Ha BallaTta nopaka 3a ctaTycC.

6. VcTakHeTe ja GapaHaTa rpyna 3a pasroBop M NPUTUCHETE
U36epu, PTT unu @ 3a [a ja u3bepeTe nopakara 3a

cTaTyc.

M/\KO cakame Oa ucrpamume pa3s/fiu4dHa rnopaka 3a cmamyc,
moxe Oa s8Heceme 5-yucgppeH 6poj Ha cmamyc u 0a

npumucHeme Vcnpamu Ha. lTomoa cnedu Yekop 6poj 5.

LeneH cTatyc

AKO BalLMOT JaBaTen Ha yCrnyru ja uma OBO3MOXEHO
oanukata LieneH ctatyc, Ha NpyKasoT 3a ucnpakamwe ctaTtyc
Ke ce nojasu onumjaTa 3a BHecyBahe npuateH 6poj, 3a
BHECyBare Ha BpojoT Ha MpUMaYoT Unn NpUTUCHeTe abce 3a
npebapyBare Ha CMUCOKOT CO KOHTakTW. 3a rpyna, usbepete
ja rpynata Bo pamku Ha nankarta. [loToa ncnparete ja
nopakarta 3a cTaTyc co nputuckamwe Ha U3bepu, PTT unu

Q)

Ha eKpaHoT Ke ce I'IOjaBl/I €4eH o4 cneagHuTe naBellTan 3a

AocTtaBa:

* UcnpaTeH cTaTyc — NpuKkasoT usreryea of NpukasorT 3a

cTaTtyc..
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+ CTaTycoT e HeycneLlleH — Ha eKpaHoT ce Bpaka
NPETXOOHMOT MpUKas BO POK O HEKOSKY CEeKyHOM.
lMoyekajme u3sewmaj 3a docmasama rnped ucrpakaHe Hog
3AENELLKA [NV
Hokoriky eneseme 8o meHumo 3a cmamyc 00 3aghameHa
epyna 3a pa3208op, 38yKom eedHauw ce rpekuHysa 3a 0a ce
0B803MOXU MPEHOC Ha 8awama riopaka 3a crmamyc.

m,ﬂomnky ce MpuMU rnosukK 3a umHu cryvau, MTH800
g8edHal ce MPUKIIydysa KOH MOBUKOM 3a UMHU Criy4au.

mﬂOKOﬂKy € rnocmaeeHo 00 cmpaHa Ha eawuom Oasamen Ha
ycnyeu, He e MOXXHO Oa ce ucnpamu ropaka 3a cmamyc Ha
rnpueameH 6poj wimo He e 80 CriucoKom co KOHmakmu.

Honru TekcTyanHu nopakm

NudpacTtpyktypata TETRA nogapyea nopaku co HajMHory
1000 3Hauwn. bpojoT Ha 3Haum MoXe Aa ro BuguTe Ha nesata
cTpaHa. MpumeHnTe JOMNMM TEKCTYarnHu nopakum Moxe aa ce
ypefyBaaT U MOXe [a M npocneaysaTte 1 fa ogropapare Ha
HuB. CaHgayeTo 3a NPMMEHN U caHgayeTo 3a ucrnpaTteHu
nopaku kopucTar 3aegHu4ka memopuja. Co npumareTo
[Oonrn TeKCTyanH nopaku BallnoT NPOCTOpP 3a CHUMaH-€
MOXe [a Ce HanosnHu MHory 6p30, 3aToa pegoBHO OpuieTe
M cTapute nopaku.

mﬂaaamenom Ha ycnyau Mmoxxe 0a au oHego3MoXu dosleume
meKcmyarsiHU ropaku.

3ayyByBak€ U NpocrenyBake

Ogaa ognuka nm oBo3MOXyBa Ha AOMaKMHOT U MOBUITHUTE
CTaHuum merycebHo ga komyHuumpaat 6e3 ga buagar
AocrtanHu Bo UcTo Bpeme. NopakaTa ce 4YyBa cé goaeka
npumMmayoT He ce nNpunon KOH CUCTEMOT UM HE NOMUHE
BPEMEeTO Ha UCTeKyBaH-e.
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NMNoBuKyBamwe

OBaa ognunka My OBO3MOXXYBa Ha KOPMCHUKOT Aa npuma
curHanu 3a noeukyBare. Kora pagmoto npyma nopaku 3a
NMOBUKYBak-€, MM NPEKMHYBA TEKOBHUTE YCNyrn U ce obuaysa
[a OQroBopu Ha CUrHamnoT 3a NoBUKyBare 6e3
JononHUTENHo oanoxysarwe. OTKako ke ce 3aBpLUmn CO
CUTHanoT 3a NOBWKYBake, pagnoTo M3Nerysa of pPeXnmor 3a
NOBUKYBaH-€ 1 ce Bpaka BO HOPManHMOT pexnm. KopucHukoT
MoXe Aa fobuBa camo NOBULM 3@ UTHU Crlydam Npy pexnm
3a NnoBuKyBate. [MocTojaT YeTUpK BUAA Ha cuUrHan 3a
NMOBUKYBaH-E:

¢ HOpMaJiHO NoBUKYyBaHk-€
* [naBeH nnaH-3apagu 3ronemMyBam€e Ha

Tl |
CUrypHOCTa, ce ucnpaka Ha rpyna HeKornky
natu. KopucHuKoT Moxe aa npudatiu Mpyna sa
NOBWKyBake CO NpUTUCKake Ha koe buno || costael.
Korn4ye 1 ce npeHaco4yBa KOH Hecpeka
=]

WHopmaTmBHaTa dasa (nporpamckuTe
KoM4yuhsa He ce 03Ha4YeHwn).

* Pexxum Ha nosrnekyBame — BKIy4YyBa CaMo rnacosHa
KoMyHuKauuja. Moxe ga ce nsbpuiie padyHo

mﬂoenekyeaf-bemo € MOXHO caMo Koea paduomo e 80 ¢hasa
Ha eMpeXXysaH-e Ha JloKallHa cmpaHuua.

» TecTupare Ha NOBUKYBaH-ETO —QMUCMEYEPOT MMa MOXHOCT
Aa ja TecTupa oBaa oanuka. PagnmoTo kpeupa TOH co
nojaea Ha ,TeCTUpahe Ha MOBUKYBaH-ETO" HA EKPaHOT.
OBO3MOXEHO € camO eHO MPOrpamMcKo Kornye
~<Tectnpamweto e OK" 3a notBpaa n Opuere Ha TECTOT.

MHTepakumm Kora KOPUCHUKOT € BO APYr PEXUM:

* TXI-pexum —KopucHUUMTE MOXeE Aa ja npovuTaaT
nopakara, HoO He MOXe fa ogrosopaT Ha Hea. Tue nmaar
MOXHOCT Aa mnsnesat og TXI-pexXrmoT co npuTucKame Ha
NpOrpamMcKoTo Kornye unu co oTdprawe Ha nopakara 3a
NMOBMKYBaH-E.
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* DMO-pexnm —noBrKyBaH-eTO He € NogapXaHo.

 Pexxum 3a UTHU cry4Yan — cuTe CUrHasnu 3a NoBuKyBahe ce
UrHopupaar.

®a3u Ha ycriyzama 3a No8UKys8at-e

+ ®asa Ha ucnpakare curHan — KOPMCHUKOT NprMMa nopaka
3a NoBUKyBahe. TOHOT 3a anapm yKkaxyBa Ha npvkas Ha
TEKCTOT Ha nopakarta Ha ekpaHoT. oa Hero nva Tpu
onuuu 3a n3dop Ha KopucHukoT: Mpudatn, otdpnn
nnn /s . AKO KOPUCHUKOT ro npudhaTti CUrHanor, oA, Toj
MOMEHT HUTY efHa apyra ycrnyra He MOXe [a ro NpekuHe.
Konueto 3a MeHn oBO3MOXYBa noronem n3bop (Npukas Ha
AecHarta cTpaHa).

Ll Q.
MoswkyBare 1

Ll <) (e

MoBukyBare 1

Mpudpatin

CepwosHocT-1
Tpyna 3a Tectuparse
CoobpakajHa Hecpeka

FoToBHOCT
OTchprmn
Mopakwn

Wanean

(pucdat{ 1] Otcpprn

mKopUCHUKom Moxe 0a 20 NpeKuHe MOHOM Ha cueHasIom co
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npumuckare Ha kornyemo 3a PTT unu koe 6uno o0
rpozpamMcKume Konyura.

* VMIHopmaTtuBHa hasa — KOPUCHMKOT € CE YLUTE BO PEXUM
3a NoBMKYyBaH€e 1 MOXe [ia NpuMa nogetarHu
WHopMaLnMn 3a MHLUMAEHTOT LUTO Ce CITy4YuIt Npeky
nocrieqoBaTenHyn TEKCTyanHu Uy rnacoBHU Nopaku.
KopucHukoT Moxxe ga nobapa noseke MHopmauum co
KOpUCTEH-€ rMacoBeH rpyrneH NoBuK UNW TEKCTyanHa
dyHKUMja 3a NOBUKYBaH-€ LUTO My OBO3MOXYBa Ha
KOPWCHWKOT Aia ucnpartu TekcTyanHa nopaka o gasatenoT
Ha ycnyraTta. KopncHMKOT MOXe cekorall fja ogrosapa
W Aa npaka TekcTyarnHa unv rnacosHa nopaka co nomoLu
Ha rnacoBHWOT rpyneH MnoBuK.



CaHOa4e 3a noeukyeame
CaHgayeTo 3a NoBUKYyBakbe My JaBa MOXHOCT Ha
KOPVICHUKOT 3a Nperneq 1 3adyByBake Ha nopakute 3a
NOBUKYBak-€ 3apau UOHO ynaTyBake Ha HUB. 3a ga rm
npernepate nputucHerte /x=w\ > Mopaku > CaHpaue 3a

NnoBUKyBaH-€. Kora paanoTo € BO peXXnm Ha NoBUKyBaH-€,
MOXe [a 'M YnTaTe cCaMoO TEeKOBHUTE NopaKku 3a NoBUKyBaH-€.

CaHpaue 3a WAP

Opete Ha ,CaHgade 3a WAP” Ha cTpaHumua 119 3a noBeke
MHdopMaLnu.
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NMuwyBawe TekcT

MN3bupame pexum 3a BHeCcyBaHe TeKCT

PexxnumunTe 3a BHeCyBatbe TEKCT o OflecHyBaaT BHECYBaHETO
MMUHba, GPOEBU 1 MOpaKWU.

Bo npukasoT 3a BHECYBaHe TEKCT, M3GepeTe [=w\ > Pexum
Ha BHecyBak€e 1 NoToa n3bepete eaeH of crnegHuTe
pexunmn:

* OcHOBeH — 3a BHecyBa€e andaHyMepuyky 3Haum

* Hymepuukn — 3a BHecyBahe camo GpoeBu

+ Cumbon - 3a BHecyBake caMo cumbonu

+ CeKyHpapeH — 3a BHecyBawe andaHyMepunyky 3Hauu.
(OBoj pexxuMm e n3dopeH 1 Mopa Aa ro gogagerte Bo
CMUCOKOT).

Bo npukasor 3a BHeCyBah-€ TEKCT UCTO TaKa MOXxe fa ro

npuTUCKaTe Kon4eTo 3a [ja r’m MeHyBaTe pexnMmunTe BO
OCHOBEH, HYMEPUYKH, cumbonu unm CeKyHOapeH (,CI,OKOJ'IKy ro
nMmarte I'IOCTaBeHO).

JopnaBakwe Ha CeKyHOAPHUOT PeXXMM KOH CNMUCOKOT
CO peXXnmum 3a BHeCyBake TEKCT

CekyHOapHWOT pexurm e NorodeH Bo criyvavTe kora
KOPUCTUTE EAEH ja3nK U NOHeKoraLl cakaTe Aa ce
npedpnute Ha Opyr.

OBOj pexum ce nojaByBa Ha CNCOKOT Camo JOKOSKY o
nocTaBuTe NPBO NpPeKy

[*w\ > MNocTaByBate Ha BHECYBaHETO.

HuTy egeH e cTaHaapaHo dhabpuyko nporpamuparse
1 yKaxxyBa [leka He e U36paH CeKyHOapeH pexum.
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MN3bupare Ha MeToa 1 ja3uK 3a BHeCyBaH-€ TEKCT

MocTojaTt AoBa MeToAa 3a BHECYBah-€ TEKCT:

» TAP - OBo3moxyBa BHecyBahe OykBu, 6poeBu 1
cnmbonu Npeky NpuTUcKawe Ha andaHyMepu4dko Konye
efHall unn no.seke naTu.

* iTAP - OBo3moxyBa TepMnHanoT Aa ro npeasuaysa
cekoj 360op Kako LITO ro nputuckarte andaHymepuykoTo
Konye.

Moxe fa rv KopucTuTe OBMEe METOAM 3a jasuunuTe LWTO ce

nporpaMmmpaHu Bo TEPMUHArOT.

Bo npuka3oT 3a BHECYBaHe TEKCT, n3bepeTe /vew)

> NocTaByBake Ha BHECYBaHEeTO ¥ MOTOa N3MEHETE Ha
efeH o MeToguTe 1 NoBp3aHUTe jasuum (Ha npumep: TAP
aHITINCKM jasuK).

UKOHU
Bo MNPUKa3oT 3a BHeECyBaH-€ TEKCT, MKOHUTE B NOKaXXyBaaT
KOj pexum n meto 3a BHeCyBaH-€ TEKCT o KOPUCTuTe.
MkoHaTta 3a Gpoerse 3Hauu ro nokaxkyea 6pojoT Ha BHECEHM

3HaUu.
OcCHOBHM CeKyHAapHu onmc

UKOHU UKOHU

abc 1 abc 2 TAP- 6e3 ronemu Gyksun

fbc 14 Abc Zt TAP — ja sronemyBa camo
cnepgHata GykBa

ABC 1+ ABL 21 TAP — cute Byksu ronemu

abc [EQ abc EJ iTAP — 6e3 ronemu 6yksu

fibc Abc B iTAP — ja 3ronemyBa camo
cnepgHata GykBa

ABC [EE ABC E% iTAP — cute GykBu ronemu
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Hymepunuka onmc
UKOHa
123 BHeceTe 6poesu.
MKOHa 3a
onuc
cumbonu
@ OB0O3MOXyBa BHECYBaH-E MHTEPMYHKLUCKN
3Hauu 1 cumbonu.
TAP EkpaH

[MpuTUCHETE 1o KONYETO U Ha
€eKpaHOoT Ke ce nojaBu cnegHara
nHcpopmaumja:

* VkoHaTa ykaxyBa Ha
TEKOBHMOT METOA 3a
nuwyBake TEKCT — BUAETE BO
NKOHW.

WkoHa 3a Tap
Bpojau

fibe 14 |Ypenysate
1 |nopaka:

maseH
npocTop 3a
BHeCyBahe
TEeKCT

-

Vicnparu [EE][ VsGpuum

* [naBHUOT NPOCTOpP 3a BHeCyBaH€ TEeKCT LWTO Ke ja 3agpxu

BallaTa nopaka OoTkako Ke rm M36epeTe CakaHute 360pOBI/I.

npuka3 Ha iTAP

MpUTUCHETE ro KOMYETO M Ha eKPaHoT ke ce nojasu criegHarta

nHpopmaumja:

* NkoHaTa YKaXyBa Ha TEKOBHMOT MeTo 3a nuulyBak-e

TEeKCT — BugeTe BO UKOHW.

 [MmaBHWOT NpocTop 3a
BHeCyBaHh-e TEeKCT LUTO Ke ja
3agpXv BallaTta nopaka 0TKako
Ke rnm ns3bepete cakaHuTe
30oposu.

+ Ke 6uae npukaxaH peq co
npennoXeHn 3HaLm/360poBu.

VkoHa 3a iTap
Bpojay

InaBeH npoctop

TeKCT

AntepHatueeH —-AB C 2

pea

\\ abel] [YPenyBare
™ 1 |nopaka:
3a BHeCyBawbe —~

Al

Vcnpati “j[ Visbpuium
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KOPpUCTewe Ha Konynmwarta

m&lauume wmo ce docmariHu 3a Kor4ye ce rnpumepu u ce
passiukysaam 3a cekoja rnocmaeka Ha ja3uk (audeme 60
“MNocmasysare Ha nodamoyHama yHkyuja” on page 152).

Criucok co Konyura u 3Hauu 8o ancpaHylwepquu pexxum

(TAP/ITAP)

» Co mnckny4yok Ha konumwarta 0 u 1, ropHUOT pef 3a cekoe
Konye rv nokaxysa 6poeBuTte 1 ronemmute BykBu, Joaeka
Ha JonHaTta NnuHKWja ce npukaxaHn 6poesute n manute

Byksu.

+ 3appxeTe ro NpUTMCHaTO Koe BMNo HyMepuyKo Konye 3a
[a Bresete BO HYMEpPUYKU PEXMM.

» 3a ga nsnesete og HYMEPUYKMOT pexnm Bo iTAP,

n3bepeTe ro 360porT.

» 3a pa nsnesete o HyMepUYKMOT pexum Bo TAP,
3a/pXeTe NpUTUCHATO koe BUNo HyYMepUYKO Konye.

AndaHymepuuku pexum (TAP/iTAP)

0,

MpuTncHeTe 3a Aa MeHyBaTe Mery NpBa
ronema, ronemu u manm 6yksu.

L2101@° - () +&%x*=<>
€ELE¥u[]{}\~"¢i§#

Konue

Sy

%
05
S
e
s
Pony

214




Konue AndaHymepuuku pexum (TAP/iTAP)
TUVS

tuv8
WXYZ9

wxyz9

CnUCoK CO KOM4uka U 3HaLM BO HYMEPUYKU PeXuM:

Konue

Hymepunyku pexum

Ao 5™

* [puTucHeTe 3a Aa BHeceTe uudpa Ha
TOYKaTa 3a BMETHYBaH€.

» 3agpxeTe ro NpUTUCHaTO Koe 6uno
HyMepUu4Ko kon4ye 3a da Briesete Bo TAP
HYMEPUYKN PEXMM.

+ 3a pa nanesete og TAP HymepuykuoT
pexum, 3agpxeTe NpUTUCHaTO koe Buno
HYMEpUWYKO KOmMye.

Cnucok co Kon4yumwa

U 3Hayu 80 pexum 3a cumbonu:

Konue

Pexunm 3a cumbonu

0k

+ -x* [\ []=<>8§#

2@ 7). _ +&% < =<>€£

S¥a[1{}\~";i§#

™

@
Iy
T
(51) () I1{}
ok
=< >
€EL£3¥n
# % *
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Lpyru

Kon4ynkwba

Konue onuc
Koe 6uno | * Bo TAP, nputucHeTe koe 6uno konye 3a ga ro otcpnute
HyMepuy 3aBpLUYBaH-ETO Ha 360pOT 1 Aa NPOAOIKUTE CO BHECYBaHE
KO KOM4e TekcT. Ke ce nojaBu HOB Npeanor 3a 3aBpluyBak-e Ha 360poT,

[OOKOIKY e gocTaneH, 0Tkako ke ncreve spemeto 3a TAP.
* MNpuTUCHETE 1 3aapXKeTe 3a Aa BNe3eTe BO HYMEPUYKU PEXUM
of TAP vnu iTAP andaHymepuykm pexum.

C=y

* [puTHCHETE 3a Aa BMETHETE pacTojaHue.

* Bo TAP npuTtucHeTe 3a Aa ro oThpnmTe 3aBpLUyBaHETO Ha
360pOT M la BMETHETE pacTojaHue.

» BHeceTe ro HOBOCO3aAeHNOT 360p BO KOPUCHWNYKNOT PEYHMK.

* [puTHCHETE 1 3aApXKeTe 3a Aa Ce BpaTUTE Ha NOYETOKOT Of
NMHWjaTa Co TEKCT.

* [puTHCHETE egHaLL 3a Aa MM MeHyBaTe CUTe PeXMM 3a
BHecyBat-e (CYMB0MN, HyMepUYK1, OCHOBEH U CEKYHAAPEH,
[OOKOIKY € KOHUrypmpaH).

* [puTHCHETE 1 3apXKeTe 3a Aa Ce BpaTuTe Ha CTaH4apAHUOT
PeXuM 3a BHECyBaH-e.

U36epu | MNputucHete 3a ga n3bepeTe nctakHat nsbop v ga ro ctaBute
BO [M1aBHMOT NPOCTOP 3a BHECYBaH-€ TEKCT.
MN36puwm | * MNputucHeTe egHall 3a Aa ro 3bpuLLETE NOCNEAHNOT BHECEH

3HaK.
MpuTucHeTe 1 3agpkeTe 3a Aa ro n3dpuLeTe LenmoT
MPOCTOP 3a BHECYBatbe TEKCT.

Bo TAP-pexxum nputucHeTe 3a ga ro otcppnure
3aBpLUYBaH-ETO Ha 360OPOT U Nn3arajTe Harope.

Bo TAP-pexum npuTUCHETE 3a M3MeHa Ha NMPETXOQHO
BHeceHaTa Mana 6ykBa Bo rornema.

Bo TAP-pexum npuTucHeTe 3a Aa ro otdpnute
3aBpLLYBaHETO Ha 360POT ¥ N3rajTe BO pamMKn Ha MPOCTOPOT
3a BHECYBaH-€ TEKCT.

Bo TAP-pexum npuTUCHETE 3a M3MEHa Ha NMPETXO[HO
BHeceHara ronema byksa Bo mana.

MpuTncHeTe 3a Aa ce ABWxuTe Haneso. MpuTncHeTe

1 3agpXxeTe 3a Ja NoBTopute

Bo TAP-pexuM, JOKOSKY € JoCTarnHo aBTOMaTCKO
3aBpLUyBak-e Ha 360pOoT, NPUTUCHETE 3a Aa ro oTdpnuTe
3aBpLUYBaHETO.

MputucHete 3a Aa ce ABWXUTE HagecHo. MNputncHerte
1 3apXeTe 3a Ja NoBTOpUTE.

Bo TAP-pexum fgocTanHo e 3aBpLuyBake Ha 360poT,
NpUTUCHETE 3a Aa ro npudaTute 360poT.

lo 0TBOpA MEHUTO 3a KOHTEKCT, OOKOJIKY MEHUTO 3a KOHTEKCT
€ aKTUBHO.
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nuwyBawe Bo iTAP ancgaHymMepuyku pexum
Ha npumep, ajoe pa Hanuwewme ,[Jasug 232!°.

1. Bo npuka3oT 3a BHeCyBame TEKCT, U3bepeTe /vew)

> [NocTaByBak€e Ha BHECYBaH-€TO 1 NoToa N3MEHeTe Ha
iTAP English. lNputucHeTe Ha3ap 3a aa ce Bpatute Ha
MpVKas3oT 3a BHECYBaHE TEKCT.

2. Bo npuKkasoT 3a BHECYBaH-€e TEKCT, u3bepete /= >Pexum
Ha BHecyBame U noTtoa n3bepete OCHOBEH.

3. MNpuTtucHete G*). Ce OTBOpa anTepHaTMBEH pea 1 ce
nojasyea D E F 3. [pogomnxeTe co BHeECyBaHe OyKBU NpeKy
npuTUCKarke Ha edHo Konye 3a cekoja byksa. Bo pegot ce
nojaByBaat npegsioxxeHuTe 30oposu. Jlnsrajte oo
anTepHaTMBHWOT ped HagecHo, CE AofeKa He CTUrHeTe A0
[Dasua.

4. MputncHete U36epu 3a ga ro n3bepete 36oport. Ce
rnojaByBa BO MaBHUOT NPOCTOP 3a BHECYBaH-€ TEKCT.

Aemomamckama rnpomMmeHa 3a eHecyegaHe coriemu 6yK6U ce
mf@pucmu Ha rno4yemokom Ha riopakama, rno

UHMePyHKUUCKU 3HaK criedeH 00 pacmojaHue unu rnpsama
bykea Ha 360p KpeupaH Kako HO8 3aruc 3a KOHmakm.

5. BHeceTe 6poeBu nNpeky npuTUCKawe Ha eqHo Konye 3a
cekoja bykBa. Bo peqoT ce nojaByBaaTt npeanoxeHuTe
6poesw. Jlnsrajte 4O anTepHAaTUBHUOT pea HaecHo, cé
Aofeka He cturHete ao 6apaHata koMGuHauwmja.

6. 3a Bne3 Bo cMMbonu, NPUTUCHETE @ Bo pepnot ce
nojaBsyBa nNpeanoXxeHuoT cumbon. Jlnsrajte go
anTepHaTMBHWOT pef HaJecHo, Cé AofeKa He CTUTHeTe A0
6apanunot cumbon. NMputncHete U36epwm 3a ga rim nsbepete
6poeBute. bpoeBute n cumBONOT ce NojaByBaaT BO
rMaBHMOT MPOCTOP 3a BHECYBaH-€ TEKCT.
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3aknyuJyBambe 360p

Moxe Aa ja kopucTute ognukaTa 3a AenyMHO UNK LIEroCHO
3aknydvyBare Ha 360p 3a godasare 360pOBM LUTO HE Ce BO
PEYHUKOT U/MNn 3a cKkpaTyBaHe Ha CNNCOKOT CO
anTepHaTMBM Ha oHWe 360pOoBM LITO NOYHYBaaT co oapeneH
npedukc.

1. Obupgete ce aa ro BHeceTe 360poT. Jlnarajte o
anTepHaTMBHMWOT pea 3a onuuu 3a 36opoT. Cekoja onuuja
€ yCrMeLHO ncTakHarta v A4enyMHo 3aknyyeHa.

2. BHeceTe ro BTOpUOT Aen oA 36opoT. [NpBroT aen octaHysa
HenpomeHeT (3aknyyeH). HoBoBHeceHuTe OykBu Ke buaat
MCTakHaTK 1 NOTOa 3aknyveHu, JoAeka nuarate 4o
cnepgHata onuuja 3a 360poT.

3. MputncHeTe % 360opoT e cTaBeH BO NPOCTOPOT 3a
BHECYBak-€ TEKCT CO pacTojaHue U aBTOMaTCku ke buae
A0dafeH BO PEYHUKOT.

nuulyBawkbe BO HYMEPUYKN PeXUM

1. MpuTtucHete 3a [ja nuarate 40 HYMEPUYKN PEXMM.
(MJ1M 3appxeTe NpUTUCHATO Koe B0 HYMEPUYKO Komnye
3a Ja Bnesete BO HYMEPUYKM PEXUM).

2. MNpuUTUCHETE MM COOABETHUTE HYMEPUYKM KOMYMHba 3a Aa
BMETHeTe LudpuTe.

nuwyBake BO PeXUM 3a cuMmbonu

1. MpuTncHeTe 3a fa nuaraTte 4o pPeXuM 3a cuMGonu.

2. MNpuTtucHete @ lpyna cMmMBonu 1 MHTEPNYHKLNCKN
3HauUM ce nojaByBa Ha MPUKa3oT.
3. Nuzrajte go cumbonot n nputucHete N3bepu.
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nuwyBawe Bo TAP ancaHymMepuykn pexum

1. Bo npuka3oT 3a BHeCyBame TEKCT, n3bepeTe /vew)
> [NocTaByBak€ Ha BHECYBaH-€TO U M0T0a U3MeHEeTE
Ha TAP 1 nosp3aHuoT jasuk. MNputucHete Hasap 3a oa
ce BpaTuTe Ha NpuKas3oT 3a BHECYBaHE TEKCT.

2. Bo npuka3oT 3a BHeCyBakbe TEKCT, u3bepeTte /*=w)\ > Pexum
Ha BHecyBame 1 notoa n3bepete OCHOBEH.

3. MpuTncHeTe ro KONYETO O3HAYEHO CO CaKaHMOT 3HaK,
efHall 3a NpBMOT 3HaK, ABa NaTu 3a BTOPUOT UTH. Ha
npumep, 3a ga BHeceTe ,S“, MPUTUCHETE o

Kon4yeTo YyeTupw natu. 3a ga BHecete 7,
MPUTMCHETE O KOMYeTOo NeT nNaTun. AKO He ro NpUTUCHETE
KOMYeTO BO NEpUOL O HEKOSKY CEKYHAM, 3HAKOT ke buae
npudateH 1 KypcopoT ce NPUABWKYBA KOH criegHaTa
nosuuuja.

HonaBare 360pOBM BO PEYHUKOT

Cekoj jasnk nma concTBeH peyHuk. Moxe ga kpeunpare
360poBu (BKy4yBajku 1 andaHyMepuykm kpateHkn). OTkako
ke 1 kpenpaTte 360poBUTE U ke JodadeTe pacTojaHue, Tve
ke GugaTt aBTOMaTtCKku 3a4yBaHu BO PEYHUKOT U Ke ce
nojaByBaaT kako M3bop Kora BO MAHVHA Ke ja nputuckare
ncrtata KoMOUHaLUMja Ha KON4YnH-a.
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LlUTo aa HanpaBuTe ako...

Ha BawmnotMTHS800 noyHyBaaT ga TpenkaaT crnegHuTe

nopaku:
Mopakwu Onuc Ha nopaka
...-Mpumenn [MpUMeHM NOBMLM LUTO HE CE OAFOBOPEHN MU ofdueHu.
HeycnewHo MTHB800 He moxe Aa u3BpLUM NpyKadvyBake Ha rpyna 3a
npukadysame pasrosop. MTH800 npogorkysa fa ce obuaysa. [lokonky

He ycrnee, obuaete ce co Apyra rpyna 3a pasroBop.

HeycnewHo MTH800 He MoXxe aa ce permctpupa Ha cuctem 3a noTepaa
noTBpayBame (Ha npumep, KNy4oT 3a NOTBpAA € NorpeLleH unu notepaara

e oHeBO3MOXeHa Ha MTHB800).

Cnaba batepuja

Batepujata He e HanonHeTa. HanonHete ja 6atepujaTa.

OTKaxaH NoBumK

[MosukaHnot MTH800 ro oTkaxyBa NOBMKOT.

MosukoT
€ npekvHar

* MorpelweH kaHan. Obugerte ce nogouHa.
* MoBukaHnotr MTH800 ro NnpeknHa NOBUKOT.

CnpeyeH noBuk

KaHanot ce KOpucTu 3a NpuopuTeT.

M3rybeHa Bpcka
[0 cepBepoT

Osga ro npeamasnkyBa WAP-cepBepOT KOj ja NpekunHyBa
cecwjaTta.

Onuwuja 3a nTeH

Opnvkata 3a BKIny4YeH MUKPO(OH € aKTUBHa, HO Jo3BornaTa Ha

cny4aj BO KaHanoT 3a NPeHoC e JoAerieHa Ha APYr NOBWK 3@ UTHU Cryyau

ynotpeba: Ha nctara rpyna 3a pasrosop. MukpodoHoT Ha MTH800 He e

Mouekajte Aa aKTMBEH BO TEKOT Ha 0BOj nepuogd, Ho MTH800 aBTomaTcku ke

ce BKIyun ce obuae NoBTOPHO Aa ja 4obue go3sonara 3a pasroBop No

MUKPOpOHOT NPETXOAHO YTBPAEHOTO BpEME.

MwukpodhoHoT BpemeTpaeneTo Ha ognukata 3a BKIy4eH MUKPOdOH

3a UTHU cryYyau aBTOMATCKM UCTEKYBa UMW KOPUCHUKOT ro MMa MpUTUCHATO

€ UCKIy4eH konyeTo 3a PTT 3a Aa ja oTkaxe oanvkara 3a BKIyYeH
MUKPOCOOH.

MwukpodoHoT OpnvkaTa 3a BKIy4YeH MMKPOdOoH e akTmBHa u MTH800

3a UTHU cnyYau aBTOMATCKU [0 NpeHecyBa 3BYKOT 3a UTHM Criy4am co cnobogHmn

€ BKIyYeH paue.

Mpa3seH 3annc

Bpojot 3a 6p30 Guparse WTO ro n3bpasTe HEe NOCTOM UMK
6pojoT nocTom, Ho rpynata He Moxe Aa ce n3bepe.
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Mopaku

Onuc Ha nopaka

MorpewHa
eavHuLa...

CamoTecTupareTo He e yCrneLlHo. YTBpaeHa e onepaTtviBHa
rpeluka Ha Bawmot MTH800. CHumeTe ro 6pojoT Ha rpeLukara.
Mcknyyete ro Bawmotr MTH800 1 jaBeTe ce BO CepBUCHUOT
LeHTap.

[pynata Beke

lpynaTa wTo ce obuayeate aa ja Jogagerte Beke NOCTou BO

nocrou nankata Mou rpynu.

HepoBonHo BaluvoT TepMmHan e Bo NpoLEC Ha oApeayBakbe Ha Balarta
BUAMUBU nokaumja. Moxe 4a NoOMUHAT HEKOSIKY MUHYTMW Npes, npoLecoT
nogaroum [a 3aBpLuu.

HepoBonHo BaluvoT TepMumHan e Bo NpoLEC Ha oApeayBake Ha Balarta
BMANUBY caTenuTyh | nokauuja. Moxe ga nomvHaT HEKOMNKY MUHYTV Npea npoLecoT

Aa 3aspLin.

MorpelueH 6poj 3a

naeHTndukaumja

BHeceHnoT 6poj e norpeLueH.

MorpewwHa BHeceHwnoT 6poj e norpelLueH.

nosuuuja Ha

KpaTeHka

OrpaHuyeHa MoBuuMTE 3a UTHM CryyYaun, anapMmuTe 3a UTHW criydam
ycnyra 1 onepauunte 3a MOBUIHOCT (Ha Np., NpuKavyBake rpyna)

ce possoneHu. Cute apyru A0jOOBHM U MOjAOBHU MOBULN
1 NoJaTodHU yCryru ce GriokMpaHu.

Mpa3seH cnncok

Hema nporpamupanm 3anucu Bo CMIMCOKOT 3a Nn3rame.
BHeceTe ro 3anucor.

CnmncoKoT He

Cute rpynu 3a pa3roBop BO CMUCOKOT 3a CKeHUpaHe He ce

e npuKayeH npUKayYeHun.
CnucokoT CnncoKoT 3a CKeHNpahe e aKTVBEH, HO He Ce MpuKadYeHu cute
e AenyMHo rpynu 3a pasrosop.

npukayeH

Hucko HuBo Mmate nomarky og neT MMHYTU 3a pasroBop.

Ha nonHewe Ha

bartepujata

MopakaTta YkaxyBa Ha ycrnelwHo JocTaByBame Ha nowuTara.

€ fjoCTaBeHa

MopakaTta
€ HeycnelHa

yKa)KyBa Ha HeyCnewHo AOoCTaByBawe Ha nowTarta.
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Mopaku

Onuc Ha nopaka

N2
Y Pexum npu

HegocTanHa
mpexa

MTHS800 He e BO rpaHuLM Ha NokpueHocT. BpaTteTe ce Bo
rpaHuLnTE Ha NOKPUEHOCTa.

Mankata co moun
rpynu e npasHa

He moxete ga rmepare/6pviueTe rpyny Kora nankara 3a Mom
rpynu e npasHa.

Mankata co mou
rpynu e nornHa

He B1 e gossoneHo Aa gogaaete rpyna BO nankara 3a Mou
rpynu, buaejkn Beke ro cogpxu MakcuManHuoT 6poj Ha
[03BONEHN TPyMnu.

Mpo6nemu co
Mpexarta

Mpobnemu co mpexata. Obuaete ce NOBTOPHO NOAOLHA.

Hewma ogrosop

MNMoBvkaHaTa cTpaHa He oarosapa.

Hewma 3anucu

Osaa nopaka ce rojasysa npwu NpuUcTan 4O NPaseH Cr1CoK.

Hewma rpyna MpukadyBareTo e HeycnewHo. MTH800 e oTkayeH of
TeKkoBHaTa rpyna 3a pasrosop. [Noyekajte MTH800 noBTopHO
[a ce NpuKa4u Ha TeKOBHaTa rpyna 3a pasroBop.

Hewma rpyna » Ce nojaByBa Kora CTe HagBoOp oA HopMarnHarta obnact Ha

MOKPVEHOCT Ha BalaTta n3bpaHa rpyna 3a pasrosop.
M3bepeTe HoBa rpyna 3a pa3roBop LUTO e BanuaHa 3a
BaluaTa paboTHa nokauuja.

* YkaxyBa fjeka oMmurieHaTa rpyna e otcTpaHeTa of nankara co
MoWu rpynu.

Hema cnucok

CnucokoT co MpeXu e npaseH.

Hema HoBu nnn
cTapu nopaku

YkaxyBa [jeka HemMa HOBUW UK CTapy Nopaku BO CaHAa4eTo co
NPVYMEHU Nopaku.

Hema n3bpan
CMNCOK 3a
CKeHupatse

M3bpaBTe npaseH CNMCOK CO MpPeEXU (Hema CrMCOK).

HepoctanHa
Mpexa

MTH800 He e BO rpaHMum Ha NOKPUEHOCT.

Hema possona 3a
BOCMOCTaByBaHe
NoBUK

He Bu e no3BoneHo aa 6upare 6poj LWTO He e BO agpecapoT —

AOKOSKY € NOoCTaBeH o4 CTpaHa Ha BalUMOT gaBaTes Ha yCcnyru.
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Mopaku

Onuc Ha nopaka

Hema posBona 3a
npeHoc

OtnywTete ro konyeto PTT n obngete ce NOBTOPHO NofoLHa.

* He Bu e go3BoneHo ga ncnpakare TekcTyanHa nopaka unm
rnopaka 3a ctaTyc Ha 6pojoT LUTO He e BO agpecapor -
[OKOIKY € NoCTaBeH o CTpaHa Ha BaluMoT AaBaTten Ha
ycnyru.

Camo efieH 3anuc

Mma camo egeH nporpaMmpaH 3anunc Bo CUCOKOT 3a NU3rake.

MpenonHyBawe MTH800 ce uncknyyysa. OtctpaHete ro MTH800 of nonHa4or.
MperpeBare MTHB800 ce uckny4dysa. Nckny4yete ro Ha HEKOMKY MUHYTMW.
CTtpaHaTa e Mosukanmnotr MTH800 e 3adaTteH.

3acpateHa

CTpaHaTa He e

* MNosukaHnotr MTH800 e HagBop og oncer. Obuaete ce

npujaByBame

pocranHa NOBTOPHO NoAOLHa.
* MoeukaHnot MTHB800 e ncknyyeH. ObuaeTe ce NOBTOPHO
nogouHa.
O6upete ce MTH800 He moXxe fa ro BocnocTtaBu NOBUKOT.
NMOBTOPHO.
Mouyekajte, lMopaka BO TEKOT Ha BKIyYyBaHe.
noBp3yBake
HeycnewHo MTHB800 He moxe fa ce pernctpupa Bo cuctemot. Obuaete ce

NOBTOPHO NoAouHa.

BapareTto ncreve

MoTTUKHATO Of UCTEKOT Ha BpeMeTo — GaparseTo Gelue
COOABETHO UCMPATEHO, HO He Gellie MPUMEH OATOBOP, MAKO He
GeLue yTBpAEHa rpeLlka BO Mpexara.

Ycnyrata e
onbveHa

MorpeleH 6poj. MoBukajTe ro BawMOT AaBaTen Ha ycryru.

Ycnyrata He e

OBaa ycnyra He e oCTanHa Ha TeKoBHaTa Mpexa.

O3HavyBak-e Ha
jaynHaTta Ha
3BYKOT Ha
3BYYHUKOT/
cnywankara

focTanHa

Ycnyrata e Ogaa ycnyra e orpaHudeHa o Ball1oT AasaTer Ha yenyru, He
orpaHuyeHa e KyrneHa unv He e JocTanHa.

LpTn 3a KopucTeTe ro konyeTo 3a poTtaumja 3a npucnocobysarbe Ha

jaumHaTa Ha 3ByKOoT. (Kon4yeTto 3a poTaumja € nporpammpaHo Ha
,ABOjHa YHKUMja“ nnn ,jaymHa Ha 3BYKOT").
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Mopaku

Onuc Ha nopaka

Ipyna 3a
pasrosop...Aofagne
Ha

HasnBoT Ha rpynarta e JofafeH Bo nankara Ha OMUMEeHW rpyni
3a pasrosop.

['P... He MmOXe ga

Osaa rpyna He MoXe Aa ce usbpue of narkara 3a OMUNeHun

ce n3bpuwe rpynu 3a pasroBop. BawvoT gaBaTen Ha ycnyri noctaBus oBaa
rpyna fja He Moxe fia ce usbpuiie.

Obupete ce BapaHaTa ycnyra e npuBpemMeHo HegocTanHa.

NOBTOPHO

nofouHa.

EaovHuuata e
OHEBO3MOXeHa

[MpoBepeTe Kaj AaBaTenoT Ha ycnyru.

EavHuuarta e Bo

pen
BHumaHwe...

peluka npu camoTecTupame. YTBpAeHa € MMHUMarHa rpeLuka
Ha BawmoT MTH800. MTHB800 ce ywwiTe e LenocHo
dyHKUMoHaneH. [lokonky oBaa rpeLuka ce noBTopu, 3anuiiete
ro 6pojoT Ha rpeLukaTa 1 jaBeTe ce BO CEPBUCEH LieHTap.

EgvHuuarta He e
npvkayeHa

MTHS800 He moxe Aa ce npukayn Ha cucteMoT. pynaTta 3a
pasroBop Moxe Aa He buae AedurHMpaHa BO CUCTEMOT.
O6wupaete ce co gpyra rpyna.
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ToHOBMU

[ ] = Bucok ToH; [l = HN30K TOH

onuc

| Bug

MoBTOpEH

MupyBame

* Bpakate Ha maTtuyHmoT
eKkpaH

» Bpakatbe Ha Kopuctere
Ha konyeTo 3a
poTVpare, OTKaKo
BPEMETO 3a Nnsrake co
poTupare ke ucteve.

* Bpakare Ha
NOKpUEHoCT

* Bpakare Ha uenocHa
PYHKUMOHaNHOCT

L

EpHaw

Mosxe aa ce npatu

EpHaw

* [orpeLuHo npuTUCKare
Ha KonyeTo

EnHaw

* MpaBuUnHo npuTUCKame
Ha KOM4YeTo

* MTH800 HeycnewwHo
camoTecTuparse npu
BKITy4yBaH-€TO

» Of HedyHKUMOHANHOCT
[0 (hYHKUMOHaNHoCT

EpHaw

Bo Tek Ha noBuK

* Npegynpenysate 3a
NoBuWK
* MoBWKOT € nsmeHeT

EnHaw

ToH 3a NOBMK Ha Yekahe
3a Yyekame Ha
TenedOHCKM unm
npuBaTeH NoBMK

Ha cekoun 6 cekyHawn,
ce goaeka NoBuKOT
He Byae npekuHar.

MoBp3aHu nogaToun mnu
HenoBp3aHu nogartouu.

EpnHaw

[lo3Bonara 3a pa3roBop
ce ornacysa no
nputuckare Ha PTT.

EgHaw (HopmaneH
TOH)

EpHaw (kpaTok TOH)
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[ = B1COK TOH; [l = HU30K TOH

onuc Bua MoBTOpeH
[osBonara 3a pa3roBop 1 1 [Ba natn
6e3 MpexeH npemuH ce

ornacysa no npuTuckawe

Ha PTT. ToHOT ykaxyBa [ EgHaw

aeka MpeXHUOT NpeMuH
He e NoBeke JocTaneH.

» 3abpaHa 3a pasroBop

» Cuctemort e 3agpateH

* NcteueHo Bpeme

* MNoBukaHnotr MTH800He
e focTaneH unm e
3adpateH.

Hopeka ga ro
ornywTtute PTT

MoBMKOT € NnpeknHaT unm - EpHaw
HeycnelueH nopaau

MpexaTa.

W36paH norpeLueH 6po;. Be3 ToH
Bne3 Bo DMO-pexum |:| EnHaw
Manes3 ogq DMO-pexum -_-_- EpHaw
BwmpexyBare Ha nokanHa ] EpHaw

cTpaHuua — Bnes/nasnes

[MoBpaTHO SBOHEH-E Ha
TenedoHOT (Mcnpakahe)

Ha cekomn Tpn
CeKyHau, cé goaeka
NOBUKAHWUOT
KOPWCHWK He
OAroBOPY UK He ro
onbue noBuKoT

TenedoHoT e 3adareH - - Ha cekon
0,5 cekyHau

MpuTUCHeTE ro KonNyeTo |:| EpHaw

3a fa ro ucnpartute

CTaTycoT A0 AucnevepoT

Mopakara 3a cTaTtyc e 1.1 EpHaw

ncnpateHa ao

ancnevyepot

[MpremoT Ha nopakaTa 3a -_-_-_-_ EpHaw

cTaTyc He e NOTBpAEH o
AMCreYepoT, a BpeMeTo
NCTeKyBa
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[ = B1COK TOH; [l = HU30K TOH

onuc Bua MoBTOpeH
lMpuemot Ha nopakaTa 3a 1 [ EgHaw
cTaTyc e noTBpaeH

[ojaoBHM noBULM

BawmnotMTH800nprmmn 1 [1] - EpHaww
rpyneH noBuk 6e3 mpexeH

npemuH. (camo

nocTaByBaH€)

MpuMeH rpyneH NoBMK co 11 11 EpHaw
BWCOK NpuopuTeT

WcnpateH nnv npumer 11 [Ba natn

anapm 3a UTHU crnydau

AnapmoT 3a UTHK criyyam
e HeycneLleH

N I B

YeTunpwn natu

lMprMeH NoBKK 3a UTHK
cnyyau

(N

EnHaw

SBOHeH€e Ha TenedoH
(npuem)

[lBoHaco4eH npuBaTeH
NoBUK

Cnope,u, nocTtaBkaTta Ha
NOAMEHUTO 3a Ha4yuH Ha
SBOHEH:€E.

Cé popeka He
OAroBOPUTE UNU He
ro ogbuere NoOBMKOT

lMpuMeH npuBaTeH NOBUK

Cnopepg nocTtaBkata Ha
NOAMEHUTO 3a HaYMH Ha
SBOHEHE.

Cé popeka He
oaroBopuTe Unun He
ro ogbuere NOBMKOT

SBOHO 32 npmeaTteH NOBUK
Ha NoBUKYyBa4y

Cé popeka He buae
OAroBOPEHO Ha
NOBMKOT

SBOHO 3a egHOHaco4eH
npvBaTeH NPeBEeHTUBEH
NPUOPUTETEH MOBUK
(PPC).

Ha cekown 4 cekyHawn,
ce goaeka He ce
OAroBOPY UK He ce
onbue noBuKoT

SBOHO 3a BOHACOYeEH
npueateH PPC-noBuk.

Ha cekown 4 cekyHawn,
cé goaeka He ce
0froBOPU UK He ce
onbue noBuKoT

OrpaHuyena ycnyra

EpHaw, no Bnesot
BO OrpaHu4yeHara
ycnyra

MpumeHa HoBa nowTa

B B B
S —
L1 1 [ ]
[ -
-

EpnHaw
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[ = B1COK TOH; [l = HU30K TOH

onuc Bua MoBTOpeH

Hosa WAP-nopaka - - EpnHaw

HoB rpyneH nosuk |:| D EpHaw

OnuwTo

MocTaByBare Ha |:|_ MpopormkeHo

jaumMHaTa Ha 3BYKOT

(cnywanka, Tactartypa,

3BYYHUK)

lMocTaByBare Ha 1 [Mpun noctaByBake

jaunHata Ha 3ByKOT Ha jayvHaTa Ha

(sBoHO) 3BYKOT

CnipeyvyBar-e Ha NpeHoc el EpHaw

(TXI)

ToH 3a konyeTo 3a ] EgHaw, npu

poTupare npedpnake og
CMNCOK Ha ja4ynHa Ha
3BYKOT

CwurHan 3a HUCKO HMBO Ha |:| D |:| D MoBTOpEH

nonHewe Ha 6atepujata

DTMF (0-9, #, *)BoTekHa | DTMF MpoporxkeH, ce

NOBUKOT 1 poneka KOpUCHUKOT
He ro oTnyLTH
Kon4yeto

[BoeH PTT — egHokpaTteH - EpHaw

TOH

[eoeH PTT — oBoeH TOH -_-_ EpHaw

[BoeH PTT — TpoeH TOH -_-_-_ EnHaw

GPS

GPS BO nokpueHoct |:| EnHaw

GPS Hagsop of - EpHaw

NOKPUEHOCT

mKopUCHUKom He moxe da eu npudywu moHosume 3a
rnosukysarbe.
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Nupekc

A-Z
AL (ambueHTanHo cnywatse) 90
ATG (u3BecTtyBauyka rpyna 3a
pasroBop) 48
DGNA (gnHamnyko HasHadyBame
6poj Ha rpyna) 58
DMO (dyHKUMOHMPpaHe BO
OVpeKTeH pexum) 34, 61
DMO SCK 147
DMO/TMO co egeH gonup 28
DMO-rpyneH nosuk
BOCMocTaByBawe 67
npumatse 70
DTMF npeHeceHo bupatse 86
GPS (rnobaneH cuctem 3a
nosvumoHupamne) 123
GW (MpexeH npemuH) 61
Hot Mic (BknyyeH MUKpohoH) 96
HTTP-aBTeHTUYHOCT /14
InterMNI nosuk 61, 101
IP (nHTepHeT npoTokon) 45
iTAP
n3bupamre 212
WKOHU 212
nuwysawe Tekct 212, 217
npukas 213
K (knyy) 146
MSPD (noBekekpaTeH nakeT co
nogartouu) 45
PABX (lNoBukoT 3a pa3meHa BO
pamKu Ha npvBaTHa
aBTOMaTCKa rpaHka) 83
PABX-noBuk 83
PD (naket co nogatouu) 45
PIN (6poj 3a nnyHa
naeHtTudukauuja) 141

PPC
BOCMNOCTaBYyBah€ Ha NpuBaTeH
nosuk Bo PPC-pexum 80
PUK (nunyeH knyy 3a
aebnokvpatrbe) 142
RUI 182
SCK (cTaTn4eH knyd 3a
wndppuparse) 146, 147
TAP
n3buparse 212
NkoHu 212
nuwyBawe Tekct 2172
npukas 213
TMO (byHKUMOHMpPaKEe BO PEXNM
Ha BMpexyBare) 33
TMO/DMO
eneH gonvp 28
TMO-rpyneH noBuk
BOCMNocTaByBahe 54
npumame 54
TXI (cnpeyyBarbe Ha npeHoc) 57
WAP (npoTokon Ha 6e3xun4yHa
annukaumja) 103
WAP-nocpegHwuk 113
WAP-ToH 230
WTLS (6e36egHocT Ha 6e3xuyeH
TpaHcnopT) 103

A
anapm 3a UTeH cnyyaj
ncnpakate Bo TMO-pexum 94
andgaHymMepuryKo Konye
BHecyBaHe TeKCT (BykBu 1
undpwn) 12
ambureHTanHo cnywate
(AL) 41, 90
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b
6e3beHOCT Ha 6e3xnyeH
TpaHcnopT (WTLS) /03

6e3XnM4HO Koampame

Opuere Ha kny4 145
Oupatbe Ha kpaTku 6poesu 77
Oupatrbe NoBukK co egeH gonup 29
Op30 bupare 85
Opulense Ha kny4 145
6poj 3a 6p30 Gupane 50

B

BepTukanHo npeBpTEH ekpaH co
eneH gonvp 29
Bubpaumja 148
noctaBsyBawe /49
BUCOK/HU30K 3BYK 17, 30, 153
BKITy4EHO/UCKNYYEHO CKEHUPaHE
npn TMO-rpyneH nosuk 56
BKIyYyBak-€ rpyna 3a pasroBop co
eneH gonup 28
BKIyYyBah-€ NpeTxoHa rpyna 3a
pasrosop 28
BKIyYyBah-e/McKknyvyBame 14
BMpEeXyBak€ Ha fnokanHa
cTpaHuua 44
BMpeXyBare Ha LUMpoKonojacHa
cTpaHuua 44
BpemMe
efeH ponvp 29
nocTtasku 3a npukas 157
noctaBsyBawe 158
nocTaByBake€ Ha
n3efHavyBaweTo 159
noctaByBane Ha hopmaTtoT /58
Bpeme u gatym 32

r

rnobaneH cuctem 3a
nosunumoHupame (GPS) 123
ropeH MukpodoH 11, 17, 18
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rpyna 3a pasrosop 47
6poj 3a 6p3o Gupare 50
pyneH NoBuWK 3a UTHK cnyyam 92
BOCMOCTaByBaH€ BO
TMO-pexum 95
npvem Bo TMO-pexum 97
npuMmare Bo DMO-pexum 102
rpyneH NoBuUK 3a UTHU cny4van
BOCMOCTaByBaH€ BO
DMO-pexum 102

O
aaTtym
eaeH gonup 29
nocTaBku 3a npukas 157
noctaByBake 159
noctaByBak-€ Ha popmatoT 158
[BOHACO4YeH NoBuK 17
ABOHaco4YeH NpuBaTeH NoBUK 75
aebnokupare Ha TepmuHanoT 142
OvHamnyko HasHavyBane 6poj Ha
rpyna (DGNA) 58
AVpeKTHa noctaska 37
poneH MyukpodoH 12, 17, 18
NpuAaYyLWn/oTKaxu
npuaywysawe 42

E
efeH gonvp
DMO/TMO 28
TMO/DMO 28
Gupatrbe nosuk 29
BepTukanHo npeBpTeH
ekpaH 29
BKIy4yBake rpyna 3a
pasrosop 28
Bpeme 29
patym 29
3aWTUTHUK Ha ekpaHoT 29
obpasel 3a TekcTyanHa
nopaka 29



nopaka 3a cratyc 29
npucnobyBane Ha 3afHUHCKOTO
cBeTno 29
pexuM 3a npukpusake 29
CKeHupame Ha rpyna 3a
pasrosop 28
cnpeyvyBakse Ha npeHoc (TXI) 29
e[HOHaco4eH noBuK 17
€OHOHAaCcoYeH NpuBaTeH NoBuK 75
ekpaH
noctaByBahe 3agHuHa 163
noctaByBahe KOHTpacT /64
nocTaByBake Ha ofnukaTa 3a
BEPTUKAITHO
npespTyBake 160

3

3aKny4vyBare/0TKIyYyBaHe Ha
Tactatypata /43
3alUTUTHUK Ha ekpaHoT 3/
3aLUTUTHUK HA eKPaHOT CO efeH
ponvp 29
3BYK
BUCOK/HM30K 30, 153
3BYYHUK I3

n

n3bop Ha rpyna 3a pasrosop 48, 62
n3bop co ckeHnpare 48
n3BecTyBauka rpyna 3a pasroBop
(ATG) 48
WKOHM
DMO wmpexeH npemuH 22
DMO penetutop 22
GPS 126
TAP/iITAP 212
Bnbpaumja n sBoHo 23
BKIy4yeHa Bubpaumja 23
OVpeKTeH pexum 21
WCKMYyYeH 3BYYHUK (HU30K
3ByK) 23

uTeH cnyvaj 23
jaunHa Ha curHanot (DMO) 27
jaunHa Ha curHanot (TMO) 21
KOHTakTn 139
nnarakwe HU3 cnncok 23
meHun 132
HegocTanHa mpexa 21
HMBO Ha NosiHewe Ha
Gatepujata 23
HOBM MOpaku BO caHAa4eTo 3a
NpUMeHun nopaku 24
noep3aHu nogatoum 21
npenuctysay /03
npeHoc/nprem Ha nogatoum 21
npucTurHaTta Hoea nopaka 23
caHZade 3a NpMMeHu
nopaku 196
CkeHupare 21
uHTepHeT npotokon (IP) 45
MHTEPOH
cno6oaHu paue 42
MHTEepdOH 3a cnoboaHu paue 42
nucropuja
GupaH nosuk 176
NpVYMeH NoBuk 176
nponyLwTeHn nosuumn 176
ucropuja Ha GupaHu nosuum 176
ncTopuja Ha NpUMeHn nosuun 176
ncTopuja Ha NPonyLITEHN
nosuun 176

J

jasuk Ha TekcT 212

K

kanauutet /88
Koaupake
6e3xnyHO Kogupare 144
OpuLLeHe Ha Ky4oT 3a
6e3XM4HO Koaupame 145
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Konye
NpekuHyBak-e-3acTaHyBame Ha
NM3rakeTo CO KOMYETO 3a
poTupare 53
poTupare 26
konue 3a PTT (nputucHu pa
36opysaw) /3
KOMYe 3a BKNy4yBaHe-
UCKIyYyBare/NMpeknHyBame/
MaTu4HO Kon4ve /4
Kon4e 3a ncnpakamwe 13
Konye 3a UTHW criyyam 26
KOMYe 3a KOHTpona Ha
3ByYHUKoT 30, 154
KOMYe 3a HaBurauuja Bo YeTUpu
Hacoku 13
Kon4ye 3a potupare 26
NpekuHyBake-3acTaHyBame Ha
NM3rakeTo CO KOMYETO 3a
poTupare 53
Konue/porneH npekvHysad 60
KonymHa
BKIy4yBaH-e-UCKIyYyBame/
npekuHyBake/MaTU4HO
konye /4
Boku-Toku (PTT) 13
ucnpakare 13
uTeH cnyyaj 26
KOHTpona Ha 3By4HuKoT 30, 154
MeHun 25
HaBurauuja Bo 4eTupu
Hacokn 13
nporpamcku 25
LUTO MOXe Aa ce
nporpamupaat 27, 28
KOPUCTEHE Ha canHaaveTo 3a
npvMeHun nopaku 195

n

nuararbe
NpekMHyBak-e-3acTaHyBakbe Ha
Kon4yeTo 3a poTupare 53
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nokanHa ycnyra 44
Bres 44
nanes 45

M
MaTuYeH ekpaH 20
MeHu 25
MeHM Ha npenuctysadoT /09
MUKPOOOHU
ropeH MukpodoH 11, 17, 18
poneH MykpodoH 12, 17, 18
NpuaYyLWn/oTKaxu
npuayLyBake Ha JONHUOT
MUKPOGOOH 42
MpEXeH NpemMuH 61, 64

H

HameTHaT NoBuK 57

HaYMH Ha SBOHEH:E 3a [0jA0BEH
nosuk 150

HeTaKTUYKN NoBUK 91

Hu30K/BUCOK 3BYK 17, 30, 153

HoTauum 5

HYMepUYKO KoM4e LUTO MoXe Ja ce
nporpamupa 28

(o)

o6pacum 191

obpacuu gecvHupaHm og ctpaHa
Ha KopuCHUKOT 202

OB0O3MOXYyBaH-€/0HEBO3MOXYBaHe
Ha GPS 126

ofnuka 3a BKIyYyeH MUKPOdOH
(Hot Mic) 96

omwuneHa rpyna 47, 172

opraH 3a cepTudukaumja (CA) 114

OTBOpPEH MOBUNeH
npenuctysay 115

oTBopeHa rpyna 61, 101

OTKaXu npuayLlyBare/npuayLm
[0neH MUKPOdoH 42



n
narka
n3bop 48, 63
nuarajte Ao cnegHa 53
omuneHa rpyna 48, 62
ocTtaHete 53
nuwysane TekcT 211
nosmum
JBOHaco4eH noBuk 17
e[IHOHaco4eH noBuK 17
nogmMmeHu 3a 6e3benHoct 141
noAMeHM 3a KOHTakTn 138
noameHu 3a kpaTteHkun 178
noameHu 3a mou uHcopmauun 175
MoameHu 3a mpexun 184
nogmeHu 3a nopaku 138, 191
noamMeHu 3a nocnegHu nosuun 176
nogpenyBane nosuk 87
nonHewe Ha 6atepujata 7, 14
nopaka 3a cratyc /91
ucnpakawe 204
uenewe 205
ropaka 3a crtaTyc co efeH
ponvp 29
nocpeaHuk 113
nocraeka 3a Bpcka 37
noctaByBar-€ rpyna /68
rnoctaByBahe 3agHuHa 163
rnoctaByBah€e KOHTpacT 164
nocTaByBak€e Ha rofieMMHaTta Ha
TekcToT 162
nocTaByBat-€ Ha 3a4HUHCKO
ceeTno 154, 163
NnocTaByBahe Ha 3alUTUTHUKOT Ha
ekpaHoT /62
[MocTaByBake Ha pexuMorT 3a
npucnocobyBame Ha jaumHaTa
Ha 3ByKOT /54
nocTaByBar-€ Ha
cKeHupaweTo 168
nocTaByBak€e Ha ToHoBUTE /54

nocrtaeyBawe nogartoum 152
NpPeBEHTMBEH NPUOPUTETEH NOBUK
(PPC) 38
npeBpTEH eKpaH, BEPTUKANHO CO
eneH gonuvp 29
npekMHyBak-e-3aCcTaHyBakbe Ha
NM3rakeTo Co KonYeTo 3a
poTupare 53
npenucTyeay
OTBOpeH mobuneH
npenuctyeay /15
npeHecyBaH rpyneH nosuk 40
npeTxoaHo AeduHUpaH
o6pasey 203
npusateH 6poj 31/
nperneg 175
MpuBaTeH NoBuk
6uparbe Npeky CMCcoKoT CO
KOHTaKTn 77
6upare npy npumane nosuk 80
BOCMOCTaBYyBak-€ [IBOHACOYEH
noBuK 75
BOCMOCTaByBaHe eqHOHACO4€EH
noBuK 75
ONPEKTHO Gupare 76
npvBaTeH NoBuK 75
Guparse Ha kpaTku 6poesn 77
npumatrse 78
npuBaTeH NOBWK NPU UTEH
cnyvyaj 93
NpUAYLWW/OTKaXWU NpUAYLLYBaHe
Ha OOMHUOT MUKPOGOH 42
npuKaxkaH nosuk 57
npukas
TAP/ITAP 213
goma 20
nocrtaByBakbe jas3vk 157
nocTaByBa€ Ha ronemuHaTa
Ha TekcToT 162
npukas Ha JOnrv TeKCTyarnHu
nopaku 193

235

MdTHY



npukavyBame/0TCTpaHyBake Ha
aHTeHata 10
MPUKIY4oK 3a ayamno
pononHuteneH npubop 72
MPUKNYYOK 32 JOMNONHUTENEH
npubop 12
MPUKIYYOK 32 HaABOpeLLHA
aHTeHa 12
NPUKIyYoum
ayamvo 4ONONHUTENEH
npubop 12
aononHuteneH npubop 12
HagBoOpeLlLHa aHTeHa 12
npumatrse nosuum 38
npucnocobyBare Ha 3aAHUHCKOTO
CBEeTIO co eaeH gonup 29
npucrnocobyBare Ha jaunHaTta Ha
3BYKOT 28
nporpamckm konynwa 25
npomeHa Ha wudppa 143
NpoTOKON Ha 6e3xmyHa
annukaumja (WAP) 103
nceBaoHuUm 3/

P

pa3MeHa BO paMKU Ha npvBaTHa
aBTomarcka rpaHka (PABX) 83

PeXuM 3a NpUKpUBaHe CO eAeH
ponvp 29

penetuTop 61, 65

peyHuk 2719

PPC (npeBeHTVBEH NpuopuTeTEH
nosuk) 38

Cc

CKeHMpah€e Ha rpyna 3a pasroBop
co eneH gonuvp 28

CMMCOK 3a CKeHnpare 47

cnucok co 6upaHu 6poesun 176

CMUCOK CO KoHTakTh 138

Cnmcok co mpexu 170
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CMUCOK CO CTaBKM o MeHuTo /34
cnpeyyBate Ha npeHoc (TXI)
eneH gonvp 29
pexum 57
cTaBka og MeHu 131
CTPaHW4YHU KOMYMHLA LLITO MOXE Aa
ce nporpamupaar 27
CTPaHM4YHO KomM4ye LUTO MOXe Aa ce
nporpamupa 27

T

TaKTU4Kku nosuk 97
Tactartypa /2
3aKnyyyBawe/
oTknydyBawe /43
KOpUCTEHE BO andaHyMepuyku
pexum 214
KOPUCTEHE BO HYMEPUYKM
pexum 215
KOPUCTEHE BO PEXMM 3a
cumbonu 215
TEKCT Ha 3alUTUTHUKOT Ha
ekpaHoT 162
TekcTyanHa nopaka /91
ucnpakawe 191
obpaseL
eneH gonvp 29
TenedoHckn 6poj 31, 83
npernea v npomena 175
TenedoHckn nosuk 83
Gupatrbe co egeH gonvp 85
6p30 bupare 85
TenedoHckn/PABX nosuk
Gupare Npeky CrMcokoT Co
KOHTaKkTh 84
6upare npy npumane noBuk 84
BOCMNocTaByBahe 84
ONPEKTHO Gupame 84
oarosapare 86
TOHOBMU



rocTaBka 3a ,MOXe fa ce
ucnpatn® 156
nocTaByBakE Ha cuUTe
TOHOBW 155
rnocTaByBah-€ Ha TOH 3a
[o3Bona 3a pasroBop /55
rocTaByBaH€e TOH 3a
TacTtatypata /55

Yy

ycnyra 3a nakeTt co nogatoum
(PD) 45

ycnyra 3a noBeKkekpaTeH nakeT co
nopatouun (MSPD) 45

(0]

dpekBeHTeH oncer /89

hYHKLMOHMpPaH-e BO AUPEKTEH
pexum (DMO) 34

bYHKLUMOHMpPaHE BO PEXUM Ha
BMpexyBame (TMO) 33

y

yncTewe Ha Bawarta eauHuua 20

L

LUMpOKomnojaceH nosuk 40
WwTenerwe eHepruja 164
wrenewe eHepruvja (LLE) 164
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